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cHAPTER r About Mosaic

Mosaic is a powerful and flexible music notation

program for the Apple Macintosh computer. It
provides a comprehensive environment in which to

compose, notate, and print music. Here are some

examples of what you can create with Mosaic:

r Lead sheets

r Piano/Vocal arrangements

r Piano scores

r Orchestra scores and individual instrument

parts

r SAIB choral scores and individual parts

r Method books and other instructional materials

r Musical examples to be placed in word-
processing and desktop publishing programs like

Microsoft Word or PageMaker

Design philosophy
Music software today seems to fall into two

categories: either it is easy to use but doesrit offer

enough power and flexibility, or it is very powerful

but difficult to use.

Mosaic is designed to be powerful, flexible and easy

to use. The development team has attempted to

design a program that will let you create music

manuscripts that look just the way you want
without a lot of fuss.

In Mosaic we've tried to strike a balance between

tlvo extremes: making things happen automatically

versus making things be completeiy up to you.We

want Mosaic to do a lot of the work for you; on the

other hand, we have built in a great deal of
flexibility so that you can make your music

manuscripts look the way you want. Mosaic gives

you the best of both worlds, and you will enjoy the

speed at which you will be able to produce

professional music manuscripts.

What does Mosaic provide?
Mosaic provides:

r A "what you see is what you get" (WYSIWYG)

environment, similar to Macintosh graphic and

page layout soffware, in which to create and notate

music

r A standard, Mac-like interface (with a touch of
graphic flairl)

r Easy access to commands so that you don t have

to dig deeply into menus, tools, and dialog boxes to

get things done

r A simple click and drag interface to insert and

place symbols

r Standard graphic handles to move and reshape

objects

r Unlimited Undo/Redo, which provides a more

relaxing environment in which to work

r Control of page margins, staffplacement and

other aspects ofpage layout directly on the page

: Page layout templates for large documents

r A unique (non-linear) spacing algorithm that

provides automatic, graceful music formatting

r MIDI input and playback, including real-time

transcription and step entry

Mosaic feature highlights
Here are some highlights of Mosaic's capabilities:

r Unlimited maximum number of staves

(restricted only by available memory)

I
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r Unlimited symbol placement

r Unlimited text placement and formatting

r Automatic score and instrument part generation

r Multiple voices on a staff

r Moveable, adjustable palettes

r Zooming

r Transposable chord symbols, with or without
guitar fret diagrams

r Cross-staffbeaming

r Adjustabie stemlength and beam angles

r An intuitive, Mac-like text entrywindow in
which to type lyrics and then flow them into a

manuscript

r Flexible measure numbering

r Complex meters such as 3 + 4 over 8

r Ability to open and export standard MIDI files

r Ability to export notation as a PICT graphic
(with embedded PostScript) to desktop

publishing, word processing, and graphics

software

r Transposable chord symbols

r Casting Off command, which lets you set the

number of measures per line and space them

evenly or proportionally

r Scale Spacing command lets you tweak note and

measure spacing, from a single note to an entire

view

r Scale command scales the size of notes and rests

independently ofthe staffpoint size--ideal for cue

note passages.

r Ability to completely customize the Mosaic

Macintosh keyboard commands. Includes

keyboard layouts for Professional Composer,

Encore, and Finale

Read on to learn how to use these capabilities and

morel

A comparison for experienced Macintosh users
If you are experienced with the Macintosh, you can

get a pretty good idea about how Mosaic works by

comparing it to other Mac software with which you

are familiar. Here are some comparisons to other

software, including Mark of the Unicornt
Performer MIDI sequencing software.

Mosaic has two important structural building
blocks called staves and volces, which can be

understood in terms of tracks and MIDI data in
Performer. A voice in Mosaic is similar to a track in
Performer: it contains music. A voice in Mosaic is

similar to a stream of MIDI data, perhaps on a

single MIDI channel. A voice gets placed in a staff
just like MIDI data gets placed into a track. The

only difference is that multiple voices can be placed

on a staff, whereas Performer only holds one

stream of MIDI data in a track. The notes and rests

in a voice flow through the staff.

|ust like Performer, Mosaic has a separate Staves

window and Voices window and permits an

unlimited number of voices and staves in a file.

To see voices and staves as music notation, you

place them in aView, which is a standard

Macintosh window similar to what you work in
with a standard graphics or page layout program.

Musical symbols can be inserted and positioned in
the view window by clicking and dragging. For

example, you can insert a slur by clicking the slur

symbol in a palette and dragging the mouse above

or below the notes. You can reshape the slur by
dragging its reshape handles.

To enter text, you select the text tool, drag a text

box, and type in it just like you do in MacDraw.

Text can be placed relative to its position on the

8
ABOUT MOSAIC



tr

page (such as a title or page number), relative to a

staff system (such as a rehearsal mark), or even

relative to a note so that it flows with the note.

To work with lyrics, Mosaic provides a Lyric

rrindow, which functions just like a miniature

\IacWrite document. You can type, backsPace, set

the font and styIe, and so forth. When it comes

time to apply the lyrics to the music, Mosaic

automatically flows each syllable underneath the

notes you have written.

To enter chord changes, Mosaic provides a special

rool that lets you play them in from a MIDI
controller or q?e them in by hand. Mosaic

recognizes all standard chords and tensions in al1

keys.You can even teach Mosaic new chords.

Mosaic automatically formats chord symbols

correctly; once entered, they can be easily

transposed and edited.

\,Iosaic has standard cut, copy, paste and erase

commands. It also has snip and splice commands

similar to Performer.

Two of the mostpowerfui features in Mosaic are the

unlimited Undo/Redo commands. ]ust about

everythingis undoable and redoable in Mosaic.

And you can undo and redo as many times as you

rvant. This lets you work more freely, exploring

avenues and retracing your steps if necessary.

A note to Professional Composer users

Ifyou have used Professional Composer, you are of
course wondering,"How does Mosaic compare?"

You will be pleased to know that Mosaic addresses

many of Composert drawbacks and limitations. In

fact, Mosaic's design is largely due to feedback we

received from you over the years. We thank you for

your contribution and hope that you are pleased

rvith the results.

In addition to the features already mentioned

above, here are several features in Mosaic that

might interest you:

r A page view display (in addition to a scrolling

galley view like Composer's), which displays each

page exactly as it wili print and allows you to edit

music and control layout directly on the page

r Multiple voices on a staff (No staff merging

necessary)

. Combined (multi-measure) rests in multi-staff
parts, such as piano and harp parts

. Transposable chord symbols

r Automatic meter and key change warnings

before system breaks

r Cross-staffbeaming

r Adjustable slurs and ties (and other groupings)

r WYSIWYG page formatting

r Definabie beaming (You decide how beams will
automatically get grouped for each inserted meter)

r More flexible triplets and tuplets

r Automatic splitting of back-to-back repeat bar

Iines

r Courtesyaccidentals

r Optionai emulation of the Professional

Composer keyboard

About this manual
This manual is a reference guide for Mosaic. If you

would like help getting started with Mosaic, refer to

the accompanying book, "Getting Started", which

provides the following information:

r System requirements

r How to install Mosaic

r Howto prepare Mosaic for MIDI playback and

recording

__l s
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It also provides:

r A guided tour of Mosaic

r A tutorial on how to enter a lead sheet

This reference guide gives you complete

information about all of Mosaict features. The

extensive index will help you find what you need to
know quickly.

In particular, chapter 38,"Quick Reference" serves

as a quick reference guide for all of Mosaic's menu
commands, windows, palettes, and dialog boxes.

They are listed alphabetically by their name in the

ProSram.

You 1l find a helpful troubleshooting guide in the

appendices, as weli as a keyboard chart and a

keyboard diagram.We've also included a list of
references regarding music notation and

engraviag.

Watch for the following symbol in the manual:

It indicates information that deserves special

attention.

{r-
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CHAPTER 2 Opening and Saving Files

This chapter explains how to open and save Mosaic

liles.You will learn how to:

WHAT IS A FILE?

A file is a document created by Mosaic that stores

the music and other information thatyou enter. For

example, if you open Mosaic, enter a lead sheet,

and then save the lead sheet, it is written on the disk

in the form of a Mosaic file as shown in Figure 2-1.

It is separate from the Mosaic program itself.

r Open a new or existing Mosaic file

r Save your music on a disk

r Avoid file and diskerrors

r Back up your files so that you don't iose

importantwork

Mosaic saves and opens files in a standard

Macintosh fashion. If you are familiar with saving

and opening files, here are several things you

should know about Mosaic:

r Mosaic can have more than one file open at a

time.

r A Mosaic flle can contain several views. (A view

is a window in which you enter and edit music. For

more information about views, see chapter 5,"Page

Views and GalleyViews".) Dont confuse views

with files. For example, you might have several

view windows open, but only one file, because the

views all belong to the same file. If you are working
with multiple files,you can always tell which file a

riew belongs to by looking at the title bar: the name

of the file is shown in parentheses.

r You can customize what appears on the screen

when you open a new file. For information, see

"Customizing your new file setup" on page 15 in
this chapter.

saved with Mosaic

OPENING MOSAIC
To start up Mosaic and create a new file

r Double-click the Mosaic program icon to launch
(open) Mosaic.

Alternately,you can click the Mosaic icon once and

choose Open from the File menu. MoSaic will take

a few seconds to start up. You'll know when Mosaic

is ready when you see Mosaict menus in the menu

bar:

Figure 2-1:This folder contoins the Mosaic program and a file
document creoted and soved with Mosaic.

The Mosaic program icon Afle created and

' * fit" Edit fiegion FormEt Teilt luindous Palettes
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CREATING A NEW FILE

To create a new Iile, you have two choices. You can

open a new file with a pre-existing setup of staves

and windows, or you can customize the new file's

setup upon creating it.

To create a new file with a Select New from the File
menu. A newfile appearswith
the pre-existing set ofstaves
and windows.

pre-existing setup

To create a new file with a

customized setup
Select New Setup from the
File menu. The New Setup
command dialogboxappears
on the screen.

When you use the New command, what you see on
the screen depends on the default file setup that has

been saved in the copy of Mosaic that you are

running. Ifyou have not yet used the Save As

Default Setup command, you will see a window
containing a staffon which you can begin entering
music. If you would like to customize what appears

when you create a new file, see "Customizing your
new flle setup" on page 15 in this chapter.

OPENING A FILE

To open an existing file from the Macintosh Finder,

double-click the file icon.Alternately,you can click
the file icon once and choose Open from the File

menu. This will start Mosaic and bring up the

selected file.

If Mosaic is already running:

1 Select Open from the File menu.

A dialog box appears, containing a list offiles on
the selected disk. To see flles on a disk in a different
drive, click Drive. To view files on another disk
which is not currently in a drive, click Eject if
necessary and insert the other disk

2 Click the name of the file you wish to open.

3 Click Open.

The file you select will open. Alternately, you can

double-click the name of the file to open it.

Opening a standard MlDl file
Mosaic can open a file that has been saved in the

standard MIDI file format. To open a MIDI file,

select it from the Open dialog box as normal. The

flle opens as a Mosaic file; if you want to save it back

into MIDI 6Ie format, see "Saving a file in the

standard MIDI file format" on page 14.

For complete information about opening and

saving MIDI files, see chapter 30,"Importing and

Exporting Standard MIDI Files".

Opening files created in a previous version of
Mosaic
Files created in a previous version of Mosaic can be

opened as described in "Opening a file" on page 12,

SAVING FILES

Please read this section thoroughlylWhen you open

a file from a disk, Mosaic makes a copy of that flle

andplaces it in the Macintosh's temporarymemory
(called Random Access MemorT, or RAM). When

you work with the flle, you are actually working
with the copy that is in RAM, not the original file

on the disk. When you choose Save from the File

menu, Mosaic writes a copy of the modified file in
RAM to the disk, replacing the original file with the

same name.If you do not save, the modifications

D Lead sheet temFlate
D Moonlight in Uermont
D N0ni's song
D Noni's Song/no turics
ill other people's projerts
D The offbeat of auenues
D unfinished

0riue

:I

fl6jc€' --l
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-.'ou have made are never written to the disk. For

.:rample, if you quit without saving changes, the
-.iork you harre done is not saved on the disk and is

:ermanently deleted from the computer's memory.

*ways be sure that the disk you are saving the file on

as enough room!Files can be saved to any disk
rith sufficient space for the file. They can also be

zred with different names.

:r-e a file

-hoose the Save command from the File menu,

'ress command-S.

rou are saving the file for the first time, a dialog
( appears prompting you for a name.

Ifnecessary, use the Drive and Eject buttons to

)ose a disk on which to save the file.

Your file is saved on the disk in its current state,

replacing the old version with the same name. If
you want to keep the old version, use the Save As

command. See "Using Save As to preserve the last-

saved version of a file" on page 13.

Using Save As to preserve the last-saved
version of a file
When you open an existing file from a disk, Mosaic

makes a copy of that file and places it in RAM
(temporary memory). When you work with the

file, you are actually working with the copy that is

in RAM, not the original copy on the disk. When
you choose Save As, you are given an opportunity
to type a new name for the modified version of the

f.le in RAM and save it as a separate file from the

original. Doing so preserves the original version of
the file on disk, while at the same time saving the

modified version to disk under a different name.

For example, lett say that you already have a file on

disk that contains some music and lyrics. Nowyou
would like to create another version of the file with
the lyrics removed, but you still want to keep the

original version with lyrics. To do so, you would
open the file, remove the lyrics, and then choose

Save As, type in a different name for the noJyric
version, and save it under that new name. In this

example, you might just add an extension such as "-
no lyrics" to the original name. The result is a new

flle, based on the original flle, that contains the

modifications you made.

t'19 Song

Hg $ong - no luritr5

-'. pe in the desired name

iil cant use a colon in the name; all other

haracters are permitted, including spaces. If you

iler a name that matches the name of a file that

iready exists in the same folder, a dialog box will
*.1ou if you want to replace the existing file.

ck Save or press return.

ou $?nt to save the file to a different disk, use the

he and Eject buttons if necessary. Pressing

ncel rvithdraws the Save command.

Irr
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- ;:is is wlty files should be sayed frequently. If Mosaic

: r'our Macintosh should malfunction, all of the
i.,-Lrrk you have accomplished since you last saved

::av be lost! However, if the file was recently saved,

r'-.u can retrieve the latest version from the disk and

r:!rceed without having lost much work.

t.-.
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You can use Save As even if you haven t yet made

any modffications to the original file.lust open the

original fiIe and choose Save As without making
any change, You can then make modifications and

use the Save command.

To use the Save As command:

1 Choose Save As from the File menu.

The Save As dialog box appears.

2 Type in the new name for the file.

You can't use a colon in the name; all other
characters are permitted, including spaces. If you
enter a name that matches the name of a f,le that
already exists in the same folder, a dialog box will
ask you if you want to replace the existing fi.Ie.

3 If necessary, use the Drive and Eject buttons to
choose a disk on which to save the file.

4 Click Save.

Your file is saved on the disk in its current state

under the new name.

G important: after using Save As, the file shown

on the screen is the newly"saved as" flle, not the

original file. If you want to work with the original
file, you must open it using the Open command.

Choosing a disk and folder in which to save a
file
When using the Save or Save As commands, you
can use the Drive and Eject buttons to choose the
disk on which to save the file. The disk that is

currently shown in the dialog box will be the disk
on which the file will get saved. To switch to a
different disk drive, click Drive. If the dialog box is
displaying a disk in a floppy drive, but you need to
eject it to insert a different disk, click Eject and then
insert the other disk.

Once you are viewing the desired disk in the

dialog, you can then choose a folder in which to
save the file by double-clicking the folder name in
the list.

Saving a file to a disk not currently in a drive
To save a file to a disk not currently in a drive:

1 Choose the Save As command from the File

menu.

The Save As dialog box will appear.

2 Click Drive to select a disk to eject.

3 ClickEject.

The disk that is currently displayed in the dialog
box window will be ejected.

4 Insert the disk on which you wish to save the file.

5 Clicl< Save.

What gets saved in a file
Along with your music, Mosaic saves almost every

attribute of your file, including open windows and

their screen positions, zoom settings, the on/off
status of such features as combine rests, and many
others.

Some settings are saved with the copy of Mosaic

that are running on the hard disk. These settings

remain saved with Mosaic until you change them.

c- If you make a fresh copy of Mosaic, the new
copy won t necessarily have the same settings as

your old copy. Instead, it contains the factory
default settings, so you may need to reset them.

Saving a file in the standard MlDlfile format
Mosaic can save files in the standard MIDI file
format. Music saved in this format can be opened

with any program that also reads and writes MIDI
files--even programs that run on other types of
computers.

14
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-,, save a Mosaic sequence in the MIDI file format:

1 Choose Save As from the File menu

2 Click the MIDI file option

3 I,p" in a name for the MIDI file.

4 Choose a folder in which to save the fi1e.

5 Click OK.

Because of the nature of the MIDI file format, many

of the musical symbols that you can enter in
\Iosaic will not get saved in the MIDI fiie.

Therefore, we strongly recommend that you save

Ilosaic fi.les with the Save and Save As commands,

*-hich save them in the Mosaic file format. Only
sarr music as a standard MIDI flle if you need to

rransfer the file to another program, such as a

)IIDI sequencer like Performer.

Llere is a summary of the items that cannot be

sarrd in a MIDI file:

r l'ext and lyrics

r Slurs, ottavas, endings, and other grouprings

ies rlre saved.)

r -\rticulations and cirnaments

r \otehead styles (i.e. the "x" notehead)

r Dvnamics

r Staffconnections

: tr more information about MIDI fi1es, see

,'rapter 30,"Lnporting and Exporting Standard

I.llDl Fi1es".

CLOSING A FILE

lo close a Mosaic file, choose Close from the File

nenu. If you have made changes since you last

sar.ed the file, Mosaic will ask you if you would like
ro save lirst before closing. If you would like to save

rhe changes, clickYes. If you do not, click No. If 1,eu

aren't sure, click Cancel to withdraw the close

command.You can then check the file before

attempting to close again.

Closing when you have more than one file
open
Like many Macintosh programs, Mosaic allows

you to open more than one file at a time. If you have

several liles open and you wish to close one of
them, activate one of the file's windows. You can do

so by clicking the windowt title bar or by choosing

the window name from the Windows menu. For

your convenience, each of the basic windows
(Staves, Views, Voices, Lyrics, etc.) display the file
name in parentheses in the title bar.

,:G Please note! Clicking the close box in a

window's title bar does not close the file. Doing so

closes the view window, but the file stays open. This
is because each Mosaic file can contain muitiple
views, which you can close and open without
closing and opening the file. Always use the Close

command in the file menu to close the file.

CUSTOMIZING YOUR NEW FILE SETUP
The Save As Default Setup command, found in the

f ile menu, allows you to customize the fi1e that you
get when you choose New from the File menu.

The word default setup refers to an initial
framework in which you build a file. The Save As

Default Setup command allows you to customize

your new flles to save you time when building your
flles.

You can customize just about anything having to
do with a fiIe: what windows appear on the screen,

zoom settings, page layout, default settings for
features iike display combines rests, and more.

15
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For example, lett say you typically make lead

sheets.You iike to work in a page viewwith a piano/
vocal staff arrangement. You use a standard format
for the title and copyright notice, a standard font
for iyrics, and a preferred zoom setting of 200o/o.

You can use the Save As Default Setup command to
give your new files all ofthese characteristics

automatically.

To use the Save As Default Setup command:

1 Ifyouarent alreadyin aMosaicfile,open one or
choose New from the File menu.

2 Configure Mosaic as desired, including

windows, their contents, and any other features as

you find most useful.

This file will become your new file setup: Mosaic

wili remember your exact track setup,window
layout, voices, staves, zoom levels, and so on.

3 Choose Save As Default Setup from the File

menu,

A dialog box asks you to confirm or cancel your
request.

4 Click OK to confirm the command, or Cancel to
withdraw it.

When you OK the command, Mosaic redefines

your new file setup based on the current file. All
attributes specific to the current file now comprise

a New file in the copy of Mosaic you are using.

5 (Optional) Choose Save from the File, type in a

name such as"New File Setup," and save your new

file setup as a regular Mosaic file on disk.

You may be thinking,"But I already saved my new

file setup in the last step!"And you are right. You

did. But in the previous step, the new f,le setup gets

stored irz the Mosaic preferences file in the System

Folder.lf you should trash the preferences file, you

will lose your new flle setup as well. Therefore, we

highly recommend this last step, which saves your
new setup file as a regular Mosaic file on disk. Thus,

you can update it and restore it at any time without
losing it.

To see the effects of Save as Default Setup, close the

current file and choose New from the File menu. A
new empty, untitled flle will appear, identical to the

last file you saved as'New'.

Updating your new file setup
Once you have made a spare copy of your new file

setup, redefining and updating it is easy.

To update your new file setup:

I If you are in a Mosaic file, choose Close from the

File menu to close it.

If you ve made any changes to the file, you ll be

prompted to save them.

2 Choose Open from the File menu and open

your New File setup file.

3 Make the modifications you wish to make.

4 Choose Save from the File menu.

This saves the modifications to the setup file on
disk.

5 Choose Save As Default Setup from the File

menu.

This saves the modification in the copy of Mosaic

you are currently running.

QUITTING MOSAIC

Quitting Mosaic returns you to the Finder. To quit,

choose Quit from the File menu.

16
OPENING AND SAVING TILEs



j,

t

A dialog box may appear asking you if you want to

save changes made to the file. To save the changes,

press Yes. if you don t want to save changes, press

No. If you have more than one lile open, Mosaic

will ask you about each one. To withdraw the Quit
command and return to your Mosaic file, press

Cancel.

CONVERTING PROFESSIONAL COMPOSER,
FILES

Nlosaic can open Professional Composer files and

convert them into Mosaic fi1es.

To open and convert a Professional Composer file:

I Choose Open tiom the File menu.

2 Locate the Composer file that you wish to load,

select it, and click Open.

3 Wait for the 1ile conversion to take place

Depending on the size and nature ofthe file, you

may need to wait a few minutes for Mosaic while it
.onverts the Professional Composer data into

\losaic data.

rl When Mosaic completes the conversion, the

Composer fi1e appears as a view window.

5 Choose Save from the File menu and save the

nervly converted file with a different name than the

original Composer lile.

Handling invisifi ed rests
\losaic does its best to interpret the data in the

Composer fiIe. It judges the context in which

:ar.isilied rests occur and either removes them or
:onverts them into regular rests. However, they

:nav have been used in a way that Mosaic could not

=nticipate. As a result, you may need to clean up the

rri'isified rests after the file is converted, removing

-hem or re-entering them as necessary.

Handling text and lyrics
Mosaic also does its best to interpret lyrics.

However, due to the way that the lyrics may have

been entered in the Composer file, they may not
always end up all together in the same lyric
window If so, you can copy and paste them

together into the same lyric and reflow the

combined lyric through the voice. Review

chapter 16,"Lyrics" for more information. In
addition, some voice text may be interpreted as

lyrics, and some lyrics might be interpreted as

voice text.

DEALING WITH FILE PROBLEMS AND DISK
ERRORS

The following are a few 61e problems and disk

errors that commoniy oc cur. Alsuays keep plenty of
up-to-date backups of your important files as you

work. Almost any software problem is survivable as

long as you haue kept backups of your work. See

App endix A, " Troublesho oting and Te chnical

Support" for more information about problems you

may encounter with Mosaic liles.

There isn't enough room on the disk.Yorr disk is too

ful1. Eject the disk and insert one with plenty of free

space on it. Note: If Mosaic runs out of disk space

while saving a file, the file on disk will be damaged.

If this happen s, immediately use the Save As

command to save the file to a disk with more space

available. Ifyou fail to do this, and you have not
made a backup Iile, you will have lost an entire file.

As a rule, before opening an existing file, be sure

the disk on which it is stored has enough free

memory to hold the information you expect to

add.

An error occurred while writingthe file. This is a

dangerous situation. In all probability, the existing

copy ofthe file on the disk has already been erased

so that the new copy could be saved. Because ofthe
error, any partial file that has been saved cannot be

read.At this point, the only good copy of the file is

in memory. Immediately try to save the lile on

It* NING AND SAVING FItES
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another disk. Do nof attempt to use the Revert to
Saved command on the File menu; the saved copy
is damaged and you will lose the file in memory,

The disk is locked. Unlock the disk by sliding the

small tab on the back of the disk in the upper left-
hand corner down so that it covers the small ho1e.

Write-enabled (Hole is iovered)

The dkk can't be read.The disk itself may be

damaged. Return to the Finder and try inserting
the disk again. If it still can t be read, it may be

irretrievable. Ifit is a hard disk, try a disk utility
program such as Disk FirstAid.

PREVENTI NG CATASTROPH E

Save yourfile as often as possible.You should use the

Save command after every significant change to
your file.

Always keep backup copies of your important files.
We cannot emphasize enough the importance of
this. At the end of a working session, copy to a

backup disk all ofthe files you recorded and edited.

This way, if anything should happen to your
original, you will have fully updated backup of the

flle.

Saving a file under a different name while working
can be useful when you want to keep a record of
earlier versions.

When saving files during a working session, it is a

good idea to save alternately under different flle
names; if something should happen to one of the

flles, the other will be a recent version. For

example, a file can first be saved under the name

"Lead Sheet 1". The next time it is saved, choose

the Save As command from the File menu and save

it as"Lead Sheet 2". The following time, it is saved

as "Lead Sheet 1 " again, then "Lead Sheet 2" and so

forth. To be even more careful, save a file to
different disks during a working session.

Hard disk users should make sure to backup their
files to floppy disks. This should be done as often as

is bearable, at least at the end of every working
session and several times during the session if
possible. The consequences of not making floppy
backups are severe: ifyour hard disk is damaged,

some or all of the files may be lost forever.

\
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This chapter explains several unique aspects to

\Iosaic's windows, palettes, and menus.

USING THE WINDOWS MENU
,\Iosaic organizes the structure of a fiJe into
',rindows, which can be opened by selecting them

-iom theWindows menu.

ndows below this The Memory Monitorwindow

displays how much free memory

is available.

-i belong to a open

.'rsai( do(ument.

bopen a

$ndoWselect

LWindows

&atareakeady

open dhplay a

drerk mark.

The (ontrols

has tape

and galley view Ihe name ofthe file to'which the

Working with Menus, Windows,
Palette+ and the Keyboard

Figure 3-2:When multiple files are open,they are seporoted by a line
in the Windows menu.

:Qe vlew

indows also appear.

:u re 3-1 : The Windows menu.

derk-style tranr
port (ontrols for

MlDl playback and

recording.

windows belong isdisplayed in parenthe-

You can always determine what file a window
belongs to because the file name is displayed in
parentheses in the window's title bar. (See Figure 3-

3 on page 20.)

USING WINDOWS
The Views,Voices, Lyrics, Staves, and Templates

windows are similar. Figure 3-3 is an example.

(For complete information about the Staves

window, see chapter 4, "Voices and Staves".)

As you can see, Mosaict lists windows look a little
different from standard Macintosh windows. They

have many similarities, as well as a few

enhancements to the Macintosh user interface.

For information about page and galleyview

windows, see chapter 5,"PageViews and Galley

Views".

Mini-menus
Mini-menus contain commands that are specific to

their window. The mini-menu operates in the same

fashion as any Macintosh menu: click it and the

menu pops down, from which you can select a

The top three items in this menu are always

present. !\rhen a flle is open, the next five windows

are always present: Views, Voices, Lyrics, Staves,

and Templates. Other windows that you create,

such as lyrics, pages views, and galley views, appear

at the end of the list. (See chapter 5, "Page Views

and GalleyViews" and chapter 16,"Lyrics".)

]losaic allows you to open more than one 6le at a

:ime. For example, if you have two flles open, they

are separated by a line in the Windows menu as

shown in Figure 3-2 below.

Itg

MemorU Monit0r
Lonlrols
KeU Bindings

.,/ uieus (Untiiled-2)
/ Uoires (Unlitled-21

LUrics tUntilled-2|
Staues [Untitled-2)
TemElates {Untitled-2}

,/ Uielr,s (Untitled-3)
Uoices (tlntitled-5)
LUrics ttlntitled-51

,/ SlEues (Untitled-5)
lales (untitled-51Tem

lllindous

Memoru Mon

Keq Binditrgs

',/ Ui etrrs i tlntitled -21
tr0ires {Untitled-21
LUrirs {Untitled-2}
StEUes (Untitled-21
TemElEles {Untilled-

I ontrols

6E lle

llrindou,s

CHAPTER 3



$taues {Untitled-5}

aff- 1

U IUts- I

The close box

(loses the window

( l(kthe stafficon to select staff.Double-clickthe iton to open a dlaiog (lickthe staffnameto

b0x that (0nf gures vari0us aspects 0f the (aff,such a5 the number of staff

ines it has. Drag the icon t0 movethestaffup0rdown inthe list.5hift-drag

over several itons t0 seleitthem,orshift-tlick eath one,

Use the scroll bar to< 
scrollthelist.

Drag the grow box to

resize the window.

it. Use lhe up and

down arrow keys to pop-edit adja(ent staves.

Opening & closing a palette
To open a palette, choose it from the Palettes menu.

To close a palette, click its close button in the grab

bar.

Palettes always appear on top of other Mosaic

windows so that they do not get covered up' To get

a palette out of the way, close it.

Controlling a palette
Here is a summary of the ways in which you can

control a palette once it is oPen:

l\,1ove the palette by

dragging its grab bar.

(hange between

Jhe mini-menu

(ontains commands

spe(lfic to the window.

The push down anow

moves the window behind

all other open windows.

The resize button

toggles the window

between two sizes

and locations.

Drag the title bar to

move the window.

Command draqto move

the window without

bringing it to the front.

The file to which the window

belongs is displayed in

parentheses. ln some

windows,you can command-

(li(k here to switch to a

different window.

and vertical

orientation by clickinq

this swivel button.

Some palette items

can be double<litked

to change default

(haraderisti(s,such as

pla(ement and font.

Figure j-3: A Mosaic list window.

command. Often, a mini-menu command is

activated by selecting items in the window (as

described in Figure 3-3 above) and choosing the

mini-menu command.

The active window
The topmost window--that is, the window that is

in front of all other windows- -is the active

window. It is indicated by fully detailed borders;

when a window is inactive, its top border and scroll

bar are blank. To activate a window so that you can

work in it, click it. If you can t click it, choose its

name from theWindows menu.

USING PALETTES

The palettes contain a majority of the musical

symbols you can enter in Mosaic. Any symbol can

be entered by clicking the symboi in the palette and

clicking at the appropriate iocation in the view

Many symbols can also be entered via the

keyboard.

Because there are so many symbols in Mosaic, they

have been grouped into eleven separate palettes

that can be opened and arranged independently, as

shown in Figure 3-4 on page 21.

(lose the palette by

clicking its close box.

0i(k a palette item

to enter ils symbol.

I
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ldow
Arranging palettes
Eleven may seem like a lot of palettes. However,

rou will probably only have a few that you leave

open all the time, such as Notes, Articulations,

Dvnamics, Groupings, and Text. The rest can be

opened as needed.

1bu can arrange them around the outside of the

new windows, or you can place them directly on

mp of a window. For your convenience, palettes

.-. be swiveled between a horizontal or vertical

nrientation. To do so, click the swivel button at the

right (or the bottom of) the grab bar.

Retaining tool selection
This command in the Palettes menu is a checkable

menu command.When it is checked it is on; when

it is unchecked, it is off.When it is checked, and

you click a palette item to enter its symbol, it
remains selected until you click it again to deselect

it. This allows you to enter the symbol in several

places without having to reselect the palette item

each time.

When this command is unchecked, the tool will
deselect immediately after you use the tool, and the

cursor will return to an arrow.

Double-clicking palette tools to configure
them
Many of the tools in Mosaict palettes can be

double-clicked in order to configure default

settings for the tool. For example, if you would like

to change where endings appear when you insert

them, you can double-click the ending palette

symbol to open a configuration dialog box for
endings. Detailed information is provided in the

groupings, articulations, and text chapters.

nand-

nenu

grab

\1

',:tes

V Re(s

:an

Entering palette symbols
- r enter symbois from a palette, click the symbol.

-lick where you wish to insert the symbol. For

rrrre specific information about entering each

, ,ae of symbol, see chapter 38, "Quick Reference",

: the respective chapter regarding the type of
.-. mbol you wish to find out about.

Arti(ulations Dynamits Groupings

I 0rnaments )azt

Barlines TAB noteheads

HotetreuO, JText I

(*)

(h)

rlf,

Figure 3-4: Mosaic palettes-
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Command-clicking to insert a symbol on a

group of notes
Many palette symbols can be inserted oyer a grouP

of selected notes by command-clicking the palette

item. To do so, seiect the notes on which you would

like to apply the symbol and then command-click

the palette item.

Getting back the arrow cursor
TVpe command-period ( . ) to get back the arrow

cursor after using a palette symbol.

USING THE KEYBOARD
The Macintosh keyboard serves as a primary way

of controlling Mosaic. Many of the chapters in this

manual expiain in detail how to use it. For an

overview see Appendix B,"Mosaic Keyboard

Bindings" and Appendix C,"The Mosaic

Keyboard".

Using the keyboard with the mouse
In addition, you li often need to "option-click',

"shift-click', and "command-click" things. To do

so, hold down either the option key, command key,

or shift key while clicking the mouse. You'll also

hold down these keys while pressing other keys.

For example,you can zoom in (enlarge) the display

of music by holding down the command key and

pressing the open bracket key ( [ ).In this manual,

this action is referred to as command- [ .

keys

Option keys

Command

nf NotelYou only need to hold down one or the

other of each key, not both.

Type command-period to cancel long
operations
Mosaic may take a long time to compute certain

operations. When it does so, it presents a spinning

watch cursor. If you dont want to wait any longer,

you can cancel the operation by pressing

command-period ( . ) to cancel the operation. This

works for most (but not all) operations.

THE MOSAIC INTERFACE
Mosaic's dialog boxes look a little different than the

standard Macintosh ones. Shown below are radio

buttons:

Ei 'E)

Standard Macintosh radio button l,40sai( radi0 button

Radio buttons work such that you can only select

one of the given choices; if you click on a new

button, the previously chosen one will deselect.

The check boxes also look a bit different:

tr E

bar

Standard Macintosh check box Mosaic theck box

You can select any combination of them.

The following keys can be used when working in a

dialog box.

t Pressing the Return key is the same as clicking on

OK: it confirms the selection in the dialog box.

t Pressing the Enter key wrll also OK a dialog box.

It is also used when editing a list of names or data,

confirming the current one and moving to the

next.

t Pressing the Command and period keys logether

is the same as clicking on the Cancel button: it
cancels the selection and leaves the previous

settings/values unchanged.
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t Pressing the Tab key wILl confirm the current
entry fleld, then moye to the next field in the box or
list and highlight it.

Ifyou have a keyboard with arrow keys, you can

use them as follows:

t the up arrowwillmove through a list of names or
events, confirming the current selection and

moving to the previous one.

t the down arrow will move through a list of names

or events, confirming the current selection and

advancing to the next one.

t the left and right arrows move from fieId to field

il the list windows, confirming the current

selection and advancing to the next one in the

arrow direction.

-n addition to these, there are many shortcut

ke,vboard commands that will allow you to choose

;ommands from menus very quickly. They are

rndicated on the menus to the right of the

:ommands themselves and can be used instead of
:ulling down the menu and selecting the

:ommand. To use a shortcut command, hold dorvn

:he Command key and press the indicated key. For

:xample, command-X is the shortcut for the Cut

;ommand. Instead of pulling down the Edit menu
and selecting Cut, hold down the Command key

and press the X key.
na

on

x.

ta,

er
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cHAPTER 4 Voices and Staves

This chapter explains the basic elements of a music
rnanuscript in Mosaic: voices and staves. It expiains

how to build a score manually using voices and

staves, including the following:

r Create voices and staves

r Assign one or more voices to a staff

r Manage the voice and stafflists (add, delete,

move, duplicate, etc.)

r Configure a stafffor a transposing instrument or
percussion

Jb save time when setting up a new manuscript,
voices and staves can be created automatically
using the New Setup command in the FiIe menu.

For krformation, see chapter 6,"Creating a New
Fiie with New Setup".

WHAT ARE VOICES AND STAVES?

-\ r,oice consists of a line of notes and rests. The
','oice is assigned to a staff, and the notes and rests

lorv through the measures on the staff. The staff is

:iaced in a view, either a galleyview or a page view.

lbu see the voice on the staff in the view as shown

-n Figure 4- l.

Figure 4-l: Voices and staves. Voice-l is assigned to Staff-1, which is
then placed in a galleyview.

Voices exist independently of staves. You can assign

a voice to any staff, and you can even assign a voice

to several different staves. Conversely, you can

assign several voices to one staff. You can change

these assignments at any time.

Similarly, staves exist independently of views. You

can display a staff in any view, and you can even

display a staff in several different views at one time,

You can remove the stafffrom the view at anvtime

This independent structure provides you with a
great deal of flexibility in the way that you view,

format, and print your music.

CREATING AVOICE
A voice consists of a line of notes and rests. Think
of it as being what is played by a single instrumen-
talist. For example a voice could contain the notes

played by a vocalist, a trumpet player, a guitar
player, or the left hand of a pianist. It might even be

onlythe upper split of a divisi (divided) instrument
part.
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An explanation for Performer users...

A voice can be understood in terms

of tracks and MIDI data in
Performer. A voice in Mosaic is

similar to a track in Performer: it

contains music. A voice in Mosaic is also similar to

a stream of MIDI data on a single MIDI channel.A

voice gets placed in a staff, just like MIDI data gets

placed into a track. The only difference is that

multiple voices can be placed on a staff, whereas

Performer only holds one stream of MIDI data in a

track. The notes and rests in a voice flow through

the staff, just like MIDI data flows through the

track.

To create a voice:

1 OpentheVoiceswindowbychoosingit from the

Windows menu.

2 Choose Add from theVoices window mini-
menu.

Ifyou would like to add several voices at once, hold

down the option keywhile selectingAdd from the

mini-menu and then type the number of voices

you need.

Uoires IUntitled-2l

rtr 'rri:'e-t IO-CE
f,[ L]8
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FrL11P!!,i:- 1 41 Trombsnel !

3 Click the name of the voice to pop-edit the

name.

If you are naming more than one at a time, use the

up and down arrow keys to quicldy pop-edit from

one name to the next.

4 Pop-edit the range values to set the note range.

See "setting a note range" or'page26for
information.

5 If desired, enter a comment by clicking the

comments column next to the voice name.

Reordering the list of voices
To reorder the voices in the list, drag the voice icon

to the left of the name.

UDires isflTB rhoir srore I s)
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Selecting voices
To move, copy, or delete voices, you need to select

them. Here is a summary:

To select this: Do this:

A single voice Click its icon

Several voices that are not
next to one another

Shiit-click the icon oIeach
one

Several adjacent voices Hold down the shift key and
drag over their icons

Deleting voices
To delete one or more voices:

1 Select the voice(s) you wish to delete.

2 Choose Delete from the Voices window mini-
menu.

(tF Please note! \Arhen you delete a voice, it
disappears from all views in the hle.

Setting a note range
Each voice can have a note range,which is specified

in the Voices window next to the voice name.

The note range consists of a bottom note and a top

note. When you use the Check Range command in

the Region menu, Mosaic searches for notes

26
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outside the voice range. Ifit finds one, it scrolls to

that note and highlights it to bring it to your
attention.

The Check Range command is an ideal way to
make sure that you do not write notes in a voice

rhat are too low or high for the instrument.

However, you are allowed to insert notes outside

the range if desired.

- he note range is expressed in terms defined by the

1,. I I DI (Musical Instrument Digital Interface)

'recification. MIDI specifies that middle C is C3,
-.there the 3 indicates the octave from middle C to B

:aturai a 7th above middle C. C2 is C belowmiddle
..\3 is A above middle C.

- he octave number changes between B and C. For

:rample, 82 is one half step below C3. C#3 is one

:alt-step above C3. The staffbelow shows the four
,,ctaves that span a treble clefstaff.

Itrhen typing in the desired note range, specify the

lowest pitch, followed by a dash, followed by the

highest pitch. To type an accidental pitch, type the

pitch, a lower case B ( b ) to indicate a flat or a

pound sign ( # ) to indicate a sharp, followed by the

octave number. For example, to indicate the E flat

above middle C,type Eb3.

The lowest possible pitch is C negative 2 (C-2). The

highest possible pitch is G8.

Playing a voice on a MlDl instrument
Mosaic has the ability to play each voice in your
Mosaic score on a MIDI instrument, such as a

MIDI keyboard or sound module that is connected

to your Macintosh via a MIDI interface like Mark
of the Unicorn's MIDI Time Piece II or MIDI
Express.

Each voice in theVoices window can be assigned to
any MIDI channel on any available MIDI
instrument. To do so, press in the "Play/ch ' column
next to the voice name and choose the desired

MIDI device and channel from the pop-up menu
that appears as shown in Figure 4-2.

Figure 4-2:Choosing a MlDl playbackdevice and channel for a voice.
The list of MlDt devices is provided by FreeMlDl.You can change
whot's in the list by using the FreeMlDl Setup prcgram that is
included with Mosaic.

The list of MIDI devices in the pop-up menu is

provided by FreeMIDL You can change whatt in
the list by using the FTeeMIDI Setup program that
is included with Mosaic.

The "Patch ' coiumn in the Voices window provides
a pop-up list of MIDI patch changes for each voice,

from which you can choose the desired patch. The

pop-up patch list either displays generic names (i.e.

"Patch l ","Patch 2", etc.) or the actual names ofthe
sounds in the MIDI device chosen in the "Play/Ch'
column. For example, Figure 4-3 shows the pop-up
patch list for the Proteus/2 sound module from
E-mu Systems, Inc.
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Any FTeeMlDl-compatible patch librarian
software can provide patch names as shown in
Figure 4-3 for most popular MIDI synthesizers and
sound modules. Examples of such software are:

r Patchlist Manager", a simple librarian program
that is included free of charge with Mosaic

r Unisyn"', Mark of the Unicorn's universal

editor/librarian software

To create a staff:

1 Openthe Staveswindowbychoosingitfromthe
Windows menu.

2 Choose 'Add staff with voice" or 'Add staff"
from the Staves window mini-menu.

If you choose "Add staffwith voice", the staff is

added with a new voice already assigned to it. If
you would like to add several staves at once, hold
down the option key while selecting the Add
command from the mini-menu and then type the
number of staves you need.

3 From the hierarchical menu, select a clef for the
new staff.

You can choose from the list of standard clefs

shown. If you need a special clef, you can change it
later. See "Changing an existing clef" on page 93.

$taues {Untitled-l }
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4 C1ick the name of the staff to pop-edit the name.

5 If desired, click in the comments column next to
the name to type text comments about the staff.

Reordering the list of staves
To reorder the staves in the list, drag the stafficon
to the left of the name. All voices assigned to a staff
move with the staffwhen you drag.

Figure 4-3: A generic patch list on the left, and the patch list for the
E-mu Systems Proteus/2 sound module on the right. Any FreeMlDl-
compatible patch librarian software can provide patch names as
shown'on the right. Exomples of such software are the PatchList
Manager program that is included free of charge with Mosaic, and
Unisyn, Mark of the Unicorn's universal editor/librarian software.

For compiete information about MIDI playback,

recording, and FreeMIDI, see chapter 34,"MIDI
Recording and Playback".

CREATING A STAFF
A staff in Mosaic is just like the staves you see on
manuscript paper in a music store: it consists of a
number of staff lines on which clefs, meters, notes,

rests, etc. are displayed.
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After naming a staff, use the up and down arrow
keys to quicklypop-edit the next or previous name.
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Selecting staves
To move, copy, or delete staves, you need to select

them. Here is a summary:

To select this: Do this:
The voice appears indented below the staff in the

staves window.

Setting stem direction when assigning a voice
to a staff
As a short cut, you can assign a default stem

direction for a voice by using modifier keys when

dragging the voice from the Voices window to the

Staves window to assign it to a staff. You can also set

the stem direction at any time in the Staff

Configuration dialog described later in this chapter

(which is opened by double-clicking the stafficon
in the Staves window). Here is a summary:

torthis stem direction Hold down this key while dragging:

veral stayes that are not
xt to one another

Click its icon

Shift-click the icon ofeach
one

ral adiacent staves Hold down the shift key and
drag over their icons

)eleting staves
. delete one or more staves:

Select the staff or stave(s) you wish to delete.

Choose Delete from the Staves window mini-

f Please note! When you delete a staff, it
' .appears from aii views in the f,le.

ASSIGNING VOICES TO STAVES

- : re able to enter and display notes on a staff, the
,::J must have at least one voice assigned to it.
' ,':in you insert notes and rests on the staff, they

.:: inserted into the voice. If the staff currently has

. i-oice assigned to it,you can assign one to the
.:.:t as follows:

Open the Staves window by choosing it from the

ndows menu.

Stems up

Stems dom

Stems up and down

Opposing stems

Option key

Command key

Option key and command key
together

Select desired voices and drag them
together to the staff(with no keys

held down)

Assigning several voices to a single staff
You can assign as many voices to a staff as you

prefer by following the procedure in the previous

section for each voice. When doing so, you 11
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a I 'JpentheVoiceswindow.

3 ,-:rab the voice icon and drag it on top of the staff
- ::e Staves window as shown.
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Both

probably want to set a default stem direction for

each voice. A voice can have three stem directions:

up, down, or both:

To make the voice: Do this:

Stems up Option-drag the voice from
theVoices windowto the staff
in the Staves window

Stems down Command drag the voice
from the Voices window to
the staffin the Staves window

Command option drag the
voice from the Voices win-
dow to the staffin the Staves

window

If you drag multiple voices at the same time when

assigning them to a staff, the stem directions are

automatically configured. For example, if you drag

four voices to a staff, the top rwo voices are

assigned stems-uP, and the bottom two voices are

assigned stems-down.

For information about changing the stem direction

of a voice already assigned to the staff, see

"Configuring a staff" on page 3 1 .

Assigning a voice to more than one staff
You can assign a single voice to several different

staves at once. For example, you couid display a

voice on a staff in a conductor's score, and also

display the voice on a staff in the instrument

piayer's part.

Further, you might want the voice on the

instrument part to be transposed to the Proper key

for the instrument. The context in which the voice

is displayed can be different in each voice: each staff

may have a different transposition, clef, and key

signature. No matter what the context, however,

the actual pitches in the voice remain constant.
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If you change the pitch of a note on one stafi the

change is reflected in any other staffwhere the

voice is being displayed. The notes in the voice are

properly spelled according to the key on each staff.

For an example, see 'Assigning a staff transpo-

sition" on page 30.

Assigning a staff transposition
Tiaditionally, instrument Parts are untransposed

in the conductor's score so that the conductor can

read the score more easil1l.

Individual parts, however, are transposed to make

them easier for the musicians to read.

Mosaic provides for transposed instrument parts

by allowing you to set the transposition on the staff

on which the voice is displayed. Thus, a

transposing instrument voice can be placed on an

untransposed staff in the conductort score and on

a transposed staff in the instrument part. The same

Staues rl-l)

@ Tmmpets : Eb: i
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For helpful information about working with

multiple voices on a staff, see chapter 27,"Working

With Multiple Voices on a Staff".
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--rre is an exampie

::rches are displayed in both places, but they are

:r.played in their transposed form on one staff and

:-eir untransposed form on the other.

The octave number changes between B and C. For

example, 82 is one half step below C3. C#3 is one

haif-step above C3.

3 When you have typed in a pitch that deflnes the

desired transposition interval, press return to

conlirm the edit.

CONFIGURING A STAFF

The staff configuration dialog box provides several

different ways to configure the staff. You can:

r Display the staff with as few or as many staff lines

as you prefer, including no stafflines, a single statl

line or more than five.

r Hide ledger lines for notes above or below the

staff

r Rearrange the order ofvoices assigned to the

staff

r Set a default stem direction (up, dorvn, or either)

for each voice in the staff. When a voice is stems up

or down, all notes in the voice default to that stem

direction (although they can be flipped manually

with the Flip command).

Opening the Staff Configuration window
To open the Staff Configuration wirrdow:

I Open the Stayes u,indow.

2 Double-clickthe staff icon of the staff vouwish
to configure.
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;.re 4-4: The clorinet in A voice has been assigned to two different
: , es: o nontronposed (concert key) stoff for the conductor's score

: : ond o tronsposed stoff for the clorinet instrument port (bottom),
- :h is written up o minor third. Notice thot the notes belong to the

-? voice, but they ore disployed differently on eoch stoff because

: - e diffe re nt staff t ra n spositions.

,ien you insert a key change on a transposed

:i1, you select a concert key and Mosaic inserts

.. proper relative key for that instrument.

-' assign a transposition to a staff:

Click the transposition pitch to the right of the

affname to pop-edit it.

Type in the desired transposition with respect to

ddleC(C3).

Ihe note you enter represents the pitch heard when

ra instrumentalist reading the staff piays a note

n-ritten as middle C. The pitches are expressed in
rnns defined by the MIDI (Musical Instrument

Digital Interface) specification. MIDI specifies that

niddle C is C3, where the 3 indicates the octave

&ommiddle C to B natural a 7th above middle C.

This means thatC2 is C below middle C.A3 isA
rbove middle C. So if an Eb alto sax player reads a

niddle C and sounds an Eb below middle C, the

*aff transposition is Eb2.
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Alternately, you can select the staffby clicking its
icon once and choose Configure from the Stai.es
window mini-menu_

(lick here repeatedly to
(y(le between three stem

settings:stems u0 stems

down,oreither

Drag voice icons to lhis
rearranqe the order of
the voires within the

0ick these arrows to

make the stafflines
visible or invisible.

arr0w

indirates the
center ofthe staff.

DISPLAYING STAVES IN A VIEW
For information about displaying staves in a view;
see chapter 5, "Page Views and Galley Views,,.
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(HAPTER 5 Page Views and Galley Views

This chapter shows how to edit your music. What you see on the computer
screen will exactly match what you see on the

printed page.

You have full editing capabilities directly on
the page
Mosaic provides full editing capability of the music

in a page view. You can even control page layout

characteristics such as the size of the page, the

margins, the staff and system layout, the line and

page breaks, and more--directly on the page.

Viewing pages one at a time
A page view can contain more than one page. In
fact, it can contain as many pages as necessary to
hold all of the music in your score. It displays each

page in a score one at a time, and you can scroll to
the previous page, next page, or any page. The page

view is an idealway to paginate the music--that is,

to determine how the music flows from page to
page and to determine where the page breaks

occur.

Page view quick reference
Here are several important features you can use to
control a page view:

r rlbserve and edit music in a page view, which

' splays music on the screen exactly as it will print

r Display music in a galleyview,which is a

.nntinuously scrolling single staff system for
onvenient editing and note entry

r Display staves in more than one view

This chapter explains how to create views

nanually. To save time,views can be generated
rtomatically using the New Setup command in
the File menu. For information, see chapter 6,

'Creating a New File with New Setup".

#HAT IS A PAGE VIEW?
.:. :age view is a window in which you can see your
:lsic, including staves, notes, lyrics--everything,
,:C out on one or more pages in exactly the same

.:\' it will appear when you print.

'What you see is what you get"
:. page view provides you with a"What you see is

r:lat,vou get" (WYSIWYG, pronounced "wiz-ee-
;-S") environment in which to display, enter, and

lss
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Ihe title bar displaysthe name ofthe viewwith the nam(

ofthe file in parentheses.C0rnmand click the name to

(l0se this view and 0pen another in its place.

Drag the litle bar t0 move Ihe wind0w.

(lickthe close boxto rlose

the window.

The page view mini-menu

has commands for page

layout, adding pages, and

m0re.

Push down button sends the

window to the back.

(li(k the grow box to fill the

(omputer screen with the

window,

This area displays the voice in

which notes are (uIIently being

insened or edited.To (hanqe to

a different voi(e, press the box

and choose the desired voire

name from the pop-up menu.

(li(k these arrows to

s(roll to the previous or

next page.The (urIent

page number is shown.

To go to a nonadjacent

page,clickthe number,

type the desired page,

and press return.

Qunrtet # I -41'score IBartdk ttrin
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I\,4ove the labs in

the srroll bars to

scroll the display

vertically or

horizontally,orclick

the arrows.

Drag the size box to

resize the window.
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WHAT 15 A GALLEYVIEW?
-{ galley view is a window that displays music on a

*affsystem that extends endlessly to the right. The

*aff system never "wraps around" to the next line
es it does in a page view. It keeps extending to the

rieht.

.ike a page view, a galleyview ofiers firll editing

rpabilities, including the ability to modify layout

haracteristics such as the arrangement and

pacing ofthe staves.

=Citing 
large regions in a galley view

-- :.rl1ey view formats your music on a single,

.::,-.lling staff system, allowing you to see the music

- :iiruously on one system.

dleyviews are ideal for editing large scores with
any staves. A galley view is also ideal for
xerving and editing large regions of music that

ruld not flt on a single page in a page view.

Printing music in a galley view
Unlike page views, a galleyview cannot be printed

To print music in a galley view you need to place

the stayes in a page view.

To place galley view staves in a page view:

1 Addanewpageview.

2 Drag the staves from the Staves window into the

new page view

3 Print the page view.

For detailed information about adding staves to a

view, see "Displaying staves in a view" on page 36,

Galley view quick reference
Here are several important features you can Lrse to

control a galley view:

tfie close box to
,tlpwindow\\

Push down button sends

the windowtothe back,

i

tlkk the grow boxtofill
the computer screen

z/with the window.

Drag the title barto

move the window.

The title bar displaysthe name ofthe view

with the name ofthe file in parentheses.

40mmand-(li(k the name to closethis view

and open another in its place.

n the scroll bars Drag thesize boxto

resize the window.

i,orcli(k

e boxto

indow

qBaky view mini-menu

-mands for staff

:rd the margin

hsa{gin is the area at

nljtthatshowsthedel 
-16ard key siqnature.

,/
(rRnt measure number is

m here.To golo another

s€,clkk here,type the

xd measure,and press

----\ iilovethetabs

or (lick the arrows to s(roll the

display vertirally or horizon-

tally.

:TGE VIEWS AND GAI.I.EY VIEWS

,,{ -:-?

?

rrl -lgs

N

This area displays the voice in which notes are

currently being inserted or edited.To change to

a different voice, press the box and choose the

desired voire namefrom the pop-up menu.
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CREATING A VIEW
To create a page view or galley view:

1 Choose Views from the Windows menu.

2 Choose Add page view or Add galleyview from
the Views window mini-menu.

The ire'r'v view appears at the bottom of the list.

3 If desired, click the name to edit it.

Note that the view icons distinguish whether they
are a page view or a galley view. A galley view icon
contains the infinity symbol (-), indicating that it
scrolls indefinitely to the right:

Galley views

Page

Double<lick the view

i(on to open the view.

tlick the name,

and (omments to edit them.

Choosing a starting page number for a page
ViEW

To set the starting page number for a page view,
type the number in the column next to its name.
Galley views do not have page numbers.

OPENING A VIEW
To open a page view or galley vierv:

1 Choose Views from the Windows menu to open
or actiyate the Views window

2 Double-click the icon of the view vou wish to
open.

DISPLAYING STAVES IN A VIEW
After creating and opening a new view you are
presented r,r.ith a blank page in which to begin your
work. The first thing you need to do is create one or

more staves (ifyou haven t done so already). Then
you ll drop the staff (or staves) into the view
window.

You can place a staff in a view at any time, even if a

voice on the staff already contains music.

G In order to display and edit music on a staff,
the staff must have at least one voice assigned to it.

For information about how to create staves and
assigning voices to them, see chapter 4, "Voices and
Staves".

Creating staves
To create one or more staves:

1 Open the Staves window by choosing it from the
Windows menu.

2 Choose the'Add staff with voice" mini-menu
command to add a staff.

This command adds a staff with a voice already
assigned to it. Ifyou wish to add several staves,

press the option key while selecting the command.

3 If desired, name the staves and voices.

For complete information about naming voices
and staves, including setting up their note range,
stafftransposition, see chapter 4,"Voices and
Staves".

Once you have created one or more staves, you are
ready to drop them into the viewwindow The
following four sections provide the procedure for
doing each of the following:

r Displaying a single staff in a galley view

r Displaying a single staff in a page view

r Displaying a staff system in a galley view

r Displaying a staff system in a page view

Uieus (ljntiiled-l I

l'1iin EEor*? qillp!

Ft:J t pilr riril

!rl p!rt

Print @ EaE

I
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1en lkrdersta ndin g staff systems
ItAen staves are dragged onto a page, theybecome

lart of a staff system. A staff system is a group of
rle or more staves. Here are some examples:

To display a single staff in a galleyview:

1 Position the Staves window either next to or on

top of the galley view window.

The result is a single staff that scrolls endlessly to
the right.

3 To adjust the space above the staff, the size ofthe
staff, or any other aspect of the staff layout, select

Show Layout from the mini-menu and make the

desired adjustments.

See chapter 23,"Controlling Page Layout' for
details.

a} \A/hen the view is placed in Show Layout

mode, Mosaic temporarily suspends the editing of
notes and other musical symbols. Only items

having to do with page layout, such as staves,

margins, and text can be moved.

ifa
r .r single staffsystem

tr,

o rt.

t are

L -
and

r the

piano staff system

-- piano/vocal staff system

r . . .-noral staff system with soprano, alto, tenor,

- : rass staves (SAIB)

r , .:i! stafforchestra score system

i splaying a single staff in a galley view
- ..-,ev view contains only one staff system,which
: :'-ds indefinitely to the right. When more staves

- 
-. ,ided, they are added to that one system.

\

Itu

v

and

:e

for

\

I
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2 Grab the staff icon with the pointer and drag the

staff icon anywhere on top of the emptygalleyview.

S



Displaying a single staff in a page view
To add a single staff to a page view:

1 Position the Staves window either next to or on
top of the page view window

2 Grab the staff icon with the pointer and drag the

staff icon anyvhere on top of the empty page view
window.

Figure 5-1:Adding a staff by
window into o view.Staves are
in this foshion.

dragging its icon from the Staves
added to pageviews and galley views

3 To adjust the page margins, staff margins, staff
spacing, number ofstaves on the page, or any other
aspect ofthe stafflayout, choose Show Layout from
the mini-menu and make the desired adjustments.

In Show Layout mode, you can freely modify the

stafflayout. For details, see chapter 23,

"Controlling Page Layout".

Displaying a staff system in a galley view
To add several staves to a galley view as a staff
system:

1 Position the Staves window either next to or on

top of the galley view window.

2 Select the staves you wish to add.

To select several adjacent staves in the list, hold
down the shift key, click the staff icon of the first
staffand drag downwards over the rest. To select

several nonadjacent staves, shift-click the stafficon
of each one.

Notice that the staff repeats itself as many times as

necessary to fill the entire page. Ifyou dont want
the staff to fill the page, hoid down the option key

while dragging the staff into the view.

', lt> )411

\
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t To drop the selected staves into the galley view,

&ag the staff icon of any of the selected staves

afwhere in the galleyview.

T,te result is a staff system that scrolls endlessly to
c right inside the galley view window.

4 To make adjustments to the staff sizes or
spacing, choose Show Layout and make the desired

changes.

For complete information about controlling staff
layout, see chapter 23, "Controlling Page Layout".

Displaying a staff system in a page view
Below is an example of a piano score. The piano
staff system, which consists of two staves, repeats

five times to fill up the page. If a staff system has

many staves, only one or two systems may f,t on a

page.

Figure 5-2:A piano stoffsystem repeotedfivetimes on a page-

To display a staff system in a page view:

1 Position the Staves window either next to or on

top of the page view window.

2 Select the staves you wish to add.

staff

other

from
nents.

the

)r on

d

.rst

ect
'icon

t,,lrl

Staues

tlieur-+

Ci

f,f,

f,3

C3

dq Voice-1 !

l)
Stiff-9

Uieu-4
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To select several adjacent staves in the list, hold
down the shift key, click the staff icon of the first
staff and drag downwards over the rests. To select

several nonadjacent staves, shift-click the stafficon
of each one.

3 Drag the staff icon of any of the selected staves

anywhere in the page view to drop the selected

staves onto the page.

The result is that Mosaic places as many systems as

will fit on the page. If you wish to place only one
staff system on the page, hold down the option key
while clicking the stafficons to drag them.

5 To adjust the margins, staff spacing, or any other
aspect ofthe stafflayout, choose Show Layout from
the mini-menu and make the desired changes.

For complete information about editing staves, see

chapter 23, "Controlling Page Layout".

ADDING PAGES TO A PAGE VIEW
To add pages to a page view:

kii:ilfi 
'ffiil:r;?.::;:1T,;1T,*:ilil1

Pages are added either before or after the currently
displayed page. Thus, you need to display the page

before or after which you wish to insert the new
pages. To scroll to the desired page, click the page

StEU e s

tlieu-5
a3

ll

t:

:f

f,l

a:

tl

!oi:i 5
stiff a

aq Voi++-1 |

l
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4 To insert staff braces and brackets, select the

brace or bracket palette symbol and drag vertically
to the Ieft of the staves you want to connect.
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t

'i -Lick OK

:.-11 arrows at the lower left-hand corner of the

,:dorv, or click the page number between them,

:r the desired page number, and press return.

Choose Add pages from the view window mini-
nu.

-,.-pe in the number of pages you wish to add

ndicate whether the new pages are to be added

rre or after the current page.

Select a page Iayout template.

te page layout ofthe new pages can be based on

bcurrent page, a page layout template, or an

rirely new page layout.

Music is often displayed in more than one way. The

most common example of this is instrument parts
that are created from a conductorb score. The

master score has all the instrument staves together
in one large staff system. However, each instru-
mentalist's part consists of oniy one staff for their
instrument.

Here are some other examples of why a staffmight
be displayed in several views:

r The staff is being used in instrument part, which

consists of a single staff taken from a large multi-
staff score.

r It is a cue staff, which consists of another
instrumentt staffappearing on an instrument part
as a cue.

r You will print the music on different printers (say

an ImageWriter at home and a laser printer at

school or work), and you have created two separate

views with a unique page layout for each printer.

Music on a staff can be edited in any view in which
it appears. Changes to the notes and rests ofany
voice on the staffare automatically reflected on the

staffin other views. For more information about
what carries over to other yiews and what doesnt,

see the next section.

EDITING THAT OCCURS ACROSS VIEWS
When you work with multiple views, you should be

aware that editing that you do on many of the

musical symbols will carry over to all other views.

Some types of editing only affect the view in which
you are working.

When you edit the following things, the changes

you make will carry over to all views:

r Notes and rests

r Measure numbering. The measure numbering
scheme remains the same for all views.

1e

]ELETING PAGES FROM A PAGE VIEW
::lete one or more pages from a page view:

hoose Delete page from the view wir.rdow
ically

cther

from

s, see

1 one

rt the

'ent11'

page

lw
)age

-;pe in the range of pages that you wish to

ryou are deleting a single page, type that page's

umber in both text boxes. For example, to delete

ep 5, the page range would be from page 5 to

-nlenu.

llick OK

ffiPLAYING A STAFF IN SEVERAL VIEWS AT
fi{cE
.-)ne of the most useful aspects of views is that the
eme staffcan be displayed in several views at the

nme time, and it can be formatted differently in
a4r view. In the example belorar, the Staff-4 is being

Srylayed in three views at one time, as shown in
Fgure 5-3 onpage 42.
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Figure 5-3: Staff-4 is shown
here in three different views.
Clockwise from the top: in
the staves window, in o
galley view (zoomed in), in a
poge view contoining the
score, and (below) in a page
view instrument port,
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Barline types. For example, ifyou place a repeat

rline between measures 4 and 5 in a score, it
pears in all views between bars 4 and 5.

System text. For information about system text,

:'System text" on page 105.

An).thing that is specifically voice-related, such

roice text, slurs, ties, ornaments and articula-

ns, jazz symbols, etc. These items appear with
:r'oice in anyview.

Lyrics. Lyrics always appear below their voice.

E{TING THAT IS VIEW-SPECIFIC
Ihe previous section discusses characteristics in
mr Mosaic file that occur across all views, such as

*r measure numbering scheme.

here are many characteristics that are view-

rccific--that is, they only occur in the view in
hich you insert, edit, set, change, etc. them.

r Staff sizing. This allows the same staff to be

displayed at different point sizes in different views.

For example, you might display the piccolo part as

a miniature cue staff in the French horn part,while
displaying it in full size in the main score.

r Rest consolidating. This refers to whether or not
multiple measures of rests are grouped together.

These view-specific characteristics provide a great

deal of flexibility in the way that you can observe,

edit, and print out your music.

CREATING INSTRUMENT PART VIEWS
When you create a score view in Mosaic, you can

aiso create a separate instrument part view for each

instrument in the score.

For more information, see chapter 26,"Creating

Instrument Parts".

ZOOMING
The display of music in each view can be reduced

or enlarged--"zoomed"--by a percentage. You

can change the display by choosing the desired

percent from the view window mini-menu. The

higher the percentage, the larger the display. You

can step upwards through percentages by pressing

command-] (close bracket) or downwards by
pressing command-[ (open bracket).

Enlarging the display gives you a close-up view of
the music for fine tuning. Reducing the display
gives you a birdt-eye view of the music. Zooming
out is useful for selecting large region of music by
dragging a selection box over the region.You'll also

find it useful to zoom out when you are editing the

page layout.

Editing can be done at any zoom level

TIPS FOR USING VIEWS
Here are some tips you might find helpful when
using View windows.

-specifi c characteristics include:

-::e page layout. This includes which staves are

: aved, the arrangement of staves, size of page,

.:sins, staff connections, barline connections,

re zoom level. For example,you can zoom one

t in to 4000/o and zoom another out to 50ol0.

r :,se text, sllch as a title, header or fboter, staff
" -: :s, etc.

r line breaking and page breaking.

: lleasure spacing. This allows you to modify the

Ersrue spacing in a view without aflecting the

rcsure spacing in other views.

!6E VIEWS AND GAI.LEY VIEWStr!'rsl
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r The clef, meter, or key signature of a staff. These

@text items appear in that staffregardless of the

rary.



r To increase Mosaic's responsiveness, close as

many view windows as possible. Only leave open

the ones you really need at the moment.

r You can open several view windows at the same

time to copy and paste between them, cross-check

them, etc.

t Zoom out and reduce the view window size

when you are dealing with page layout control.
Doing so gives you a bird's-eye view of the entire
page.

Switching to another view in the same window
Even though Mosaic allows you to have as many
view rvindows open at a time as you prefet there is

a time-saving shortcut for switching to a different
view: hold down the command key, click the name

of the current view in the title bar of its window,
and choose the desired view from the pop-up
menu as shown below. In the pop-up menu, the
current view appears with check mark next to its
name.

ifflf,f tru l,-tA!. I

Hlto Sa*
Ealleg uieru

Tenor Sa*
Trumpet

*/ Piffnu

44
PAGE VIEWS AND 6ALLEY VIEWS

r_



I
(HAPTER 6 Creating a New File with New Setup

be New Setup command is very useful when you

rc first setting up a new manuscript. It lets you

Ject the instruments you want from a list of
nndard instruments. It then creates a new file and

uomatically generates all the voices, staves and

hvs, including:

r A voice and stafffor each instrument with
proper voice range and stafftransposition, if
mlicable

r Apage view and galley view for the full score

r A page view for each individual instrument Part

haddition, the New Setup command

&matically formats the views to your specifica-

fras. Here is a summary:

r Each page view is laid out with a title page and

b@page

r Each title page includes a title, composer, and

iitial metronome marking in any font you prefer.

r Transposed staves are used as needed in
.strument parts for transposing instruments.

r The score page view includes staffnames.

r The staff size for the score page view is optimized

trsed on the number of staves in the score.

nstrument part views are generated with 24-

nt staves.

. Page templates are generated in the Templates

rindow for the score title page, score body page,

part title page, and part body page.

The yoices, staves, and views created by this

command are identical to the ones you can create

manua\ in the Voices, Staves andViews windows.

This command simply generates them

automaticaily for you.

Using New Setup
To create a new file using New Setup

1 Choose New Setup from the File menu.

The New Setup dialog box appears.

To add an instrument

to yourscore,double-

rlirk its name.0r clirk

once and then click

The s(ore List displays the

instrumentsyou have added to

the score. Drag the staffi(ons

to rearrange their order.(li(k

their names to rename them.

(lick here to

checkoruncheck

automati( part

generation.

active

text boxorlist,which ran be

modified by the commands

in the Text menu.

Givesyouasample (urrentlya(tivetext Displaysthe

so you (an see what text attributes it has.To

(hange the attributes, use theText menu.To

chanqe the rurrently adivetext, usethe tab

key,orclirkthe desired text box or list.

Figure 6 1:The New Setup dialog box automatically generates the
entire score for you, including individual instrument part views.

2 Make the settings as desired and click OK to

confirm your choice.

l+s
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See the remaining sections in this chapter for
detailed information about making the settings in
this dialog box.

Working with the instrument and score lists
To indicate what instruments you would like to add

to your composition, select instruments from the

instrument list on the left and add them to the

score list on the right. Here is a summary of how to
do so.

To do this: Do this:

convenient to change it beforehand because you

only have to change it in one place instead of
seyeral.

IffiI
ffi

UsP Texl nenus 1o set fon't,
sizP, riulr and justifiertiDn for

To add an instru-
ment to the score

list

Click its name in the list on the left to
select it, and click the Add button. The
instrument then appears in the score
list on the right. Alternately, you can
double-click the instrument name or
press the right arrow key.

Add a generic clefinstrument that is
appropriate for the instrument you
want to add (e.9. a Treble Clefstaffl
and then rename the instrument in the
score list (see below)

Click its name in the score list. (The
score list is on the right; names can be
edited in the score list. The instrument
list is on the left; names cannot be
edited in it.)

Click its stafficon in the score list on
the right and click the Delete button.
Its name disappears from the score list,

Uncheck the part column to the right
ofthe instrument name in the score

list.

Drag the hstruments up md down ir
the score list by dragging t heir 'taff
icons.

Figure 6-2:Clickthe name ofan instrumentin the score listto change
the nome.

lncluding text labels
The New Setup command gives you the option of
including the followirg text labeis in the views it
generates:

r Title

r Composer

r Tempo marking

r Instrument name (in part views)

r Staffnames in the main score

To include a text label, check its box as shown in
Figure 6- I on page 45, and type in the desired text
for the title, composer and tempo marking. For a

sample of each text label, see Figure 6-3 on page 47

The text labels generated are standard page text

boxes, so they can be freely edited. For complete

information about page text, see chapter 15,"TexC'

To rename an item
in the score list

To remove an

instrument from
the score list

To prevent a part
view from being
gererated for an
instrument

To arrange the
order ofthe instru-
ments il the score

)

Adding an instrument that is not in the list
If you would like to add an instrument to your

score that is not in the instrument list, add an

existing instrument that has the same clef and

transposition.You can then change the name of the

instrument after you add it to the score list by
clicking its name in the score list. The score and

part view will be generated using the new name.

You can always change the name later, after the

score and part views are generated, but it is most

(REAIING A NEW III.E WITH NEW iErutl

orchestr3 Bell,

Bb tiEprano six

Tenar Clef
Bb TPnDr Six

Neur

EII.CEil!IET-]

46

il

To add an instru-
ment that is not
present in the
instrument list
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To select an instrment
from the list

justification for

fab or shift-tab

Tab or shift-tab

Up arrow or dorvn arrow

Command-tab or the right
arrow key

Activate the list and rype the
first letter ofthe name

vith

I

EG3:Text labels in o score view and instrument port view
eroted by the New Setup command. ln addition to specifying
t the text will be, you can also specify the font, size, style, ond
*ation separately for eoch label.

Setting the font, size, and style of text
Sels
Tbe New Setup dialog box lets you individually set

:be font characteristics for each text label using the

kt menu. To set the font characteristics for a text

ake the text box, instrument list, or score list

make a text box active, ciick on it so that the

rs/or appears inside the text box. To make the

frument list or score list active, click inside the

t (see Figure 6-4 below). To cycle through all

rilable text labels and both lists, press the tab key

rshift-tab) repeatedly. The name of the currently

tive text label appears in bold type above the

rylay area (see Figure 6-1 on page 45).

n,lir. t'tot rltire
(Border becomes heavy)

Figure 6-4:To make the instrument list or score list active, click it.

2 To determine the text attributes of the currently
active text label or list, observe the sample text

inside the display area, or use the Text menu to see

;:il,:- 
attributes are currently checked in the

3 To change the text of the currently active text

box or list, choose the desired font, point size, style,

and justification from the Text menu.

For your convenience, the display area in the dialog

shows the text settings for the currently activated

text or list item. As you change the settings in the

Text menu, the sample text in the display area

updates to show you what has been chosen.

Using the keyboard to get around the New
Setup dialog
While you are working in the New Setup dialog,

here are some keyboard shortcuts you can use:

To do this: Type this:

^ J=rr

:

'stto chonge

To move to (activate) the
next or previous text box

To select the next or previ-
ous instrument in the list

To add an instrument to
your new composition

ITATING A NEW TITE WITH NEW STIUP

Eb

TimFni
TrPble f,lPf

E Alto Voico
E Barilon6 Voi+e

Quick

)ct

\

To actiYate the instrument
lists

;TUtl



The new file can be easily modified
Quick Setup helps you save time and get started
quickly. When you click OK, it does most of the
work for you in setting up a new file. You may find,
horvever, that you would like to make adjustments
to the voices, staves, views, and page layouts in the
newly created file. Just remember that you can

easily modify anything. For complete information,
review chapter 4,"Voices and Staves", chapter 5,

"Page Views and Galley Viervs", chapter 15, "Text",
and chapter 23, "Controlling Page Layout".

Entering notes into the newly created views
The page and galley views generated by the New
Setup command are ready for note entry, and they
provide 16 blank measures to help you get started.
Ifyou pian to start entering notes from the
beginning of the score, Mosaic automatically
creates new measures as you insert notes (based on
the current meter). If you won t necessarily start
entering notes at the beginning ofthe score, you
will need empty measures in which to enter notes.
You can add any number of empty measures using
the Set Score Length command in the Edit menu.
For more information, see "Using Set Score

Length ' on page 77 .

Adjusting the page layout of the new views
Mosaic provides you with complete control over
the formatting of the pages generated by the New
Setup command. To insert staff braces and
brackets, select the brace or bracket palette symbol
and drag vertically to the left ofthe staves you want
to connect. To adjust the margins, staff spacing, or
any other aspect of the staff layout, choose Show
Layout from the mini-menu and make the desired
changes. For complete information about editing
staves, see chapter 23, "Controlling Page Layout".

Creating a transposed score
The New Setup command produces a concert
score. If you have transposing instruments in your
composition, and you want a transposed score, you
can easily replace the concert staves in the score

view with the transposed staves that were
generated for the parts. For information about how
to replace staves in a view, see Figwre26-2 on
page 174.

Adding more pages to the view
To add more pages to a page view, use the Add Page

command in the Page view mini-menu. For
compiete information, see'Adding pages to a page

view" on page 40.

Each view is given both a title page and one body
page. The body page has a header instead of a title.
You can add as many body pages based on the
original one as you like. You may want to modify
the layout of the body page before generating new
ones.
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,thow ffiAPTER 7 Undo and Redo

d Page
Uosaic has two powerful commands in the Edit
menu: Undo and Redo. Together, these commands

{lowyouto:
aPage

things, and Mosaic will remember every one of
them.You could then choose Undo a hundred
times and undo the half hour's worth of work.
Unlimited undo gives you freedom to experiment.

UNLIMITED REDO

The Redo command ungreys immediately after
you use Undo for the first time. Redo lets you put
back the action that was removed by Undo. (Heret

another way to look at it: Redo is an "undo" for the

Undo command.)

USING UNDO AND REDO TOGETHER
You can use Undo and Redo together to go

backwards and forwards through a series of
actions. For example, lett say that you change your
mind while working and decide to backtrack.You
repeatedly choose Undo--and suddenly realize

that you went too far back. You can then choose

Redo a few times to go forward again until you zero

in on the point at which you would like to continue.

Undo and Redo help you easily compare different
ideas, even if the differences consist of many
command strokes. For example, you could
experiment with intricate formatting designs and

always be assured of getting back to the original.
You can use Undo and Redo repeatedlyto compare

the two versions of the file.

USING UNDO AND REDO WITH THE
CLIPBOARD
Undo and Redo do not affect the contents of the

Clipboard. This allows you to retrieve something
that you did previously in a session. For example,

say that you decide to retrace your steps, undo
several times, and proceed in a different direction
Then, you change your mind and decide that you
would like to keep what you had done previously.

body
a title
he

rdify
g new

r :-\perrment more

:, .n if you are familiar with the standard

,:.-intosh "previous action only" Undo, you'll

. :.sider Mosaict unlimited Undo arld Redo a

,: " l rlI.

jere is how Mosaic's Undo and Redo commands

I'TLIMITED UNDO
[-hdo 'lakes bacli'whatever you just did. It could

he that you added a staff, deleted a staccato,

iserted some notes, moved a slut or anything.

Cboosing Undo from the Edit menu (command-

Z) undoes the most recent action that you took.

ado is useful when you do something by
rident. For example, let's say that you try to select

oote to add an accidental, but you accidentally

agthe note a little bit to the left so that it is now

r ofposition. Rather than dragging it back and

diously trying to line it up again with the other

otes, simply choose Undo. It will pop back to its

rd,inal position as if it had never moved.

illo is also useful if you dont like what you have

me. Remember, you can undo just about

rrything in Mosaic.

: Jon t have to stop after using Undo just once,
:rer-er. Undo is unlimited. Mosaic remembers

::-,- action you take from the momentyou open a

. 'rou can work for half an hour, do a hundred

ETUP
l+s

r iar-e time



Depending on what it is, you might be able to
retrieve it simply by undoing back to the original
point where you changed your mind, copying what
you want into the Clipboard, and redoing forward
again up to the current point and then pasting.
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(HAPTER 8 Notes and Rests

s chapter explains how to enter the following
$ols with the mouse and Macintosh keyboard

btes, dotted notes, rests, and grace notes

ccidentals

hords

ddition, this chapter explains how to:

dd a dot to an existing note

djust the position ofnotes, rests, dots, and

dentals

djust stem lengths and beam angles

hange the duration ofnotes and rests

ontrol the spacing ofnotes and rests

nter notes via MIDI, see chapter 34,"MIDI
ording and Playback'.

:YTERING A NOTE, REST, OR CHORD WITH_{E 
MOUSE

: ::ring notes with the mouse is straightforwardt

- --asically point and click. The following
.-:r.rns explain how to enter notes, rests, dots,

- - -:ientals, and chords with the mouse.

e Before working with notes and rests, be sure

how Layout command is unchecked in the
'rvindow mini-menu. When it is checked, you

enter or edit notes, rests, and other symbols.

r The keystrokes described in this chapter are

&Mosaic default keystrokes. If you get results

der than what is described here, the keystrokes

rryhave been changed. To restore the default

$ooaic keystrokes, see Appendix D, "Customizing

lbsaic's Key Bindings".

Selecting a voice on a staffwith multiple voices
If you are entering a symbol on a staffthat contains

more than one voice, you need to select the voice

before you click the staff. See "Entering notes and

rests" on page 17 5 in chapter 27, "Working With
MultipleVoices on a Staff".

Entering a note or rest
To enter a note or rest with the mouse:

1 Open the note or rest palette by choosing it from
the Palettes menu.

2 Click the desired note duration.

3 Click the staff at the desired location and, if
entering a note, the desired pitch.

You can keep clicking as many times as desired. To

change the duration, click a different duration in
the palette.

Ledger line guides appear during note entry
Ifyou enter notes above or below the staff, ledger

line guides appear to help guide you during note

entry with the mouse or keyboard. These guides

help you determine exactlywhat pitch you will
enter.

Entering a dotted note or rest
To enter a dotted note or rest with the mouse

t
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The arrow turns into a cross hair, indicating that
when you click the mouse, a note will be inserted.



3 Click the staff at the desired location and, if
entering a note, the desired Pitch'

Adding a dot to an existing note or rest

T;t." 
dot to an existing note or rest using the

1 Click the dot symbol in either palette'

You can choose the dot symbol from either the note

or rest paiette. It doesnt matter which'

2 Click the notehead or rest, or click just to the

right of it.

Adding an accidental
To enter an accidental (sharp, flat, natural, etc')

with the mouse:

1 Click the desired accidental symbol in the note

palette.

2 Click near the notehead as shown in Figure B-1

to enter the accidental.

1 Click the desired duration in the note or rest

palelte.

2 Click the dot symbol (as shown to the left) in the

palette.

willbe entered successfuliy' Ifyou are adding an

accidental to a note in a chord, and the notes are

clustered tightly together you may want to use the

Macintosh keyboard to enter the accidental for

greater accuracy' See "Working with accidentals"

on page 56.

To adjust the position of the accidental, drag it with

the mouse.

Building a chord
To add a note to a chord with the mouse:

1 Click the duration in the palette that matches

the duration of the note(s) already in the chord'

2 Click directly above or beiow the existing note'

The new note is added to the same stem as the

existing note. If necessary, Mosaic will

automatica\ flip the stem. If you accidentally click

too far to the left or right, the note won't get entered

on the same stem. Don't worry. Just choose Undo

(command-Z) from the Edit menu and try again'

Ifyou choose a different duration than the existing

note(s) in the chord, Mosaic enters the note at the

same beat location, but the note is placed on a

separate stem' See the next section'

Entering notes of different duration on the
same beat
Mosaic allows you to enter poiy-rhythmic {igures

on a staff. They can be entered in the same voice' or

into seParate voices.

If the rhythms separate for a brief phrase (a few

notes), enter them in the same voice'

If the rhythms seParate for an extended period'

create a second voice on the staff and enter the

separated rhythms in the second voice' See

'Assigning severai voices to a single staff" on

page 29.Aiso see chapter 2T,"WorkingWith

Multipie Voices on a Staff".

Fiqure 8'1: Cticking to enter an occidentol' Mosaic is forgiving ond

lelts you click onyih"r" neor the noteheod, os shown here by the

dashed box.

Mosaic is forgiving about exact\ where you click'

As long as you click in the general vicinity of the

notehead as shown in Figure 8-1, the accidental

li'tLlr

rl
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. rnter two or more notes (or rests) of different

-:,:iions on the same beat in the same voice:

llick the desired duration in the note palette.

llick to enter the first note or rest.

llick a different duration in the note palette.

r -ick directlyabove orbelow the existing note at
-. :esired pitch.

Entering a grace note
:*'lVorking with grace notes" on page 59 .

rnmary
krre is a summary of the ways in which you can

*r notes and rests with the mouse.

': add this: Do this:

Click the note or rest in the
palette and click the staff

1. Choose lvhere to insert
e

the
2. Choose a duration (with or without a dot)

3. Insert the note or rest, or several notes to build a

chord

t'- The keystrokes described in this section are

the Mosaic default keystrokes. If you get results

other than what is described here, the keystrokes

may have been changed. To restore the default

Mosaic keystrokes, see Appendix D, "Customizing

Mosaict Key Bindings".

Choosing where to insert
To enter notes using the Macintosh keyboard,

position the insertion cursor in the staff at the

desired location. The insertion cursor is a small

vertical bar with a pitch indicator as shown below

in Figure 8-2.

vith

ls

l.

)te.

lick
ered

do

rin,

e or rest

ted note or rest

;;idental

double-dot, or triple

Click the note or rest in the
palette, click the dot in the
palette, and then click the staff

Click the desired duration
and tle grace note qmbol in
the palette, and then click the
staff

Click the desired accidentai in
the palette and then click to
the left or on top ofthe note

Click the desired dot in the
palette and clickthe notehead
or rest, or click to the right of
it

Click directly above or below
the existing note

lnsertion cursor

-Pit(hindi(ator

f Note: the dot will remain highlighted until
u select another duration.

HIERING A NOTE,REST,OR CHORD USING
IDG KEYBOARD
l!fu section describes how to type note, rests, and

irds using the Macintosh keyboard. Here are the

=ck steps to enter notes:

Fiqure 8-2.The insettion cu$or consists of a small vertical bar with a
pitch indicotor.The insertion cursor determines where the next note
will be entered from the keyboard. Here the insertion pointwill enter
a middle C.

Using the cursor
The insertion cursor determines four things about

the note being inserted:

l' Which voice on the staffthe note will be inserted

into. Since a staff can contain more than once voice,

the insertion cursor determines the voice. See

"Switching the insertion cursor to a different voice

or staff" on page 54.

2. The beat location in the measure: at the

beginning, at the end, in-between other notes, or

on the same beat as an existing note. Use the left/
right arrow keys to move to the desired beat.

3. The pitch of the note. Use the up/down arrow
keys to move to the desired pitch.

ace note
,tlng

the

.res

:e, 01
cond, third, fourth,
,te ofa chord

I
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4. The cursor octave range. The top and bottom of
the insertion cursor are octave boundaries. Ifyou
type a letter between A and G, the cursor wiil jump

to that pitch within the octave prescribed by the

insertion cursor. To change to a different octave,

hold down the shift key and press the up/down

arrow keys before typing the pitch letter.

Placing the insertion cursor on a staff
To place the insertion cursor on a staffwhen

entering a note:

1 Click the arrow cursor at (or near) the desired

spot on the staff.

When you click on a staff to place the ihsertion

cursor, you are actually placing it in a voice on the

staff. Mosaic displays this voice in the horizontal

scroll bar at the bottom of the view window as

shown below:

.lgl.ELl1i j.1i j.1i1. ji1.il1.:il.jijijilijiliji;iji\ u ie'U- |

0 I<lt iL,:p

Figurc 8-3: The current voice.

tf Please note! If you tryto enter a note on a staff

that does not have a voice assigned to it, Mosaic

warns you that you need to assign a voice first. See

'Assigning voices to staves" on page 29.

2 If necessary, move the insertion cursor with the

arrowkeys.

Switching the insertion cursor to a different
voice or staff
Most of the time, a staffhas only one voice assigned

to it. When you click the staff, the cursor will be

placed in the voice and you are ready to enter notes.

However, if you have more than one voice in the

staff, when you click the staffto place the insertion

point, Mosaic places it by default in the top voice

(listed first beneath the staff in the Staves window),

There are two different ways to select a voice. One

way is to hold down the command key and press

the up or down arrow keys.

To select a voice using the command key:

1 Place the insertion cursor at the stafflocation
where you would like to enter the notes, or press

command-up arrow or command-down arrow to

switch to the desired voice.

Keep pressing until you see the desired voice at the

bottom of the window as shown in Figure 8-3

above.

2 Once you have selected the desired voice, start

entering notes.

The other way to select a voice is to press the voice

indicator box and choose the name of the desired

voice from the pop-up menu provided:

3 Click the Voice indicator box and choose the

name of the desired voice from the pop-up menu.

The cursor jumps to that voice.

Tsnor

Use this procedure to move the insertion cursor to

a voice on a staffabove or below the current staff

Bass
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Ioving the insertion cursor
:iere is a summary of ways to move the cursor:

: move the insertion (ulsor: Do This:

Setting a dotted duration
To set a dotted duration:

1 Press the open bracket ( [ ) or close bracket ( ] )
keys to select the desired base duration.

2 Press the decimal key or period key ( . ) once for
a single dot.

To select a double-dot, press option-decimal or

option-period. To select a triple dot, press

command-option-decimal or command-option-

period.

Notice that this highlights the appropriate dot in
the palette, along with the base duration.

(- Note: the dot will remain highlighted until
you select a different note duration. You can

deselect it by pressing the decimal key.

Entering a note, rest, or chord
Once you have placed the insertion cursor and set

the duration, you're ready to enter a note, rest, or
chord. Below is a summary.

(- You can use either the main keyboard or the

keypad on an extended keyboard to speed up

entry.

To enter: Do this:

ight within a mea-

dorvn one line or

e next or previous

.iorvn one octave

pitch (A through G)
he current octave

u1'pitch in a different

et a duration:

Press the up/down arrow keys

Press control and the left/
right arrow keys

Press shift (or option) and the
up/down arrow keys

T1,pe the desired letter

differmt voice (either
re sme staffor a differ-
rne)

Press shift (or option) and the
up/down arrow keys to move
to the desired octave and then
press the desired pitch

Press command and the up/
down arrow keys

staffabove or below
urrent staff

Press command and the up/
down arrow keys or choose

the desired voice from the
voice indicator pop-up menu

S:*ring the duration
Once you've placed the insertion point, you are

pedv to select a duration.
the

Press either the open bracket ( [ ) key or the

eebracket(l)key.

&e note palette is not already open, this will open

rnd select the duration ofa quarter note. Ifit is

ready open, see step 2.

Press the open bracket key ( [ ) to select a lower

uration; press the close bracket key ( ] ) to choose

hfoiher duration.

he duration you select will highlight in the

rlette. You can continue to cycle through the

u'ations as needed.

A note with no accidental

A note with natural

A note with a flat

A note with a sharp

A note with a double flat

A note with a double sharp

A dotted note

Press retrun

Type an equals sign ( = )

Tlpeamirussign(-)

Tlpeaplussign(+)

Tlpeaslash(/)

Type an asterisk ( * )

Press the period or decimal
key and then retun

TES AND RESTS
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The first note ofa chord Press enter

Once you have done so, press one of the same keys

as mentioned above to add the desired accidental.

To add: Do this:

A sharp Type a plus sign, or press the
plus ( + ) key on the kelpad

A flat Tlpe a minus sign or the
minus ( - ) key on the kelpad

A double sharp Type an asterisk ( * ) or press

the asterisk key on the kelpad

A double flat

A double-dotted or triple-
dotted note

A dotted note with an acci-
dental

The second, third, fourth,
etc. note ofa chord

A note on the same beat
with a different duration

Select the desired note dura-
tion and click the double-dot
or triple-dot palette symbol

Press the period or decimal
key, enter, and then the
appropriate accidental note
k.y

Press enter

Position the insertion cursor
on the desired beat/pitch and
press enter or return

Type
slash

a slash ( / ) or press the
key on the kelpad

A rest Press the space bar

A dotted rest Press the period or decimal
key and then the space bar

tf Note: the dotwill remain highlighted until
you choose a different duration or deselect it. To do

so, press the dot key again.

Notice that the cursor advances

when you press return:

But when you press erxrer, the cursor

remains at the same beat location so

that you can enter a chord.

WORKING WITH ACCIDENTALS
The following sections describe several ways to

enter and edit accidentals.

Adding an accidental to an existing note
To add an accidental to a note that is already

entered, use the arrow keys to position the

insertion cursor on top ofthe notehead, or click the

notehead to highlight it as shown:

OR

A natural Type an equal sign ( = ) or
press the equal key on the
kelpad

These keys are the same ones as you use to enter a

note. If the insertion cursor is not placed precisely

on the notehead,you maymistakenly enter

note, instead ofjust the accidental. Just choose

Undo and try again.

To enter an accidental with the mouse, see

an accidental" on page 52 in this chapter.

Entering a courtesy accidental
A courtesy accidental

is a sharp, flat,

etc. placed in front of
note that doesn't

need it: the note is already accidentalized by one

earlier in the measure or by the key signature. It
added to the note as a reminder. It can be

with or without parentheses:

To add a courtesy accidental with parentheses to

existing note:

1 Click the desired courtesy accidental from the

notes palette.

I

t1-l-#
,..,I

-l--H
--r

\

t

56

2 Click the desired note.
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tal.

re

add a courtesy accidental without parentheses

an existing note, see 'Adding an accidental to an

kring note" on page 56.

ftping a note to its enharmonic equivalent
Eo change a note to its enharmonic equivalent

rydling:

):-eat one or more notes.

. speliing of each note changes to its

:armonic equivalent.

IOI'ING A NOTE OR REST

$fter you have entered notes and rests, you may

ri* to "tweali'their left-to-right position in the

ffisure. Or perhaps you accidentally entered the

rrong pitch and wish to move the note to the

trrect pitch. Or perhaps you need to move a rest

il of the way of a note in another voice on the

dd

kgging left or right
bmove a note or rest to the left or right, drag it
rlhthe arrow cursor.

t Piease note! When dragging a note left or

Q!6 Mosaic does not let you drag past a note or
Hine.lf y6g yTish to change the order of the

ffis, use cut and paste. See chapter 18,"Edit

Oommands".

Bagging up or down
bmove a note or rest vertically, drag it up or down
rlh the arrow cursor.

:.qging notes in this fashion produces the same

s:its as if you performed a diatonic transposition
r the Tianspose command in the Region menu.

- '-Transposing diatonically by dragging notes"
- -roe I 1Q

DELETING NOTES AND RESTS

Notes and rests can be deleted several ways

r Select the note or rest and choose Cut, Erase, or
Snip from the Edit menu.

r Select the note or rest and press the delete key.

r Place the insertion cursor to the right of the note

or rest and press the delete key.

ADJUSTING AN ACCIDENTAL
Sometimes you may need to adjust the position of
an accidental. With the arrow cursor, drag the

accidental left or right to the desired position.

DELETING A DOT OR ACCIDENTAL
To remove a dot or accidental:

1 Click the dot or accidental with the arrow cursor
to select it.

CHANGING THE DURATION OF NOTES AND
RESTS

The durations ofnotes and rests can be easily

changed in the foliowing ways:

To change the dura- Do this:
tion ofthis:

rd

ss

ad

rtal

rral,

ofa
:ally

1e

tt is

ryed

oan

A single note or rest

Several (many)
notes or rests irll at
once

Clickthe desired duration inthe notes
(or rests) pclel-e and click the note-
head ofthe note you wish to change.

Select the notes and then apply tlle
desired duration h the flotes or rests
palette by command-clicking the
desired item in the palette.

Select the notes and then choose Dou
ble Durations or Halve Durations
from the Region menu.

.he

To double or halve
the duration ofone
or more notes or
reStS

When you change durations, Mosaic is not picky
about whether you are dealing with notes or rests.

For example, you can select both notes and rests at

the same time and change their duration from the

TE5 AND RE5IS
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I -rtrose Flip Enharmonic from the Region

2 Press delete, or choose Cut or Erase from the

Edit menu.

e

il



notes palette. (Mosaic won't change the rests into

notes; it will just change the rest into the equivalent

duration of the note you select in the palette.)

ADJUSTING STEM LENGTH
Mosaic gives notes the proper stem length and

direction to each note. For example, the stems on

notes in ledger lines above or belorv the staffextend

to the center iine on the staff.

You may find, however, that there are times when

you need to adjust the stem length, such as to avoid

a collision with another symboi or text.

Adjusting the stem of single note
To adjust the stem length of a note:

1 Click the stem of the note.

A handle appears at the end of the stem.

2 Dragthehandlethatappears
at the end of the stem.

Adjusting the stems of
beamed notes
To adjust the length ofbeamed notes, drag the

beam up or dorvn as shown below:

Adjusting the beam angle
To adjust the angle of a beam:

1 Click the beam.

Handles appear at either end of the beam.

2 Drag either handle up or down.

For more information about working with beams,

see chapter 9,"Beams".

HIDING STEMS

The Hide Stems in the Format menu command

removes stems from the currently selected notes.

The Re-stem command brings back the hidden

stems.

To use these two commands, select the notes (see

"selecting what you want to edit" on page 131),

and choose either Hide Stems or Re-stem from the

Format menu.

The Hide Stems feature is ideal for TAB (tablature)

and chord slashes.

.H,
ffi

^7um

Figure B 4: Hiding stems in rhythm slashes ond tobloture.

HIDING RESTS

The Invisify Rests commancl in the Format menu

hides rests. This includes the whole rest that

automatically appears in empty measures. Hidden
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rts appear greyed out on the computer screen to

ficate their presence to you; however, they are

mpletely hidden when the view is printed.

b hide one or more rests, select them and choose

rrisify Rests from the Format menu. Once

risified, rests appear grey on the computer screen

o indicate that they are invisified and will not
rint. To make rests visible again, select them and

ioose Show Rests from the same menu.

dden rests can be useful in many situations. Here

:a few examples:

r -'-, hide unwanted divisi part rests.

r .-, hide the default whole rest that appears in
-::n- measLrres to make the measures completely

- ,t-: \.
r To make completely blank manuscript paper by
lEfing the default whole rests in the empty
csrtres that you lay out on the page.

hrking with empty measure whole rests
tr convenience, Mosaic automatically places a

*ole rest in emptymeasures. This empty-

msure whole rest is both similar and different
bn the whole rest you enter from the Rests

n{ette. The most notable difference is that it

-not be removed. It remains in the measure as

lng as there are no notes or rests in the measure.

JBsoon as you enter a note or rest in the measure,

bever, it automatically disappears.

0n srreen

ln print

Figure 8-5:An invisified empty-measure whole rest.

With regard to editing, the empty-measure whole

rest acts much like a regular whole rest. For

example, it can be selected, cut, copied, and pasted,

either by itself or selected together with other

music. The only exception is with the Cut

command. Normaily,when you cut something, it is

removed and placed on the Clipboard. Empty-

measure whole rests get placed on the Clipboard by

the Cut command, but they are not removed from
the measure. If you want to remove them, use the

Invisify Rests commands mentioned above.

Empty-measure whole rests differ from regular

whole rests in another way. Text, dots (for dotted

durations), and other symbols cannot be attached

to them.

USING SPECIAL NOTEHEADS
Mosaic provides a host of different noteheads that
you can use instead of a regular notehead,

including a slash notehead for chord symbols.

For complete information about noteheads, see

chapter 25,"Using Special Noteheads".

WORKING WITH GRACE NOTES

Grace notes are ornamental notes that adorn

regular notes. \\rhen played, they usually take up

part of the duration of the note that they adorn.
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hnthough empty-measure whole rests cannotbe

noved, they can be hidden with the Invisifu
ks command. When they are invisified, they

1;mr greyed out on the computer screen, and the

Snot appear at all in print, resulting in a

mpletely blank measure.

How grace notes differ from regular notes
In Mosaic, grace notes can be placed anl,where,

and they can be beamed, slurred, tied, and

ornamented in the same fashion as regular notes.
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Here is what makes grace notes different from
regular notes in Mosaic: they are smaller, and they

do not have a duration; that is, they do not'tount"
when Mosaic adds up the beats in a measure.

Therefore, enough space is provided in the

measure for them, but they do not affect how

rbgular notes in the measure will line up with notes

in the same measure on other staves.

rf Please notel Grace notes cannot be made into

a triplet or tuplet. They can, however, be enclosed

in a triplet or tuplet in which the note they adorn

resides as shown below:

r-3

Entering a grace note with the mouse
To enter a grace note with the mouse:

1 Click the desired duration in the note or rest

palette.

2 Click the

grace note

symbol (as shown to the left) in the palette.

3 If necessary, click the dot symbol in the palette,

4 Click the staff at the desired location and pitch.

Entering a grace note with the keyboard
To enter a grace note with the keyboard:

1 Press the open bracket ( [ ) or ciose bracket ( ] )
keys to select the desired base duration.

2 If necessary, press the dot key to make a dotted
duration.

3 Press the comma ( , ) key to toggle on the grace

note palette symbol.

G Note: the grace note palette symbol will
remain highlighted until you deselect it. To do so,

press the comma key again.

4 Press return to enter the note.

Remember, you can press the plus or minus keys

enter the grace note with a sharp or flat.

Adding a slash to a grace note stem
To add a slash to the stem of a grace note:

1 Click the slash symbol

in the ornaments palette.

2 Click the grace note.

Alternately, you can click the grace note to select

and apply slash by command-clicking the slash

symbol in the palette.

Using grace notes to notate a cadenza
To notate a cadenza, enter the cadenza notes as

grace notes.

SCALING THE SIZE OF NOTES

The Scale command in the Format menu allows

you to scale the size ofnotes and rests

independently of the staff. This command is ideal

for making cue note passages.

Scaled notes differ from grace notes because they

do take up the correct duration with respect to

notes in the same measure on other staves. They

still"count"when Mosaic adds up the number of
beats in the measure. For an explanation of grace

notes, see "Working with grace notes" on page 59.

AII symbols that are "attached" to the notes and

rests in the voice are scaled with the notes.

Attached symbols include articulations,

ornaments, groupings such as slurs and ties, and

dynamics, including hairpins. To scale, select the

notes and choose the Scale command from the

Format menu.
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You can scale any region, from a single note to the
entire piece. For example, if youd like a measure
with a whole note to be wider, you can select the
whole note and increase the spacing. For
information about selection large regions, see
"Selecting large regions" on page 132.

20070 Spacing

Figure 8-7: Scaling the width of o single whole note.

Scaling can be done on both notes and rests.

Scaling is cumulative. For example, if you scaie a
single measure, and then scale a larger region that
includes the measure, it maintains its spacing
proportionally.

The Scale Spacing command is view-specific. It
only af[ects the data in the view you have selected.
This gives you greater flexibility because you can
choose a different scaling amount for each view;
which mayhave its own unique spacing
requirements.

rf The results of Scale Spacing in a page view are
restricted by the line break settings. For example, if
you have already used the Casting offcommand to
force 4 measures per line, scale spacing will have no
affect over the length of the entire line. It will have a
an effect, however, on a region within the four bar
line (as shown in Figure 8-7 above, for example).

Restoring default spacing
To return a region ofnotes and rests to their default
spacing, select the region and ch oose Restore
Default Spacingfrom the Format menu.
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-84:The first example is normol size fi00ok).The second
ft isthe same passage scoled to 50% withtheScotecommani.
tb that voice-.reloted symbols such as atticulations, groupings
aas slurs and ties, and dynamics are scaled as *ui,ti.rni ,tiff
-Ethe same size.

B can be made larger or smaller. To restore
dols to their original size, scale them to l00o/o.

.7 Text items such as the coda sign cannot be
- 
-,=ed rvith the Scale command. Scale text items

-i,difying their point size.

. - rq is staff-specific. For example, a voice can be

' =: to 507o on one staffwhile displayed at 1007o
- ::trrther.

*ing cue notes with the Scale command
1ou would like to use a certain voice for cue
as, copy the cued instrument notes from the
review (or the original instrument part) and
cE them into the instrument view where they
! serve as cue notes. Then scale the copied
*rial as desired. Copying in this manner leaves
eoriginai part at full size.

TIf,ITROLLING NOTE SPACING
thScale Spacing command in the Format menu
aryou tighten or expand the spacing for any
&ted region of notes or rests. Spacing is set by
sentage,where I00%o is the current spacing.
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ffiAPTER e Beams

his chapter covers everything you need to know
bout working with beams, including:

' i:arling rnanually (overriding auto-beaming)

r . -i:tomizing auto-bearning

r ::tering, deleting, and adjusting a beam

. :.aming across staves and over barlines

I}RKING WITH AUTO BEAMING
rbaic beams notes automatically as you enter

-m. By default, Mosaic follows standard beaming

urentions, and it does so with respect to the

Erent meter. For example, eighths and sixteenths

Fbeamed in two groups in 6/8 time. In 4/4,

tlrths and sixteenths get grouped in four sets, one

reach quarter note.

Lning Auto Beam on and off
SeAuto Beam command in the Format menu can

rmrned off and on as desired. When it is checked,

-5 Beam is turned on.When it is unchecked,

-b Beam is turned off.

fien auto-beam is on, Mosaic automatically

lrms notes as you enter and edit them.

mAuto Beam off when youwish to override the

rthat notes get groupedwhen Mosaic beams

rexample, if you are entering eighth notes in 4/4

-,Mosaic auto-beams them in groups of two by

frrlt. If you would like to auto-beam a passage in
rps of four:

electAuto Beam in the Format menu to toggle

> Beaming off before you enter the notes.

2 Enter the notes and beam them manually.

To beam notes manually, see the next section

Entering a beam manually
To enter a beam manually:

To select the notes, shift-click each one, or drag a

selection box over them.

2 Choose Beam from the Region menu

As a shortcut, press command-B.

Deleting a beam
To delete a beam:

1 Select the beam or beams to be deleted

To select a beam, click it. To select multiple beams,

shift-click each one.

2 Choose Cut or Erase from the Edit menu.

As a shortcut, press one of the following key

combinations: delete, command-X (Cut), or
command-B (Erase).

Adjusting the vertical position of a beam
To adjust the height ofthe bearn (the distance from
the noteheads), drag the beam up or down as

shown below:

-"t

-?---T---r
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You can also position thebeam in between notes as

shown here:

Adjusting beam angle
To adjust the angle of a beam:

1 Click the beam.

Handles appear at either end of the beam.

2 Drageither handle up or down.

CUSTOMIZING BEAM GROUPING
You can customize the way in which Mosaic groups

notes with beams. For example, in 6/8 time, Mosaic

beams eighth notes in threes:

But you might want eighth notes to be beamed in
pairs rather than in threes:

Beamed notes are grouped according to the current
meter. Mosaic allows you to customize how
beamed notes are grouped from within the Change

Meter command. Thus, each time you create a

meter, you can customize how beamed notes get

grouped. To change an existing meter, you
the meter with the Change Meter command.

To insert a meter in order to customize beam

grouping:

1 Place the insertion cursor at the beginning of
the measure in which you want to place the meter.

This places the insertion cursor in the measure. If
you wish to change an existing meter, place the

insertion cursor immediately to the right of the

existing meter.

2 Choose Change Meter from the Region menu.

3 Select the desired meter.

4 Click the space between notes to toggle on or
the beam connection between the notes.

Keep toggling the beam connections until you
set the desired grouping configuration.

5 Set the Warning signature at system breaks and

All staves options as desired.

See "Inserting a meter change" on page 94 for
information.
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ea * Click OK to confirm your choices or click cancel

mwithdraw the Change Meter command.:s get

e-enter
The meter change is entered. When Auto Beam is

rned on, any beamed notes you enter within the

qion prescribed by the meter change will be

gurped in the manner you chose in the Change

lleter dialog.

l.

m

ng of
meter. f Please note! The above procedure does not

&t notes that are already beamed. It only affects

Lrnewly entered notes are beamed.
I

HEAMING A REGION

bre-beam a region:

Notes can span more than one staff as lvell:

;ure. If
the

I the

menu.
' -: necessary, change the meter at the beginning

-.-. region to set up the desired default bearn
' -ring.

- ,:rke sure thatAuto Beam is checked in the
-:rat menu.

. :;lect the region

To create a cross staffbeam group:

I Enter Lhe notes on one of the staves in the staff

group.o -hoose Beam from the Region menu.

TAMING ACROSS STAVES

lrheaic provides cross-staff beaming. A cross-staff

Sam connects notes that are notated on separate

gES.

It doesn t really matter which one 1rcu choose. If
most of the notes will be notated on a particular

staff, use that one for convenience.

2 Beam the notes if they are not beamed

automatically.

rn or ot-

\

I

Remember that you can override the default

beaming. See the other sections in this chapter.

/ou havE 3 To move a note within the beamed group to

another staff above or below, option-drag the

notehead up or down.
'aks anc

[or mor.

': reirn can lie above or belorv the staves as

,, n above, or it can be moved verticallv to a

. :ron in-betrveen the staves:

As you drag, you will see an arrow indicating that

the note will be placed on the other staff.\Arhen you

release the mouse, the note will be displayed

according to the clef and key signature on the staff.
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4 Option-drag each note you wish to move to the

other staff.

You can option drag more than once to place the

note more than one staff awav.

5 Adjust the beam placement as desired by
dragging the beam handles.
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:HAPTER 1()

xrpings are musical symbols that span across

es. They include:

t :-irs and ties

r -::plets and tuplets

. :.lssandos

r -:.dings

r - -:irpin crescendo and decrescendo

- .' chapter explains how to enter them, delete
' .:-.. adjust them, extend or shorten them, flip
' ::: above or below notes, and set defaults

:.::Jing their appearance.

trCGROUPINGS PALETTE

,f,lgroupings (except the hairpin crescendo and

&crescendo) are entered with their respective tool

-rte Groupings palette. The groupings palette has

tfollowing tools:

Groupings

;{AT IS A GROUPING?
t grouping is a symbol that spans across several

ffi in a voice and in some way indicates a

rcical modification to the notes. For example, a

irr indicates that the notes should be played in a

mooth, connected fashion.

. saic handles groupings in as musical a fashion

:trssible. For example, when you enter an octave

--racket (Sva), the notes rvithin the bracket are

displayed T lines and spaces from the one on which

they were originally written. If you remove the 8va

bracket, the notes return to their original position.

Mosaic does not allow groupings to cross voices.

For example, you cannot begin a slur on a note in
Voice- I and end the slur on a note in Voice-2. This

makes musical sense because symbols like slurs

and ties indicate how a single musical voice should

be played. Also, imagine what would happen if you

had another view in which Voice- I and Voice-2

were displayed on separate staves. How would a

slur be displayed in such a case? As a result, ifyou
attempt to cross voices, Mosaic does not enter the

grouping symbol and notifies you that you cannot

enter it across voices. (Endings and octave up/
down brackets are exceptions: they affect all voices

displayed on the staff.)

ENTERING A GROUPING
Any item in the Groupings palette can be entered

by the method described in this section. Several

groupings, such as ties, ottavas, and endings, have

special considerations which are discussed in later

sections in this chapter.

To enter a grouping:

I Click the desired grouping frorn the palette.

2 Click above or below the first note of the region

and drag from left to right to the last note.

Slur

Straight gliss

Triplet/

Ending

Staffbrace

Tie

Wavy glks

Roll

Tremolo

Staffbracket

let

irr
7
frf

U
(
IT

E:-1 )r)
{ (

Because agrouping is part ofthe voice, it appears as

part of the voice on any staff in any view. For

example, if you enter a crescendo in the piccolo

voice in a master score view, the crescendo is

automatically added to the piccolo voice in other

views as well, such as the piccolo part view.

EA [4-.l



Don't worry about how it looks as you are

dragging. You can adjust the position as much as

you want after you enter it. You can drag either

above or below the notes. Ifyou change your mind
after entering the grouping, you can flip the

grouping to change its vertical position.

(G Note: if you are entering the grouping in a
page view, Mosaic allows you to drag from one staff

system to the next. )ust drag from the lirst note to

the last note no matter what staff the last note is on.

Ifyou have to end the grouping on the next page,

see the next section.

(G Remember: if you have more than one voice

on a staff, you cannot begin the grouping in one

voice and end it in another. You must begin and

end the grouping in the same voice.

Entering a grouping over a large region
Ifyou need to enter a grouping over a large region,

large enough so that it would not be practical to

d rag and scroll over the entire region, you can enter

the grouping by selecting a start and end point.

To enter a grouping over a large region:

1 Click the note at the beginning of the region to
select the note.

2 Shift-click the note at the end of the region to

select it.

t? Please note! The notes that you select at the

beginning and end of the region must be in the

same voice. Otherwise, the grouping will not be

entered.

3 Command-click the icon of the desired

grouping in the Grouping palette.

The grouping is inserted over the region defined

the selected events.

Entering a grouping by selecting a region
You can also enter a grouping by selecting a group

of notes and command-ciicking the desired palette

item.

'lo enter a grouping over a selected group of notes:

1 Drag a selection box over the group ofnotes to

select them.

^ t?F

l-,,J

2 Command-click the desired palette item in the

Groupings palette.

The grouping gets inserted over the selected

region.

Entering a tie by clicking a note
Ties can be inserted two ways: by dragging over the

notes to be tied as described earlier in this chapter

or by clicking the lirst of two notes to be tied.

lb enter a tie by clicking the note to be tied:

1 Click the tie symbol in the Groupings palette.

2 Click the first of the tlvo notes to be tied.

Mosaic will connect the tie to the first note of the

same pitch in the same measure or next measure. If
no note of the same pitch exists, Mosaic won't

insert the tie.
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ed by Ties are automatically formatted to avoid staff

1ines.

Entering a triplet or tuplet
^Mosaic is flexible about triplets and tuplets. You

can insert a tuplet ofjust about anyvalue you can

think of, and you can choose how the tuplet is

displayed.

4 Choose whether to display the second number.

When the second number is displayed, the tuplet is

expressed as a ratio:

f-* 3t2 j

:oup

Llette

otes:

:s to

Before you insert the triplet or tuplet, you need to

choose the tuplet ratio and set the appearance of
the tuplet. To do so:

1 Double-click the triplet icon in the Groupings

palette.

The Tuplet set up dialog appears.

5 Click OK to confirm your choice or click Cancel

to withdraw the command.

Once you have made the above choices about the

tuplet, enter it by dragging over the notes.

(.i Please note! The settings you make in the

Tuplet setup dialog are remembered and saved

with the file.

Determining a tuplet ratio
A triplet is always expressed as 3 in the time of 2.

Ifyou are entering a tuplet, and you are not sure

what the tuplet ratio should be, think of the

number of notes that will in the tuplet. This is the

first number of the ratio.

Then, think of the amount of time that you want

them to fit into, and determine how many notes of
the same duration would fit in that time if they were

not a tuplet. That is the second number.

For example, let's say that you wanted to enter an

eighth note quintuplet over the span of a half note.

So the ratio would be 5 in the time of X. To

determine X, think of how many straight eighth

notes it takes to create the duration of a half note:

four. So the ratio would be 5 in the time of 4.

@ in rte tme or fl
numb*r onl! fi
slur A

broken bracket rr-

E show 2nd number ],1

2 Type in the desired ratio.

See "Determining a tuplet ratio" on page 69.

I Choose the desired appearance of the tuplet.

eomples are shown below.
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Tuplets
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Entering tuplets and ties at the same time as
notes
Mosaic lets you enter ties and tuplets at the same
time as you enter notes. This is a real time saver,

especially for tuplets, which sometimes require
rebeaming and other manual reformatting when
entered after the fact.

This technique can be done with MIDI step record
entry (described in chapter 34,'MIDI Recording
and Playback'), mouse entry, or Macintosh
keyboard entry. First select a note duration from
the Notes palette and then select the tuplet (or slur)
tool in the groupings palette before you begin note
entry. You can then enter notes and they will be
grouped accordingly. The tuplet (or slur) tool
remains selected until you click it to turn it off or
select the arrow cursor.

Below is an example of step-record a passage of
eighth note triplets:

Begin with the

tuplet tool seleded

at the same time as

a note or rest

duration. ..

. . .and then just

flyrn thenotesvia

MlDl,the mouse,

orthe keyboard,

Entering an ending
Endings are brackets placed above measures that
serve as separate endings for a repeated section of
music.

Endings are a little bit different from other
groupings because they are entered per measure
rather than per note.When you enter an ending, it
is placed over the entire measure (or measures) in
which you enter it.

To enter an ending:

I Click the ending tool in the Groupings palette.

2 Click aq,where in the measure you wish to enter
the ending.

Ifyou are entering the ending over several

measures, click in the first measure and drag into
the last measure. When you release the mouse, a
text box appears.

I Typ. in a number for the ending (or any text
that you wish).

The ending text does not have to be a single
number. It can be any text that you want, e.g. "2.
and 3." or "Repeat two times".

4 Click anl,where outside the ending text box to
complete the insertion.

5 If desired, repeat steps 2 arrd 3for a second,
third, fourth, etc. ending.

11.--ltEll

Editing the text in an ending
To change the text in an ending:

1 Double-click the ending text box.

2 Typ" the desired text or choose the desired font
and style from the Text menu.

3 To confirm the edit, click anywhere outside the
text box.

To cancel the edit, press command-period.

. ..;,
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alette.

[o enter

ed font
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I

,., adjust the position of the text, drag it with the
- lse.

Adjusting the height ofan ending bracket
. adjust the height of an ending bracket:

I Click the ending bracket to select it.

t Grab the upper handle on either side of the

hacket and drag it vertically.

:--:5e to adjust the height.

{djusting the endpoints of an ending
- adjust either endpoint of an ending bracket:

t Click the ending bracket to select it.

I Grab the upper handle on either side of the

hecket and drag it horizontally.

!tber handles to adjust the endpoints.

I

ldjusting the drop lines of an ending bracket
- :djust the length of the drop lines of an ending
' ::;ket:

t Click the ending bracket to select it.

I .rab the lorarer har.rdle on either side and drag it

=:.ically

I

to adjun the length ofthe drop lines.

Extending an ending to an adjacent measure
To extend an ending over the next measure (or

measures):

1 Click the ending bracket to select it.

2 Grab either of the two handles nearest the

measure you are extending over and drag over the

desired measure(s).

Setting the default characteristics for endings
Mosaic allows you to determine the default

appearance for endings.You can control the default

height, position, shape, and thickness ofthe ending

bracket. In addition, you can choose the default

font and type style for ending text.

To set the default characteristics for endings

1 Double-click the ending tool in the Groupings
palette.

The Repeat Endings setup dialog appears.

Drag these handlesto set the defauh heighl,distan(efrom the

barlines, length ofthe drop-brackets,and text position.

2 Choose the desired font, size, and style from
Text menu.

This needs to be done before you click OK.

3 Choose the desired type of drop-brackets.

4 Type in a bracket thickness in points.

nd,

t l
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Repea ngs

Br:rlret Thickness :ffi poirts
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You can type decimal point sizes. For exampie, if
you are printing on a Postscript printer, and you
would like a fairly thin ending bracket, try a point
size of 0.5 or below. You might try printing some

ending brackets while experimenting with
different values to choose a thickness that suits you.

5 Drag the handles of the sample ending bracket

to set its default position.

You can set the following default parameters with
the bracket handles:

r The height of the ending

r The distance of either end of the bracket from
the measure barlines

r The length of the drop brackets

r The position of the ending text with respect to
the bracket

Remember that these are default settings. Once an

ending has been inserted, any ofthese things can

be adjusted further on that particular ending.

Entering a tremolo
To enter a tremolo:

I Double-click the tremolo syrnbol in the

Groupings palette.

A dialog box appears asking you for the number of
slashes.

2 Type the desired number of slashes.

3 Click OK.

4 Click above or below the first note and drag

from left to right to the last note.

The tremolo is entered between the notes.

A tremolo's effect on duration
The Tiemolo grouping has the effect of halving the

rhythmic duration of the notes that it connects. In
the example below, the tr,vo half notes at the

beginning of the measure take up their full two-
beat duration before the tremolo is inserted.

After the tremolo is inserted, their original
combined duration of four beats is reduced to

This meant to reflect the musical meaning of the

tremolo, i.e.:

-=-:

Deleting a note that has a tremolo
In the above example, if the first half note in the

tremolo is deleted, the remaining tremoloed half
note retains the tremolo, as well as its halved

duration:
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.'tu two

-lick the tremolo to select it.

I )rag its handles to change its angle or length.
E{ii- }

Mlusting a tremolo
Omce you have entered a tremolo, you may wish to

mdifyits position. To do so:

-Io extend or shorten the endpoints, drag either
handle horizontally. Hold down the shift key to
constrain your motion horizontally:

To change the angle ofthe hairpin, drag either
handle up or down:

To change the size of the opening, hold down the

option key and drag the right,hand handle:

FLIPPING A GROUPING
Groupings can be flipped so that appear on the

opposite side vertically above or below notes.

Io flip a grouping

1 Click the grouping to seiect it

fb select multiple groupings,

shift-click each one.

FFWW
rf the

r the

t half
1

rr,ORKlNG WITH CRESCENDOS &
]ECRESCENDOS

-: hairpin crescendo and decrescendo markings

---. <roupings, although they are located in the

, -.-ramics palette.

_r? a,
!

Hairpin aescendo and derrestendo

in the Dynamics palette

b insert a crescendo or decrescendo, use the

Focedure described in "Entering a grouping" on

ree67.

lnce the grouping has been entered, you can

qrosition it in a number of ways. To do so, click
rehairpin to select it and then drag it as described

dow.

- adjust the height of the hairpin, drag it up or

n[I :BOUPINGS
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2 Choose Flip from
the Format menu.

ADJUSTING A GROUPING
Groupings can be placed in a wide variety of
situations. As a result, their default position and

shape may not always be appropriate. For example,

a slur may cut through the stems of notes, or it may

collide with notes in another voice.

Mosaic provides completely flexible grouping

symbols that can be adjusted to look exactly as

needed to avoid symbol collisions and to look
exactly the way you prefer. This section explains

briefly how to make adjustments to arcs (such as

slurs and ties) and brackets (such as tuplets and

endings.)

Adjusting a slur or tie
To adjust a slur or tie:

1 Click the slur or tie to select it.

Handles appear on both ends. In addition, Bezier

curve handles appear.

End pointhandles

and Bezier curve

handles.

2 To adjust the endpoints, drag the endpoint
handle.

I To adjust the overall shape of the slur, drag the

middle of the arc.

Drag the middle of

the arc to adjust

the overall shapeof

theslurortie.

4 To further adjust the shape of the slur, drag the

Bezier curve handles.

Drag the Bezier

(urve hrndles to

further adjust the

shape ofthe arc.

Adjusting a tuplet bracket
Tuplet brackets and numbers can be adjusted freely

with their handles. To adjust a tuplet, click the

tuplet bracket or number to select it and drag the

handles as desired.

r-J-1- Drag the handles to (hange

the angle of thetupletorthe
length of the descenders.

To move the entire bracket, drag the body of the

slur or bracket:

r-d, Drag the bra(ket itself

to move the entire

To move the number of the tuplet, drag the handle

that appears on the number.

Drag the handle on the

numberto move it.You

can also drag the number.

DELETING A GROUPING
To delete a grouping:

I Click the grouping to select it (handles visible).

2 Press the delete key, or choose Cut
(command-X) or Erase commands in the Edit
menu-
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THAPTER 11 ArtiCUlatiOnS, ornaments, and
Dynamics

rticulations, ornaments, and dynamics are all
mbols that indicate how notes should be played

me examples are:

r ::laCatoS

r r-:;ents

r _-,Irings

r : ills

r l,i'narnics symbols such as ft, pp, and sfz

. .lzz symbols such as lip trills, doits, falls, and

-; chapter explains how these symbols work in

saic, how you can enter them on one or more
es at a time, and how you can adjust and delete

IMERSTANDI NG NOTE-SPECI FIC
miBoLs
Ilink for a moment about these symbols: none of
mle'n have meaning by themseives. They only have

mning when placed near a note (or notes) to

rlicate how the note(s) should be played. You

inld say that these symbols apply to the note(s).

.lr a result, we will refer to these types of symbols

*-specific.

nuse they apply to notes, note-specifc symbols

e'attached" to notes when you enter them in
bsaic. For example, ifyou enter an accent above a

*e, the accent becomes attached to the note. If
m cut the note and paste it somewhere else, the

ent goes with it. If you transpose the note, the
rEYlt stays with the notehead. If you snip music

Sre the note so that it shifts backwards a few

casures, the accents stays with it.

As you can imagine, this makes working with artic-
ulations, ornaments, and dynamics easy. Once you
have entered them, you rarely have to deal with
them again.

Entering note-specific symbols is as easy as

pointing and clicking. And once theyte entered,

Ivlosaic provides complete flexibility in their
placement. Even though the symbol always

remains attached to its original note, you can drag

it any'where to place it exactly where you want.

INSERTING A NOTE-SPECIFIC SYMBOL
To insert a note-specific symbol:

1 Click the desired symbol in its palette

Note-specific symbols are found in the

Articulations palette, Ornaments palette,

Dynamics and I azz p alette.

the

Articulations 0rnaments Dynamics )azz

(G Please notel The hairpin crescendo and

diminuendo symbols at the bottom of the

dynamics palette are groupings. For information
about how to enter them, see "Entering a grouping"

on page 67.
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2 Click directly on the notehead of the desired
note, or click in the vicinity of the notehead.

If you click directly on the notehead, Mosaic places

the symbol in the customary location. If you ctick
above or below the notehead, the symbol will be

placed above or below the note.

ADJUSTING A NOTE-SPECIFIC SYMBOL
After inserting a symbol, you can adjust its
position by dragging it.

For fine tuning the position. zoonr irr.

lnserting symbol on several notes at once
To save time, you can enter a note-specific symbol
on more than one note at a time.

For example, ifyou entered a staccato passage, you
can enter all the staccato svmbols at once.

As another example, you might want to enter a

dynamic symbol in an orchestra score vertically in
all the voices at one time.

To insert a symbol on more than one note at a time

1 Select the arrow cursor from the notes palette.

2 Select the desired notes.

To select a group of notes, drag the selection box
over them. To select discontiguous notes or notes
in separate voices, shift-click each one.

. ^ ^ tt . -. +Pr+

3 Command-click the desired svmbol in the

palette.

The symbol is attached to each selected note.

FLIPPING A NOTE-SPECIFIC SYMBOL
Note-specific symbols appear either above or
below the notes to r,r,hich they are attached.You can

change their position with the flip comrnand.

To flip a note-specific symbol:

1 Select one or more symbols.

To select a single symbol, click it. To select several,

drag the selection box over them. To select

discontiguous symbols, shift-click each one.

VVVV

2 Choose Flip from the Format menu.

A A A ,{

DELETING A NOTE-SPECIFIC SYMBOL
To deiete a note-specific symbol:

1 Select the symbol.

To select a single symbol, click it. To select several,

drag the selection box over them. To select

discontiguous symbols, shift-click each one.

2 Press the delete kev.

Alternately, you can use the Cut (command-X) or
Erase commands in the Edit menu.
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(HAPTER 12 Measures and Barlines

. ;hapter explains how notes flow tl-rrough

::r rlres. In addition, it explains hou, to:

r ::': the number of measures in the score

r ---rJ and remo\€ measures anpvhere in the score

r ,rst off" (determine the nurnber of measures

-; .-ue and control overall l-rorizontal spacing)

r :ert and delete barlines

. - :rq barlines left and right to adjust measure
-.:

, :-ange a barline from one type to another

r - .e repeatbarlinesatthebeginnir.rgandendofa

- .e single-bar and double-bar repeat barlines

:eate "rneasureless" music (music with no

--- nes) using the invisible barline

,l:nually adjust line and page breaks

-.nnect barlines between staves

: rtbrmation about numbering measures, see

- .: ter 1 3, "Numbering Measures".

dTORKING WITH MEASURES
: \Iosaic, measures and barlines serve as a
*.:rervork through which the notes in each voice

: .',..s. For example, if you snip two bars of notes

:- n a staff, the notes disappear and all the notes in
,rt -;oice after them "flow" backwards through the

::ea-.ures left over to Ii[ up the space.

fhe notes in measures 2 and 3 are sele(ted and snipped...

...the notes are removed.

tf
1

L1 Can

d

...and the notes afterwards flow backwards through the measures to fill the gap:

eral,

eral

.) or

The measures themselves are not snipped. In
general, measures (and the barlines that define

them) are treated separately from the notes that
flow through them.

For example, a key change, meter change, or clef
can be placed in a measure, and it will affect how
notes that flow past it are displayed. However, the

measure and the key change itself do not flow with
the notes; they remain separate.

Using Set Score Length
When you create a musical score in Mosaic, it
contains a certain number of measures. When you
open a new file, it contains one measure, and new

measures are added as you enter music.

You might, however,like to set up the score before

you begin entering music. For example, you might
create a score template that contains 100 measures,

in which you would like to place meter changes, key

changes, repeat barline sections, and so forth,
before you begin entering notes.

To do so, choose Set Score Length from the File

menu, type in the desired number of measures, and

click OK. The measures are added as empty
measures (with a whole rest).

-) tt
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Adding and removing measures
Two commands in the Edit menu allow you to
insert or remove measures anp,vhere in a score.

When you do so, measures are added or removed

from all views.

To add or remove measures:

1 Place the insertion cursor at the location where

you would like to insert or remove measures.

Use the left/right arrow keys to ensure the

placement you want. If you don t want to split up an

existing measure, be sure to place the cursor at the

very beginning or very end of the measure.

2 Choose Insert Measures or Delete Measures

from the F.dit menu.

A dialog box appears asking you how many you

would like to insert or delete.

AZ

shift...

*U

SM

lel 5co,e tength...
I@IE@

oetere veasures...t

3 Typ. in the number of measures and click OK.

The measures you chose are removed, including all
music within them.

CASTING OFF
Casting Offis term used by music engravers that
refers to the process of determining where line
breaks and page breaks fall within the music. The

Casting Off command in the Format menu iets you
control where line breaks occur in your page views.

You can specifi, a certain number of measures per
line, and you can choose between equally spaced

measures on a line or proportional spacing.

Casting offcan be done in the current view or in all

views.

The Casting Off command also lets you contract or
expand the overall default note spacing, which has

an impact on where Mosaic automatically places

line breaks and page breaks when you don t specify

a certain number of measures per line. The overall

default note spacing also directly impacts the

spacing of notes in galley views.

c- The Casting Offcommand controls the

spacing of the entire view (or views). If you would
like to expand or contract note spacing for only a

specific passage of notes, a single measure, or
region of measures, use the Scale Spacing

command described in "Controlling note spacing"

on page 61.

To cast off, follow this procedure:

1 Open the view window that you want to cast off.

Make it the active (topmost) view.

2 If you have previously entered manual line

breaks (as described later in this chapter), and you

want to replace them with the new spacing, delete

them.

Manual line breaks override the Casting Off
command. Manual line breaks are created using

the line break tool (the Hand icon) in the barlines
palette. Manual line breaks appear in Show Layout
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ou

MS.

er

l

de as"pins" stuck in the page at the end of a line.

rinformation about deleting them, see "Deleting

ne or page brealC'on page 84.

Choose Casting Off from the Format menu.

,.' 
',,,,,I,1f .: ,:+ - ,+;:ur r: [,p-, , "- jE p..p,.r.,rr,,

In particular,lyrics tend to force a wider spacing to

accommodate the text. Assigning a smaller point
size to the lyric text (in the Lyrics window) allows

tighter spacing.

Space measures n per line
This option produces a fixed number of measures

per line. You have two options for how the

measures are spaced: evenly or proportionally. The

example in Figure l2-lshows a line of music

formatted both ways to illustrate the difference.

Bars with short durations take up more space with
proportionai spacing.

This option is greyed out if the current view
(topmost window) is a galley view because there

are no line breaks in a galley view.

Automatic line breaks
This option restores the region to Mosaic's default

line breaks, which are based on the default

notehead width setting below this option. (Manual

Iine breaks are preserved.) This option is greyed

out if the current view (topmost window) is a galley

view because there are no line breaks in a galley

view.

r--rr13tic linP hrer[s

shorl notes occupu E noteh.ed vidths

:.rose the options as desired.

::- r)ptions are discussed in the following
,_tns.

.:;k OK to confirm or Cancel to withdraw the

--.:rand.

rr change your mind after clicking OK, you can

undo and try again.

kto expect after casting off
kic does its best to space measures as you

+est with the Casting Off command. In some

rc,however, measures just will not fit on one

!--: i.r rnlu

rcsues per line;even spacing

wrres per line; proportional spacing

F r- 3 --r

t=3___-l1-" r T.
-=F

al2-l:Even versus propottional spacing when using the n
IEsper line option.

T+
=
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line--the notes would have to be piled on top of
one another to fit on the line. In this case, Mosaic

reduces the number of measures on the line to

produce a minimum comfortable spacing.



Short notes occupy n notehead widths

This option lets you increase or decrease Mosaic's

overall default note spacing. Ifyou increase this

number, notes and rests become more spread out;

if you decrease it, spacing becomes tighter' The

value you enter is a number of notehead widths'

The default value is 2 noteheads' Fractional values

are also aliowed, such as 2.4 or l'7 noteheads'

Frgre l2-2 shows the difference in spacing

between the default value of 2 and a value of 3'

\44ry does Mosaic specify this value in notehead

widths? Well, it is not crucial to understand why in

order to be able to use this feature But ifyou are

wondering, the aigorithm Mosaic uses to sPace

notes and rests is based on notehead widths' In this

algorithm, the shortest note duration in a measure

(or an eighth note,whichever is shorter) is

assigned a default spacing width of two noteheads'

Accordingly, the next higher duration is given a

spacing width of three noteheads, and so on' This

formula is a standard among music engravers (who

have their own special versions of it, of course) '

For example, if the shortest duration in a measure

is a sixteenth note, all sixteenth notes in the

measure are given a spacing of two noteheads wide'

Eighth notes are spaced three noteheads wide'

quarter notes four, and so on.

In page views, this option has more effect when you

choose the automatic line breaks option in the

Casting Off dialog box because Mosaic uses the

noteheads setting to determine how many

measures wiil fi.t on each line. However, if you have

chosen a certain number of measures per line' line

breaks take precedence over note spacing'

In galiey views, the effect of this option is most

noticeable because ga11ey views are always

displayed using the default notehead width

spacing, and measures never have to stretch or

sh.ink to match the width of the line on the page' If

you want to flne-tune the spacing in your

document, observe a gal1ey view when making

small changes (such as 2'4 instead of 2'3,fot

example) because you will see the difference more

readily than in a Page view.

Whole note Ghortest duration in measure) takes up a

width of 2 noteheads.

Short notes o(cupy 2 notehead widths:

Sh0rt notes 0(cupy 3 notehead widths:

Sixteenth note Gh0rtest duration in measure)

width is setlo 2 noteheads.

Whole note {shortest durati0n in measure) takes up a

width of 3 noteheads.

\

Sixteenth noti Ghortestduration in measure) width isset

to 3 noteheads.

Fioure 1 2 2: lJsinq the deloult norehead width to change the defoult

nZr, ,poung liis example is tahen from a golley view' whi.ch i>

affe,ctid muih more by this option because golley views ore always

disptayed using the default notehead width spocing'
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de

Eview only / All views / New views only
'he options control what is af[ected when you

lf drc dialog b ox. This view only casts off the

bJlviews, as well as new views that you create.

bviews onlyleaves existingviews alone and

- 
off new views that you create with the Add

rleorAdd galleymini-menu commands in the

lhwindow. Think of this last option as a

.."&ence, since it affects all newviews that you
rrt-

TXKING WITH BARLINES
Itmic provides the following barlines in the

Erfines palette:

Note that when you click on a staff, but not directly
on 6n existing barline, a new barline is added to all

views, creating a new measure in the process.

Similarly, barlines can be deleted in a familiar
fashion:

1 Place the insertion cursor just to the right of the

barline, or click the barline to select it.

Ifyou are placing the insertion cursor, use the left/
right arrow keys because they ensure that no other
symbol is in between.

2 Press the delete key.

The barline is removed in all staves

Dragging a barline
Barlines can be dragged left or right to adjust the

width of the measures on either side of the barline.
To drag the barline, grab the middle of it as shown

below, not the handles at the top and bottom ofthe
barline. They are used to connect the barline to the

staff above or below.

s

Standard barline

Double bar

open fine

Left (open) repeal

Back-to-bark repeat

€ to split (onsolidated rests

lnvisible barline

Heavy barline

Heavy double bar

Fine

right klose) repeat

Dashed barline

Double bar repeat

Line breaktool

:Sllowing sections explain how to work with
rbarlines.

mrting and deleting barlines
ia'-iines can be inserted in a similar fashion to

roramusical symbols in Mosaic:

.-..t the desired barline lrorn the Barlines

k the type of barline that you want to insert.

Oick on any staffin any view at the desired

tbn of the barline.

s
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If, Iater on, you wish to restore the measures to

their originai, default widths, select the notes and

rests within them and choose Restore Default

Spacing from the Format menu.

Changing a barline
Any existing barline can be changed to any barline

desired.

To change a barline:

I Select the desired barline from the Barlines

palette.

2 Click directly on the bariine you wish to change,

or click anywhere in the measure following the

barline.

Splitting repeat barlines at system breaks
Repeat barlines automatically split when the fall on

a system break. For example, when a left repeat

barline falls at a line break, it ends the iine with a

regular barline and begins the next line (following

the clef and key signature) with the left repeat

barline.

A back-to-back repeat barline splits itself in the

same manner, with the right repeat ending the first

line and the left repeat beginning the next line.

You can get Mosaic to end a line before a repeat bar

with a double barline instead of a regular barline as

shown below:

Above,a double barline (which is currently hidden) has been placed backto-back

(at the same lo(ation as) a repeat barline.Wiren this measure b0undary falls at a

system break as shown below,the barlines split up a(ordingly.

To set up a system break with a double-barline

followed by a back-to-back repeat barline:

1 Choose the desired double barline (normal or

heary) from the palette.

2 Click on the barline that ends the measure.

This causes the barline to change to the double

barline.

3 Choose the left repeat barline from the palette.

4 Ciick on the same barline as in step 2.

If the barline does not currently fall on a system

break (such as if it is in a galley view), Mosaic

displays the repeat barline by itself. When the

barline falls at a system break, the two barlines will
automatically split up.

rf When two back-to-back barlines split up, the

space in behveen them does not count as a

measure.

lnserting a left repeat bar at the beginning ofa
new line (system)

To insert a left repeat barline at the beginning of a

system:

1 Select the left repeat barline from the barlines

palette.

2 Click anlwhere near the beginning of the

measure.

In the example shown here, the cursor was clicked

after the key signature, but you can click anlT,vhere

near the beginning ofthe bar.

+
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)arline

ormal or

asure.

double

re palette.

r system

Iosaic

:n the

arlines will

plit up, the

rsa

nning of a

nning of ;,

barlines

f the

vas clickec

l anl.wher:

3 When you insert a repeat barline in this

fohion, you are not creating an extra measure

Letween the repeat bariine and the previous

6arline. In fact, if you refill the music such that the

rpeat barline doesn t fall at the beginning of a new

he, yotlll see a single repeat barline:

=#

---{t---{:#
--_- nP

llsing the invisible barline to notate
runeasured music
ihe invisible barline in the barlines palettes allows

eu to notate music without barlines. This is useful

ir unmetered music. Invisible barlines can be

derspersed with regular barlines to mix
umetered sections of music with metered

n-tions,

- .nter one or more invisible barlines:

' ,.-lick the invisible barline in tl.re bariines palette.

I Click each barline that you want to make

i:-^ rsible.

Jsing single or double measure repeat
rymbols
l:e single and double measure repeat symbols can

- inserted to indicate that the previous measure

could be repeated once or tlvice.

Jr enter either one of these symbols:

I Create the measure to be repeated.

I $elect the single or double measure repeat

hine in the barlines palette.

! -1ick the barline at the cnd of the measure to be

::;ated.

Splitting consolidated rests with barlines
All barlines in the Barlines palette, except for the
plain barline and invisible barline, split

consolidated rests. Ifyou need to split a

consolidated rest with a plain barline, use the split-

rest plain barline shown below.

To split a consolidated rest using this barline:

1 Make the Consolidate Rests command

unchecked in the view mini-menu.

2 Click the split rest barline tool in the Barlines

palette.

3 Click the barline in the score where vou want to

split the rest.

4 Check the Consolidate Rests command in the

viewmini-menu.

Use this barline at rehearsal marks, tempo

markings, codas, or other landmark symbols that

do not automatically split consolidated rests.

Special barlines (all except the plain barline), meter

changes, key changes, and clef changes

automatically split rests without the need for this

barline.

To "unsplit" the barline, click it with the plain

barline.

ADJUSTING LINE AND PAGE BREAKS
The line break tool in the barlines palette give you

the ability to:

\RIINE5 ITASURES AND BARLINE5
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r Push one or more measures onto the next or
previous system

r Push one or more measures to the next or
previous page

The line break tool only controls how measures

flow from staff to staff (system to system) and page

to page. It does not cut and paste (rearrange the

order of) measures. For information about how to
cut and paste measures, see chapter I 8, "Edit
Commands".

The line break tool gives you manual control over

how many measures appear on a line (system). By

moving measures from one line to another, you can

open up music that is too crowded by moving one

or more measures to the next or previous system.

Likewise, you can tighten up music that is too
spread out by adding measures to it from the

previous or next system.

c- The line break tool has no effect in a galley

view, since a galley view has no line breaks, system

breaks, or page breaks.

rf Manual line and page breaks take precedence

over the Casting Off settings described earlier in
this chapter.

Using the line break to push measures to the

previous or next system in a page view is easy. To

do so:

1 Select the measure move hand tool from the

barlines palette.

2 To move one or more measures to the previous
system, grab the last measure you wish to move

and drag up.

This moves the measure you grab, as well as any

measures to the left of it on the line, up to the

previous system. If you do so in the top system on
the page, the music gets pushed to the last system

on the previous page.

3 To move one or more measures to the next

system, grab the first measure you wish to move

and drag down.

eh-+€rilduejq. gruit For frtt-ilefroiltr-ldu aa-Fr-t?!,I -

,rf

This moves the measure you grab, as well as any

measures to the right of it on the line, down to the

next system. If you do so on the bottom system on

the page, the music gets pushed to the first system

on the next page.

bov! the ftui - tad .oJa:l{ A
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4 Repeat steps two and three until you have the

desired measure placement.

You may find that once you start sliding measures

backwards and forwards, you ll need to make a few

more adjustments to get the desired spacing.

Deleting a line or page break
To delete a line break:

1 Choose Show Layout from the page view mini-
menu,

2 Select the line break "pin'icon displayed at the

right-hand side of the staff and press delete.
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le next

rto move

I there are several, you can drag a selection box
m them to select them all at once.

,re 12-i: lf a poge has several pin icons,you con select them all at
reby dragging a select box over them.

:ONNECTING BARLINES BETWEEN STAVES
.()nnect barlines between staves in a system:

I Click anv barline in the svstem.

I ltrtically drag the handles at either end of the

:lrrline to connect it to one or more staves above

md below the staff as needed.
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(HAPTER 13 Numbering Measures

aS

Ihis chapter explains how to create automatic

msure numbers in a document. For information
*out rehearsal marks or other text, see chapter 15,

tc)fi

INSERTING MEASURE NUMBERS
To insert measure numbers:

1 Place the insertion cursor in the measure that
you would like to begin measure numbering.

Mosaic can begin numbering in any measure. Since

Mosaic automatically places measure numbers
above the top staff of the system, you can place the

insertion cursor on any staff in the system. In
addition, measure numbers will appear in all
views, so the view in which you place the insertion
cursor does not matter.

2 Choose Measure Numbers from the Format
menu.

The Measure Numbers dialog appears.

3 Select the desired text font, point size, and style
(italic, bold, etc.) for the measure numbers from
the Text menu.

Mosaic remembers the text settings when you save

the file, so you only have to adjust these settings the

first time.

llosaic can automatically number measures in
ur document.You can:

r ,{utomatically display measure numbers at every

rcsure, at any regular interval of measures (i.e.

elery4th,5th, or 1Oth measure), once at the

lreginning of every system, or once at the

hginning of every page

e Choose any font, style, and point size for the
:nbg15

r Choose a left, right, or centered justification

iove or below the barline

: Adjust the position of a single measure number

r .ddjust the position of ail measure numbers with
espect to the staff and barline, with or without

reserving individual adjustments you mayhave
mde

r lemove measure numbers

r j.estart numbering at any measure using any
.::1ing number

,;aic automatically places measure numbers

-',- '.-e the top staff in a system that contains two or
:,. :e staves.

rr:su16 nurnfgring settings are saved with the file.
-_e1'can also be adjusted and saved in your new

- ulefault setup. For more information, see

'-stomizing your new file setup" on page 15.

-<asure numbers appear in all views in a file,

Measure Numbers
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4 Set the justilication (left, right, center) of the

numbers with respect to the barline by using the

|ustifii command in the Text menu.

Notice that the sample number shown in the box
repositions itself to reflectthe justification you have

chosen. Notice also that the reference for
justification is the barline.

5 Choose to place the numbers above or below the

staff.

6 Choose the views in which you would like

measure numbers to appear.

These three options control what is affected when

you OK the dialog box. This view only affectsthe

current view (topmost window). All views affects

all views, as well as new views that you create. New

views onlyleaves existing views alone and affects

newviews thatyou create with theAdd page orAdd
galleymini-menu commands in theViews window.
Think of this last option as a preference, since it
affects all new views that you create.

7 Choose how frequently you would like the

measure numbers to be displayed.

If you choose the n measures option, a measure

number will only be displayed at the interval of
measures that you type in. For example, if you

number every 4 measures, and you begin at

measure l, you will see a measure number above

measure 5, measure 9, measure 13, and so on. If
you number every system or every page, the

measure numbers will only appear at the beginning

of the system.

c? Dont hesitate to experiment. You can always

change the number scheme if you dont like what
you get.

8 To adjust the default position of the measure

numbers with respect to the staff and barline, drag

the handle of the sample number shown.

9 If you would like to begin numbering at a

number other than the actual number of the

measure, type in the desired number in the

Starting with text box.

Mosaic knows the measure in which you placed

insertion cursor and displays its real number in
text box. Sometimes you may want to start with a

different number, such as after a repeat section, or

if you are creating a series of numbered exercises.

10 If you are inserting measure numbers for the

first time, ignore the Preserve adjustments check

box. (lt only atTects numbers that have already

inserted.)

If you are changing existing measure numbers,

option allows you to preserve adjustments you

have made to the position of existing measure

numbers. See'Adjusting the position of all
numbers" on page 89.

lt Click OK to confirm your choices or click

Cancel to withdraw the command.

Mosaic enters the measure numbers according to

your specifications. The number starts at the

measure containing the insertion cursor and

proceeds until the end ofthe score, or up to

another measure at which you have restarted

numbering. For information about restarting, see

"Restarting measure numbers" on page 89 in this

chapter.

ADJUSTING MEASURE N UMBERS
Once you have inserted measure numbers, you can

change their position, individually or together.You

can change their font, style, size, and justification.

Adjusting the position of a single measure
number
To adjust the position of a singe measure number,

simply drag it to the desired position.You may find

it useful to zoom in on the number while doing so.
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rdjusting the position of all measure numbers
- ,liust the position of al1 measure numbers:

f Place the insertion cursor in the measure where

rcsure numbering begins.

Lroose lvleasure Numbering from the Format

-::_U.

il Adjust the position of the sample measure

r"rnber as desired.

I :; r'ou have previously made adjustments to the

:, - .ition of individual measure numbers and you
,r :r1d like to preserve those adjustments, check the
: :.:erve adjustments option.

u uncheck this option, all existing measure

-..-rers n,ill move to the position that you set up

:.:P 3.

i ,iick OK to conlirm 1.our choice or Cancel to

: lrar,v it.

Sanging the font, size, and other attributes of
:'1e numbers- :nange the font, size, and/or style of measure

i -:-it,ers:

" ..ace the insertion cursor in the measure rarhere

- :::Llre numbering begins.

- roose Measure Numbering from the lormat
" :l- -1.

i !:Iect the desired text font, point size, and style

: ie rneasure numbers from the Text menu.

4 Be sure that the Preserve adjustments option is

checked.

This ensures that the positions of the measure

numbers will not change.

5 Ciick OK to confirm your choice or Cancel to

withdraw it.

REMOVING MEASURE NUMBERS
To remove existing measure numbers:

1 P1ace the insertion cursor in the measure where

measure numbering begins.

2 Choose Measure Numbering from the Format

menu.

3 Select the None option

4 Click OK to confirm your choice or Cancel to

withdraw it.

RESTARTING MEASU RE N UMBERS
Mosaic allows you to:

'.)

r Restart at any measure in the score

r Restart with any number

r Restart as many times as you like in a score

For example, you might want to re-number the

measures in a coda section at the end of a score to

reflect the measures in the repeated section. Or,

you might have a repeat section with a first and

second ending, and you would like the measllre

numbers after the second ending to take the repeat

into account.

When you restart measure numbering in a

document, the new section of numbering can have

a different font, style, position, and numbering

scheme from other sections in the score. Of course,

it can also match the previous section.
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To restart measure numbering:

1 Place the insertion cursor in the measure at

which you wish to begin re-numbering.

2 Choose Measure numbering from the Format

menu.

3 Typ" in the desired starting measure in the

Starting with box.

4 If you want the new section of measure numbers

to match the previous section, leave all other

options the same and click OK.

5 If you would like the new section of measure

numbers to be different in anyway from the

previous section, make any changes you would like

to the pt+Jsition, font, numbering scheme, etc.

6 If you have made adjustments to individual
measure numbers, and you would like to preserve

these adjustments, check the Preserve adjustments

check box.

7 Click OK to confirm your choice or Cancel to

withdraw it.

Whenever you restart numbering, the new

numbering scheme begins in the measure

containing the insertion cursor and proceeds up to

either:

r theendofthescore,

OR

r the next point at which measure numbering has

been restarted.

For example, lett say that you start measure

numbering at a coda section at the end ofthe score.

If you then go back to the beginning of the score

and restart measure numbering from the

beginning, the new numbering will take effect up

to the last measure before the coda section. The

numbering in the coda section would remain

unchanged.
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n rhe (HAPTER 14

- tris chapter explains how clefs, meter changes, key

-qnatures, and ottavas work in Mosaic. It begins by

:rplaining general principles that are common to

' 
-four, 

and then it presents four separate sections

, explain aspects that are unique to each one.

" addition to general information, this chapter
-iis you how to insert, change, and remove a c1ef,

:iter, key signature, or ottava.

Eech section also covers advanced features, such as

hrsto:

r -nsert custom clefs

r -utomaticaily display a warning clef, meter, key

:rature, or ottava just before a system break

r -reate complex meters such as 2+3 over 8.

o ,ustomize the way tl-rat beamed notes are

- .rped

r ,:anspose notes to a new key

. ..e-spel1 notes in a new keylvithout transposing
.:r pitch

.F{DERSTANDI NG HOW THEY WORK

-t: changes, meter changes, key signatures, and

--l-as all work in the same lvay. They are staff and

:e..$ure related. They exist on a given staff at a

: :n measure in the score. They are not affected by
tr notes in voices on the staff. Rather, notes in the
, .;e(s) on the staffflow around them as the music

: "rs through the staff, and the clef, meter, key
, i:ature, or ottava affects how the music is

;-:.T;t." 
tn" measure and in subsequent

Clefs, Meters, Key Signatures, and
Ottavas

They control the display of notes
C1efs, meters, key signatures, and ottavas are not
just graphic symbols that you can place in a staff.

Rather, they control the display ofthe notes that
follow them. Meters affect how notes are beamed.

Key signatures affect how notes are spelled enhar-

monically. Clefs determine the line, space, or
ledger line on r,vhich notes are dispiayed on the

staff.

For example, if you insert a key signature of E flat
(three flats) from measure 20 to measure 30, all E

flats (and A flats and B flats) within those measures

will be spelled with respect to the key signature: no

flat sign.

Ifyou change the E flat key signature at measure 20

to the key of C major (no sharps or flats), all E flats

would be spelled with a flat accidental.

n

{3 Note, however, that the pitch of the notes has

not changed. In general, clefs, key signatures and

meters do not affect the actual notes themselves.

Rather, they control the dkplay of the notes.

Here is another example: if you enter some notes in
one clef, and then change the clef, the position of
the notes on the staffwould change to reflect their
original pitch in the new clef.

#
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They control a region of measures on the staff
A clef, meter, key signature, or ottava controls a

region of measures on a staff. The beginning of the

region is defined by the clef, meter, key signature,

or ottava itself. The end of the region is defined by
the next one on the staff, or the end of the piece.

This means that a clef, meter, key signature, or

ottava remains in effect until the next one on the

staff. For example, if you begin a staff in 414 time
and piace no other meter changes on the staff, the

staff remains in 414 for the entire length of the

piece.

If you then placea3l4 meter change at measure 20,

the staff would be in 4/4 time from measures 1 to 19

andin 314 time from measure 20 to the end of the

piece.

20

Ifyou then placed a 2/4 at measure 10,the piece

would be in 414from measures 1-9,in214from
measures 10-19, and in 3/4 from measure 20 until
the end ofthe piece.

10 2t

If you wanted to change the staff to 214 from
measure 10 all the way to the end of the piece, you

would need to select all the music through to the

end of the piece and change the meter.

As we have already noted, the region affected can

be as long as the entire piece of music. Sometimes,

however, the region might be as small as one

measure--or even less than a measure, as in the

case where you place a clef change in the middle

a measure for only a few beats.

Each staff in a system can be unique
You can have different clefs, meters, and key

signatures in staff system at the same time on

different staves. For example, you can have

multiple meters on different staves in the same

measure: a314 on staff-1, a 6/8 on staff-2, and a

2+ll4on staff-3.You can even have a 7/8 on staff-4.

although this will introduce problems with the

automatic alignment of the beats in the measure

across the staves.

WORKING WITH CLEFS

Mosaic provides a high degree of flexibilitywith
regard to clefs. You can:

r Display any clef symbol shown in Figure 14- I

r Place a clef symbol on any line on the staff,

as:

OR

.r Place a clef change any,r,vhere in a measure:

e

i

.};

a
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r Automatically display a warning clef change at a

r*em break

r -reate a stafflvith no clef

" ,i these things can be done with the Change

= ;Omn-rand.

.-:erting a clef
:sert clef:

p{ace the insertion cursor at the point where you

Er to insert the clef.

- ,-an insert a clef anpvhere, including at the

:: r.ning of, in the rliddle of, or at the end of a
- ::!Ufe.

- :roose Change Clef fror.n the Region menu.

"= Change Clefdialog appears.

3 To select a clef, click the horizontal scroll arrows

below the clef display.

4 To change the vertical position of the clef you

have selected, press the vertical scroll arrows to the

left of the display.

5 If you wish Mosaic to automatically display a

warning clef change if the clef change occurs at a

system break, check the Warning Clef at system

breaks option.

6 Click OK.

If the clef is inserted in a region on the staff that

already contains notes, the notes will be re-

displayed on different line, space, or ledger line to

reflect their original pitch with respect to the new

clef.

Changing an existing clef
To change an existing clct:

1 Click the existing clef.

rwith

: 14-1
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: - I : Clef symbols provided by l/losaic.
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Doing so places the insertion cursor just to the

right of the clef.

2 Choose Change Clef from the Region menu.

3 Select the desired clef byclicking the horizontal

scroll arrows below the clef display.

4 Click OK

Removing a clef change
To remove a clef:

1 Click the existing clef,

Doing so places the insertion cursor just to the

right ofthe clef.

2 Choose Change Clef from the Region menu.

3 Change the clef back to the clef just before the

one you want to remove.

For example, let's say that the staff began with a

treble clef and changed briefly to a bass clef. To

remove the bass clef, change it back to a treble clef,

4 Click OK.

Changing the location of a clef
To change the location of a clef,you must remove it
using the procedure in the previous section, and

then insert it at the new location. See "Inserting a

clef" on page 93.

WORKING WITH METER CHANGES
Mosaic provides a great deal of flexibility with
meter changes. You can:

r Insert standard meters such as 4 I 4, 3 I 4, 6 I 8, 12 I 8,

312,and cut time

r Insert custom, complex meters as shown below

r Insert a meter change in all staves in the system

r Automatically display a warning meter change

a system break

r Insert a meter change in the middle of a

lnserting a meter change
'I1o insert a meter change:

I Place the insertion cursor at the location at

which you want to enter the meter change.

Meter changes are most often placed at the

beginning of a measure, so you il place the

insertion point just to the right of the barline in the

desired measure. You can, if you like, insert the

meter change between notes in the middle of the

measure. For example, you may do so in order to

re-bar a section of music. For information about

re-barring after you insert the meter, see

chapter 20, "Rebarring".

2 Choose Change Meter from the Region menu.

The Change Meter dialog box appears.
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tlin!p FlEtir b*qirrLin! in rpisure O

Eitli: 4l (lick here create or break

JC

,f
beam (onne(tions

7 If you would Iike Mosaic to automatically

display a meter change warning in the previous

system if the meter change occurs at a system

break, check the Warning signature at system

breaks option.

; in the systen:

neter change:

= 
Uirninq siqniturp il !ustpnl brrBkE

I +ll rtrve=.

1ie of a measu:
! io enter a standard meter, type it in the boxes
-:. -, ided next to the first button.

8 lf you would like to enter the meter in all staves

in the system, check the A11 staves option.

lbcaic allows you to type any integer (1,2,3,4,

:-) in the top box (numerator). The highest

mber you can enter is 25. In the lower box, you

atype anynumber that is a power of wo (1,2,4,

L16,32, 64, l2B, 256, etc. ). The highest number

r can enter is 1024.

9 Click OK

location at

:hange.
Changing an existing meter
To change an existing meter:

:d at the

lace the

re barline in tL

e, insert the

middle of the

so in order to

mation about

3r, see

1 Click the existing meter

r -, enter a common time or cut time. click them

= ect them.

Doing so places the insertion cursor just to the

right of the meter.

I To enter a custom complex meter, type in the

mer using integers, the plus character ( + ), and

uuesiash character ( / ).

2 Choose Change Meter from the Region menu.

3 Set up the options as desired.

See "Inserting a meter change" on page 94 in this
chapter for detailed information about the options

4 Click OK.

: is an example

Region menu

3AIS.

S Eu=tom 2+4+5/8
Removing a meter change
To remove a meter:

1 Click the existing meter.
, ;hoose hon, beamed notes will be grouped

- raticalll', click the space between notes to

--.. on or offthe beam connection between the

::.

Doing so places the insertion cursor just to the

right of the meter.

2 Choose Change Meter from the Region menu.

-: toggling the beam connections until you have

r -:e desired grouping configuration.
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3 Enter the same meter as that which immediately

precedes the meter you wish to remove.

r Optionally naturalize accidentals from the

previous key signature. In addition you can choose

whether to naturalize all previous accidentals or to

naturalize only accidentals that have changed. And
you can choose whether to naturalize before or
after the barline.

4 Click OK.

Changing the location of a meter
To change the location of a meter,you must remo\.e

it using the procedure in the previous section, and

then insert it at the nerv location. See "Inserting a

meter change" on page 94.

r Display a warning key signature when the key

signature occurs at a system break

WORKING WITH KEY SIGNATURES
Mosaic provides the fbllorving capabilities with key

signatures. You can:

lnserting a key signature
To insert a key signature:

r Insert any standard key signature from seven

sharps to seven flats

. Change the key signature in such a way that

pitches remain the same but are re-spelled

correctly with respect to the new key

1 Place the insertion cursor at the point where you

wish to insert the key signature, or select a region of
notes.

Notes in original key

You can insert a key signature anyvhere, including

at the beginning of, in the middle of, or at the end

ofa measure. Ifyou select a region ofnotes, and the

end ofthe region occurs before the end ofthe piece,

a key signature is also inserted at the end of the

region to restore the old key signature after the ne$

key section.

2 Choose Change Key from the Region menu.

Notes re-spelled in new key

The Change Key dialog appears.

r Change key in such a way that the notes are

transposedto the nerv key from their original key

in original key

Notes transposed to new key

3 Select a key signature by clicking the left or right

scroll arrows.

(TEIS, MTTER5, KEY SIGNAIURES, AND OTIAVAS

BKe

E lnsprt rp]3ti./p kp! on tr:nstospd ltive5

S Haintain pttcn

0 Att strves

#

96

S nituriliE. non*

O neturalire chingpd i'-+ before berlne
u naturahEe ill i l-i ilter EirhnP

E- *:.ltllt :tr:1li: :1 :I:fT lI:*:



he

r choose

als or to

;ed.And
re or

re key

here yoL.

:egion o:

ncluding

the end

;, and tht
Jre piece

cf the

r the nerr

nenu.

I or righ

1 Select a naturalization option.

:ramples of each option are shown below

Naturalize none

Naturalize (hanged

Naturalize all

I If you wish Mosaic to automaticaliy display a

rarning key change at the end of the previous

*stem when the key change falls at a system break,

*eck the Warning signature at system breaks

option.

3 If you wish to maintain current pitches and re-

pell them correctly in the new key, click the

Yaintain Pitch option.

I If you wish to transpose pitches to the nerv key,

=oose the Tianspose up/down option.

I If you wish to insert the new key in all staves in
6e system, check the All staves option.

t Set the "lnsert relative key on transposed staves"

qtion as desired.

Se "Using the'Insert relative key on transposed

reres' option 'on page 97 for an explanation ofthis
rption.

I C1ick OK to enter the key or click cancel to
rirhdrawthe command.

Using the'lnsert relative key on transposed
staves'option
This option automatically becomes checked when
you enable the AII staves option.'v\rhen it is
checked, Mosaic assumes that the key you choose

in the dialog box is the concert key, and it inserts

the correct relative key in each transposed staff.

You can also use this option when inserting a key

signature in a single transposed staff. You choose

the desired concert key, and Mosaic inserts the

proper relative key for you.

For more information about transposed staves, see

'Assigning a staff transposition'on page 30.

Changing an existing key signature
'[o change an existing key signature:

1 Click the existing key signature.

Doing so places the insertion cursor just to the

right of the key signature.

2 Choose Change Key from the Region menu.

3 Set up the options as desired.

See "Inserting a key signature" on page 96 in this

chapter for detailed information about the options.

4 Ciick OK.

Removing a key signature change
To remove a key signature:

1 Click the existing key signature.

Doing so places the insertion cursor just to the

right ofthe clef.

2 Choose Change Keyfrom the Region menu.

3 Enter the same key signature as that which
immediatelyprecedes the key signature you wish to
remove.

l:Ef5, l/lETER5, KEY SIGNATURES, AND 0ITAVAS
97

IAVAS



-: .--.a.-

,,:-- -ra .l

.l

. ,1. | -]:

,)i ll--i

" - :.t the r

_k aN:

: . -oving ar
: :l\r|e ll.l

. .ct thc r

, r,rOSe Ll-,

..:ct tl-ie r

. . ckoK.

, -:osing an

- -rrOSe a d.

.ltlOSe Pr.

E

""""r":""itili#

: :rlllipE:
-rflivE PrPferene

aE# g$,,
os"6

I Select the o

I C1ick OK.

i,1 ottavas in 1

:,ioice(s) you

-LEI5, ME

4 Click OK.

Changing the location of a key signature
To change the location of a key signature, you mllst

remove it using the procedure in the previous

section, and then insert it at the new location. See

"Inserting a key signature" on page 96.

OTTAVAS
Ottavas (octave brackets) signify that the notes

within the bracket are to be played up or down one

or two octayes from the octave in which they are

dispiayed.

To accommodate this notion in Mosaic, notes that

are grouped with an ottava bracket are dispiayed

seven lines and spaces below (or above for Bvb) the

one on which they were entered. If the ottava

bracket is removed, they return to their original

position.

lnserting an ottava over existing notes
One r'vay to insert an ottava is to enter the notes in

the octave you wish them to be played, and then

enter the ottava bracket. When you do so, the notes

willbe displayed an octave below (or above).

'l'o enter an octave bracket:

1 Enter the notes in the octave they should be

played.

2 Select the notes.

3 Choose Change 8va/Svb from the Region menu.

4 Choose the desired option.

The zero option removes any existing ottavas in the

selected region. +1 and *2 represent 8va and 15

ma, respectively. Minus 1 and minus 2 represent

8vb and 15mb, respectively.

5 Select the display options you would like.

Repeat ottava at system breaks places an "Sva' (or

"8vb") at the beginning ofthe next system when

the ottava crosses a system boun dary. Hide bracket

hides the dashed-line bracket.

6 Click OK to confirm the insertion.

The octave bracket is entered and the notes within

the bracket are displayed an octave lower (or higher

when entering an Svb.)

--

i.r Note: octave brackets affect all voices on the

staff that fall within the bracket.

lnserting an ottava to the end ofthe score

Ottavas can be inserted by choosing an insertion

point with the cursor. Doing so causes the ottava to

extend to the end ofthe score:
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and 15

Present

I Place the insertion cursor at the location where

tou would like the ottava to begin.

l his can be the very beginning of the score, if
desired.

2 Choose Change Bva/Bvb from the Region menu.

3 Choose the desired ottava marking.

4 Select the display options you would like.

5 Click OK to confirm the insertion.

Removing an ottava
Io remove an ottaYa:

I Select the notes which have the ottava.

I Choose Change Sva/8vb from the Region menu.

3 Select the zero option.

{ Click OK.

Choosing an alternative way to display ottavas
-o choose a different default ottava spelling:

1 Choose Preferences from the File menu.

ike.

'8vd'(or'

mwhen
ide brackei

ltes within
' (or higher
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I Select the ottava displaypreferences as desired.

r .lrct< ( lK.

' - ottavas in the file will change to reflect the

ice(s) you made.
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(HAPTER rs Text

- his chapter explains how to enter and edit the first

.ur types of text listed in the tabie belorv.

For information about measure numbers, see

chapter 1 3, "Numbering Measures".

This chapter explains general conventions that are

comrrron to all four types, and finally, it provides a

section explaining each type.

OVERVIEW OF TEXT
Mosaic provides six types of text. Each type serves

a particular purpose, which is summarized below:

Ll,rics and chord symbols are especially unique, so

they are explained in their own chapters. See

riapter 16,"Lyrics" and chapter I7,"Chord
Svmbols".

Iext Type Examples

'.'oice text Fingering numbers, note-spe-
cific directions iike sraccato

)tafftext Performance instructions for
a specific instrwent

)i stem text Rehearsal marks, tempo
markings like,4llegro, direc-
tions to instrment playerstr

Page text Title, header/footer, copy-
right notice, page numbers,
staffnamesI

-. ric text A verse oftext below notes

t,t't I

-:.lfd similar to voice text; transposable Chord qmbol tool I-ead sheet chord svmbols
;. mbols

Ft
7
s ffi

Description Entry

Anchored to a specific note in a specific
voice; sticks to the note like an orna-
ment.

Voice text tool

Anchored to a specific measure on a
specific staff.

Stafftext tool

Appears above the top staffin a staff
system; appeus above any stafffrom
the system when it is placed separately
in another view.

System text tool

Anchored to the page. Can only be
entered in a page view.

Page text tool

Automatically centers each syllable
beneath (or above) each note. Florvs
through all notes in a voice.

Lyrics window

,J,
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Do this:

Click the voice, system, or
page text tool and either cJick
or drag the text cursor to cre-
ate the text box

Click the text with the arrow
cursor

Shili-click each one, or drag a
selection box over them

Drag it with artow cutsor

Click it with the arrow cursor
to select it and drag any han-
dle

Double-clickthe text with the
arrow cursor, or click the text
boxwith the tool that created
it

Click anywhere outside the
text box or press the enter key

Click it to select it and press

the delete key

Press command-period

Do this:

Press the arrow kevs

Position the cursor to the
right ofit and press the delete
k.y

Double-click the word
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USING THE TEXT PALETTE
To enter voice, staff, system, or page text, select the

appropriate tool from the text palette and insert a

text box with it. The text palette contains a tool for
each type of text:

Editing a text box
Here is a summary of the ways to use a text box:

To do this:

To create a text box

Voice text

System text

Rehearsal mark

Da (apo

5egno

(hord symbols

Staff text

Page text

Metronome marking

Dal segno

Coda

To select a text box

To select several text boxes

To move a text box

To re-size the text box

(hord symbols with guitar fret symbols

To edit text inside the text
box

WORKING WITH TEXT BOXES

A text box is a resizable, transparent box in which
you can type and edit text. Ifyou have worked with
MacDraw SuperPaint, or similar graphics

software, you are already familiar with how to use

text boxes in Mosaic.

To complete an edit inside
$e text box

To delete a text box

To cancel text editing

Creating a text box
Voice text, staff text, and page text is entered by
selecting their appropriate tool and then dragging
or clicking with the text cursor to create a text box.

To change the font, point
size, style, orjustification of
all text in the text box

Click the text to select the text
box and make the desired
changes

(o Please notel Page text can only be inserted in
page view. You are not allowed to create a page

box in a galley view, since there are no pages.

To entertext,selectthe desired text t00l

and either click or drag t0 (reate a text box.

Typing and editing text inside a text box
Once you have inserted a new text box or double-

clicked an existing one to type and edit text inside

it, use the following actions to edit the text:
Mosaic text boxes can be handled using customary
Macintosh text box conventions. For example, the

text box can be re-sized by dragging one of its

handles:

To do this:

Move the text cursor witlin
the text box

Delete a character

Select a word

Select several words or sen-
tences

Dragoverthem inside the text
box

b =l=
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)ox:

:.r ngc'

: it)ic
':t:: box

lutifr the text to the left
margin, to the right megin
or to the center

Choose |usti$r from the Text
menu and select the desired

the font, polnt size
of some text in the

Select the text and choose the
desired font, size, and style in
the Text menu

Setting default text attributes
For many of Mosaic's text features, such as measure

numbers, rehearsal marks, and staff names, you

can use the Text menu to set the default font. For

example,when you open the Measure Numbering

dialog to insert measure numbers, you can set the

text attributes by selecting them from the Text

menu before okaying the dialog. These attributes
are remembered with the file and remain so until
you change them.

The ability to set default font attributes is universal

among Mosaic dialog windows that deal with text.

This means that you can set the default font for:

r Measure numbers

r Text in repeat endings

r All system text, such as rehearsal marks

lnstalling fonts in the Text menu
The fonts that you see in the Text menu are the

fonts that you have installed in your Macintosh

system. If you are not familiar with how to install
text fonts in your Macintosh system, refer to your
Macintosh documentation.

You can use any text font listed in the menu,

including symbol fonts. You can even use music

text fonts to insert musical symbols as text,

although it would be easier to enter musical

symbols from Mosaict palettes.

n? When troubleshooting font problems in
Mosaic, determine if the problem occurs in your
word-processing software, or other programs that
deal with text. For example, if you carit find a font
that shouid be in the list, check the font list in your
word processor. Most likely, it will be missing
there, too, and you know that the problem lies

somewhere in the Macintosh system.

'click
or

rrow

justification

Enish inserting or editing
lie text

Click anywhere outside the
text box

Cancel text editing Type command-period

It Words in a text box can have a different font,

lnint size, and text style, as shown below Simply

cdect the text and choose desired the font, style,

ad point size from the Text menu:

f, cre-

lrag a

ursor

'ursor

han-
'Ptay 

in " /r///?p@mnyt
th the
re text
:eated

o

the

iutting, copling & pasting in text boxes
::fi can be freely cut, copied, and pasted in text

:,,r\es using the commands in the Edit menu. You

:::1 even do so between a text box in Mosaic and a

:. npletely different text editing program, such as

n rrd-processing software. For exarnple, you can
,::te a paragraph of text in your favorite rvord-

:::;essing software, copy it into the clipboard,
.iitch into Mosaic, and then paste it into a Mosaic
-.ai box.

..rr5lNG THETEXT MENU
-ir text menu allows you to select the font, point
;:. style, andjustification (leti, right, center) of

---; text, no matter which of the five types it is.

;€tting text attributes
-: ;hange text attributes using the Text menu:

" :tlect the text.

e: 'Typing ar.rd editing text inside a text box" on

; t:-: 102 for a summary of how to select the text.

I -hoose the desired attribute fronr the Text

-:L-I.

:er key

r ess

re tex-t

ed

ted in .
rqe ter

S.

x

ouble-

inside
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Entering musical symbols as text
If you would like to enter a musical symbol that is
not in a Mosaic palette, and you have a font in your
system that has the symbol, you can enter it as text.

To enter the symbol:

1 Click the voice text tool to select it.

2 Click or drag near the desired note to create the

text box.

3 Select the desired font and point size from the

Text menu.

4 Enter the desired symbol by typing the

appropriate key.

5 Complete the insertion by clicking the voice text
tool to deselect it or by pressing enter.

VOICE TEXT
Voice text is text that gets "attached" to the

note nearest the point at which you enter it.
Shown below, the voice text being entered is

attached to the last note in the measure.

(muted]

Notice, however, that ifthe first three notes are cut
and pasted after the last note, the text remains with
the same note (now at the beginning).

Voice text is displayed with the note on any staff
and in any view. Voice text flows, cuts, copies, and
pastes with the note.Voice text behaves in the same

way as an ornament or articulation. For a more

detailed explanation, see "Understanding note-
specific symbols" on page75.

To insert voice text:

1 Click the voice text tool to select it.

2 If you are inserting text on a staff that contains

multiple voices, press command and the up/dorrn
arrow keys to select the desired voice.

If the staff only contains one voice, you can skip

this step.

3 Click or drag the text cursor above or below the

note to which you wish to attach the text.

This creates a new text box. Ifthe note you are

attaching the text to is crowded by other notes,

avoid attaching the text to the wrong note by
clicking directly on top of the notehead, The tert
box will appear just above the note, and you can

reposition it after you type in the text.

4 Typ" the desired text in the text box.

5 Complete the insertion by clicking anywhere

outside the text box.

6 To adjust the position of the text box, drag it. To

adjust the size ofthe text box, select it and drag one

of its handles.

The text box will remain with the note and

maintain its orientation to the position of the note

within the measure.

STAFF TEXT

-I- Stafftext is text that gets"attached" to a staf
at the measure where you enter it. It appears

with the staff at the measure in all views. It remains

attached to the measure over which it is inserted,

regardless ofthe notes or rests in the measure.

,J,
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skip

:nsert staff text:

X Click or drag the text cursor above or below the

rmsure to which you wish to attach the text.

lvpe the desired text in the text box.

a iomplete the insertion by clicking anywhere

r-.ide the text box or by pressing the enter key.

I To adjust the position of the tert box, drag it. To

r&rst the size of the text box, select it and drag one
,*its handles.

- raff text box remains with its measure and

:;rtains its orientation with respect to the staff.

SYSTEM TEXT

E In Mosaic, a staff svstem consists of one or
El m61s staves, iust like in a conventional
rmsic score. Most of the time, each staff in the

rr[em represents one instrument.

r example, music for a solo instrument is notated

e a single staff. Mosaic treats the staff as a single-

mffsystem. A traditional piano/vocal score

msists of a three staff system: a top staff for the

ual part, and two lower staves for the left and

git hand piano parts. In a full orchestra score, a

l$em might have as many as 40 staves or more to

rtate each instrument in the orchestra.

im -Itrosaic, you will often create a master score view

ir* contains all the staves in the piece of music

pmtped into one system. In conjunction with the

ncster score view, you will create other views that

auain a subset of staves from the master score.

k axample, to create individual instrument parts,

m r,r'ill create a single-staff view for each staff
in'rn the main score. (In some cases, an instrument

prst may consist of several staves, as in a piano or

harp part.) You also might create sub-scores that
display staves from only a certain instrument

section, such as woodwinds.

System text is ideal in these types of situations.

When you place system text above a system, that

text will appear with every staff in the system, no

matter what view or system the staffis placed in. In
addition, system text always appears at the top of
the system, regardless of whether the system

consists of one staff or forty staves.

lnserting system text
To insert system text:

1 Scroll the view to the top staff of the system

2 Click the desired system text tool in the Text

palette.

Choose among the following system text items in
the Text palette:

System text

Rehearsal mark l\4etronome marking

Dal segno

Coda

Figure I 5-1: System text tools in the Text palette.

Use System text for plain text items such as tempo

markings like Allegro non troppo.Use the other
symbols as desired. Repeat signs such as the coda

sign, Segno, Dal Segno, and Da Capo can be

entered by themselves or with additional text that

you enter, such as D.C. al Segno, Da Capo al Fine, or
D.C. al segno e poi la Coda.To insert a metronome

marking, see "Inserting a metronome marking" on

page 106.

3 Click above the measure which should contain

the text to create a text box.
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4 Choose the desired font, style, and point size

from the Text menu.

You can configure a default font, style, and point
size for each type of system text so that you do not
need to do so each time you enter it. See the next
section,"Configuring the default settings for
system text".

5 Typ" any text that you wish.

6 Click anywhere outside the text box to complete

the insertion.

Configuring the default settings for system
text
To configure the default font, text style, and point
size for one ofthe system text palette tools:

1 Double-click the desired system text tool.

2 A default settings dialog box appears.

3 While the dialog box is on the screen, choose the

desired font, text style, and point size from the Text

menu.

4 Choose either the "preceding measure" or
"following measure" option.

When you click above a barline to insert the staff
text, Mosaic needs to know whether to attach the

text to the measure before or after the barline. This
option also affects which line the text appears when

the barline occurs at a system break.

5 Drag the handle of the sample text item to select

a default position with respect to the staff.

6 Click OK to confrm your settings or Cancel to
withdraw them.

lnserting a metronome marking
Metronome markings consist of a note duration
followed by an equals sign and a number in beats

per minute:

J= tzo

To insert a metronome marking:

I Double-click the metronome marking icon Lr-

the Text palette as shown in },'igure 15- 1.

A dialog box appears.

2 Select the desired note duration.

Please note: the sample metronome marking in thc

box does not change duration, so don t be

concerned that it doesn t change when you select a

duration other than a quarter note.

I Select the desired font, text style, and point size

from Text menu.

4 Drag the handle of the sample marking to the

desired position with respect to the barline.

5 Choose either the "preceding measure" or
"following measure" option.

When you click above a barline to insert the staff
text, Mosaic needs to know whether to attach the

marking to the measure before or after the barline.

l
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' iiick above the measure in which you would
,,: :o insert the metronome marking.

For voice text, select the note to which you would
like to attach the voice text. For tempo marks,

rehearsal marks, stafftext, or system text, place the

insertion cursor in the staff where vou would like to
paste the text.

- :e ofthe duration 1'ou selected appears, along
--. an equals sign.

L'.'pe the desired number for the metronome
- . -. ino

4 Choose Paste from the Edit menu.

I ,-:;k anpvhere outside the text box to complete
" : -rsertion.

The text is pasted above (or below) the staffat the

same height and position from where it was copied

or cut.

i*eting system text
::1ete system text:

PAGE TEXT

,-ick the text to select it.

Page text is text that is anchored to a specific

position on a page. It does not flow with

- : :ess the delete key or choose Cut or Erase fiom
- , llit menu.

music, and it is unaffected by the positions of staves

or other musical symbols. It remains on the page in
the exact position at which you insert it or move it.

Ersting the position of system text

)djust the position of system text, drag the text

Lto th" desired location.

Because its position is defined by its location on the

page, page text cannot be entered or displayed in a

galley view.

.'= 
idjustment will take effect in all views tl.rat

-:.in the system text.

Page text is completely flexible. It can be placed

aryrwhere on the page.It can consist of any amount

oftext, and the text can be displayed in any font,

style, point size, and justification.

Examples of page texl. are:

ftying & pasting voice, staff, and system text
liryt" text box of voice text, stafftext, or system

Fcan be copied and pasted.

- SL) r Manuscript title, subtitle, composer, date, notes,

etc.

:,.-ect a sir-rgle text box. r Headers and footers

r Page numbers

r Copyrightnotice

r Staffnames

r Exerciseinstructions

. -.. ihe text once to select the text box. Handles

: --J appear at its fbur corners. Only one text box

-- --: copied and pasted at a time.

- :oose Out or Copy tiom the Edit menu.

--': rtxt is placed on the Clipboard.

'-licate 
the location where you would like to

lnserting page text
To entcr page text:

E

:lI
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I Go to thepagein apageviewonwhichyouwish
to insert the text.

Ifyou want the text to appear on a single page, such

as on a title page, scroll the view window to that
page. Ifyou want the text to appear in all pages in a
view such as for a header, footer, or page number,
open the page template on which the pages in the
view are based,

2 Choose the desired font, style, and point size

from the Text menu.

3 Click the page text tool from the Text palette,

4 Click or drag at the desired location to create a

text box.

5 Type the desired text.

6 Complete the insertion by clicking anywhere

outside the text box.

Deleting page text
To delete page text:

1 Click the text to select it.

2 Press the delete key or choose Cut or Erase from
the Edit menu.

Cutting, copying, and pasting page text
To cut or copy page text:

1 Click the text to select it.

2 Choose Copy or Cut from the Edit menu.

To paste page text:

I Cut or copy one or more page text boxes.

2 Scroll to the page on which youwish to paste.

3 Choose Paste from the Edit menu.

(G Page text cannot be pasted into a galleyview.

When page text is pasted, it is placed at the same

location from which it was cut or copied. This is

useful for duplicating headers and footers. See

"Creating running headers and footers" on
page 108.

Creating running headers and footers
To create a running header and/or footer, or anv

text that appears on every page in a view, you can

either:

1, Insert header/footer page text on one page and

the copy and paste it onto all the other pages

OR

2. Insert the header/footer page text on a page

layout template and then use the layout template

when creating new pages. For information about

creating and using page layout templates, see

"Using page layout templates" on page 16l .

Although option 1 may be easier in the short run,
its main drawback is that each instance of the

header, footer, or page number is separate from tle
other pages. For example, ifyou decide to

reposition the header or footer, you wiil either hare

to reposition it on every page, or reposition it on

one page and then recopy it to all other pages.

Therefore, use option I only with documents that

consist of a few pages, where changing all the pages

will only take a moment.

To replicate page text as described in option 1

above:

1 Insert the header, footer, and/or page number
on the first (or any) page in the view.

2 Position the text exactly where you want it on
the page.

3 Click the page text to select it.
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- Be sure you select the entire text box, such that

shandles become visible. Do not select the text

rside the text box.

it -noose Copy lrom the Edit menu or press

--r-rar-rd-C.

i Click the page scroll arrow in the horizontal

':--:il bar at the bottom of the viewwindow to

r..11 to the next page.

i ,roose Paste from the Edit menu or press

:mand-V.

fttext automatically appears at the same location

[il *u, copied from, so you don't have to adjust it

Frut.t the original page.

' i.epeat steps 5. and 6. ur.rtil you have reached the

-.. :age in the view.

Seating page numbers
:r:+ text is used to create page numbers.

fte numbers are handled in the same manner as

hning headers and footers as described in the

|riour section. The only difference is that you

hd to insert a special page number character that

fmmatically displays the proper page number for

ft.o.t"nt page.

I o: rre you follow the procedure below for

: .=rting page numbers, revieu. options I and 2 in
:. .ection "Creating rurning headers and filoters"
--:age 108.

-. nsert the page number character:

JCo t" the flrst page in the view, or go to the

]ropriate template page.

Hi:;[::ili:.:'l:l;in:;::ffii'

2 Choose the desired font, style, and point size

from the Text menu.

3 Click the page text tool from the Text palette,

4 Click or drag at the desired location on the page

to create a text box.

5 Choose Insert page # from the Text menu.

6 If desired, type any additional text before and/or

after the page number.

7 Click anywhere outside the text box to complete

the insertion.

8 If you inserted the page number on a template

page, apply the newly modified template page to

any pages that are based on it.

9 If you inserted the page number on the flrst page

of a regular view, follow the procedure in the

section "Cutting, copying, and pasting page text"

on page 108 to replicate the page number on the

rest ofthe pages in the view

Creating staff names
Page text is used to create staff names. Create them

by typing page text next to each staff on the

::T.:t" 
page on which you will be basing your

(- Most often you ll want to place the full staff

names on the first page and abbreviate names on

each subsequent page. In this procedure, enter the

full names on the first page in the view. See the next

section for how to obtain abbreviated names on

subsequent pages.

The procedure below can be done on a page

template or a body page in a regular page view. If
you builda regularbodypage with staff names,you

can create a page template from it at any time.
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To create staff names:

1 Scroll to the first page in the view.

2 If necessary, choose Show Layout from the view

window mini-menu and drag the left page margin
to the right to make room for the staff names.

Be sure to select Hide Layout to exit layout mode
when you are finished with this step.

3 Click the page text palette tool.

4 Choose the desired font, size, and style for the

staff names.

5 To make the staff names justify to the left edge of
the staff, choose Justify from the Text menu and

select the Right option.

6 Drag a text boxout next to the left of the frrst
staff.

7 \p" in the desired text.

To indicate multiple parts on a single staff, use the

return key to place text on separate lines as shown:

Trombones F

8 Complete the insertion by clicking anywhere

outside the text box.

9 Select the staff name text box.

10 Choose Copy from the Edit menu.

ll Choose Paste from the Edit menu.

This pastes a copy ofthe text box back onto the

page exactly on top of the original text box.

12 Hold down the shift key and drag the page

box down to the next staff.

This places the pasted text box next to the

staff. The shift key constrains dragging so that

text box lines up vertically with the original one.

13 Repeat steps 1 I and 12 above until all staves

have the name next to them.

l4 Double-click each name and change it to the

desired name for that staff.

Abbreviating staff names on body pages
Often, full instrument names are used on the

page oniy. On subsequent body pages, the

instrument names are abbreviated. To create

abbreviated staffnames, you can copy the page

Iayout of the page that has the full names, paste it
onto the second page, and abbreviate the names

the second (and all subsequent) pages.

The procedure below can be done on a page

template or a body page in a regular page view. If
youbuild a regularbodypagewith staff names,

can create a page template from it at any time.

To abbreviate instrument names on bodypages:

I Scroll to the first page in the view (or any page

that contains the full staff names).

2 Choose ShowLayoutfromthe view

3 Choose Select All from the Edit menu.

This selects the entire page layout, including the

staff names. To indicate this, a dashed line

around the edge ofthe page.

4 If the view does not have a second page, add a

second page to the view.

See 'Adding pages to a page view" on page 40 for
more information.
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j Scroll to the second page in the view.

i ,-hoose Paste from the Edit menu.

This pastes the layout onto the page, including the

lrffnames.

- Double-click each staff name and type in the

rsired abbreviated name.

I To adjust the margin and the system margin,
.fuose Show Layout from the mini-menu and drag

&margin lines.

I To adjust the position of all the abbreviated staff
:;--ees, drag a selection box over them to select

firn and drag them to the desired position.

flaking staff names or abbreviations appear
rn other pages in the score
- rake the staff names appear on another existing
- , a: in the score:

" -hoose Shor,v Layout from the mini-rnenu.

- -roose Select All from the Edit menu.

.":-; 
selects the entire page layout. To indicate this,

- ::-.hed line appears around the edge ofthe page.

l. -roose Copy from the Edit menu to copy the

- ,:.

-:-. ;opies the entire layout.

I -.--roll to the page on which you want the names

r i:rear.

i l::oose Paste from the Edit menu.

i :.:peat this procedure for each page in the score,

: have a long document, see "Regenerating

a-- based on a template" on page 162 for
- ::ration about hor,v to quickly apply a layout to

- -:qes in a score.

Ifyou have just started the score and have not
created other pages yet, see "Using page layout
templates" on page 161 for information about how
to save the page with the staffname abbreviations

as a page layout template which you can use as a

model page from which to create new pages in the

score.

Centering a page title, subtitle, or other text
You can easily center a page title or other text as

follows:

I Choose Show Layout from the page view mini-
menu to display the margins of the page.

2 Clickthe PageTextpalettetool.

3 Drag a text box across the top ofthe page (or
another vertical position for other text such as

footers), beginning at the left margin and

extending all the way to the right margin.

4 Choose lustifu from the Text menu and select

Center.

5 Choose the desired font, size, and style for the

title text.

6 Type the title text.

il 7 (Optional) Toaddasubtitle,pressreturn,select
a different point size, style, and font (if desired)

and type the subtitle.

8 Complete the insertion by clicking aryr,vhere

outside the text box.
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16 Lyrics

chapter explains how to: Mosaic allows you to enter lyrics either way. You

can type in lyrics directiy on the page below the

notes, or you can type the lyrics in a self-contained

lyric text window just like you would in standard

text editing software such as MacWrite. In fact, the

lyric text window is like having MacWrite built in
to Mosaic: it's a separate text editing window in
which you can type, backspace, cut, copy, and
paste, and change the format of your lyric text. The

lyric text window also allows you to see all the text
together in one window.

lvric text and then automaticallv flow tl-re

and words beneath the notes in a voice

lyrics in the lyric text window, which

a standard text editing environment

Type lyrics directly on the staff

and change lyrics, either on the page or in
lvric text window

with multiple lines of lyrics

the font, point size, and style of all the lyrics,
In Mosaic, a body of text in a lyric window is called

a lyric.It consists of an independent line of text--
syllables and words--which can be applied to the

notes in a voice,just as they do in a traditional
score. The lyric text is assigned to a voice, and then
the text is displayed below (or above) the notes of
the voice on a staff in the score. Each word and

syllable is centered below (or above) its

corresponding note: the first word or syllable is

centered below the first note in the voice, the

second word under the second note, and so on.

word or syllable, or anyportion of lyric text

text is specifically designed for the purpose of
syllables and words in a line of text below

note in a voice. Ifyou need to insert a single

or phrase, such as a tempo indication, or if
are not sure ifyou should use lyric text for your

see summary of the five different types

at the beginning of chapter 1 5, "Text"

f.-
NG LYRICS

vocal scores, lyrics are syllables and Mosaic can automatically line up the words with
the notes for you, skipping rests so that the next
word appears under the next note, rather than the

rest. You can override the auto-flow of the lyrics at

any time, which allows you to adjust the way in
which the lyrics flow with the notes and skips rests.

that accompany notes in order to indicate

or syllable to be sung. Lyrics are usually

below (or sometimes above) the staff on

the notes are displayed, and each lyric word

is centered below (or above) its note.

composing, lyricists can develop lyrics When typing in lyrics, you separate syllables and

words as you naturallywould: with a space or a

dash. When you split up a single word by
separating each syllable with a dash, Mosaic
centers the dash between the syllables and the

notes.

from the music or together rvith the
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OVERVIEW OF HOW TO ENTER LYRICS

In general you will find it most convenient to enter

iyrics in the lyric text window because of its ease

with text editing and powerful auto-flowing

capability. Below is an overview of tl.re process to

enter lyrics using the lyric text window.

1. Create a lyric in the Lyrics window

2. Open the lyric textwindow

3. Typ. the text in the lyric text window

4. Automatically or manually flow the lyrics

through the voice

5. Adjust the auto flow to obtain the desired

placement of the syllables and words with the notes

in the voice

6. Make minor additions, deletions, and changes to

the text by editing the lyric text directly on the staff

These procedures are discussed in the next few

sections.

CREATING A LYRIC

A lyric is a single line of text that can be applied

(automatically flowed under or over) the notes in a

voice.

To create a lyric:

I Choose Lyrics from the Windows menu.

The Lyrics window appears.

2 Add a lyric by choosing Add from the Lyrics

window mini menu.

The lyric appears with an icon and name.

Drag the icon to

rearranqe the lyrics in

list when you have

more than one lyri(.

3 (Optional) Clickthe name to pop-editthe
of the lyric.

The name appears only in this window and the

status bar in the bottom of the view window, so

consider it to be nothing more than a reference

you.

-f

5 If you want the lyrics to start in a measure

than measure 1, type in the measure number in
Measure column.

Ior example, the lyrics may start after an

introduction or pick up measure.

You have just created a lyric. The next two

explain how to open the lyric window and begin

typing in text.

OPENING A LYRIC TEXT WINDOW
A lyric text rvindorv is the place n here you

lvrics (s1,11ables and rvords).

To open a lyric text window:

I If it isn t already visible, open the Lyrics

(or bring it to the front) by choosing Lyrics from
theWindows menu.

2 Double-c1ick the lyric icon next to the name to

open the lyric text window.

LYRI(S
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4 Choose the voice to which you want the lyrics tr

apply from the pop-up menu in the Voice column

next to the lyric name.
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,.indow.

I Optional) Ifdesired, you can close the Lyrics

rdorv.

ixr can work in the lyric text window without
aing the Lyrics window open.

-TPING IN LYRIC TEXT

-:ce you have created the lyric and opened the

'":ic window, you are ready to begin typing in lyric
ctt

d.

ldrore doing so, you may want to position the lyric
ist ryindow in front of, or next to, a view that

n-.plays the notes in the voice. This allows you to

"€ the text flow beneath the notes.

Aneri€{, t*e Deaxtlful

Controlling text flow manually or
automatically
Before you enter lyric text, you should decide

whether you would like to control the text flow
manually or automatically. (For an explanation of
what text "flowing" is, see "Understanding lyrics"
on page 113.) Text flow is controlledbythe
following two rules:

l. A space (or a dash) causes the text immediately

after it to jump to the next note

2. A tab causes the text immediately after it to jump

to the beginning of the next measure

For example, if you type a word, and then a space,

the next word you type will be applied to the next

note. If you type a tab, the next word you type wili
be applied to the first note in the next measure.

Flowing text automatically is much easier than

doing so manuall1. bscnuse you don t have to keep

track of rests, barlines, and tabs. You can simply

type words with spaces in between (as you

normallywould when typing text), and insert

dashes between syllables where desired. The Auto-

flow command matches each word (or syllable)

with a note, enters extra spaces to skip rests, and

enters tabs wherever barlines fa11 in the text.

Ifyou flow text manually, you need to keep track of
where rests and barlines fall in between the words

and syllables so that you can type an extra space

where necessary to skip a rest and a tab r,vhere

necessary to start a new measure.

Most of the time, you will find it much easier to

florv text automatically.You might find that when

making adjustments and fine-tuning the flow of
the text, you might prefer to do so manually.

These fivo methods are explained in the next two

sections.

Heft * s0nr llnnrj. l.rln|. ninli

lyrk

: sectio-'

d begir:

r type

i \ftTtl

;s tro:-

-': t 6-1: Place the lyric text window in front of (or next to) a view
tu .g the voice to which the lyrics will be added so you can
z-,2 how text flows beneoth the notes.
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Entering lyric text and flowing it automatically
To enter lyric text and flow it automatically:

1 (Optional) Position the lyric text window in
front of (or next to) avierv that displays the notes in
the voice you want to flow text beneath.

2 Make sure that the lyric window is the active
window.

Click its title bar to activate it.

3 Choose the desired text font, point size, and
style from the Text menu.

You can change the font attributes later, if
necessary, so this step is not critical.

4 Typ. in the first word or syllable.

5 To enter the next word or syllable, type a space
(or dash) and then type the word.

G Suggestion: you might find it easiest to type
words as whole words first and then go back
afterwards to insert dashes between syllables where
necessary. Itt easier to type tvhole words than to
stop and ligure out when to type a dash!

6 Keep repeating steps 4 and 5, separating each

word or syllable with either a space or a dash. Donl
worry about entering extra spaces for rests or tabs
for measures.

Mosaic provides a way to extend a line for a
sustained syllable or word. See "sustaining a word
or syllable with an underline" on page 117.

7 \44ren you are done, or if youd like to see the text
beneath the notes, flow the lyric text to see it lined
up with the notes.

Turn to the section called'Auto-flowing lyric text"
on page I 19 for detailed information.

Entering lyric text and flowing it manually
To enter lyric text and flow it manually:

1 (Optional) Position the lyric text window in
front of (or next to) a view that displays the

the voice you want to flow text beneath.

2 Make sure that the lyric text window is the

window.

Click its title bar to activate it.

3 Choose the desired text font, point size, and

style from the Text menu.

You can change the font attributes later, if
necessary, so this step is not critical.

4 Place the insertion cursor where you would
to begin inserting text.

y
If the lyric has no text yet, the cursor will appear

the upper left corner of the window.

5 Typ. the first word or syllable.

An example is shown below. The lyric text
is superimposed on top of a view showing the

that the text will flow under.

F

0h

6 Choose Apply changes from the lyric text
window mini-menu.

This causes the lirst.lvord to appear on the staff,
that you can see where you are beginning.
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GL*1y) Separating syllables and words with a dash
Type a dash to separate syllables in a word, as in
this example:?ot

(hoosing the Apply changes

(ommand from the mini-menu

(auses lhe text t0 appear on the staff.

o4

J*:m ;mre 
a sPace (or a dash) and the

Hal le-lu -jah!
I Iia rest is next, type a space and then an extra

:.;e to skip over the rest.

! Ii a barline is r.rext, press tab.

| {untitled-l }

Hal-le-lu- jahl L

v

ffte example above, it would be necessary to type

ED"ft..,i.* ord oh.
if Notice that Mosaic automatically centers

dashes betlveen the notes and syllables. When the

word crosses a barline, Mosaic automatically
centers the dash below the barline.

IBat unv time you would like to make the text

k,--:':t;'.xll"i'.:I'.'ff 'chooseApprv

lfeep repeating steps 7 through l0 until you are

P* 
enteringthetext. 

G,

ftrating syllables and words with a space

len typing lyric text, there are tvvo ways to

[ar"t" syllables and words: type either a space

hr..n them or a dash.

Typing a non-breaking dash or space
To type a non-breaking dash or space (one that
doesn t separate the word), hold down the option
key while typing the dash or space.

)fre example below, spaces separate the four

!+t.r in the word Hallelujah.

Sustaining a word or syllable with an underline
\Arhen a word or syllable sustains across more than
one note, the most commonly used convention is

to extend an underline from the end ofthe word or
syilable across the notes for which it should be

sustained, as shown below for the word ralrps:

{al le lu jah !
This has been accomplished by typing ore
underline character ( _ ) immediately after the

syllable 7u, as shown below:-r : lu jah

Tu_rq1*'jjttl__
Itonlytakes one underline
(harader in the lyric textwindow

to obtain an underline €xtending

all the wayto the next note as

shown in the previous example.

: (5
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Do this:

Type a single spacebeforemd
after the word, the same m
you normally do when typirg
text

Separate each syllable with a
dash ( - ), i.e. "Hal-le-jul-lahl-

Hold dom the option key
and type a dash

Hold dom the option key
and press the space bar

(j Note that it only takes one underline character

to get a line that extends all the way to the next note!

Don't type more than one.

You can use the return key in the lyric text

to arrange the text into lines without af[ecting

flow ofthe text.

Extending an underline across several notes
If a syllable or word should be sustained over

several notes, type one underline character for
each note. In the example below, the word darkisto
be held for six notes: the dotted eight, the four
sixteenths, and the dotted eighth.

-in - dal darE ness shades

To accomplish this, six underline characters have

been entered immediately after the word dark in
the lyric text window:

Summary of what to type to control lyric
flow
Here is a summary of what to type in order to ge

various results when typing lyric text.

To do this:

To centera word or syllable
undet a note

9
Ihese six underlines underline through the

To center a syllable under a

note and display a centered
dash between it and the
next s)4lable

six held notes forthe word darl<.

c- The underline extension automatically

extends over rests.
To type a non-breaking
dash (a dash that won't sep-
arate the word)

Sustaining a syllable or word with dashes
Ifyou prefer dashes centered below each note

instead of a continuous line, enter a non-breaking

dash (option-dash) followed by a space for each

note:

To tlpe a non-breaking
space (a space that won't
separate the word)

To extend an underline
from the current word or
syllable to the next note

Tnre an underline character
(_)

To sustain a

word with a
next note

syllable or
dash under the

Tlpe a non-breaking dash
(option-dash) followed by a
space under the next note

lel-in - da! ddth - ilsss sDades fls. To beginflowingin the next Tlpe a tab
measure

IAy DdndEei-fu-ddi ddrft - - - - - - dess s,dd€s

Todisplay a separated dash beneath each note,type0ption-dash (to entera n0n-

breaking dash) followed by a space foreach note.This example has Jix option

dashes, one for eaih of the six notes,

lffmerit the beautiful!

tby good utitb bto-tlJet-bood
s&rl-n-*ag s*a,l

f,l,+ DBflxi-ft.-JfuJ,

spa-aas sHes,

mer4-ca, A- ftter-i-cd

sea to

Lament
Thy hatd

iEa _om Ist ile resf,
vdde| fre, Eaath -is awel cofre I

slddes frq

ric- | {Dido's tamenl Rria}
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qUTO-FLOWING LYRIC TEXT

-ier you have entered new lyric text, or ifyou have

-;de significant changes to existing lyric text, you
--+d to use the Auto-flow command in the mini-
:-<nu in the lyric text window to re-flow it in order
.: see it on the staff.

-:rorving" consists of the following process: it
:<Eins at the current location of the insertion

--:rsor in the lyric text window From there, the first

".rrd or syllable to the right ofthe cursor is placed

;der the first note in the voice, the second word or
.,Lable under the second note, and so on. Flowing

-:rtinues according to the text, spaces, dashes, and

=derlines that you have typed.

lert flows according to the following two rules:

fA space (or a dash) causes the text immediately

E;*:: ;.:::"i:.:;:i ;;:.. * .,. -,

Effi::};;Jffiind.wmini.
]u ir,...,, .xtra spaces so that no text falls below

EI[{*:}i':,,:;ir;:ilitl#H',ff','
=rto flow the lyrics:

JEace the insertion cursor at the point at which

]would like to begin auto flow.

E:::i.'*: 
I Hi.,, *,T;,ffi 

',ffi;:"

2 Choose Auto-Flow from the lyric text window
mlnl-menu.

0h beaut

bopc the fruitcdl,tain

(f Please note! Ifyou have inserted extra spaces

or removed spaces by hand, Auto-flow will
eliminate your modifications. Be careful when

reflowing to preserve sections in which you have

customized the flow.

EDITING LYRICS ON THE STAFF

Once you have entered lyrics in the lyric text

window and flowed thern, you can make

adjustments to the text directly in a view. You can:

r Add, delete, or edit text

r Insert or remove spaces, dashes, and underlines

r Change the font, point size, and style of any

portion of the text, including all the text

Adding, deleting, and editing text
To add, delete, or otherwise edit lyric text in a view:

1 Click the text to place an insertion cursor in the

text.

Mosaic activates a text box for the syllable or word

that you click.

-------= ,fiLf

..--: :ow all the text, pla(e the

r -- :- iursoratthevery beginning
-:,'atextwindo\r.
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2 Make the desired change(s) in a standard

fashion.
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Do this:

Press the arrowkeys

Position the cursor to the
right ofit and press the delete
k.y

Double-click the word

Drag overthem inside the text
box

Double-click a word to seiect the entire word. Use

the delete key as usual. Use the arrow keys to move

the insertion cursor left and right and to the

previous or next syllable or word.

This procedure works for single words. To

the font, size, or style of more than one word,

the text in the voice, do so in the lyric text

as described in "Editing lyrics in the lyric text

window" on page 120.
3 When you have completed the edit, ciick
anywhere outside the text box, or use the arrow
keys to move to the next or previous syllable.

EDITING LYRICS IN THE LYRIC TEXT
WINDOW
Once you have entered lyrics in the lyric text

window and flowed them, you can make

adjustments to the text in the lyric text window.

You can:

If you have made any changes that alter the auto-

flow, the text reflows when you complete the edit.

Changing the flow when editing lyrics
Ifyou insert or delete spaces, dashes, or underlines,

they do not afFect the auto-flow immediately as you
type them. Instead, they take effect when you exit
the current text box, either by using the arrow keys

to scroll to the next or previous box, or by clicking
outside the text box to complete the edit.

r Add, delete, or edit text

r Insert or remove spaces, dashes, and

r Cut, copy, and paste text

r Change the font, point size, and style of any

portion of the text, including all the text

Changing the font, point size, and style
You can quickly change the font, point size or style

of a single word, syllable, or portion of a word. To

do so:

Adding, deleting, and editing lyric text
To add, delete, or otherwise edit text in the lyric
text window, use the actiofis fsted in the table

below to edit lyric text.

1 Double-click the syllable or word to select it.
Io do this:

'ilLf Move the text cursor within
the text box

Delete a character

it
- -lt'

A Select a word

Select several words or sen-
tences.

If you are selecting only a portion of a word, drag

over the desired characters.
Change the font, point size
or style

Select the text and choose the
desired font, size, and style in
the Text menu

2 Choose the desired font, point size, and style

from the Text menu.

Applythechanges
made

you have Choose Apply changes from
the lltic text window mini-
menu, close the wildow, or
bring another window to the
frontI
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Cutting, copying, and pasting lyric text
rr cut or copy text in the lyric window, select the

::xt to be cut or copied and choose Cut or Copy

:rrm the Edit menu.

Lr paste text into the lyric window:

I Copy the text into the clipboard using Cut or

-op,v.

! Place the insertion cursor atthe point where you

muld like to paste, or select text to be replaced.

3 Choose Paste from the Edit menu.

dpplying changes to the staff
-,',aen you have completed the changes in the lyric
-:rt rvindow and wish to see them take affect in a

--eir-, choose Apply changes from the lyric text

"--:rdow mini-menu.

- If you have made major changes, you may

r-mt to use the Auto-flow command to more easily

=ndle rests and barlines.'t"

Setting the font, point size, and style of lyric
st
-:e the lyric text window to apply font attributes

;=h as typeface, point size, and style to lyric text.

:r,u can set the font attributes for as little as a single
::racter or as much as the entire lyric.

l: set the font attributes of lyric text:

' ielect the tert.

]select a portion of a word, drag over the

]macters. To select an entire word, double-click it.

Jselect several words, drag over them. To select

E;.;ilxt"ffi:"J.'H""Tifi ' 
o' uo,"

E;n*.j;;;d 
font, point size and style

_'Rt(5

Displaying syllable and measure boundaries
rics The ShowWord Breaks

mini-menu command

appears in the Lyric text

entry mini-menu. When this menu item is

checked, syllable and measure boundaries are

displayed in the lyric text entry window as shown

below:

REMOVING LYRICS

There are severai ways to remove lyrics, depending

on your intentions.

If you want to delete lyric text in order to replace it
with different text, select it in the lyric text window
and choose Cut or Erase from the Edit menu, or
press the delete key.

If you want to remove lyric text entirely and not

replace it, you can either delete the lyric in the

Lyrics window, or choose None from the voice

assignment pop-up menu in the lyrics window.

s (ffmBrac.

If you want to temporarily remove the text from the

voice, choose None from the voice assignment

pop-up menu in the Lyrics window.

ADJUSTINGA LYRIC LINE'S DISTANCE FROM
THE STAFF

To adjust the distance of a lyric from the staff:
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1 Choose Show Layout from the vie'w, mini-menu.

2 Drag the lyric handle up or down to the desired
position.

tc If you adjust the vertical position of a lyric line
in a page view, the adjustment will not affect that
lyric line on other systems. This al1ows you to make
adjustments on an individuai system without
affecting other systems.

PLACING LYRICS ABOVE THE STAFF
To place a lyric above a staff:

I Choose Show Layout from the vietv mini-menu.

2 Drag the lyric handle to the desired position
above the staff.

G In a galley view, this is only necessary once.

However, in a page view, you 11 need to do this for
each system in the score.

HANDLING MULTIPLE VERSES

Vocal music often has several verses. To

accommodate this, Mosaic allows you to assign

more than one lyric to a voice-there is no lirnit.
And you can verticaliy position thern in any order
above or below the staff.

In the example shown below, notice that three
separate verses have been created and assigned to
the voice called Lead Vocals.

3 Position each verse by choosing Show layout
mode from the view window mini-menu and
dragging its position vertically

PRINTING LYRICS
Io print the contents of a lyric text r,r,indow:

1 Select all the text in the lyric text rvindow.

2 Choose Copy from the Edit menu.

3 Go to the View window and choose Add page

view.

4 Doublerclick the page view icon to open the
page viewwindow

5 Click the page text icon in the text palette.

6 Drag a textbox in the pageyiew.

7 Choose Paste from the Edit meng.

8 [fnecessary,arrangethe rextand the textbox
desired.

9 Choose Print from the File menu.

EDITING NOTES THAT HAVE LYRICS
lfyou cut or paste notes irr a voice that already
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To enter multiple lines of lyrics:
contains lyrics, you need to re-flow the text
the positions of the measure breaks) to

1 Create a separate iyric for each line of text. accommodate the changes in the notes. This can

done either manually (see "Entering lyric text
2 Assign each of the lyrics to the same voice. flolving it manually" on page 116) or

(see "Entering lyric text and flowing it automati-
cally" on page 1 1 6) .
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17 Chord Symbols

chapter explains how to:

Format chord symbols in a way that you prefer

Enter chord symbols by typing them in or
them in from a MIDI controller

Teach Mosaic new chords by piaying them from

(hord symbol tool
(hord symbol

with fret board

Change, move, and otherwise edit chord

Transpose chord symbols

Figure 1 7-l:The chord symbol tools in theText palette.

CONFIGURING CHORD SYMBOLS
Before you begin entering chord symbols, you will
probablywant to make adjustments to their default

appearance, including the font used, default

distance above the staff, etc. As usual in Mosaic,

double-click the chord or Fretboard symboi tool to
open the Chord Symbols or Fretboard Symbols

dialog box.

information about other types of text in
see chapter l5,"Text"

symbols can be entered from the Macintosh

ln

with the assumption that you are aiready

with MIDI input in Mosaic. If you are not

would like to enter chords via MIDI, you may

it helpful to review chapter 34,"MIDI
and Playback'. This fret symbol

pop-up menu is

n0t

the

present in

Chord

F

ffi :Hm
Um'
m'ffi

5ymbols dialog.

CHORD SYMBOL TOOLS Figure l7-2:Fretboard Symbol dialog. Open this diolog box by
double-clicking thefretboord symbol tool.Thefret board chaft is only
present when you double-click the fret boatdtool in the Text polette.
For chord symbols without fretboards, double-click the Chord
Symboltool.

provides two chord symbol tools in the text

They let you enter transposable chord

above any voice in any staff. One tool
chord symbols as text alone, while the other

the text accompanied by the appropriate

fret board chart.
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Here is a summary of what you can do in this
dialog:

ENTERING CHORDS
Once you have set the chord symbol settings as

desired, you are ready to begin entering chord
To do this: Do this: symbols. You can enter the chords by typing

in or by playing them in from your MIDI
controller.

Adjust the height ofthe
chord text above the staff

Drag it up or down.

Adjust the position ofthe
fret board chart with
respect to the chord text

Drag it to the desired location
above, below, or next to the
text.

If you would like to play chord symbols in via a

MIDI instrument, make sure that Mosaic is

successfully receiving MIDI data from the MIDI
device before you begin entering chords. For

information about setting up MIDI input, see

chapter 34,"MIDI Recording and Playback".

Change the font, point size,
or style ofthe chord text

Click the sample chord text
above the staffto select it and
choose the desired font, point
size, or style from the Text
menu while the Chord Sym-
bol dialog box is open.

Change the size ofthe fret
board chart (available only
with fret tool)

Click the fret board chart to
select it and choose the
desired point size from the
Text menu. You can choose
any size you like; for best
appearance on the screen and
on low-resolution printers,
choose a point size of 16, 20,
24,32, or 40.

To enter chord svmbols:

1 Click one of the two chord svmbols tools in
Text palette.

One enters chords without guitar fret board
the other enters them with guitar fret board

The Learn button is explained later in this chapter.

The Format Chord Text option
When checked,the Format Chord Tbxt optionin
the Chord Symbol dialog box causes chord
qualities to be superscripted as shown below on the

left. When this option is unchecked, chord
qualities are displayed at the same size as shown on
the right

2 Click on or above the note or rest where you

wish to begin entering the symbols.

The note you click becomes selected, and the

Chord Entrywindow appears.

c'(,1%) cz('t3)

Formatted

(Format (hord Text

option k che(ked)

Notformatted
(Format (hord Text

option is unchecked)

Select one of

the two chord

symbol entry

tools.

Figurc I 7-3: Formotted versus non-formotted chord text. Clirk the note above which you want

t0 begin entering the chord symboh.

It becomes highlighted to indicate

that the chord will be placed above it.

lfnecesary,

Saving chord symbol settings
Chord symbol settings are automatically
remembered in the file.

the (hord Entry

I
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If necessary, move the chord symbol window 6 To enter the chord symbol you have just typed
in, use one of the following methods.of the wav.

do so, drag the title of the dialog box to move it. To do this: Do this:

Type in the desired chord, or play it on your
To enter the chord and pro- Press tab
ceed to the next note or rest

controller.
Press command-tabTo enter the chord and pro-

ceed tr: the next neasure

chord appears in the text box. For details about
To enter the chord and pro-
ceed to the previous note or
rest

Press shift tab
chords and playing via MIDI, see the

sections in this chapter.

To enterthe chord and pro-
ceed to the previous mea-
sure

Press command-shift -tab

If desired, choose a fret board chart for the

from the pop-up menu provided.
Press return or click OKTo enter the chord and

fret board chart you choose does not affect the
close the chord entrywir-
dow

For example, the chord text might be"Em/
To cancel chord entry alto-
gether

Press command-period or
, but you want the guitar fret board chart to click Cancei.

an "Em" instead. Choose'irin triad" fiom
pop-up menu. 7 Use the above keystrokes to move forwards and

backwards through the voice.

Mosaic highlights the note that is currentiy selected

for chord entry. If you would like to enter a chord

symbol at a position in the measure where there is

no note or rest, see "Placing chord symbols on

beats where there is no note or rest" on page 130.

8 When you are finished entering the chords, click

oK.

Uie

crds g[, E[ cr,fJ Bh

TYPING IN CHORD SYMBOLS
In the Chord Entry dialog box, you can pretty
much type the chord you want. Mosaic is not

concerned about capitalization; it will correctly

ORD SYMBOI.S
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What to type:

To get a < qmbol, type option \
a > s1mbol, type

Play this:

::rter a chir

'pen the I
: .idY open j.
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..i a note. L)

lo1 and th
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interpret the chord regardless ofcase. For example,
if you want to enter B-flat, you can type "bb".

Mosaic always stacks chord suffixes that are

enclosed in parentheses, brackets, or braces.

Here are some more examples:

(hord:

Working with chord suffixes
Here is a summary of the things you can do rvhen
working with chord sutfixes:

Ci('l3)

c4hl
Symbol: What to type:

c7+91s
b

lower case "b" (b)

#

Pound sign (#) ^7hL,, '13

Dash (-)

Ms
Shift option-8

a Option o
E
c

A Option j

"^,zr7glzfitfs)619 619

Slash ( / )

PLAYING IN CHORDS VIA MIDI
When 1.ou are enterirrg chords in the (lhord Entn'
dialog box or in the Chorcl Symbol dialog, you
play them from your NIIDI controller. Mosaic

Underline
analyzes what you play and creates the

chord symbol. Here is a summary of how to get the
best results:

The text itself

T1.pe the suffr<es and enclose
them in parentheses, i.e.
(#ebl3)

To get this:

A root chord 'fhe root chord

Type the suffixes and enclose
them in brackets, i.e. [#9b13]

Triad or seventh chord Any voicing ofthe chordwith
no more than a 5th betleen
the botton two notes.

Stacked sufftxes
with no braces
or brackets

Tlpe the suffixes and
enclosedthemin a < and a >, Inversion or hybrid chord

example: E/G# or A/B
Any chordwith a bass note of
a minor 6th or more awavi.e. <#9b13>

To get a < symbol, type
option-\
To get a > qmbol, qpe
shift-option-\

Poly chord
Lrample:
F
C

Any chord with another
chord of a minor 6th or more
away

I

Description:

A flat

A sharp

N,Ilnor sign

A dimilished
symbol

A half-dimin
ished symbol

A major 7 trian
gle

The 6/9 chord
suffrx

A diagonal slash
for a hybrid
chord, inver-
sion, or altered
bass

A horizontal
slash for a poly
chord

Any other text

Stached suffixes
rvithin braces

Stacked su{fixes
within brackets
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Ete tr:
tz-r

enter a chord via MIDI

Open the Chord entry diaiog box (if it is not rriq tr EPt pr:ition

open). fDnt, siEr, ind stqlP

do so, click one of the two chord entry tools and
,.... tltlrItIPt HPro!nrrron

. HM-IITITI]
a note. Or double-click an existing chord This fret p0p up

and then use the tab and shift-tab menu is not present in

the Chord Symbols

to move to the desired note.

Play the chord on your MIDI controller.
E FErmit Chord TFxt

chord appears in tl.re chord entry dialog.

if necessary, choose the desired fret board chart

the pop-up menu. 3 Ti,pe in the desired name for the chord in the

sample text box.experimenting with many different cirords,

use the guidelines provided above.

the chords yotr

If so, 1.ou need to teach Mosaic the chord.

have done so, Mosaic will recognize the

in anykey.

teach Mosaic a new chord:

Double-click one of the tr,rrc chord svmbol entrv

to open the Chord Symbols dialog box.

Play the chord you wish to teach to N{osaic in
position.

playit in anykey.A question mark appears 4 If desired, choose a fret board chart from the

pop-up menu provided below the keyboard.display if Mosaic does not recognize the

in addition, the keys you played are

by the keyboard diagram: Mosaic will learn the fret board chart as well the

chord name.

5 \\rhen you have chosen the chord name and fret
board chart as desired, click the Learn button.

Doing so causes Mosaic to learn the chord as you
have named it.

ls
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G;------
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6 Repeat this procedure for each chord that you

wish to teach Mosaic.

You can teach Mosaic as many chords as you like.

Remember, you don't need to teach Mosaic

standard chords because it alreadyknows them.

7 When you are finished teaching Mosaic new
chords, click OK.

Mosaic memorizes the chord and will dispiay the

chord text any time you play the chord in any key.

You can play inversions when teaching Mosaic a

chord, but if you teach Mosaic the chord in root
position, it learns the inversions automatically. If,
later on, you discover an inversion that is

recognized incorrectly, simply teach Mosaic the

specific inversion.

Changing the way Mosaic spells a chord
You can change chord spellings using the learn

button as described in the previous section. For

example, you may want Mosaic to display'A-7"
instead of'Am7" or"Amin7". |ust teach Mosaic the

new spelling using the procedure in the preceding

section.

lncluding a fret symbol with new chords
As you can see from the procedure in the previous

section, you can indicate what guitar fret symbol to
use with the new chord.You can teach Mosaic to
use any guitar fret symbol with any chord in the

same manner. lust type in or play in the chord in
the Fret Symbols dialog box, choose the desired

fret symbol, and click the Learn button.

Preserving your chord library
Your library of chords is stored in the Mosaic

Preferences file, which is located in the System

Folder. In System 7, it is placed in the Preferences

Folder inside the System Folder. In System 6, it is
placed in the top level of the System Folder. We

strongly recommend that you regularly make

copies ofthis file so you ll always have a backup

it. By doing so, you won t ever lose your chord

Iibrary.

EDITING CHORD SYMBOLS
This section covers many aspects of editing

symbols.

Changing a chord symbol
To edit a chord symbol, double-click the chord
root and then make the desired changes in the

Chord Entry dialog box.

Moving chord symbols
To move a single chord symbol, drag it. To

the height above the staff of an entire line of
symbols all at once, option-drag one of the

Or, click one to select it and drag the arrow that

appears at the end of the line. To bring the chord

back to the chord baseline, select it and choose

Realign from the Format menu.

Drag this handleto

chords on

c-ds sb, EE
"t

that line

ju5t option-drag

one ofthe chords.

Removing a chord symbol
To remove a chord symbol, select it and choose Cut

or Erase from the Edit menu, or press the delete

ky'

Selecting all chord symbols (or a range)
To quickly select all chord symbols (or any range of
symbols):

1 Click the first chord symbol you want to select it.

2 Scroll to the last symbol in the range.
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Shift-click just to the right of the last symbol you 2 Select the chord symbols you want to reformat.
to select.

See "Selecting all chord symbols (or a range)" on
page 128.

eh* r 3 Command-click the chord tool in the Text

palette to apply the new format to the selected

chord symbols.

Removing fret board charts from existing
chord symbols
To remove fret board charts from existing chord
symbols:

ing the font of existing chord symbols
the font of existing chord symbols, select 1 Select the chord symbols.

and choose the desired font, size, and style

the Text menu. Chord symbols are selected in See "Selecting all chord symbols (or a range)" on
page 128.fashion, including shift-clicking (see the

section) and dragging a selection box

them. t' 2 Command-click the chord tool without fret

board charts in the Text palette.

and pasting chord symbols
behave much like voice text when it The chord symbols are reformatted using the

current formatting of the chord symbol tool
without fret board charts. Ifyou want to further
modify the formatting of the chords, see the

previous section.

to cutting and pasting. They go with the

to which they are attached. Ifyou copy and

the notes to which they belong, the chord

go along, too.

ng chord symbols Adding fret board charts to existing chord
symbols
To add fret board charts to chord symbols:

you have entered chord symbols, you may

format them differently. For example,you

want to superscript the chord qualities by 1 Select the chord symbols.
"Format Chord Text"option shown in

L7-2 onpage 123. See "Selecting all chord symbols (or a range)" on

page 128.
chord symbols:

the desired changes to one or both ofthe
2 Command-click the fret chord tool in the Text

palette.
tools in the Text palette.

chord symbols"on page 123 and
The chord symbols are reformatted using the

current formatting of the fret board chart chord
symbol tool. If you want to further modify the

formatting of the chords, see "Reformatting chord
symbols"on page 129.

Format Chord Text option" on page 124.

probably want to reformat both so that they

with one another.
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TRANSPOSING CHORD SYMBOLS
To transpose chord symbols:

I Select the chord symbols you wish to transPose.

If desired, you can select the chords symbols

together with notes.

Select them using the standard selection methods

in Mosaic. A chord symbol displays a grey box

around it when it is selected.

2 Choose Tianspose from the Region menu,

choose the desired transposition, and click OK.

Using chord symbols on a transposed staff
Chord symbols are automatically transposed when

the voice to which thev are attached is placed on a

transposed staff, just like the notes in the voice'

CREATING A SEPARATE VOICE FOR CHORD
CHANGES
When dealing lr.ith chord changes, you need

complete flexibility. For example, 1,ou may need to:

r Place chord changes at locations where there is

no note or rest, as shown belour

Bb7 Am

r Display the chord changes over several different

staves in one view.

r Displaythe chord changes in several different

views, such as in individual instrument parts.

r Automatically transpose the chord changes in

instrument part views lor transposing

instruments.

All of these tasks can be accomplished by creating a

separate voice for the chord changes as described

in the following section.

Placing chord symbols on beats where there
no note or rest
When working with chord changes, you will
run into a situation where the rhythmic lo

of the chord symbols you are entering don't

up with the rhythms of the notes in the voice. A

common example is when you have several

changes occurring over the course of a held note.

T}re wav to handle this is to create an extra voice

the staff. Give it a name like "Chord Changes",

insert invisihed rests at reguiar intervals as

Then place the chord symbols in the "Chord

Changes" voice instead of the voice containing

notes. In the example below, quarter note

rests are being used in the rvhole note bar,

Displaying chord change! over multiple
and views
You can use the technique described above to

display the chord symbols in your score r,vherever

you lvould like, such as in instrument part views'

lust assign the Chord Changes voice to the staff

rvhich you rvould like to display them. If you

the Chord Changes voice to a transposed staff

as in a part view for a transposing instrument),

chord changes will be automatically transposed to

the correct key Another benefit of this technique

that if you modify the chord changes, the change

will automatically be reflected throughout the

score.

(HORD SYMBOLs
130
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cHAPTER rs Edit Commands

This chapter explains how to work with the Edit

aenu commandsl

r Select a musical symbol to edit it

r Select small and large regions, and multiple

rices

r Determine the voice in which you are editing

r Remove music with the Erase, Cut, and Snip

ommands

r lnsert music with the Paste, Merge, and Splice

ommands

r Copymusic into the Clipboard for pasting

Be sure to see chapter 7, "Undo and Redo" for
hformation about Mosaic's unlimited Undo and

Bedo capabilities.

ile aware of the voice you are editing
r-".member that notes always exist within a voice.
,',ien you are cutting, copying, and pasting notes,

--.llie note of what voice you are copying from and

:rsting into by observing the voice status box at the

:.ritom of the view. If you don't pay attention to the

::;e, you'1l start getting unexpected results.

*se l8-l: Make note of the voice you are currently editing here in

-voice indicator box at the left-hand side of the horizontol scroll
G-To chonge the voice click in the box and choose the desired voice
fun the pop-up menu, or press the commond key ond the up or
tnorrowkey.

t{osaic allows a great deal of flexibility when

diting voices.You can:

: Copy and paste within a single voice

r Copy and paste from one voice to another

r Copy and paste within multiple voices at the

same time

These procedures are discussed in the next few

sections.

SELECTING WHAT YOU WANTTO EDIT
Below is a summary of how to select things for
editing.

To seled this: Do this:

Several items that are not
next to one another

Shift-click each item.

An entire region of items I)rag a selection box over
them.

A single item (note, rest,
dot, grouping, articulation,
beam, accidental, etc.)

A large region, either in a

single staffor across mmy
staves, that is too large to
drag a selection box over

All notes and rests within a

single voice

All items on a page

All items in the score

Click the item once.

Select a note at the beginning
ofthe region in the upper-
most staff, scroll to the end of
the region, and shift-click in
the lowest staffjust to the
right ofthe last item you want
to select (See "Selecting large
regions" on page 132 for a

further explanation.)

OR

Place the insertion cursor at
the begirning ofthe region
and choose Extend Selection
from the Edit menu.

Double click any note or rest
in the voice

Scroll to the page in its page
view and choose Select All
from the Edit menu.

Open a view that contains all
staves (and voices) and
choose Select AII fiom the
Edit menu.
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Zooming in to select specific items
You might find it easier to select items in dense

notation by zooming in the display.

SELECTING LARGE REGIONS

Mosaic has a several convenient ways to

regions of music in a score.

1

To more easily sele(t the flat a(cidental in

the middle ofthis measure,the display

below has been zoomed in to 400%.

Shift-clicking
Think of large regions in a Mosaic score as a

rectangle, as shown in Figure 18-2:

--_---_-.

Zooming out to select larger regions
One way to select a region is to drag a selection box

over the area as shown below. Zooming out in a

galley view is useful for selecting long regions of
measriles,

T
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reasa

:d -te I 8-2: Selecting o large region in o scorc.

:..:u can select everything in this region by placing

:e insertion cursor in the upper left corner and

-en shift-clicking in the iower right corner as

t se{ect everythlng within this

rqP region,cli(k the insertion

:I5or here on the highest staff in

t Rgion and to the left ofthe
t$note or rest. (Alternately,you

- s€lectthefirst note or rest

5-'. I 8-3: Selecting o large region by shift-clicking.

shown below Figure 1 8-3. In doing so, you are

defining the area you wish to select, including all of
the voices vertically between the selection points.

. . . and then shift<lick a blank

area on the staffjustto the right

ofthe last note or rest in the

region here./mpolrort: be sure to

dkk in a blank part ofthe staff; if
you click a note or rest instead,

you'll just seled that one note

instead ofthe entire region.
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The region can begin and end any.where, even in

the middle of a measure. It does not have to include
the entire measure.

Similarly, the region you select does not have to
include all staves in the system; it may only contain
a portion of the staff system. You can even select a

region on a single staff.

Ifnecessary, you can scroll the window as far as

needed before you shift-click. If you are in a page

view, you can scroll as many pages as necessary. (To

avoid lots of scrolling, you can use the Extend

Selection command discussed in the next section.)

G If you want, you can begin the selection in the

upper right corner ofthe region, scroll backwards
(to the left) and shift-click in the lower right. As

long as you shift click itthe opposite corner from
the currently selected note (or cursor location),

you will select everything in between.

If you are selecting a single voice on a staffthat has

several voices, indicate the beginning ofthe
selection region by clicking a note in the voice you
want to select (instead of placing the insertion

cursor at the beginning). Then shift-click in the

staff at the end of the region as shown in Figure 18-

3, or use the Extend Selection command as

described in the next section.

Using the Extend Selection command
The Extend Selection command in the Edit

extends the currently selected region to a

that you specify. Ifthe insertion cursor is

instead of a selection, it creates a selected

from the cursor location.

Unlike shift-clicking, the Extend Selection

command includes the entire measure that you

specify.

For convenience, the default measure that
in this dialog box when you first open it is the

measure in the piece, which makes it easy to

everything from the current selection to the end

the score.

USING THE CLIPBOARD
Mosaic has a standard Macintosh Clipboard. The

Clipboard is a temporary storage location for
music that has been cut, snipped, or copied.

that has been placed in the Clipboard with those

commands can be pasted, merged, or spliced

the Clipboard.Any music in the Clipboard

remains there until the next time you use the Cut,

Snip, or Copy commands, in which case it is
replaced by the newly edited data.

ERASING, CUTTING, AND SNIPPING
The Erase, Cut, and Snip commands in the Edit
menu each remove selected music, but they do so

in slightly different ways.

EDIT (OMMANDS
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Ib remove music using the Erase, Cut, or Snip

command:

1 Seiect the data.

Use any of the methods discussed in the section

c.lled "Selecting what you want to edit" on

page 131.

2 Choose Erase, Cut, or Snip from the Edit menu.

lhe Erase command does the following:

-. Removes the music

2- Leaves behind empty measures where the notes

md rests used to be

-' Leaves the Clipboard empty

lre Cut command is the same as Erase, except that

--- step number 3, Cut places the removed data on

:.e Clipboard.

-:e Snip command does the follorving:

- Lemoves the music

- rlloses up the gap where the notes and rests used
' re by shifting all the music after the removed

-., -: -_ l\ll

' ?laces the removed music on the Clipboard

-: the three commands, Erase does the least. It
,i-:nply removes the music, and that's it. It does not

ri:ce the removed music onto the Clipboard. Since

=e Clipboard remains empty, the erased music is

rr:'i a\.ailable flor pasting, merging, or splicing.

:-=se is handy when you have something in the

lrboard already that you don t want to lose. Both

and Snip do place the removed music on the

making the removed music available

pasting, splicing, or merging.

:: T (0Mi\4ANDs

When using Erase or Cut, any rhythmic space

taken up by erased notes (or rests) is left behind.
However, if you want to remove the space as well,

use Snip as shown below:

lfthe notes in measures 2 and I are selected...

...and then erased or cutthe spa(e theytook up remains behind,but...

....ifthe notesare snipped,the notesatmeasure4shiftto measure 2to fill the gap.

:

:

O These three commands, as well as the delete

key, cannot be used to remove clefs, meter

signatures, or key signatures. To remove these

items, see their respective sections in chapter 14,

"Clefs, Meters, Key Signatures, and Ottavas".

COPYING
The Copy command in the Edit menu places a copy

of all currently selected music in the Clipboard,
making it availabie for pasting, splicing, or
merging, as discussed in the next section. Copying
Ieaves the original music unchanged.

To copy:

1 Select the data you wish to copy.

Use any of the methods discussed in the section

called "Selecting what you want to edit" on
page l3l.

2 Choose Copy from the Edit menu.

PASTING, SPLICING, AND MERGING
The Paste, Splice, and Merge commands insert

music from the Clipboard into one or more voices

on a staff.
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Each command inserts music in a different way.

For example, let's say that the following two bars of
notes are currently in the Ciipboard:

To insert music using the Paste, Splice, or
command:

I Copy, Cut, or Snip music into the clipboard.

(lipboard contents: This is important because if the clipboard has

nothing in it, there is no music to paste, splice,

merge.
And let's say that you would like to insert these tlvo

bars of notes at measure 4 below: 2 Placetheinsertioncursoratthe
and beat, and in the desired voice.

5 (,

If you Paste, the music in the Clipboard replaces

what is already there at measure 4:

To position the insertion cursor at the desired

measure and beat, use the left/right arrow keys.

select a voice, press command-up arrow or
command-down arrow. Alternately, if there is

6 1

already a note at the location where you want to

insert and the note is in the right voice, you can

click the note to select it.

3 Choose Paste, Splice, or Merge from the Edit

menu.

The music in the clipboard is inserted at the

selected location.

r
For information about editing more than one

at a time, see "Editing several voices at once" on
page 137.

If you Splice, the music in the Clipboardis spliced

in-between the notes on either side of the insertion

cursor, and everything to the right is shifted to the

right to accommodate the new data. In this

example, the notes that were at measure 4 are

shifted two bars later to measure 6 to accommodate

the two measures of half notes spliced in from the

Clipboard:

SHIFTING
The Shift command in the Edit menu allows you

slide r-rotes and rests earlier or later in a piece of
music. For example, you could select a section

move it four bars earlier.

6

To use the Shift command:

I Select the music that you wish to shift.

AII notes after measure 4 shift to the right to accommodate the spliced music.

For information about selecting, see "Selecting

what you want to edit" on page 131.

2 Choose Shift from the Edit menu.
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The Shift dialog box appears.
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To shift by a number of whole measures, type

number of measures, select either earlier or

and click OK.

To shift by a number of measures plus an

Pasting multiple voices
\4rhen pasting, merging, or splicing, Mosaic

establishes a one-to-one correspondence between

the voices in the clipboard and voices on a staff or a

s).stem. It pastes the first voice in the Clipboard

into the voice on the staff that contains the

insertion point (Voice-4 in this example). From

there, it pastes the second voice into the next voice

down in the system, and so on until either the last

voice in the Clipboard is pasted or until there are

no more voices in the system to paste into.

duration, type the number of measures,

the "shift by an aclditional x note" option, tvpe

appropriate duration, and click OK.

To shift by less than a measure, type in 0
click the "shift by an additional x note"

type in the appropriate duration, and click

SEVERAL VOICES AT ONCE
allows you to use the Cut, Snip, Erase,

Paste, Merge, and Splice commands on

voices at one time. For example, you might
pastes into

to Snip seyeral bars from all the staves in a

multiple voices
copying, cutting, or snipping music in more

one voice at a time, Mosaic keeps track of each

separately, and it also maintains the order of
in the Clipboard, as shown in the

below

Pasting into non-adjacent voices
Most of the time,you will probably copy and paste

into the same number of voices, as shown in the

above example--and most often they'I1 be the

same voices. However, there may be times when

you would like to paste what is in the Clipboard

into non-irdjacent voices. For example, you might
want to copv several bars from the Violin I, II, and

Voice-1

TLIPBOARD

Voice-'l

Voi(e-2

Voice 4

Voice-5

SiAFF 5Y5TEI\4

Voice 5

Voice-2

Voice 3

Voice-4

ILIPBOARD

Er,"r l

Mk,r ]

Voi(e-7

SIAFF SYSTEI\,{
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III parts and then paste into the Flute I, Clarinet I,

and Bassoon I voices,which are not adjacent to one

another.

All three ofthese voices can be pasted into at once

by the following procedure:

1 Copy the three violin parts.

2 Select a note or rest in the Flute, Clarinet, and

Bassoon voices at the measure and beat at which
you want to paste.

Shifrctick each note to select all three at once. If
there is no note at that location, insert one and then
select it.

3 Choose Paste.

In this example, the Violin I music would be pasted

into the flute part, which is the topmost of the three

destination voices. Violin II wouid be pasted into
the Clarinet voice, and Violin III into Bassoon.

EDITING EMPTY MEASURE WHOLE RESTS

For convenience, Mosaic automatically places a

whole rest in empty measures. This empty-
measure whole rest is both similar and different

from the whole rest you enter from the Rests

palette. The most notable difference is that it
cannot be removed. It remains in the measure as

long as there are no notes or rests in the measure.

As soon as you enter a note or rest in the measure,

however, it automatically disappears.

Even though empty-measure whole rests cannot be

removed, they can be hidden with the InvisiSr

Rests command. When they are invisified, they

appear greyed out on the computer screen, and the

do not appear at all in print, resulting in a
completely blank measure.

0n screen

ln print

Figure 184: An invisified empty-meosure whole rest.

With regard to editing, the empty-measure

rest acts much like a regular whole rest. For

example, it can be selected, cut, copied, and

either by itseif or selected together with other

music. The only exception is with the Cut

command. Normally, when you cut something,

removed and placed on the Clipboard. Empty-

measure whole rests get placed on the Clipboard

the Cut command, but they are not removed

the measure. If you want to remove them, use

Invisify Rests commands mentioned above.

EDITING LYRICS AND NOTES TOGETHER
Lyrics can't be selected in a page or galley view.

Therefore, they cannot be cut, copied, pasted, etc.

together with the notes that they flow beneath.

However, the lyrics can be edited in the lyric text

window and then reflowed beneath the notes in
voice after you complete editing on the notes in

voice. For information about editing and flowing

lyrics, see chapter 16,"Lyrics".
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I

ER 19 Transposing

you accidentally drag horizontaliy, the note will
move sideways instead of vertically. Choose Undo

lrom thc Edit menu and try again.

3 -r4rhen you reach the desired line, space, or
ledger line, reiease the mouse.

NG DIATONICALLY

All of the seiected notes are transposed by the same

number of lines and spaces as the note that you

dragged.
transposition transposes notes by a

of scale steps within the currer-rt key G Dragging a note vertically produces the same

result as if you used the Transpose command

diatonic transposition option. Because the

transposition is diatonic, an accidental on a note

may change or disappear at the note's new pitch,

depending on the key signature and other

accidentals in the measure.

Tlansposition respects accidentals in the

signature, as well as accidentals placed on the

being transposed.

diatonically by dragging notes
transpose a note diatonically, drag it vertically

desired line, space, or ledger 1ine.

more than one note at a time: Transposing diatonically using the Transpose
command
As arr allernative to dragging, vou can transpose

notes diatonically using the Transpose command

in the Region menu. To do so:

Select the notes to be dragged.

a group of notes that are next to one

drag a select box around them. To seiect
1 Select the notes to be transposed.

that are not next to one another, shift-click
one. To select all notes in a voice, double-click

To select a group of notes that are next to one

another, drag a select box around them. To select

notes that are not next to one another, shift-click
each one. To select all notes in a voice, double-click

any note in the voice.

note in the voice.

any one ofthe selected notes up or down.

drag, a notehead tracks which line or space

dragging to. Mosaic constrains your
2 Choose Transpose from the Region menu or

press command-T.
verticalliz, so that you don t have to worry

accidentally movir.rg the note horizontally, If

The Transpose dialog appears.
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3 Choose the Diatonic option.

4 Choose the desired diatonic intervai. 3 Choose the Chromatic option.

4 Choose the desired chromatic interval.

5 Choose a direction (up or down).

6 Click OK to confirm the edit.

5 Choose a direction (up or down).

6 Click OK to confirm the edit.

TRANSPOSING CHROMATICALLY
Chromatic transposition is exact transposition by

some interval of half steps. Pitches are shifted

upwards or downwards in pitch by the number of
semitones that you choose.

TRANSPOSING BY KEY

Transposing by key transposes the notes from
key to another.

The Change Key command in the Region menu

provides an option to transpose notes by key. To
Notes that are transposed chromatically are

automatically spelled correctly with respect to the

current key signature. In addition, Mosaic

maintains the relationship of accidental spellings

with respect to the key signature.
1 Select the region of notes to be transposed.

To select a region ofnotes, drag a select box
To transpose chromatically: them, or shift-click a note at the beginning and

1 Select the notes to be transposed.
of the region. To select all notes in a voice,

click any note in the voice.

To select a group of notes that are next to one

another, drag a select box around them. To select

notes that are not next to one another, shifrclick
each one. To select all notes in a voice, double-click
any note in the voice.

2 Choose Change Key from the Region menu.

The Change Key dialog appears.

2 Choose Transpose from the Region menu or
press command-T.
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The chosen key signature is inserted at the

beginning ofthe selected region to indicate the new

key. Ifthe end ofthe region occurs before the end ol
the piece, a key sipJnature is also inserted at the end

of the region to restore the old key signature after

the transposed section.

Select a naturalization option.

"Inserting a key signature" on page 96 for
about these options.

If desired, choose the Warning signature at

breaks option.

"lnserting a key signature" on page 96 for
about this option.

Choose the Transpose option, and select either

up or down option.

Select the desired key signature by clicking the

arrows below tl.re staff.

convenience, the name of each key

is displayed above the staff.

If desired, click the All Staves option.

inserts the key change in all staves in the

desired, check the "Insert relative key on

staves" option.

the'Insert relative key on trar-rsposed

option'on page97

OK to complete the insertion.
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I
PTER 20 Rebarring

Rebar command allows you to obtain the When a voice is rebarred, it gets rebarred on every

staff (in any view) in which it appears.number of beats in every measure. You

use Rebar to:

Place the proper number of beats in each

Rebarring a selected region
To rebar a region of notes:

after changing the meter
I Select the notes you want to rebar.

Shift all music forwards or backwards across

after inserting or deleting a note or rest You can select a region of notes in a single voice, or
several voices on the same staff or on different

staves.
Clean up barline placement after copying and

rebarring works
rf Rebarring begins at the start of the measure

containing the first selected note.

2 Choose Rebar from the Region menu.

The selected region of notes gets rebarred.

Rebar command rearranges existing notes and

to place the proper number ofbeats in each

in a region. It does so by moving notes to

next measure or previous measure. Rebarring

with the first measure of a range of
If the lirst measure doesn't contain Selecting a large region to rebar

You may need to rebar a very large region, one that

you might not be able to select entirelyby dragging
a selection box over the entire region. See

"Selecting large regions"on page 132.

notes and rests to make it a complete

(with respect to the current meter

, the necessary number ofbeats are

from the notes at the beginning ofthe
measure. If the first measure has too many

Rebarring a single staff from the cursor to the
end of the staff
Ifyou place the insertion cursor on a staff (instead

of selecting a region), rebarring begins at the

measure that contains the insertion cursor. It takes

place in all voi ces on that staff orll and proceeds to

the end ofthe piece.

the extra beats are pushed into the second

the first measure has the correct number of
Mosaic proceeds to the second measure and

the same procedure

process continues for each measure in the
To rebar from the insertion cursor to the end ofthe
staff:

region. Even though this may seem like a

Mosaic accomplishes it within seconds.

the Rebar Command has finished, all the I Place the insertion cursor in the measure in
which you would like to begin rebarring.in the region have the correct number of

2 Choose Rebar from the Region menu.
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(.f When rebarring using the cursor, rebarring

only takes place in voices on the staff containing

the cursor.

Rebarring more than one staff at a time
To rebar more than one staff at a time, select all the

voices you wish to rebar.

To quickly select each entire voice, shift-double-

click any note in each voice. The shift key causes

other selected notes to remain selected when you

double-click.

Rebarring an entire piece

To rebar an entire piece:

1 Open a gal1ey view that contains all staves in the

Iile.

2 Choose Select All from the Edit menu.

3 Choose Rebar from the Region menu'

Tips about rebarring
Here are several tips to know about rebarring:

r If a notehead fa1ls on a barline as a result of

rebarring, Rebar automatically splits up the note

properly. For example, if a half note ends up being

split in half by a barline, it gets notated as two tied

quarter notes.

r Rebarring might be slightly imprecise about how

it splits up complex rhythms (such as complex

tuplets) when they fall across a barline in order to

preserve their recognizability.

r Rebar ignores grace notes.
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?',| Checking Rhythm and Range

Check Rhythm command in the Region menu CHECKING A LARGE REGION
You may need to check a very large region, one that

you might not be able to select entirely by dragging

a selection box over the entire region. See

"Selecting large regions" on page 132.

your music for measures that do not have the

number of beats and rests.

Check Range command scans your music for
that lie above or below the note range you

for each voice in the Voices window. CHECKING A SINGLE STAFF FROM THE
CURSOR TO THE END
Ifyou place the insertion cursor on a staff (instead

of selecting a region), checking begins at the

measure that contains the insertion cursor. It takes

place in all voices on that staff onl7, and proceeds to

the end of the piece.

either command finds an error, Mosaic

scrolls to that offending measure or
In the case of a note, Mosaic selects the note

identifv it.

NG A SELECTED REGION

check range or rhythm over a region of notes:

Select the notes you want to check.

To check from the insertion cursor to the end ofthe
staff:

can select a region of notes in a single voice, or
1 Place the insertion cursor in the measure in
which you would like to begin re-barring.

voices on the same staff or on different

2 Choose Check Range or Check Rhythm from
the Region menu.

Rhythm checking begins at the start of the

containing the first selected note. G When checking using the cursor, checking

only takes place on the staff containing the cursor.
Choose either Check Range or Check Rhythm

the Region menu. CHECKING AN ENTIRE VOICE
To quickly check an entire voice:

error is found, Mosaic scrolls to the location

either places the insertion cursor in the errant 1 Double-click any note in the voice.
or highlights the out-of-range note.

This selects the entire voice.
If desired, correct the error.

2 Choose Check Rhythm or Check Range.

check for further errors, re-select the region

repeat the procedure. CHECKING SEVERAL STAVES AT ONCE
To check more than one staff at a time:

1 select all the voices you wish to check on each

staff.
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To quickiy select each entire voice, shift-double-

click any note in each voice. The shift key causes

other selected notes to remain selected when you

double-click each new voice.

2 Choose Check Rhythm or Check Range.

CHECKING AN ENTIRE PIECE

To check an entire piece:

1 Open a galley view that contains all staves in the

file.

2 Choose Select AII from the Edit menu.

3 Choose Check Rhythm or Check Range from

the Region menu.

4 Ifan error is found, correct it.

5 Repeat steps 1 through 4 until no errors are

found.
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R22 Consolidating Rests

consolidated rest consists of two or more four or above measures in a row will be

consolidated; three in a rowwill not. The

Preferences command also lets you choose

befiveen two widths for the consolidated rest bar.

empty measures (measures that have a

rest in them) that are combined into one

-measure rest as shown below:

To set the minimum number of measures to
consolidate:

I Choose File Preferences frorn the File menu.

To qet a narrow bar Iike this, use the

"Narrow"option in the File Prefer

en(es command in the Edit menu.
2 Typ. in the lowest number of measures that you

want to be consolidated.

3 Click OK.
ng on rest consolidating

Consolidate rests command in the page view Editing measures that have been consolidated
To edit measures that have been consolidated:causes adjacent empty measures to be

and printed in this fashion.

the Consolidate rests menu item is checked,

I Temporariiy disable rest consolidation by
unchecking the Consolidate rests mini-menu
command.emptymeasures in the viewbecome

Note: rest consolidation is view-specific.
All consolidated rests will revert back to individual
measures.

you enable it in a view it only occurs in that
2 Do the necessary work on the measures.

off rest consolidating 3 Re-enable rest consolidation by checking the

Consolidate rests mini-menu command.the menu item is unchecked, rests become

A11 empty measures are displayed
If you insert music into measures that were

consolidated, they will no longer consolidate.

consolidation does not occur in galiey views.

the minimum number of measures

Splitting consolidated rests with barlines
All barlines in the Barlines palette, except for the

plain barline and invisible barline, split

consolidated rests. Ifyou need to split a
consolidated rest with a plain barline, use the split-
rest plain barline shown below

Preferences command in the File menu allows

choose the lowest number of consecutive

measures that will be combined. For

if you set the minimum to be 4 measures,
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To split a consolidated rest using this barline:

1 Make the Consolidate Rests command
unchecked in the view mini-menu.

2 Click the split rest barline in the Barlines palette.

3 Click the barline in the score where you want to
split the rest.

4 Check the Consolidate Rests command in the

viewmini-menu.

Use this barline at rehearsal marks, tempo

markings, codas, or other landmark symbols that
do not automatically split consolidated rests. Meter
changes, key changes, and clef changes

automatically split rests without the need for this
barline. To "unsplit" a rest, click the barline with
the plain barline tool.

I
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CHAPTER 23 Controlling Page Layout

Iayout in Mosaic consists of the following r Create and use left-hand and right-hand
(facing) page templates and use them in a

document

of your music:

Page size and margins

The layout of staves (staff systems) on the page,
Zooming out to get an overview
Zooming out is especially useful for adjusting the

Iayout because you have more of an overview ofthe
entire page. Layout can be adjusted at any zoom

level, so you can choose the level that suits you best.

their order, spacing, margins, and staff

Staffconnections such as braces, brackets, and

Page text, such as titles, staff names, headersi
Working on page layout in a galley view
Most layout characteristics are controlled in page

views, since printing ultimately occurs from the

page view. Some layout characteristics can also be

controlled in galley views. For example, staff
spacing can be adjusted in a galleyview. However, a

galley view has no margins because it has no page

dimensions.

and page numbers

Lyric placement below or above a staff

page layout is all of these characteristics put

think of it as a description of a single,

sheet of manuscript paper.

chapter explains how to: Galley views do not have the following page layout

characteristics:
Control these lavout characteristics on anv

if the page already has music on it, r Page size and page margins

r Pagetext

r Staff margins

r Brace and bracket staff connections

you to see immediately the effects of your
adjustments on the music

Build your own page layout from scratch, or

an existing page layout

new pages to a score based on an existing (O Note: you can control barline connections in a

galleyview.lavout

layout changes to a page in the middle of a
Short versus long documents
If you are going to be working on a score with many
pages, create a page template and base all pages in
the view on the template. Then, if you need to make

a change to all the pages, just change the template

and re-apply it to all pages based on that template.

For example, if you want to change the font of all

document, such as removing blank staves

a system

the page layout of one page to another

page layout templates on which to base all

ln a score
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the page numbers, you only have to do so once on

the template page; all pages based on that template

will be updated when you re-apply the template.

Ifyou are going to be working on a short piece (3 or

4 pages at the most) and you don t mind making

changes manually to each page, you don t need to

create a page template.

Even ifyou alreacly have an existing score and you

rarould like to begin using a page template for the

pages in the score, you call create a tempiate--even

one that is based on an existing page in the score--

and appiy it to the all of the pages in the score.

For information about how to create and use page

templates, see "Using page layout templates" on

page 161.

SETTING THE PAGE SIZE AND MARGINS

Different printers can hold different paper sizes'

For example, laser printers typicaliy hold a paPer

tray for 8.5 by I i inch or 8.5 x 14 inch paper. A

wide-carriage ImageWriter II can feed 8.5 by 1 i,
8.5 by 14, or 14 x 11 inch ('tomputer") paper.

Even though Nlosaic is completely flexible and n'ill

allow you to set up any Page size, you are ultimately

limited by the paper size in your printer. If you try

to print a page in Mosaic that is larger than the

paper size in 1,or'rr printer, the music wili run off the

edges of the paper.As a result, most of the time

you ll want to choose a page size tl.rat matches (or is

smaller than) your printer's paper. If you would like

to work rvith a page size that is larger than your

printer paper and then print at a reduction, see the

next section.

Matching your printer's Paper size

To match your printer's paper size:

1 Select Chooser from the Apple menu and select

your type of printer.

2 Close the Chooser.

3 Select Page Setup from Mosaic's Fiie menu'

4 Select the paper size option that matches the

of the paper in your printer.

Ifyou are not sure what size to select, consult

printer manuai.

5 Leave the other options alone for now and

OK to conhrm your choice.

6 Open or activate the page viewwindorvin

you are setting the page size.

7 Choose Page layout setup from the

8 Select the Use paper size check box in the Page

Layout setup dialog.

Doing so causes the page size values below to

match the paper yor-ive selected in the chooser' In

addition, the page margins are set to match the

print area. (Most printers have a slim margin

around the edge of the page on which they

print. The area inside that margin is the print area.)

The page mzLrgin values will be non-rounded

numbers (expressed in inches).

9 If desired, adjust the page size and margins by

typing in the desired values.

You can make the page size smaller and the

margins larger, but don t make the page size larger

or the margins smaller because your music will
extend beyond the edge of the print area and get

cut off at the edges of the page.

Working with page sizes larger than your
printer paper
At times you may want to create pages in Mosaic

that are larger than the paper in your printer. For

example, you may want to create an orchestra score

on I 1 by 17 inch paper.
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Ifthis is the case, you can create a larger page size

and then print the page at a reduction on a laser

printer. For example, an 11 by 17 page will fit on an

8.5 by 1 1 sheet of paper if it is reduced to 650/o.

can then take your score to a Linotronic or

other Postscript- compatibie typ€setting machine

that handles larger pages sizes and print out the

at 100%. There are also 11 by 17 inkiet
tl.rat are affordable and can print large page

such as 9.5 by 13

information, see "Printing at a recluction" on

166

USTING PAGE MARGINS
margins serve as boundaries for staves. Staves

be dragged outside the margins. Page text,

(for titles, headers and footers, page

, etc.) can be placed anpvhere inside or

the margins.

adjust the page margins:

(Optional) Choose Show Layout from the page

mini-menu and drag the margins to the

location 1'ou rvould like.

Choose Page layor-rt setup from the mini-menu.

1'ou dragged the margins in step 1, tl.re page

values n ill be non-rounded numbers

in inches) which reflect the current

of the margins.

Adjust the page margin values (rvhich are

in inches) to the desired values.

necessary, round them off to the nearest

va1ue, such as the nearest quarter inch.

Click OK to confirm your choices.

ONTROLTING PAGE I-AYOUT

If yori want, you can set the margins with the "Use

printer page size" option. This option sets the page

size and according to tl.re page size and page

reduction values you have currently chosen in the

Page Setup dialog box. In addition, it sets the

margins to the paget print area. The print area is

the area in which the printer can print. It rvi11 not be

able to print anything outside the print area.

ADDING STAVES

This section discusses adding staves to a vierv that

already contains staves. For complete information
about adding \taves to a ne\v, empty view, see

"Displaying star.es in a vierv" on page 36.

Staves are added to a page view or galley view by

dragging their stafficon from the Staves window
into the yiew. In doing so, either they can be added

to an existing staffsystem as shown in Figure 23-1,

or they can be added as a new, separate staff

system.

To add one or more staves:

1 Open or activate the view window

To open the vierv, double-click its icon in the Views

window. To activate a view window that is already

open, select the view name from the Windows

menu.

2 Choose Staves frorn the Windorvs menu.

Ifyou have several files open, be sure to select the

right one. This opens the Staves rn indow or brings

it to the front ifit is already open.

3 If you are adding multiple staves, select the

staves you wish to add in the Staves window

Shift-click the icon of each one to select it. If you

haven t created the staves yet, hold down the option

key and choose Add staff from the mini-menu to

add them. For more information, see "Creating a

staff" on page 28.
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4 Drag the staff (or one ofthe group) from the

staves window on top of the page view window,
positioning the tracking line at the vertical location
where you would like the staves.

When the tracking line connects to an existing
system, the staves are added to that system. \4rhen

the tracking line doesn't connect to any existing
staves, the staves being added become their own
system.

2 Typ. the number of leger lines you prefer

between staves, staff groups, and systems.

Notice that you have separate control over each

type of space, as noted below:

Figure 23-1:When the trocking line connects to on existing stdff, the
stoff (or staves) being odded to the poge will be odded to that system.

5 Adjust the spacing of the systems, if necessary. lege6 between systems

See "Spacing staves evenly" on page 157 for
information.

SETTING THE DEFAULT STAFF AND SYSTEM
SPACING
When adding staves and systems to a page or galley

view, the staves are spaced according to a default

number of leger lines above and below each staff.

You can control the distance between stayes when
they are added using the System Layout Preferences

command. 3 Click OK to conlirm your choice.

To set the default staff and system spacing for
staves:

I'he default spacing affects how the staves are

spaced when added to the page. You can adjust

1 Choose System Layout Preferences from the

Format menu.

spacing by dragging the staves. You can expand

contract the spacing evenly with the Realign

command. See "Spacir-rg staves evenly" on

page 157.
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STAFF SIZE Reducing or enlarging a staff
To reduce or enlarge a staff:can be enlarged or reduced to anypoint size.

example, you might enlarge staves for
1 Select Show Layout from the view window mini-
menu.

music or for band charts so that

i can more easily read them--especially
performance situations where the music is hard

read.
2 Select the staff (or staves) you wish to enlarge or

reduce.

might reduce a staff and add it to a system as a

notes staff.
See "Selecting staves" on p age 15 4.

3 Choose Size from the Text menu.

4 Select the desired point size for the staff.

5 Click OK to confirm your choice.

The staff is scaled on the page.

you might reduce staves to fit more staves on a

a staff is reduced or enlarged, all symbols on

staff, including articulations, dynamics, and so

are reduced or enlarged as well. Ifyou need to

text, use the Size command in the Text

reduced or enlarged staves appear on

(ri Please note! When a staff is reduced or

enlarged in a page view the scaling occurs on that

page only. It does not get scaled on other pages in
the view, nor does it get scaled in other views.If you

wouldlike to scale the staff on all the pages, create a

page template and scale the staff on the page

template. See "Using page layout templates" on

page 161 for more information.

setting staff size, you need to consider how

reduced or enlarged staffwill appear on the

screen. The best-looking staff sizes are

16,20,24,or 28 points--or any multiple of
the staff lines will be evenly spaced

zoom level. At other point sizes, the staff Setting a default staff size

The System Layout Preferences dialog allowsyou to

choose a default staff size, so that any time you add

a staff, it is displayed at the desired point size.

will not be evenly spaced at every zoom level.

reduced or enlarged staves print
have a laser printer or a high-resolution

printer like a StyleWriter, reduced or To set the default size for staves added to a page

staves are scaled, and they print
I Choose System Layout Preferences from the

Format menu.
have a lower-resolution dot-matrix printer

as an ImageWriter or ImageWriter LQ, 2 Type in the desired point size in the Default staff

size box.or enlarged staves will print best ifthey are

to 12,16,20,24,or 28 points. Ifyou scale to

point size other than these, the output may not 3 Click OK.

desirable.
This default setting is saved with the file.
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ADJUSTING SYSTEM MARGINS
Staff system margins consist of the very left-hand

or right-hand edge of the staff system. The left edge

of a staff system is connected with a barline

extending across all staves in the system. The right
edge may or may not be connected with a barline,
depending on whether you have connected the

barlines of the system.

Either the left-hand or right-hand edge of the

system can be dragged independently to any

position within the left and right page margins.

Here are some of the things you can do by adjusting

system margins:

r Indent the first system on the page

r Indent numbered exercises

r Place separate systems next to each other to
create a separated coda section

To adjust system margins:

r Drag the left-hand or right-hand edge of the

system. Note that you cannot drag the system

margins past the ieft or right page margin.

EDITING STAVES

When Show Layout is chosen from the page view

or galley view mini-menu, staves can be edited in
many ways.You can:

r Select one or more staves

r Drag one or more staves to any position on the

page

r Cut, copy, and paste staves to rearrange them or
transfer them from one page, view, or file to
another

r Reorder staves by dragging them

r Position staves manuallyby dragging them

r Evenly space staves using the fustify command

These operations are discussed in the following
sections.

rf Please note that when editing staves in a

view, you affect the display for the entire view.

However, when you edit staves in a page view,

only affect the page on which you are editing
(unless it is a template page, of course),

SELECTING STAVES
When Show Layout is chosen from the mini
staves can be selected in the following ways.

To select a single staff, click it.

To select several non-adjacent staves, shift-click
each one.

To select a group ofstaves, drag a selectionbox

them in a page view. You might find it helpful to

zoom out first to more easily cover all the staves.

To select all the staves in a system, double-click
staff in the system.

To select all the staves, along with ail other page-

Iayout related material on a page, such as page

choose Select All from the Edit menu.

(f When a staffis selected, it displays a

box around it.

MOVING STAVES

Staves can be freely moved up or down, either ia
page view or a galley view.

To move one or more staves:

1 Be sure the view is in Show Layout mode by

selecting the Show Layout command in the view

window mini-menu.

If the command says Hide Layout, and page

margins are alreadyvisible on the page, the view

already in Show Layout mode.
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To move a single staff, click anl.r,vhere on the on the page. Ifthe tracking line is connected to an

existing staff, the staff (or staves) you are dragging
will be added to its system.

and drag up or down.

can reorder staves by dragging past the staff

or below the one you are moving. See the When reordered, the spacing of a staff at its new

location is controlled by the default staff spacing

that you have set in the Staff Layout Preferences

command in the Format menu.

sectlon.

To move several staves at once, select them and

one ofthe selected staves up or down.

"Selecting staves"on page 154.
REMOVING STAVES

Selected staves can be removed from a page by

selecting them and choosing Cut or Erase from the

Edit menu. Alternately, you can select the staff and

press the delete key.

NG STAVES

can be reordered with complete flexibility in
Reordering can be used to:

To cut a staff:
Change the order of staves within a system

Move a staff (or staves) from one system to 1 Be sure the view is in Show Layout mode by
selecting the Show Layout command in the view

window mini-menu.
Split a staff (or staves) into their own system

reordering staves, you can drag a single staff
2 Select the staff or staves you wish to remove.

several selected staves at once. See "Selecting
See the section called "Selecting staves" on

page 154.on page 154 for intbrmation.

Note: when reordering staves, braces and 3 Choose Cut or Erase from the Edit menu, or
press the delete key.

stick to the staves to which thev are

unless you drag the staff outside the

If so, the brace (or bracket) disappears. Ifyou cut the staves, they are placed in the

Clipboard and can be pasted. See the next section.
sure the view is in Sl.row Layout mode by

the Show Layout command in the view Removing empty staves from a system
The above procedure is ideal for removing empty

staves in a system in a page view at a point in the

score where oniy some staves are active. By

removing empty staves from the system, you

reduce the size of the staff system, and you can then
possibly fit more systems on the page. See the next

section for how to replicate the reduced system

once you have removed the empty staves.

mlnl-menu.

the staff (or staves) up or down in the view

to the desired position.

drag, the tracking shows rvhether the staff is

connected to the system, or whether it has

its own system. If the tracking line isnt
to an existing staff, the staff (or staves)

are dragging will be inserted as a new system

I{TROLI,I NG PAGE IAYOUT
't 55



156

COPYING AND PASTING STAVES

Staves can be copied by selecting them in Layout

Mode and choosing Copy from the Edit menu.

Once staves have been copied or cut into the

Clipboard, they can be pasted:

r Back onto the same page

r Onto a different page, either in the same view or

a different view, or even a view in another file.

Copying and pasting to replicate a staff system
Pasting staves can be useful in many situations. For

example,let's say that you have a score page with
one full staffsystem filling the page.You deleted

inactive staves to reduce the size of the system. Now

you have one system that is much smaller, and now

there is room on the page for a second system. You

can copy the reduced system and paste a second

copy onto the page below the first.

To paste one or more staves:

1 Open the page or galley view into which you

wish to paste them.

If it is a page view, scroll the page onto which you

wish to paste the staves. The page can be a template

page, if desired.

2 Be sure the view is in Show Layout mode by
selecting the Show Layout command in the view

window mini-menu.

3 Choose Paste from the Edit menu.

The staves appear at the bottom ofthe page. They

are spaced evenly according to the default staff

spacing set in the StaffLayout Preferences dialog in
the Format menu.

4 Select the pasted staves and drag them to the

desired position and/or system.

If necessary, you can use the Realign command in
the Format menu to change the spacing.

POSITIONING LYRICS

For information about how to position lyrics

or below a staff, see 'Adjusting a lyric iine's

from the staff"on pagel2l or "Placinglyrics

above the staff" on page 122.

USING BRACES AND BRACKETS

Staff braces and brackets can be placed in any

configuration to connect staves within a staff

system.

(f Staves must be in the same system in order

connect them with a brace or bracket. If they

not in the same system, see "Reordering staves"

page 155 for information about how to place

in the same system.

Entering a brace or bracket
To enter a brace or bracket:

1 Open a page view in which you wish to enter

bracket or brace.

Braces and brackets cannot be entered in a

view.

2 Click either the brace or bracket symbol in
Groupings palette.

3 Drag along the left edge of the staves you wish

connect.

Extending or shortening a brace or bracket
To extend a brace or bracket to include more

or shorten it to include fewer staves:

1 Click the brace or bracket to select it.

Handles appear on the top and bottom.

2 Drageitherthetophandleorthe
up or down.

The brace or bracket can only be extended to

within its system. It cannot be extend to staves in
other systems.
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You don't have to be in Show Lavout mode to 2. Space them evenly over any desired vertical
rangethe bracket.

the distance from the staff Converting staves to their default spacing
Staves have a default spacing, which is set in the

Staff Layout Preferences command in the Format
menu. This procedure causes selected staves to
revert to the values prescribed in that dialog.

To convert staves to their default spacing:

adjust the distance of the brace or bracket from
staff, drag it left or right.

ng a brace or bracket
delete a brace or bracket:

Click the brace or bracket to select it.

1 Select the staves you wish to re-space.
Choose Cut or Erase from the Edit menu, or

the delete kev. As a shortcut, you can just select the top and

bottom staff of the group that you wish to respace.
BARLINES

connect the barlines between staves in a system: 2 Choose Reformat from the Format menu.

Click any barline on a staff in the group you Spacing staves evenly through any vertical
ran9e
Mosaic can space staves evenly through any

vertical range on the page that you choose.

like to connect.

Drag the handles of the barline up or down as

to connect them to other staves.

can connect as many staves as you would like,
When doing so, Mosaic leaves extra space betvveen

systems, as well as extra space between staff groups
(staves that are braced or bracketed within a

system), to visually distinguish them. The extra
space that Mosaic uses is controlled proportionally
by the default leger line spacings in the Staff Layout

Preferences command in the Format menu.You

can expand or contract spacing by changing the

differences between the leger line values in the

dialog.

To space staves evenly through any vertical range:

all the staves in the system.

or changing barline connections
remove or change a barline connection:

Click the barline.

NG STAVES EVENLY
provides youwith the abilityto space staves

I Position the top staff ofthe range at the location
at which you would like it to end up.

within any vertical space in a view. This is
helpful after adding, cutting, pasting or
staves on a Page. 2 Position the bottom staff of the range at the

location at which you would like it to end up.
vou have the staves in the order that vou

you can evenly space them in one of two 3 Click the top staff and shift-click the bottom
staff to select them.

them to their default spacing, or

ONTROLI. ING PAGE TAYOUT
't57

2 Drag the handles at either end as desired to

rcmove or modify the barline connections.



Alternately, you could select all the staves to be

spaced.

4 Choose Realign from the Format menu.

The staves reposition themselves evenly within the

space between the top and bottom selected staff.

Extra space is inserted between systems and staff

grouPs.

INSERTING STAFF NAMES AND OTHERTEXT

Page text is part of the page layout, since it is

anchored to the page like staves. Page text consists

of titles, headers and footers, copyright notices,

exercise numbers, staff names, and other page-

related text items.

See "Page text" on page 107 for information about

how to insert staff names and other text'

MAKING A CODA SECTION
This section serves as an example ofhow you can

put Mosaic's page layout features together to create

a desired page layout.

Here is the procedure for creating a separated coda

section:

t Drag the right-hand margin of the staff above

the coda system to the left as far as desired.

You might try about half way, depending on the

music.

2 Drag the left-hand margin of the coda staff

system to the right. Be sure to drag it past the

opposite edge ofthe system above.

3 Enable layout mode by selecting Show Layout

from the page view mini-menu.

4 Double-click one of the staves in the coda

system to select the entire system.

5 Drag upwards to align the coda system with

previous system.

s

You can zoom in to fine-\une the placement.

6 Disable show layout mode by selecting Hide

Layout from the view window mini-menu.

s

NUMBERING EXERCISES

Staff indenting can be used to create numbered

exercises for method books or other training

material.

To create numbered exercises:

1 Create a page that contains a single staff

that fills the page.

s

+

2 Drag the left m

-:ry exercise.

! Enterpagetext
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I

Drag the left margins of each staff that begins a 4 As desired, modify the page size, margins, staff

layout, page text, staff connections, barline

connections, and other layout characteristics as

described in the sections in this chapter.Enter page text, if desired, at each indent.

LDING A PAGE 5 Save the page layout as a template (if it isn t
already).section provides an overvierv of the process of

a page layout.

are tlvo ways to approach building your own
See "Pasting a body page into a template view" on

page 162.
layout:

You can modify an existing page.

You can build a page from scratch.

6 Apply it to existing pages, or create new pages

based on the new page layout.

you have completed your page, you can apply
See "Copying and pasting page layouts" on

page 160 or "Regenerating pages based on a

template"on page162.to other pages in your document. You can even

a page template on which other pages can be

For information, see "Using page layout

on page 161,

Building a page layout from scratch
Here is an overview of how you can create a Page

from scratch:

ifying an existing page layout
1 Create a new view with a blank page.your own page layout based on an existing

layout is not a structured process.You can. Llse
2 Set the page size and adjust the page margins

(for page views only).
ofthe procedures described in this chapter to

the page to your liking.

the process would proceed as follows: 3 Add staves in the Staves window and name

them. Name the voices in the Voices window. If
necessary, add extra voices, name them, and assign

them to the desired staves.
Open a Mosaic fiIe that contains the page layout

you wish to modify.

could be a file that you created. It could be one 4 Set up the default staff spacing rvith the Staff

Layout Preferences command in the Format menu.sample template files that ship on the Mosaic

5 Drag all the staves from the Staves window onto

the page in the view window.Choose Save As and save the flle under a new

that describes the template yoll are about to
6 If desired, use the Realign command to adjust

the staff spacing evenly on the page.

the page view that contains the page.
7 Enter a staffbracket on each system and stalf

braces to connect staves where desired.

8 Connect the barlines in each staff system, if
desired.
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9 Add any desired page text, including staff names

to the left of each staff, a title at the top of the page,

a header and/or footet page number, and so on.

Once your layout is in the templates view, you can

use it as a model for pages in your regular views.

See "Pasting a body page into a template view" on

page 162 to see how to copy the page layout from

the body page to a template view in the Templates

window.

Making a title (first) page and a body page
When building your own pages, remember that the

first page of your score will probably have a

different layout than the body pages because it
needs extra space at the top for the title, subtitle,

composer, and other information. In addition, it
may have full staff names, whereas the body page

might have abbreviated staff names. Therefore, you

might begin by building the body page first, and

then make a copy of it and modify the copy to turn

it into a title (first) page.

For information about how to copy and paste a

page layout, see "Copying and pasting page

layouts" on page 160.

You can reduce the spacing of the staves slightly to

allow for more space at the top for the title.You may

even need to remove a system, if possible, to make

more room.

Using left-hand and right-hand (facing) pages

You can create left-hand and right-hand page

layouts for facing pages. For example, you might

design the pages to mirror one another, with the

footer at the inside margin and the page number at

the outside margin.

To make facing page layouts:

1 Build one of the t\,vo pages.

3 Modify the copy to make the opposite facing

pa8e.

You can then copy the left-hand page layout,

it on all of the left-hand pages in the view, and

Iikewise with the right-hand page. For

about copying a pasting page layouts, see the

section.

COPYING AND PASTING PAGE LAYOUTS

Mosaic allows you to select the page layout

teristics of a page and apply them to any other

page. This allows you to:

r Get a page to have the same layout as any

Page

r Build your own page layout and then apply it
existing pages in a view, or use it as a model for

pages added to the view

r Get all the pages in a view to have the same

layout

r Change the page layout of all the pages in a

Copying a page layout
To copy a page layout:

1 Be sure the view is in Show Layout mode by

selecting the Show Layout command in the view

window mini-menu.

2 Choose Select AIl from the Edit menu.

3 Choose Copy from the Edit menu.

The entire page layout is copied, including page

size, margins, staff system layout, staff

connections, and page text.

Pasting a page layout
To paste a page layout:

1 Copy a page iayout as described above.
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Be sure the view is in Show Layout mode by

the Show Layout command in the view

mlnt-menu.

Scroll to a different page in the view, or any view

the same type (page or galley).

A page view layout cannot be pasted into a

view. Likewise, a galleyviewlayout cannot be

into a page view.

Once you are displaying the desired page,

Paste from the Edit rnenu.

The page converts to the same page layout as the

page.

a page layout to all pages in a score
are t\vo ways to apply a page layout to all

ln a score:

pastethe layout and then it on each page in
score

USING PAGE LAYOUT TEMPLATES
A page layout template is a page layout that is used

as a model for the body pages in your music

manuscript. (The body pages are the regular pages

in a page view.)

Page Iayout templates serve two primary purposes:

1. They serve as a model layout for new pages

added to a score (Templates appear in the Add page

command as choices for a layout on which to base

the new pages.)

2. They serve as pristine, original copies ofthe page

layouts that you design which you can copy and

paste onto pages in your score.

Creating a new page template
Page templates are stored as a single-page view in
the Templates window. To create a new page layout

template:

1 Choose'lemplates frorn the Winclows menu.

the layout as a page layout template and 2 choose Add from the Templates windou, mini-
menu,the pages in the score using it as a model

for the newly generated pages

I may be suitable for shorter documents 3 (Optional) Click the name to pop-edit the

have a few pages. You'll most likely want to name.

Option 2 for long documents with many pages.
Opening a template view
To open a template view, double-c1ick the page

tempiate icon in the Templates window.
the previous section for Option 1. See

pages based on a template" on

162 for Option 2 Building a template layout from scratch
Once you have created a new template and opened

the template view, you see a blank page, just as you

do in a new page view From there you can build
the layout using all of the procedures outlined in

this chapter to set the page size and margins, staff

system layout, page text, staff names, headers,

footers, etc.

a page layout change to all pages in a

a change to all pages in a view, make the

on one page (either a body page or a

page), and then apply the layout of the

page layout to the rest of the pages in the

When applying the modified page layout to

of the pages in the view, you have the same
The only difference between building a page in a

template view versus a regular view is that if the

staves have voices filled with music, no music is

options as presented in the previous section.

NTROTTING PA6T I.AYOUT
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displayed. This allows you to get a sense of what the

layout is without music cluttering up the staves. If
at any time you would like to see the layout with the

music, copy and paste the layout to a page in a
regular view.

This applies the template page layout to the

page in the view.

Generating new pages based on a template
To generate one or more new pages in a view

on a page layout template:

Pasting a body page into a template view
Ifyou have already created the layout as a body
page in a regular view, and you would like to

convert it into a template, you can copy the layout
from the regular page and paste it into a template

view.

1 Choose Add page from a page view mini

See "Copying and pasting page layouts" on
page 160 for more information.

Applying a page layout template to a regular
page in a page view
To apply a template page to a regular body page in
a view:

1 Position the Templates window either next to or
on top of the page view.

2 Drag the page layout template onto the new

Pa8e.

2 Select the number of pages to be added.

3 Select the desired page layout template.

4 Click OK.

Regenerating pages based on a template

To do so, grab the icon as shown below and drag it
on top of the page.

To regenerate the pages in a view based on a

tempiate:

I Go to the first page of the range of pages you

want to regenerate in a page view.

2 Choose Delete page from the view window
mini-menu.

Remember, deleting a page from a page view

doesn t delete the music: just the page through

which the music flows.
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I

Delete the pages that you wish to regenerate'

Click OK.

Choose Add page from a page vierv mini-menu'

Add the same number of pages as you just

Choose the desired Page temPlate'

Click OK.

la,vout of theregenerated Pages match the Page

Line breaks and Page breaks are

Please notel Anv moclifications you have made

pages are lost during this procedure

they are replaced by the nerv page layout'
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R24 Printing

chapter explains how to: See "Page Setup ' on page 248 in the Quick
Reference chapter for detailed information about
the Page Setup options. Ifyou are printing at a

reduction on a laser printer, see "Printing at a

reduction'on page 166 in this chapter.

4 Click OK.

Get your music ready to print

Print the music

music at a reduction

Print horizontally on the page

The settings are saved with the view.

All of the options in the Page Setup dialog box,
including paper size, reduction level, and portrait/
landscape orientation are saved separately for each

view. As a result, each view can have its own,
unique settings. For example, you might want to

print the master score at 650lo on a laser printer to
fit all staves on the page and print the instrument
part views at 1007o.

you see is what you get (WYSIWYG)

what you see on each page in a page

is exactly what will come out of the printer
Often, you may rvant many views (all instrument
part views, for example) to have the same page

setup settings. To make page setup settings for
more than one view at a time:

you print the view. Therefore, you'll want to
up the page layout exactiy as you want before

print. See chapter 23,"Controlling Page

for important information about setting

page size, margins, stafflayout, title, page I Open the Views window
header/footers, etc.

2 Select the desired views.
the Page Setup settings
the page setup settings for a view: Shift-click the view icons or shift-drag over several

at a time.
the viewwindow.

Page Setup from the File menu.
3 Choose Page Setup from the File menu.

4 Make the settings as desired.

5 Click OK.

The settings are saved with each view.

the settings as desired.
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6ETTING READY TO PRINT
ilosaic can only print music in a page view. If you

:rter the music in a galley view, you need to place

:e staves in a page view See "Creating a view" on

- aqe 36 for information about how to do this. Once

:-e staves have been placed in a page view, they can

:e printed.
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New views are created with the last Page Setup

settings you made.

Using the Mosaic Smart Scaling option
The Mosaic Smart Scaling option allows you to

scale the document you are printing to any size.

This option provides better results in most

situations than the other standard scaling options

provided in the Page Setup dialog box. Leave the

standard options set to their default value ( 1000/o)

and use the smart scale option by typing in the

desired percentage.

PRINTING
Once you have set up the page layout exactly as you

want in a page view, you are ready to print.

The Print command allows you to print a single

page view, several page views at once, or all page

views at once. (Galley views cannot be printed.)

Printing a single page view
To print a single page view:

I Be sure the desired printer is selected in the

Chooser.

3 Choose Print from the File menu.

4 Select options for page range, number of copies

etc. See your N{acintosh and printer
documentation if you need more information
about these options.

5 Click OK.

You should have already done this in the process of
setting up the page size.

2 Make the desired view the topmost window. about these options.

To do so, either choose its name from the Windows

menu, click its title bar to activate it, or double-

click its icon in the Views window.

6 Click OK.

I Choose Views from the Windows menu.

This opens the Views window.

2 Select the views you wish to print.

To select a view, click its icon. To select several

adjacent views, shift-drag over their icons. To

several nonadjacent views, shift-click each

icon. To select all views, choose Select A11 from
Edit menu.

3 (Optional) Set up any desired options in the

Page Setup dialog box.

See "Page Setup" on page 248 in the Quick
Reference chapter for detailed information
the Page Setup options. Ifyou are printing at a

reduction on a laser printer, see "Printing at a

reduction" on page 166 in this chapter.

4 Choose Print from the File menu.

PRINTING AT A REDUCTION
Printing at a reduction (less than 1000/o) on a

printer is useful if the page size in your Mosaic

score is larger than the paper you are printing it

Printing several page views, or all page
To print several views at one time, or to print
views:

{t} For best results, always use Mosaic Smart

Scaling instead ofthe standard reduction option

the Page Setup dialog box. See "Using the

Smart Scaling option'on page 766.
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Virtual page in

Mosair

I

if you scored your music in Mosaic on

that are I I by I 7 inches, but you have to print
on a laser printer which only takes 8.5 by 11

paper, you need to reduce the pages to get

to fit on the paper. Poltrail Landscape

determine the reduction:
The easiest way to set up the page size in order to

print landscape is as follows:Determir.re the longer edge of ,vour virtual page

I Select Page Setup from the File menu.

this example, it is 17 inches, as shown belorv. 2 Select landscape printing.

11" 8.5"
(orresponding

paper edge
3 Choose Page layout setup from the page view

mini-menu.

Printer

paper 11" 4 Check the Use printer page size option.
1

Determine the longer edge

ofthe page in Mosaic,

The page size and margin settings below get

automatically set for you. The margin settings take

into account a thin area at the edge of the page

where the printer can't print anything.

the corresponding paper edge by it. 5 (Optional) Increase the page margins slightiy if
you want.

above example the corresponding paper

is the vertical length of the paper, which is l1 Dorit make them smaller or else your music will
get clipped at the edge ofthe page.Therefore, you would divide 1 1 by 17,

equals approximately 0.65. Thus, the

amount is 657o to get the I 1 by 17 page to

an 8.5 by 1 1 sheet of paper.

often, you ll divide the page heights, or, ifyou
horizontally, the page widths because

the longest edges. It is important to divide

edges when calculating the reduction to

that all the music will lit on the page.

LANDSCAPE
printing is when you orient the page

as shown below.
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25 Using Special Noteheads

noteheads and TAB noteheads palettes provide The selected notes'rvill change to the ner,v

notehead.variety of noteheads in your music, including:

X noteheads for percussion parts

Slash noteheads for chord parts in lead sheets,

Changing all noteheads in a voice
To change all noteheads in a voice:

parts, etc. 1 Double-click anynote in the voice.

Special effects, such as a hollow notehead on
This selects all the notes in the voice,

notes

An invisible notehead 2 Command-click the desired notehead in the

noteheads palette.
Numbered noteheads for stringed instrument

(rAB) Creating stemless chord slashes
A common notation in lead sheets is to indicate the

chords with stemmed chord slashes.

Another method is to write four stemless slashes in
a measure with chord symbols written as text

above the slashes. To create stemless chord slashes

in this fashion, see chapter 3l,"Creating Rhythm

Slash Notation".

lnvisible notehead

ing a single notehead
:hange a single notehead:

the desired notehead in the noteheads
The invisible notehead
The Noteheads palette provides an invisible

notehead. Apply this notehead as described above.

the notehead that you wish to change.
0n srreen

ng a group of noteheads
a group ofnotes:

the notes that you wish to change.

a selection box over them, or shift-click each ln print

to select it.

the desired notehead in the

palette.

Figure 25-1: Using the invisified notehead.
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26 Creating lnstrument Parts

chapter explains how to create separate Creating transposed staves for transposing
instruments
Transposing instruments are instruments whose

music is written in a different key than the actual

(concert) key. The key in which they are written is
determined by the transposition of the instrument.

For example, the Clarinet in A is written a minor
third higher than concert key. This convention
makes it easier for the instrumentalist to read the

music.

parts from a score by creating a

page view for each instrument. It also

how to handle transposing instruments

as Bb Tiumpet or Eb Alto Sax.

EW

you create a score view in Mosaic, you can

a separate instrument part r.iew for each

in the score.

the instrument parts for a large score with When you are creating instrument parts, you want

to notate music in the appropriate key for the

instrument. This requires creating a second staff

for that instrument, assigning the appropriate

transposition to the staff, and assigning the

instrument voice to the transposed staff.

instruments can be time-consuming, so be

to follow the shortcuts presented in this

Fortunately, instrument part views only
to be set up once. From then on, they

reflect changes made in the master

Likewise, changes made to each part are

reflected in the master score. The Here is an example:

can be viewed, edited, and printed separately

the score or printed all at once with the score.

instrument parts there are two important

Create transposed staves for transposing
(such as Bb trumpet or Eb alto sax)

Create an instrument part page layout template

preparations are discussed in the next two

section explains how to build the
Figurc 26-l:The A clarinet voice has been assigned to two different
staves: o non-transposed (concert pitch) staff for the conductor's
score (top) ond o transposed staff for the clarinet instrument patt
(bottom), which is written up o minor third. Notice thot the notes
belong to the some voice, but they are displayed differently on each
staff.

parts.

\ clarinet parl

\
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To create the transposed stafffor each transposing
voice:

To build an instrument part page layout

172

I Add a new staff and name it.

2 Set its transposition.

3 Assign the desired voice to it by dragging the

voice icon from the Voices window to the new staff
in the Staves window.

4 Proceed to the next section to prepare the page

layout template for the instrument part.

If you aren t yet familiar with the procedures

mentioned above regarding the creating of a staff,

see "Creating a staff" on page 28.

CREATING AN INSTRUMENT PART PAGE
TEMPLATE
rr&rhen you create instrument parts, you are usually
generating many of them. To make things easier,

you should build a page layout template before

creating the instrument parts, so that their format
is similar and so that you can generate each part
quickly.

A page layout template is a page Iayout (which

consists of page size, margins, staves, title,
instrument name, copyright notice, or other text)

thatyou have stored as a model from which to build
pages in views. For more information, see "Using

page layout templates" on page 161.

(3 You may need to make several instrument part
templates, depending on your score.You might
need a single stafftemplate for regular instruments,

a double-staff template for harp and piano parts,

and a single-staff-line part for percussion

instruments. In addition, you Il probably want to

make a title page version and a body page version
(with no title and page numbers added, for
example) for each type of template.

I Open the Templates window and choose Add
from the mini-menu.

2 Double-click the new view icon to open its

viewwindow.

3 Choose Template Layout setup from the mini-
menu and set the desired page size and margins.

4 Position the Staves window either next to or
top of the template page view window

5 Drag a staff into the page view window.

It doesn t really matter which staff you drag

because it only serves as a model for the staves of
the other instruments.

6 Arrange staves in a way that you prefer.

You can determine:

r The number of staves on the page

r The staff spacing

r The staffmargins and indenting

r The staffsize (enlarged or reduced)

For more information about controlling these

characteristics, see chapter 23,"Controlling Page

Layout".

7 Add a generic title, composer, instrument

copyright notice, and/or any preferred text you

desire.

When you are finished, the template should look
something like this:

(RTATIN6 INSIRUMENT PARTS

-.:ier creating th
:ove, yodll war

. lge two and be'
'.:le and added e

lo make a body
.:tle page:

1 Make the titlr
indow.

2 Choose Sele<

.re entire page J

3 Choose Cop

{ Add a new te

re Templates l

5 Double-clicl
.,'indow.

6 Choose Past

(REA]ING

rrebume*kE

-

-

--

i_-
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I choose Add

ro oPen lts pagc
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and margins.
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TITLE
3ublille

-rfter creating the title page template as shown

.bove, you 11 want to create another template for

:age two and beyond on which you ve removed the

:.tle and added a page number.

lo make a body page template that is based on the

::tie page:

I Make the title page template view the active

i'indow.

2 Choose Select All from the Edit menu to select
-jle entire page layout.

3 Choose Copy from the Edit menu.

I Add a new template view by choosing Add from
re Templates window mini-menu.

5 Double-click the nen, template icon to open its

,rrndow

6 Choose Paste from the Edit menu.

7 Remove the tit1e, add a page number, additional

staff, or whatever you prefer to modify the layout

for the body page.

The result will be a page that is similar to the title

Page:

0ne-$tEff instrument/bod pE e

1

Once you have created this template, you are readv

to create instrument views as described in the next

section.

CREATING THE INSTRUMENT PARTS VIEWS
Create the instrument parts views one at a time. To

create the first one:

f Add a new page view and open it.

2 Open the Templates window and drag the

instrument template onto the new page.
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-- lt>l L< Figure 26-2: To reploce a staff tn a VIEW with another staff, put

vtew Show Loyout mode, Drog the new stoff from the

window onto the label of the existing stoff on the Paqe. AII

This applies the template page layout to the vier'v

Page.

3 Position the Staves window either next to or on

top of the Page view window'

i,":T"se 
Show Layout from the page view mini-

of the otd staff on the page ore replaced by the new one.

6 Change any text references to the instrument

name on the page by double-clicking them to

the text.

7 If necessary, choose Add Pages from the mini-

menu to add more Pages to the vierv'

When adding Pages, Lrse the body page tempiate

you created for your instrument Parts'5 Replace the current staff on the page with the

approPriate staff in the Staves window'
8 To create another instrument Part, rePeat

through 7.To do so, drag the staff icon from the Staves

window and droP it directly on tuP of the name of

the staff currently on the page' In the example

below the Clarinet (transp o sed) staff is going to

replace Staff- 1 .Be sure to drag the transposed staff'

if there is one.
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H:1}dns 
With Multiplevoices on a

chapter covers the following important To select a voice using the command key:

volces

when you are working with
ron a staff: I Place the insertion cursor at the stafflocation

where you would like to enter the notes.

Choosing a voice in which to enter notes

Entering symbols and voice text

Entering groupings

Handling stem direction

Splitting and joining notes that share the same

2 Press command-up arrow or command-down

arrow to switch to the desired voice.

Keep pressing until you see the desired voice at the

bottom of the window as shown in Figure 27-l on

page 175.

3 Once you have selected the desired voice, start

entering notes.

NG NOTES AND RESTS

The other way to select a voice is to press the voice

indicator box and choose the name of the desired

voice from the pop-up menu provided:entering notes on a staff that contains

voices, you enter them in the same

as you would on a singie-voice staff. 4 Click the Voice indicator box and choose the

name of the desired voice from the pop-up menu.

before you begin entering the notes, you

to choose a voice into which to enter them. The cursor jumps to that voice.

current voice is displayed in the horizontal
Tenor

bar at the bottom of the view window as

below:
Bags

IHl

frf Using rests and invisified rests
When you enter multiple voices on a staff, you need

to use rests or, if preferred, invisified rests to

correctly align the beats in each voice.

27-l:Selecting the currcnt voice.

a votce
are two different ways to select a voice. One

is to hold down the command key and press

up or down arro'rv keys.

Jll

175

For details about creating a percussion staff, see

uhapter 28,"Creating a Percussion Staff".
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In the example below, rests have been entered in
the first three beats in the top voice so that the

fourth beat is aligned properlywith the fourth beat

of the bottom voice. On the right, the rests have

been invisified so that theywill not print.

Hower.er, groupings cannot cross voices' That

they cannot begin on a note in one voice and

on a note in another voice.

c- Endings are an exception to this rule

they are attached to measures of a score rather

any particular voice.

JJ
In cases where the music is dense, and you

easily drag the grouping over a single voice,

a more precise alternative way to enter the

grouping by selecting the start and end note.

JJ
To enter a grouping by selecting the start and

11ote:

Figure 27-2:: L)sing rests to properly olign notes in multiple voices on

o stoff. ln the second example, the rests hove been invisified, so they

will not appeor in the score when it is printed out.

I Click the note where you wish the grouping

begin with the arrow cursor to select the note.

ENTERING SYMBOLS AND VOICE TEXT

When entering symbols and voice text on a staff

with multiple voices and fairly dense music, you

want to be careful when inserting symbols (such as

articulations ornaments) and voice text (note-

specific text).It is e4sy to attach the symbol or text

to the wrong note.

2 Shift-click the note where you wish to end

grouping to select it and leave the first note

as we11.

3 Command-click the desired grouping in the

Groupings palette.

Therefore, the most reliable way to make sure you

attach the symbol to the desired note is to click the

notehead itself when inserting the symbol. The

symbol is placed at a default position, and you can

adjust the position from there by dragging it.

CONTROLLI NG STEM DIRECTION

Whenworkingwith multiple voices on a staff,

direction becomes very important.

Each voice can have a default stem direction:

up, stems down, or either.

For detailed information about inserting symbols,

see "Inserting a note-specific symbol" on page75.

For information about inserting note-specific text,

see "Voice text" on page 104.

ENTERING GROUPINGS
Groupings can be entered on a staffwith multiple
yoices in the standard fashion: by selecting the

desired grouping from the palette and dragging

over the desired notes.
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stem direction when you assign When stems are set to both up and down, stem

direction is determined by the note placement on

the staff: notes in the middle space and up are

stems down. Notes below the middle space are

stems up.

you flrst add voices to a staff, you can set a

stem direction for each voice as you add it:

Do this:

Option-drag the voice from
the Voices windowto the staff
in the Staves window

3 Click OK to confirm your choices.

Flipping stem direction
To flip stems:

1 Select the notes whose stems you wish to flip.

2 Choose FIip from the Format menu.

Command-drag the voice
from the Voices windorv to
the staffin the Staves window

Command-option drag the
voice from the Voices win-
dow to the staffin the Staves

window

multiple voices at the same time
SPLITTING NOTES THAT SHARE THE SAME
STEM

Regardless ofvoice, notes entered on the same beat

with the same stem direction are placed on the

same stem.

drag multiple voices at the same time when

them to a staff, the stem directions are

configured. For example, ifyou drag

voices to a staff, the top two voices are

stems-up, and the bottom tlvo voices are

stems-down.

However, sometimes you might want the notes to

be displayed on a separate stems, such as to notate

a split part:

I

---d-']r-
I

--f-
the default stem direction for each

the default stem direction for a voice:
Figurc 27-3: Examples of notes on the some beat but with separote

the staff icon in the Staves window.
stems.

To split notes that share the same stem:

1 Select the note or notes that you wish to split.
X)u can select the staff and choose

from the mini-menu.

the stem direction icon next to each voice To select a single note, click it. To select a group of
notes, drag a selection box over them. To select all

notes in a voice, double-click any note in the voice.

2 Choose Split Notes from the region menu.

the desired default stem direction for the

RKING WITH MUI.TIPLE VOI(E5 ON A 5TATT
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At this point, you won t see any difference on the

screen; however, the note(s) has been split from its

original stem, and you can flip its stem or move it
independently as shown in Figure 27-3.

To fix a note or accidental collision, drag the

noteheads or the accidentals horizontally.

3 Ifyou wish to flip the stem ofthe separated note,

select it and choose Flip from the Format menu.

I-l- --+Tn-f[---r--

4 If you wish to move the separated note, drag the

notehead.

To fix a stem collision:

1 Click the stem to select it.

2 Alternative 1: shorten the stem by dragging

handle.

CONNECTING NOTES ON A BEAT TO THE
SAME STEM

Due to stem direction, editing, or other circum-

stances, you may encounter a situation where you

have two stemmed notes on the same beat whose

stems are currently separated, and you wish to join
them to the same stem.

#r--d-

I

)--T-
--J---i----

3 Alternative 2: flip the stem by choosing Flip

from the Format menu.

To join the stems:

I Select the note you wish to join to a stem.

2 Choose Cut from the Edit menu.

3 Select the stem.

4 Choose Merge from the Edit menu.

EDITING VOICES SIMULTANEOUSLY
Multiple voices on a single staff are edited

neously in the same fashion as multiple voices on

separate staves. For information, see "Editing

several voices at once" on page 137.

----,r--
-t--
-f-
AVOIDING COLLISIONS
When you are working with multiple voices on a

staff, you will often run into a situation where

notes, accidentals, and stems collide.
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28 Creating a Percussion Staff

chapter provides some tips on how to build a ,tri1i1ffi lgli[!;,.i\ staues tttntiiled -2]
@

Treble

)' B"rt

l9 Voice-l5

il8:.

il8..

t"

staff.

3 Click the staffname to pop-edit it.

Creating voices for each drum part on the staff
Next, you need to create a separate voice for each

drum part on the staff:

1 Open the Voices windor,r'.

UP THE STAFF
are several things you'll need to do to set up 2 Hold down the option key and select Add from

mini-menu.percussion staff before entering music.

you need to create the staff and assign voices 3 Add the number of voices you will need.

4 Click the names of the voices to pop-edit them.

the staff
the percussion staff: Use the down arrow key to scroll the pop-edit box

to the next voice.

Add staff (empty) from the Staves

mlnl-menu. 5 Assign a note range to each voice.

For unpitched percussion, such as a snare drum,
the note range consists of a single note. For

example, if the snare is displayed on the center staff
Iine, the note range would be 83 to 83.

the hierarchical menu, choose one of the

percussion clefs provided.

Assigning the voices to the staff
Now you need to assign the voices to the staff:

I Select the voices.

179



. - ANGING N

: .. 1OL1 hISi

. -il-notehei
. i {r the \'ar:

. tiads as',t

: .her case. \

.read YoLl I

,, change a sir

: .lect the c1.

:.tE-.

i Click the no

.:,change seve

:e voice:

'tr Select the nr

:r-ou want to c

:ruble-click ar

;r"rig6.

. -ommand-
:eheads pa1,

::PARATINC
.ren you enti

.-n direction

. ornaticalil':
rt erref, yOLt t

'--arate so tha

r\vn in the t(

-tt,.t.t.1.t

(REATING

I

'triffil..Elfllli,\ staues {drum

E StarT-l

: 6 sntt*
I cg Cun,b3l,

!/\I
lli
H}

2 Drag them to the drum staff icon in the Staves

window.

5 Click the stem icons of the voices to set the

default stem direction.

The voices appear beneath the staff. A voice can be stems up, stems down, or both.
(Both means that the stem direction is

on the pitch.)

6 Click OK to confirm your choices.

Displaying the drum staff in a view
To display the staff, drag it into a view:

Setting up the staff
You can set up the staffas a single line staff, and you

can hide ledger lines:

1 Open a view

You can add the drum staff to a new view or an

existing view.1 Double-click the icon of the drum staffin the

Staves window.

Alternately, you can select the staff and choose

Configure from the mini-menu. The Staff

configuration dialog appears.

2 Drag the drum staff icon into the vierv at the

desired location.

For more information about adding staves to a

view, see "Displaying staves in a view" on page

ENTERING NOTES ON THE STAFF

Once the drum staffhas been placed in a view
can enter notes into each voice in the standard

fashion.

Make sure that you enter the notes in the proper

voice. The current voice is displayed in the scroll

bar at the bottom of the view window.

2 Click the stafftriangles next to the stafflines to

turn off all the staff lines except those that you

prefer.

Notes will be inse(ed by

keyboard or mouse into th€

kick voice.To change voices,

press command-up anow or

command-down arrow.0r

choose the desired voicefrom

thevoice pop-up menu atthe

bottom ofthe window.

M

'..] 
,1 'l ,l

The arrow at the left of the barline indicates the

center line. Ifyou want a single-iine staff, leave this

staff line turned on.

3 Uncheck the Show ledger lines option.

4 If necessary, drag the voice icons to arrange the

voices in the order that you prefer.

To switch voices, press command-up arrow or
command-down arrow. Or choose the desired

voice frorn the pop-up menu at the bottom of
window.

S tEff

tl
:)
:)

u
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NOTEHEADS To separate the stems:

you first enter the notes, they'll appear as

noteheads. In addition, anytime you add 1 Select the notes in one of the r.oices you r,vish to
separate.to the voice, they'll appear with regular

as we11.

either case, you can change the noteheads to any

You only have to select notes in one of the voices,

not both.

you prefer, such as an X or a slash.
2 Choose Split Notes from the Region menu.

change a single notehead:
REBEAMING
While working with multiple voices on a drum
staff, you may flnd that notes need to be rebeamed.

Select the desired notehead from the Noteheads

Click the note you wish to change.
'Io quickly rebeam the notes:

change several noteheads, or all noteheads in I Make sr-ire that Auto Beam is selected in the

Format menu.VO1CE:

Select the noteheads you wish to change. When Auto Bearn is checkecl, the notes w111 be

bearned in groups that conlorm r,ith the current
meter. If Auto Beam is uncheckecl, the notes u,i1l all

be beamed together.

want to change all the noteheads in the voice,

any note to select all the notes in the

2 Select all the notes that you wish to rebeam.

Command-click the desired notehead in the

palette. To select a group of notes, a measure, or a range of
measures, drag a selection box over them. To select

all the notes in a voice, double-click any note in the

voice. To select all notes in all voices, shift-double-
click a note in each voice.

TING NOTES ON THE SAME STEM

you enter notes in voices tl-rat share the same

direction, the stems of the notes connect

so that the notes share the stem.

you maywant the stems to remain 3 Choose Beam from the Region menu.

so that they can be easily differentiated, as

in the top two voices below:

.t .H.t I i1 I I n 1

t' /.' t'ttl
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29 Special formatting

chapter covers several miscellaneous 2 Choose Split Notes from the region menu.

At this point, you won t see any difference on the

screen; however, the note(s) has been split from its

original stem, and you can flip its stem or move it
independently as shown in Figure 29- 1 .

issues. It explains how to:

Split a chord note from the chord onto its own

Display notes on a different staff above or below

staffon which the voice lies 3 if you wish to flip the stem of the separated note,

select it and choose Flip from the Format menu.
NG NOTES FROM A CHORD
the same stem, regardless of whether they

same voice as other notes in the chord, +---{--rbe split from the stem. This a1lows you to

them differently, such as to flip their stem in
opposite direction, or move them slightly to the

or right.

I

--1--F-
---f-----f---

4 If you wish to move the separated note, drag the

notehead.

l: Exomples of o note that has been separated from its

WRITING CROSS-sTAFF NOTATION
In piano scores or other keyboard notation, a line

of notes being playingbythe left or righthand may
trayel across to the other staffmomentarilyin order
to clearly notate the pitches. To indicate that the

notes should be played by the same hand, they are

connected in some way, either by a beam, a slur, or
other grouping. If the note is a single note, its stem

will extend all the way back to the original staff.

ond formatted os a separote note.

split a note from a chord:

the note or notes that you wish to separate

the existing stem.

a single note, click it. To select a group of
drag a selection box over them. To select all

in a voice, double-click any note in the voice. To write cross-staff notation in this fashion, see

"Beaming across staves" on page 65.
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30 lm

MI tsifiils 
and Exportins standard

chapter explains how to open and save

MIDI files. It explains:

What a MIDI file is

Whyworkingwith MIDI files is beneficial to you

How to open (import) a MIDI file

How to save (export) your music in Mosaic as a

file

Please notel If you are familiar with handiing

files, this chapter contains no surprises: you

them with the Open command in the File

and you save them by choosing Save As and

the MIDI file format option before

Save. See "Importing a MIDI file" on

186 for a description of how the MIDI data is

into and from voices and tracks.

T IS A MIDIFILE?
is an acronym for Musicallnstrument Digital

It is a standard specification that was

by electronic music instrument

and music computer companies in
early 1980's to standardize the way in rvhich

music instruments and computers

file conforms to the MIDI standard speci-

Since many companies subscribe to the

a MIDI file can be read (opened) by any

that supports the standard. This provides

between products, making it easier for
to work on your music with any companyt

file contains musical performance

what notes were played, when they
played, how hard or softly they were played,

and so on. This information is recorded by a

sequencer, and then the sequencer stores and

makes a record of the performance information as

a MIDI flle.

For example, you can record an entire song--as
many tracks as you need--into a sequencer like
Performer, and then make Performer save your
performance as a standard MIDI fiie. The MIDI file

contains all the nuances ofyour performance, and

it stores all the tracks in their original form as

separate tracks.

WHAT DO MIDI FILES OFFER?
Mosaic's MIDI fi1e capabilities allow you to transfer

music to and from other music software that also

opens and saves MIDI files, such as:

r Anothernotation program

r A MIDI sequencer such as Performer

r Music soltware on another type of computer,

such as an IBM PC or compatible

Transferring files to and from Performer
MIDI files offer a way for you to play your music

from a MIDI keyboard, record it into a sequencer

such as Performer, and then transfer the sequence

into Mosaic to notate and print it.

Playing in music from a keyboard or other MlDl
controller
Recording and playing back music using a MIDI
sequencer iike Performer offers many benefits.

Some of the most important ones are as follows:

r If you have good keyboard skills, you can enter

music much more quickly and efliciently by
playing it into a sequencer than by typing it directly
into Mosaic.

185
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r Ifyou cannot play or type very fast, but you have

a MIDI controller such as a guitar or wind
controller, you can enter notes more efficiently
with it.

r You can hear the music as you enter it, which
allows you not only to enjoy listening to it, but also

to check it for pitch and rhythmic errors.

r MIDI sequencing software like Performer offers

powerful editing capabilities that Mosaic does not
provide, such as customized transposition
mapping.

IMPORTING A MIDIFILE
Mosaic intelligently interprets the musical data that
it reads from a MIDI file. Mosaic correctly notates

unquantized MIDI data, so there is no need for you
to quantize your MIDI file before you open it with
Mosaic.

To import (open) a standard MIDI file into Mosaic:

1 Choose Open from the File menu.

2 Select the MIDI file you wish to open.

3 Click Open.

You may see a dialog that asks you about splitting
tracks into piano staves. Choose the desired

option.

There are three types of standard MIDI files:

r Format l: MIDI data is saved as separate tracks.

r Format 0: MIDI data is saved as a single,

multichannel track.

r Format 0/tempo and meter information only.

Mosaic can open all three types.

How MlDl file tracks are imported
When opening a MIDI file, Mosaic:

r Places the music in each separate MIDI
in a separate voice and staff.

r Preserves track names by making them the

of the voice and staffon which the music is

r Chooses the appropriate clef (bass or treble)

each track. Ifmost ofthe notes are above

it uses a treble clef; if most notes are below, it
bass clef.

r If the track contains many notes in both the

and treble clefs, Mosaic gives you the option of
splitting the track into a grand staff with a

and bass clef.

EXPORTING A MIDIFILE
When exporting a MIDI file, Mosaic saves each

voice in the flle as a separate track. The voice

becomes the track name. Meters and key

signatures are preserved.

To export a MIDI file:

I Choose Save As from the File menu.

2 Typ. a name for the file.

3 Select the MIDI file format option.

4 If desired, choose a disk and folder in which
save it.

5 Clicl' Save.
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TEMPLATES TO IMPORTED MIDI Now copy the Page View Layout from the Piano

tmplate File. To do so:
section explains how to applyMosaic page

templates to a Standard MIDI File (SMF) or 1 Open the Views window from the Piano staff
template file.Composer" file that you have just

in Mosaic. This procedure may be useful if,
example, you want use our template flles (i.e. 2 Double-click the Page View icon in the Views

window to open the PageView.Staff Template) as the page layout for an

file. Because you won't have to create the
3 Select Show Layout from the mini-menu.

4 Choose Select A11 from the Edit menu.

5 Select Copy from the Edit menu.

iayout format yourself, this will save time.

the purposes of this tutorial, we will use a

piano example saved as a Standard

File and apply the Mosaic Piano Staff

included with Mosaic in the Template

folder.

Procedure Outlined
basic steps for applying a Mosaic Template

a template f,le to an imported file are:

Open the Standard MIDI file and the Template

the Page View layout from your Template

and paste it onto a new Page View ofyour
MIDIIile. The layout is now copied to the clipboard. To apply

the layout onto a new page in your Standard MIDI
file, you must create a new page and paste the

layout onto the page. To do so:

staff repiacement to replace the Staves and

with the Staves and Voices in the Standard

file.

the newly formatted Page to a Template
1 In the Standard MIDI file, Open the Views

window.

the Template to pages ofyour Standard
2 From the mini-menu, choose Add Page.

File Page View. 3 Double-click the Page View icon to open the

blank page window.
Started
Iaunch Mosaic and open a Standard 4 Select Paste from the Edit menu.

file (SMF). Mosaic will convert the SMF.

open the Piano Staff Template included in The layout is now pasted onto a new page. This
page layout includes the same Staves and Voice

assignments from the Piano Staff Template file.
(Note: Mosaic has added these additional Voices

files folder on the Mosaic Utilities
You should now have two Mosaic liles open.
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and Staves the bottom of the Standard MIDI file's

Voices and Staves windows). Since we need to
create a page layout template with the staff and

voice assignments from the Standard MIDI file, we

need to re-assign the current Voices and Staves

with theVoices and Staves from the Standard MIDI
file. This procedure is called staff replocement.To

do so:

I Choose Show Layout from the Page View
menu.

2 Choose Select AII from the Edit menu.

3 Choose Copy from the Edit menu.

4 Open the Templates window in the

Standard MIDI file.

Hi:" 
Show Layout from the Page View mini- 5 Choose Add from the Template window

menu.

2 Open the Staves window of the Standard MIDI
file.

6 Optional: click the Template name to
and rename the Template.

3 Select the first staff in the Staves window
(Treble, in the MIDI file), and drag the staff icon
onto the Page View so that the name of the first staff
in the PageView (Right Hand Staff,from the Piano

Template flle) highlights.

Type in Title Score Template, for example.

7 Double-click the template icon to open a

TemplateView.

8 Choose Paste from the Edit menu.
Note: after staff replacing, the events frorn in the

Standard MIDI file flow thru the once empty staff. You have just loaded a Template fi1e, which you

now appiy to your converted Standard MIDI
This procedure works with any file's staff

Subtitle

&rrebk i :ai
EBss :ca : :

leB& : it:
Bknhhdnr :c. ! :

B ftOlh#nf :ca : :

even full orchestral scores. Repeat the above

procedure for every Template you want to load,

including full score templates and part

To utilize the newly created Template:

1 Open theViews window of the converted

Standard MIDI file.

2 Choose Add Page from the Views window
menu. Double-click the page icon to open a

PageView.

4 Repeat this procedure for the Bass clef staff. 3 Choose Page Layout Setup from the Page

mini-menu.
After replacing the staves in a Page View, we can

now create usable templates in the converted

Standard MIDI file. To do so:

4 Select the Title Page Template in the Page

Setup dialog box.

5 Click OK.
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31 Creating Rhythm Slash Notation

slash notation as shown below in Figure 3 Once you have entered the desired rhythms,
change the noteheads to the rhythm slash notehead

at the bottom ofthe noteheads palette.

1 is common in charts produced for
purPoses.

produce r\thm slash notation such as this:
slash noteheads

Place the insertion cursor on the center line of
staff.

sure the insertion cursor is in the voice that you

See chapter 25,"Using Special Noteheads" for more
information on how to do this. This chapter

provides many useful shortcuts for changing
noteheads.

if you have more than once voice on the staff.

Enter regular notes in the rhythm that you 4 If you would like to remove the stems, select the

notes and choose Hide Stems from the Format
menu.

like.

example, if you want four quarter-note slashes,

four quarter notes. Notice that the notes are

on the center line. This aligns the slashes

with respect to the staff. You are not

to quarter notes, however. You can enter

duration that you like. 5 You can now enter chord symbols above the

rhythm slashes. See chapter 17,"Chord Symbols"

for more information.

Ah Bh Am7 c7 a7 87 At c

A, cz Bb7 A Bb^7 A7 c Bb Eb At

3 I -l : Rhythm slosh notation.
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12 Creati ng G u itar Ta blatu re

chapter explains how to create a tablature staff Setting up a Guitar TAB staffis a multi-step

process:accompany a standard notated staff. This can be

for guitar parts as shown in the example in

32-t. 1 Create two grouped staves, one treble clef staff

for standard notation and one TAB staff for
tablature notation.chapter assumes that you are familiar with

standard notation in Mosaic via the

keyboard or MIDI instrument, and that 2 Configure TAB staffwith six staff lines.

3 Enter note durations on the appropriate staff

line.

are familiar with the fretboard of the

that you are writing for.

EXPLAINED 4 Alter the noteheads to fret numbers using the

TAB noteheads palette.

5 Hide Stems, if you choose.

(TAB) notation graphically represents a

instrument's fretboard. By placing a TAB

on the appropriate line, the string and

of any note can be indicated. For example:

While the examples in this section concentrate on

guitar TAB, these techniques can also be applied to

bass guitar, dulcimer and banjo. Let's get started.

6th nring,lrd fret 6th string, lrd fret
'lst String,open

played toqether

open E chord

BOUREE
J. S. Bach (1685-1750)

Lute Suite in E minor, BWV 996

32-l : Tablature example.
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Getting started
To begin, open a New File. To duplicate the

example above, we must create two staves in the

Staves window and four voices in the Voices

window.

8 In the Staves window, double-click on the

Guitar staff icon to open the Configure Staff

window.

Click in the Stems column to assign the top

I Choose Staves from the Windows menu.
with stems up and the bottom voice with stems

down.

2 Choose Add (w/Voice) from the Staves window
mini-menu to add a staff.

Configuring the TAB staff
Since each line of a TAB staff

strings on the instrument, you must create a

You should then have two staves in the Staves

window
with stafflines equal to the number of strings

the instrument. In our example, we have

3 (Optional) Click on the staffnames to pop-edit
the names.

guitar TAB staff with six staff lines. However, if
were writing for the bass guitar, you would

Name the first staff Guitar and the bottom staff

Thb-Guitar.

configure a staff with four staff iines. To

guitar staff:

4 Choose Voices from the Windows menu.

1 With the Staves window open, double-click

Thb-Guitar staff icon to open the Staff

Configuration window.

5 Press the option-key and choose add from the

Voices Window mini-menu. 2 Click the staff triangle below the last staff

add an additional line.

Add tr,vo additional voices (you should now have

four total voices in theVoices window). You should now have six stafflines.

6 (Optional) Click on the voice names to re-name

your voices.

Name your voices upper, lower, tab, tab2.

7 With both the Staves window and Voices

window open, drag your unassigned voices to the

Staves window.

You should have two voices assigned to the top staff
and two voices assigned to the bottom staff.

3 Click OK.

Buitar
uppef il

l)

l)

€tib iJ
Cg t.b2 : f xg

<t:':n-i[

E Shov Le€er Lines

Staues SuitB in

192
(REATING GUITAR TABTATU

:

r ?resstl

*=tlno

5 Follow

:r: iES.

':-

\

I

l=i-.

C
t-

I-t

for sl.ffT.b-Gritrr



data onto the TAB staff 3 Change the clef to TAB.

enter yoLlr staves into a GalleyView:

With the Staves window open, select your Thb-

You are now ready to input music. You should

alreadybe familiar with inputting standard

notation via the Mac keyboard or a MIDI
keyboard. For the purposes of this tutorial, we will
concentrate on inputting onto the TAB staff. Click

onto your TAB staff and enter notes on the

appropriate string. To enter the TAB example

below:

stafficon and drag it onto your GalleyView.

should now have tlvo staves in your Galley

Place the cursor on the Thb-Guitar staff in your

View and choose Change Clef from the

menu.

Click onto the staff so you have a blinking Be sure that you enter the correct duration and

appropriate sting on the TAB staff.You should

never have a note entered in a space on a TAB staff.

on your TAB staff.

Use the up/down arrow keys so that your
cursor appears on the bottom staffline, Once you have the lower TAB line entered above,

we can begin to alter your noteheads to TAB

noteheads. Once again, the notehead numbers

represent the fret location on the string. To change

the noteheads:

line represents the low E or 6th string of the

Select the eighth note duration from the Notes

1 Open the Noteheads Palette from the Palettes

menu.
the Macintosh Return key to eRter two

notes. 2 Click number 3 in the Noteheads palette to

select it.
the above procedure for the rernaining

Number 3 will appear highlighted in the palette.
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3 With the arrow cursor, click onto the first eighth

note on the TAB staff in the GalleyView.

Your notehead will change to a 3 (third fret ofthe
6th sting or G below middle C, the corresponding
pitch from the Guitar staffabove).

4 Repeat this procedure for the remaining notes.

Speed entry ofTAB noteheads
You can speed up the entry of TAB noteheads by
selecting identical notes and command-clicking
the TAB notehead number. This will alter multiple
notehead types (i.e. change all selected noteheads

to 3). To do so:

t Drag a select box around a group of notes.

To select non-adjacent notes, hold the shift-key
down and ciick onto the individual noteheads.

2 Hold down the command-key and click onto a

TAB notehead in the TAB palette.

AII selected notes will change to the appropriate
TAB number.

3 Repeat this process for similar groups of
noteheads.

Cleaning up
The string and fret are now indicated on your TAB

staff. To clean up the file, unbeam and hide the

stems. This will make the TAB staff look nicer by

only displaying the fret number and string.
forms of TAB notation display beams and

thus, this step is optional. To unbeam figures

are beamed:

1 With the arrow cursor, click onto the beam.

It will display as selected when the "handles" on

beam display.

2 Press the Delete key on your Macintosh
keyboard.

The selected grouping will unbeam.

To Hide Stems in the score:

1 Drag a select box with the arrow cursor to
all the events in you TAB staff.

The notes will appear white and enlarged when

selected.

2 Choose Hide Stems from the Format menu.

You should now have a score which resembles

score below. Continue the entry procedure to

complete the upper TAB voice and the

measures.

You may also want to make the numbered
notesheads larger. To do so, select them again,

choose Scale from the Format menu, type in
and click OK.
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Exporting Music Notation to Other
Programs

provides you with the ability to export program by pasting a captured PICT from Mosaic
into the Scrapbook. If it looks correct in the

Scrapbook but incorrect when pasted into your
graphics program, then your graphics program
probably does not support the conversion of these

PICT elements.

notation to desktop publishing, word
graphics, or other software. Mosaic

two different ways to accomplish this:

Pasting Mosaic notation via the Macintosh
into the other program (as a PICT

Exporting music notation from Mosaic as an

Pict Capture onlyworks in page views. The menu
command greys out for galleyviews. If you have

material that you would like to export, place it in a
page view.

To use PICT Capture:

I Open the page view that contains the music.

PostScript (EPS) file

general, the pasting method is easiest--
ifyou are pasting short excerpts--and

work weli for most desktop publishing

Dedicated graphics and graphic
programs usually do better with or require 2 Choose the desired zoom level from the view

window mini-menu.files.

PICT CAPTURE

33

PICT Capture command lets you export any

of a page, from a single note to the entire

as a standard PICT graphic. From the

the notation can be pasted into the

Scrapbook or any program that

standard PICT graphics. Exported music
its engraved appearance when printed on

printers such as laser printers ar-rd

machines. Mosaic'.s PICT or-rtput

the best print quality that 1,our printer is

of.

Some graphics programs do not support the

of PICT eiements such as "clipping

or "imbedded PostScript", which is how
creates some of its non-font graphics such

and beams. Mosaic's PICT output to these

may produce unpredictable results. Most
processors and page layout prograt-ns do not

this problem. You can test your graphics

Mosaic captures notation exactly as it is displayed
in the view window, including the current
magnification setting for the view. The

magnification setting is not crucial if the graphics

software you are exporting to allows you to scale

PICT graphics to any size.

3 Choose PICT Capture from the Edit menu.

The cursor turns into a cross-hair.

4 Drag a selection box over the region you wish to
capture.

Mosaic captures exactly what you select within the

borders of the selection box. You don't need to

include whole objects. In the example below, the tie
and stafflines that extend past the edge of the

selection box will get cut off at the selection box
border.
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Uieu
1 Make sure that LaserWriter 8.1.1 (or higher) i-i

selected in the Chooser.

2 Open theviewyouwishprint.

3 Choose Print from the File menu'

4 For the destination, choose File.

- 

PltT(apture

selection box

That's itl When you release the mouse, the region

you selected is placed on the Macintosh clipboard

as a standard PICT graphic with embedded

PostScript.

5 Switch to other softn are and use the Paste

command in the Edit menu to place the exPorted

music.

5 Click Save.

A dialog box appears asking you for informatior

about the fi1e. Try choosing the options shown

below. You may need to experiment with them t.'

achieve best results with your graphics Program

fi tPs Files for Hfer v E Centns 650 H0

Iles k t op

Neu E

freate File: f,a trce I

F{U Song-Foge ll Saue

formffti

o ffsilr

EPS M6E slondErd Preuieu v

O Einnru

Font inclusion:

O Leuel I f,omFEtible
O Leuel 2 0trlu

Rll v

t- Don t use the "Postscript ]ob" option. It does

not create an EPS file and most programs won't b.

able to import it. Only use the EPS options.

6 Click Save.
t'- This procedure requires LaserWriter 8' I .1 (or

higher). For information, see "LaserWriter 8. I .1

(or higher) is required for EPS export" on page B in

tlre Mosaic Getting Startedbook.

To export music to an EPS file:

The resulting fiIe can be imported into the other

program; consult the documentation of the othe :

program for information.

EXPORTIN6 I\4USIC NO]ATION TO OIHER PROGRAM)

saue

cooies:I Page*: O flll O From:

Pdp er

: air 8ll

, Ieslination....
.Printer i FilqE

'8 riro HetB Ii-r-
;......... ...........- ..........i

Printer: "IaserJet 4"

To:

Sour(e

gfirstfrom:@

4
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Fiqure j3-1:This is the lVlosaic excerpt frcm above pasted into
FrameMoker, the desktop publishing program used to produce this
manual.

\&rhen you import a lvlosaic-generated PICT into

another application, make sure that all Mosaic

fonts (Sonata, NIosaicFont, and FretBoard) are

installed in the s),stem and available to the other

application.

EXPORTING AS A POSTSCRIPT FILE

The Macintosh system software a11ows you to

export a page of music as an Encapsulated

PostScript (EPS) File on disk. The resulting hle can

be imported into other softu,are programs which

import EPS files. This process is a way to export

music into Postscript cornpatible page-layout

programs like Aldus Freehand and Adobe

Illustrator.

-
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ER 34 MlDl Recording and Playback

provides you with the ability to record, play 2 Press in the "Play/ch' column next to each voice

and choose the desired MIDI device and channel

from the pop-up menu that appears as shown in
Figure 34- L

and step-enter music via a MIDI keyboard or

instrument.You can:

Step-enter notes (one at a time) from your MIDI

Record music in real time by playing along with
metronome click

Split left- and right-hand keyboard parts onto

The list of MIDI devices in the pop-up menu is

provided by FreeMIDI.You can change what's in
the list by using the FTeeMIDI Setup program that

is included with Mosaic.

separate staves

NG PLAYBACK FOR EACH VOICE
has the ability to play each voice in 1.our
score on a MIDI instrument, such as a

Figure34-l:Choosing a MlDl playback device ond chonnel for o
voice.The Iist of MlDl devices is provided by FrceMlDl.You can change
what's in the list by using the FreeMlDl Setup progrom that is

included with Mosaic.keyboard or sound module, that is

to your Macintosh via a MIDI interface.
Choosing a sound (patch) for each voice
The "Patch'column in the Voices rvindow provides

a pop-up list of MIDI patch changes for each voice,

from which you can choose the desired patch. The

pop-up patch list either displays generic names (i.e.

"Patch 1 ","Patch 2", etc.) or the actual names ofthe
sounds in the NIIDI device chosen in the"Play/Ch'
column. For example, Figure 34-2 shows the pop-

up patch list for the Proteus/2 sound module from
E-mu Systems.

voice in the Voices window can be assigned to

MIDI channel on any available MIDI
Before you begin recording and

MIDI data in Mosaic, the hrst thing
want to do is make these playback

To do so:

Open the\bices window
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Preparing for MlDl recording and playback
Before ,vou proceed with this chapter, you must

:nake the preparations necessary for MIDI
:layback and recording in Mosaic. These

:reparations are explained in detail in chapter 3,
-Preparing for MIDI Recording and Playback'

page 13) of the Getting Srarred book that

.ccompanies this Usert Guide.



Any FTeeMlDl-compatible patch librarian
software can provide patch names as shown in
Figrre34-2 for most popular MIDI synthesizers

and sound modules. Examples of such software

are:

r PatchList Manager"M, a simple librarian program

that is included free of charge with Mosaic

r Unisyn'", Mark of the Unicorn's universal

editor/l ibrari a n softr,vare

Figure 34-2: A generic patch list on the left, and the patch list for the
E-mu Systems Proteus/2 sound module on the right. Any FreeMlDl-
compatible patch librarian software can provide patch nomes as

shown on the ight. Exomples of such software are the PatchList
Monoger program that is included free of charge with Mosaic, and
Unisyn, Mark of the Unicorn's universal editor/librarian software.

If you do not have Unisyn or another FTeeMIDI-

compatible universal editor librarian program, and

you would like to see patch names as shown on the

right in Figure 34-2, see chapter 7,"Using Patchlist
Manager" (page 83) in the Mosaic GettingStarted

guide.

Using a different sound or instrument for each
voice
If you have a multi-timbral MIDI synthesizer or
MIDI sound module (one that can play different

sounds on several MIDI channels simultaneously),

you can hear Mosaic play multiple instruments

simultaneously by assigning voices in your
manuscript to different MIDI channels on your
sound module. Then select the desired patch on

each channel ofthe sound module.

If your synthesizer is not multi-timbral, all voices

will playback using the same sound. See your
MIDI dealer for information about the many

inexpensive MIDI sound modules now available.

Patching thru to a sound module
Once you have assigned each voice to the proper

MIDI channel and you have selected the desired

"patch'(sound) on each channel ofyour sound

module,you will always hear the correct sound

when you record into Mosaic. This is because of
Mosaic's patch thru feature. Patch thru takes any

notes received by Mosaic and echoes (plays)

through the MIDI channel(s) assigned to the

which currently holds the insertion cursor, as

shown below:

MlDl (able
(able

ffi

l'
MlDl sound module

Figure j4-3: Here is an overview of how Potch Thru works.You

the voice thot currently holds the insertion cursor. lt then sends

note to thot channel. A sound module set to receive on that
plays the note using whatever sound (patch) is currcntly
thot channel.

To switch to a particular sound, just place the

insertion cursor in the voice assigned to that

channel and sound.

If you dont want to hear the sound module,you

can turn off patch thru by unchecking the "Patch

thru'command in the Controls window mini-
menu (described in the next section).
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CONTROLS WINDOW

Controls window serves as a control center for
playback and recording features, and it is

to

of features.

The Controls window floats on top of all other
windows, much like Mosaic's palettes. To open it,

choose "Controls" from the Windows menu. To

close it, click its close box. To close it when the title
bar is hidden, choose "Controls" from the

Windows menu.

transport (ontrols

to (ontrol

record-

a tape deck.

position arrow shows

where you are in the

scroll

to move

is

to the (ounter.

button turns step

on and off.When itt on, notes

The mini-menu has options for scroll-

ing during playback,hiding the title
bar, patching thru, and hand+plitting

during rerording.

The click button enables

5hift double<lick anywhere on the console to hide the

title bar.When it is hidden,shift-drag to move the

console.

The (ountoff button raus€s there t0

be a countoff before playback or

rerording. Double-click it to set the

number of measures,

Ihe (ounter displays the (urrent

playbark or record location in

measures and beats.(li(k it (or

pres the detimal key on the

numeri( keypad) to edit the
(ounter.

TheWait button

suspends playbark or

recording until you

play a note,a time where the

cursor is lorated.When it's ofl

be entered.

the title bar
make the Controls windolv smaller and less

you can hide the title bar. Here is a

of what to do:

Do this:

Choose "Hide title bar" from
the mini-menu, or
shilt-double-click mywhere
on the console

Shift-drag it

the title bar Shift -double-click anlvhere
on the console

(ONE NOTE AT A TIME)
recording is one of the fastest and most

ways to enter notes into Mosaic.

(f If you have a multi-timbral sound module,

and you would like to hear the notes play with the

correct sound on each voice as you step-enter, see

"Choosing a sound (patch) for each voice" on

page 199 before proceeding below.

To step-record notes into Mosaic:

I Open the Controls window by choosing it from
the Windows menu and check to make sure that the

Step-record button is highlighted.

1,/ UU E ilt I

PLITT PRUSE

The Step+ecord button

disables the internal speaker click

on the l\4a(intosh, which (li(ks

during playback and recording.

Double-(lick the button to set

various (li(k settings.

f ontrols
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Once you have checked this button, you can close

the controls window; it does not need to be open

for step entry.

2 Indicate where you would like to enter the notes

by clicking any staff at the desired measure and

beat location.

For more information about moving the insertion

cursor, see "Moving the insertion cursor" on

page 55.

I Determine the voice that you would like to enter

the notes into by pressing command-up arrow or
command-down arrow to select the desired voice.

As you do so,

watch the

current voice

name in the

voice indicator box at the lower left hand corner of
the view window Alternatively, you can click the

current voice name, type the desired voice name,

and press return. See "Switching the insertion

cursor to a different voice or staff" on "Switching

the insertion cursor to a different voice or staff" on

page 54.

4 Select a duration for the notes by pressing

command-open bracket ( [ ) and command-close

bracket ( I ) to cycle through the durations in the

notes palette.

Alternately, press I for whole note,2 for a half note,

4 for a quarter note,6 for a sixteenth, and 8 for an

eighth note.

5 If the notes you are entering are tied, or if they

belong in a tuplet, click the tie or tuplet tool in the

Groupings palette.

This lett you enter the tie and/or tuplet at the

time as the notes--a real time saver. If the

anything other than a triplet, you'll have to

click the tuplet tool to configure the tuplet

you proceed.

6 Enter the note or chord by playing the

pitch(es) on your MIDI controller.

7 To enter more notes or chords of the same

duration, just keep playing.

You dorit have to reselect the same duration.

8 To enter notes of a different duration, press

appropriate duration key before playing them.

I Ifyou are entering tuplets or ties at the same

time as the notes, you can turn them off at any

by clicking the tuplet or tie palette icon.

10 You can stop at any time to play or edit what

have entered.

Beams, barlines, and note spellings
Step-entry is the same as Macintosh keyboard

mouse entry with regard to auto-beaming, auto-

barring, and note spellings. For example, if
beam is checked, notes will be automaticaily

beamed as you play them. If Auto-bar is

Mosaic will automaticallyplace the correct

of beats in each measure with respect to the

meter. For more information about these

refer to the Mosaic manual.

Troubleshooting
If you don t see notes appear on the screen after

completing steps 1 -2 above, run through the

checklist below. If you find anything awry when

going through these steps, correct the problem r

try again to enter notes into Mosaic. If you still
no response, proceed through the rest ofthe
list:
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r Make sure your MIDI keyboard (or other
;ontroller) is turned on.

r Make sure that a MIDI cable connects the MIDI
OUT of the keyboard to the MIDI IN of the

interface.

r Make sure that the MIDI Interface is connected

to the modem port (marked with a telephone icon)

or printer port (marked with the printer icon).

\[ake note of which port is being used for later.

r Run the FTeeMIDI Setup program and turn to
*Testing for MIDI input and output" on page27 of
rhe Getting Startedbook to make sure that

FTeeMIDI can successfully send MIDI data to your
instruments.

r After you have checked all of the above items,

run Mosaic and open a new or existing file. Make

sure that the Step Record button is highlighted

black) in the Controls window in Mosaic.

./ lJlJ E-
TLST PAUTE FE':']Et,

lll I

The Step+erord button

r Click the insertion cursor on any staff, and make

sure that a voice name appears in the voice box at

the bottom left-hand corner of the view window. A
soice must be displayed here for MIDI entry to be

successful; MIDI entry won t work if it says "none",

I il., :,:# J: ::Ii.,. 
"n,he 

s,aff,

].y foUo*ing the MIDI preparation procedure

Jg"in fro* the beginning.

r If you still have trouble, contact Mark of the

Unicorn technical support.

PLAYING BACK
Before you play back, the first thing you need to do

is choose the MIDI instrument you with to play

each voice on. This is explained earlier in this

chapter in 'Assigning playback for each voice" on
page 199.

Choosing which voices to play
Each voice in the Voices window has a play-enable

button next to it. Ifthe button is black, the voice

will play; if it is white, the voice will not play. Click
the button to toggle its status. To quickly solo one

voice, option-click its playbutton. To quickly
play-enable all voices, double-click any play-enable

button.
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Figurc 34-4: Here,the horn voice has been soloed by option-clicking
its play-enoble button.To ploy-enable all voices agoin, double-click
any play-enable button.

Setting a tempo for playback
To set the tempo for playback, insert a metronome

marking at the beginning of the piece or wherever

you would like to play back. If you don t want to
keep the metronome marking,you can delete it
when you are done playing.

Choosing where to start playback
During playback or recording, the Counter
displays the current playback or recording location

in measures and beats. When Mosaic is stopped,

the counter displays where playback or recording

will begin when you press play or record.

There are several ways to change the current
counter location. If you are familiar with
Performer, some will be familiar to you:

1
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r Click the counter to highlight it. Use the tab key

or decimal key to move between the measures and

beats. Type in the measure and/or beat youd like. If
you make a mistake in entering a value, press the

backspace key or click on the field again and re-

enter the value. Press return to complete the edit.

(- Note! If you have'Auto-scroll" or"Scroll on

stop'enabled in the Controls window mini-ment
the topmost window wili scroll with you when you

use these methods to change the playback locatioc
This is a convenient way to move around your
manuscript.

Scrolling during playback
Mosaic can scroll galley views and page view

windows during playback so that you can always

see what is currently playing. To do so, select

Auto-scroll in the Controls window mini-menu so

that the menu item is checked. Doing so causes the

top-most window to scroll during playback. You

can switch windows during playback if you like.

With Auto-scroll enabled, the top-most view wi.ll

always scroll to the current counter location in the

Controls window

lf you have problems with playback...

Here are some common problems with playback

and some things to try:

r If you don't hear anything, open the Voices

window and make sure that the play-enable

buttons for each voice are black (enabled). (Ifyou
have several files open, be sure you are looking at

the correctVoices window.) Also make sure that the

MIDI channel assignment is the same channel as

the receive channel on the synthesizer or sound

module. Make sure there is a MIDI cable going

from the MIDI OUT on your interface to the MIDI
IN on the synthesizer or sound module. Make sure

the sound module is turned on and that the volume

is turned up.
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r Press the decimal key on the Macintosh keypad.

Doing so highlights the measure field in the main

counter, and you can use the tab, decimal, and

numeric keys as above.
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enter

OR

r Click on a staff in a page or galley view at the

desired location.

OR

r Use the position arrow below the main

transports to cue to the desired location.
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G Please notel In some cases, such as when you

are working with a large score, scrolling may

become somewhat slow. If so, try checking the

"Scroll to counter" option in the Controls window

mini-menu instead. This causes the window to

scroll to the current location when you stop

playback rather than scrolling continuously during

playback.



I
If you hear the wrong kind of sound (e.g. flute

of clarinet), check which patch is currently

in the Voices window Patch column.

If all of your voices are playing the same

but you want each one to play a

instrument, check your MIDI instrument

make sure thatitis mubi-timbral, (one that can

a different sound on each MIDI channel

. Once you have verified that it is

you may need to set it to "multi"

If it doesn t play back at the correct tempo, try
a metronome marking. If a metronome

already exists, try deleting and re-

it.

you hear a bizarre sort of flanging effect

like doubled notes) on each note, you may

recorded doubled notes, or you may have a

feedback loop. Either uncheck the Patch thru
in the Controls window mini-menu, or

the MIDI echo feature of vour svnthesizer.

ING IN REALTIME
can record what you play in real time.You

record, play along with a metronome click

by Mosaic through the Macintosh's

speaker, and then press stop. Mosaic

what you recorded as notation using an

rhythm analyzing algorithm.

prefer, Mosaic can automatically split left

hand playing into two staves. To do so, set

a piano grand staff (two staves, with treble and

clef). Then check the"Hand Splitting"option
Controls window mini-menu. When the

is checked, recorded MIDI data is split

between the two staves. It does not

which staffyou place the insertion cursor in
recording. Note, however, that hand

will only occur on a treble clef staffthat
a bass clef staff below it, or a bass clef staff that

a treble clef above it.

IDI RE(ORDING AND PTAYBA(I(

To record in real-time:

1 Place the insertion cursor on the staff you want

to record on.

If you want Mosaic to automatically split the left
and right hand parts onto a treble and bass clefstaff
pair, place the insertion cursor on either one ofthe
two staYes.

2 Check or uncheck the Hand-splitting option as

desired in the Controls window mini-menu.

If you donl want to split the music between a bass

and treble clef staff, uncheck this option. If you do,

check it.

3 (This step is optional) Set the tempo at which

you would like to record by inserting a metronome

marking where you will begin recording.

You can delete the metronome marking after you

are done. Slowing things down helps to produce a

more accurate transcription. For information
about how to insert a metronome marking, see

"lnserting a Metronome Marking" on page t 5- 1 l.

4 Open the Controls window by choosing it from
the Windows menu and click the "Clik" button to

highlight it.
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Ifyou would like to check out various settings for
the click, double-click the button to open the Click
Options dialog.

5 If you would like a countoff, click the Countoff
button (the button that says"2 bars") to highlight
it.

If you would like to change the number of countoff
measures, double-click the Countoff button, type

the desired number of measures, and click OK.

6 If you would like Mosaic to wait for you before

you begin your countoff and recording, click the

Wait button to highlight it.

7 Indicate where you would like to begin

recording by clicking any staff at the desired

measure and beat location.

For more information about moving the insertion

cursor, see "Moving the insertion cursor" on

page 55.

8 Determine the voice that you would like to

record into by pressing command-up arrow or

command-down arrow to select the desired voice.

As you do so,

watch the

current voice

name in the voice indicator box at the lower Ieft

hand corner of the view window Alternatively, you

can click the current voice name, type the desired

voice name, and press return. See "Switching the

insertion cursor to a different voice or staff" on

page 54.If you are splitting what you play into a

piano staff, place the insertion cursor in the voice

on the top staff.

9 Get readv to record.

10 Press the Record button in the transport

controls to begin recording.

If you have the Wait button enabled, it will flash

indicate that it is waiting for you to trigger the

beginning of recording. When you are ready,

any note on your MIDI controller to do so.

ll Listen to the countoffifthere is one and

time with the metronome click.

Try to play as accurately in rhythm as you can.

will ensure a more accurate transcription.

12 When you are done recording, press the Stop

button in the transport controls.

Using the controls from the Macintosh
Keyboard
All of the buttons in the Controls window are

mapped to keys on the Macintosh keyboard as

shown in Figure 34-5 onpage207.

These key bindings become active when the

Controls window is open. When you close it,
key bindings revert to the standard ones. See

'Appendix C: The Mosaic Keyboard" for more

information.

(G Please note! When you have the Controls

window open, the 1 and 2 keys on the keypad

not select a whole and half note duration.

they trigger Rewind and Pause. If you would
use these keys to select the whole and half note

durations, close the Controls window. (

the space bar starts and stops playback

entering a rest. And the decimal key on the

Macintosh keypad edits the counter instead of
selecting a dotted duration.) If you want to

these key bindings, see Appendix D,

Mosaic's Key Bindings".
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Mosaic may take a moment to process the MIDI
data you have just recorded. If you made a mistake.

you can play back what you recorded to find it. You

can then stop and fix the mistake. Or you can undo

the recording and try again.
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the number of countoff measures 4 Click OK or press return to confirm your choice.

change the number of countoff measures:

Double-click the Countoffbutton in the
Changing the click settings
Normally, Mosaic emits the click sound from the

Macintosh internal speaker. If you want, you can

set up Mosaic so that it sends the click as a MIDI
note to a device, such as a drum machine or the

drum kit on your MIDI synthesizer. You can also

choose when to hear the click.

window.

countoffbutton is the one that says "2 bars". A
aPPears.

To set up the MIDI click:

1 Double-click the"Clik'button in the Controls

window.

The Click & Countoff Options dialog box appears

as shown in Figure 34-6 on page2O7.

2 Check the "Source of cliclC'and other options as

desired.
i4-6: the click and countoff options dialog box

Type in the number of countoff measures that These options are discussed in detail in the

following sections.would like under the Countoffoptions section.

If you would like Mosaic to only count offwhen 3 Enter the MIDI playback parameters for the

accented click and the normal click.are recording, check the "Count off only when

check box.
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Notice that you can make them be the same note or
different notes. For example, you might want a cow

bell sound on the down beats and a side stick

sound for the rest ofthe beats.

4 Click OK.

Source of Click
Source of click specifies how the click is generated.

Select one or both options.

The Internal speaker option produces a click

sound from the computert internal speaker. This

option is greyed out if MIDI Manager is currently

installed in the System on yollr computer.

(O Please note: the internal speaker click maynot
work on all machines. (The check box option may

even be greyed out in the dialog box.) If so, use the

MIDI click described below instead.

The MIDI option will send a MIDI note for every

click. For this option, you must set up a synth or
drum machine to receive these notes and play a

tlick sound ofyour choosing. For example, a

drum machine could play rim shots, or a

synthesizer could play short beeps.

Click Preferences

No accent removes the accent from the first click in
each measure. This option affects both the internal

speaker click and the MIDI click.

Aiways ciick makes the click audible whenever

Mosaic is counting off, playing or recording.

Only during countoff makes the click audible only
during countoff measures, which are specified and

enabled with rhe Countoffbutton in the Controls

window. When playback or recording begins, the

click will fall silent.

0n1y when recording makes the click audible only
when Mosaic is in record mode. If the Countoff
button is enabled, Mosaic will also click

countoffin this mode.

Internal Speaker Click Volume
The Internal speaker click volume slider controls

volume of the Macintosh speaker click. To

the click volume, drag the slider to the right; to

reduce volume, drag to the left. Or, press the +
buttons at each end of the slider.

amrmffiqqqFh
lnternal 5FeikPr EliEk YolunrE

Mosaict clickvolume is not affected bythe
slider in the Control Panel. This allows you to

attenuate (or turn off) the warning'beep sound.

and turn up the click.

Data for MIDI Click
These options define what notes are played if
MIDI option is selected. The Accented note is

on the first beat of each measure; the Norma1

played at all other times. Each note has four

parameters:

The device pop-up menu specifies the MIDI
that will play the click sound.

Pitch is the pitch ofthe note, expressed as a scale

letter (A-G) (use the number sign'#'to
sharp, or a small letter'b to represent a flat) and

octave number. For example, C3 means middle

Velocity is the attack (on) velocity, expressed as a

number from 0-127.

Gate specifies the length ofthe note in
(thousandths of a second).
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(HAPTER 35 Using FreeMlDl Setup

This chapter explains all the major functions of the

FTeeMIDI Setup application.

See "Working with FTeeMIDI Conhgurations" on

page 220 for information on working with multiple
FTeeMIDI configurations.

FREEMIDI PREFERENCES

The FTeeMIDI Preferences dialog box is where you

tell FTeeMIDI which serial ports you will be using

for MIDI, whether you want to use Inter-
application MIDI, whether FTeeMIDI should
monitor patch changes and whether FreeMiDI

should allow non-FreeMIDI applications to use the

serial ports for MIDL These options are explained

more fullybelow

To set FTeeMIDI Preferences:

1 Choose FTeeMIDI Preferences...from the File

menu.

The FTeeMIDI Preferences dialog box appears.

FreeMl0l Preferences

Softuore CompotibilitU

O FreeMlBl appli.dlions onlg
O nllou other apDlicaliont

Ml0l Lonfiguralion

Serial Porls:
E Modem
E Printer

flpplications:tHt16a

El Monilor p6lch ch6nges

Usr th. 'MlDl &nfrqur.lion .heck box.r to
sbl. or dir$l.iportlorHtDl. lf
n.essyg , Evlq 4.d porls will b. .cannEd
f.r interfacE iutom.ticill!. T. djsrble E tort
t+nporrrilg, lse ih. MlDl lnlerfa.. di.log.

Figure 35-l: FreeMlDl Preferences Dialog Box

2 Choose the settings you desire and click OK or
click Cancel to leave the FTeeMIDI Preferences

unchanged.

Read the following sections for information on the

various options in this dialog box.

FTeeMIDI Setup is the application that you use to

edit your FTeeMIDI configuration or FTeeMIDI

Sr'stem Preferences. It is the application that is

hunched or switched to when the Edit FTeeMIDI

Configuration.,. command is chosen in FTeeMIDI-

compatible applications such as Performer,

llosaic, or Unisyn. In FTeeMIDI Setup, you can

edit the properties and connections of devices as

rell as the various settings in the FTeeMIDI

Srstem, such as Inter-application MIDI and

\Ionitor Patch Changes. You can view the current

patch list for a device in a pop-up menu.You can

control the Tiansport functions of a FTeeMIDI

s€quencer, such as Performer. You can also use

FTeeMIDI Setup to test your studio connections.

The Current FreeMlDl Configuration
There is no need to make a FTeeMIDI

;onfiguration'turrent". Whichever conflguration

is visible in the FTeeMIDI Configuration window is

the current configuration that all FTeeMIDI

applications will use. Whenever you launch

FTeeMIDI Setup to view or edit your FTeeMIDI

.:onfiguration, the configuration document with
r-hich you were last working is opened automati-

cally. If you do not launch FTeeMIDI Setup, other

FTeeMIDI applications will be using the FTeeMIDI

;onfiguration that was last opened in FTeeMIDI

setuP.

ivou open a new or existing configuration, it will
mmediately become the current configuration
jrat all FTeeMIDI applications will use.
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Software Compatibility
If you wish to use MIDI applications that do not
support FTeeMIDI at the same time as FTeeMIDI-

compatible applications, click Allow other

applications in the Software Compatibility section

This allows non-FreeMIDI applications to have

access to the Macintosh serial ports while
FTeeMIDI applications are running.When the

Allow other applications option is set, FTeeMIDI-

compatible applications cannot play MIDI in the

background.

If you will only be using FTeeMIDI-compatible

MIDI applications, click FTeeMIDI applications

only. This aiiows FTeeMIDI applications to play

MIDI in the background.

lnter-application MlDl Commu nication
If you wish to be able to send MIDI data between

FTeeMIDI-compatible applications, click the Inter-

application MIDI check box. This option uses up

some Central Processing Unit (CPU) overhead, so

leave this option turned off unless you know you

will be using it.

Extras
Ifyou wish to have any patch changes that are sent

by FTeeMIDI updated in real-time for all your
FTeeMIDI applications, click the Monitor Patch

Changes check box. For example, ifyou choose to

monitor patch changes, the patch column in
Performer's Tracks window always correctly

displays the last patch change sent to each device.

This option uses up some Central Processing Unit

(CPU) overhead, so if you find your Mac is

working too slowlywhen using FTeeMIDI

applications, try Ieaving this option turned off.

AppleTalk and the Printer Port
If AppleTalk is enabled on the printer port and 1,ou

select the printer port under MIDI Configuration

and OK the FTeeMIDI Preferences dialog box, a

warning alert box appears, which asks if you woulti

like to claim the printer port for MIDI.

The Printer porl seems to be in use bU:

RppleT6lk

g

Ere Uou sure gou uant to
cl8im lhis port for MlDl?

Fig ure 3 5 -2: AppleTo lk Worni ng Alert

If you are using AppleThlk for network communi.

cations or for an AppleTalk printer, you should

clickLeave it alone and re-thinkyour MIDI studi

setup. Otherwise, click Claim the port and

FTeeMIDI will be able to use the printer port for
MIDI.

If you clicked Claim the port, you should disable

AppleTalk in the Chooser when you are through

configuring FreeMIDI, in order to avoid seeing thir
warning alert again.

Ifyou are using AppleTalk for an Ethernet nefivork

and your Ethernet connection is made via NuBus

or SCSI or some other bus that does not utilize tle
printer port, FTeeMIDI should not ask about

disabling AppleTalk and network communications

should not be interrupted.

FAX/Modem and Networking Software
Compatibility
Some FAX/Modem and nehvorking software can

cause conflicts with other sofhvare that needs to

use the serial ports such as FTeeMIDL If you have

- 3 QL
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MlDl Configuration
Click the check box for each serial port (modem

and printer) to which you have a MIDI interface

connected. Be sure that you connect and power up

all the MIDI interfaces that you will be using,

because FTeeMIDI has the ability to automatically

find most of your MIDI gear.
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software and it needs to be active while you

working with FTeeMIDI applications, you may

to setthe Allow non-FreeMIDI applications

in the FTeeMIDI Preferences dialog. Even

may not work. You may need to disable such

while using FreeMIDI, if it continues to

conflicts. It may take some experimentation

flnd out what settings work best. For more

see "Software Compatibility" on

2t0

SETUP

the Quick Setup... command to add and delete

from your FTeeMIDI configuration. This

is especially good to use when you need

add or delete more than one device from your

Quick Setup can also shorten the

of connecting devices to interfaces, since

connections can be specified before the devices

in the FTeeMIDI Configuration window
then automatically appear when the setup is

Config
Quick Setup diaiog box contains an Auto

.. push button which opens the Auto Config

box.Auto Config can automatically find
of the MIDI devices in your MIDI studio. See

Your studio automaticallv" on

19 of the Mosaic Getting Started book for
on using Auto Config to configure

for vour studio.

Quick Setup to Add FreeMlDl Devices
use Quick Setup to add devices:

Choose Quick Setup... from the Configuration

Quick Setup dialog box appears.

Manufaaturer:
Vamaha

Sludio toralinn:

Ca ble:

Neu Ieuice: llurren t Io n f i gurat ion:

<< Remoue <<

Piece ll, ModemMI
K200 0
IG5OO

Pro t eu!,7 2
PC 2OO

CBH. O5

Fiqure i5-3:QuickSetup Dialog Box

This dialog box contains a list of all the MIDI
devices that are contained in your current

FTeeMIDI configuration on the right side under the

lab el C ur r e nt C o nfi gur at i o n.

2 Select the correct manufacturer, model, studio

location and cable (ifapplicable) from the pop-up

menus on the left and then clickAdd.

If the pop-up menus do not contain a description

of a particular device, choose Other and click Add.

We will see how you can re-name and re-define

these devices later in this manual. For nowtheywill
be called by the default name Device- I for the first

such device, Device-2 for the next and so on.If you

accidentally add a device to the iist that you do not

want to appear in your studio configuration, select

its name from the list and click Remove.

3 When you have added all the devices to the list
that you wish to add to your studio configuration,
click Done.

The FTeeMIDI Configuration window will appear

containing all of the MIDI devices defined in the

Quick Setup dialog box and their connections.
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Figure 35-4: FrceMlDl Configuration Window

The FTeeMIDI Configuration window will appear

containing all of the MIDI devices defined in the

Quick Setup dialog box and their connections,

minus the devices which were removed.

This window contains a graphical representation of

your MIDI studio. It contains MIDI interfaces,

FTeeMIDI devices, interface-to-device connectiom

and an Info Bar.

Use the title bar of the window to move it as with
any standard Macintosh window. Use the

horizontal and vertical scroll bars to view portions

of the window not currently visible as with any

standard Mac window. Use the Zoom button to

toggle the windowbetween full size and its currem

state. Use the grow handle to change the size or
shape of the window.

T11500

ffi!--]-
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Using Quick Setup to Remove FreeMlDI
Devices
To use Quick Setup to remove devices:

1 Choose Quick Setup... from the Configuration
menu.

The Quick Setup dialog box appears

Figure 35-5: Quick Setup Dialog Box

2 Select the device or devices you wish to remove

from the Current ConJiguration: Iist on the left side

and click Remove.

The selected devices will disappear from the list.

3 When you have finished removing devices, click
Done to close the Quick Setup dialog box.
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Figure 35 6: FreeMlDl Configuration Window
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THE FREEMIDI CONFIGURATION WINDOW
This window is where you edit your FTeeMIDI

Conliguration. It is the window that will appear

when you choose the Edit FTeeMIDI ConJigu-

ration..,command in other FTeeMIDI applications

such as Performer, Mosaic, and Unisyn.

Model:
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In the FreeMII)I Configuration window, you can

liew, edit, and rearrange your FTeeMIDI

configuration in most any way that you like.

The FTeeMIDI Configuration window shows your

.urrent configuration. You can make any other

previously saved conliguration the current

configuration simplyby opening it.

Use the Quick Setup command along with the Auto

Config command to quickly set up a conf,guration

that matches your MIDI studio. For more

information, see "Configuring Your studio

automatically" on page 19 of the Mosaic Getting

5tarted book.

Editing Device Info in the FreeMlDl
Configuration Window
lbu can edit some of the properties of devices that

appear in your FTeeMIDI configuration directly in
:he FTeeMIDI Configuration window The

:roperties that you can change are the

nanufacturer name, model name, device ID,

Jevice name, and MIDI transmit and receive

;hannels. See "Editing FTeeMIDI Devices" on

rage 215 in this chapter for information on editing

.;l/ the properties of FTeeMIDI devices.

Io quickly change the manufacturer, model, device

ID or MIDI channel for a device:

f Select the device you wish to edit by clicking its

kon.

It's device info appears in the info bar near the top

of the window.

kiurlv eil HIrl00 IJ I -1E t-tE,

hure 35-7: FreeMlDlConfiguration window lnfo Bar

E ,"r.., a new manufacturer or model name from

$" uppropriute pop-up menus.

Uniess you want to leave the model name blank,

you will need to change the model name for a

device if you change its manufacturer.

olher

Figure 35-8: Pop-up menus in lnfo Bor

3 Enter new device ID or MIDI transmit and

receive channels numbers in the appropriate text

entry box(es).

If you would like to enter consecutive MIDI
channel numbers, enter the numbers like this: 1-8.

Ifyou would like to enter non-consecutive

numbers, enter the numbers like this: 1,3,5,7,10.

Editing FreeMlDl Confi gurations
You can add, delete, edit, rename, duplicate,

connect, disconnect, and rearrange FTeeMIDI

devices in the FTeeMIDI Configuration window.

Use the techniques below to add and remove

devices from your FTeeMIDI configuration if you

only need to add or remove one device at a time.

Otherwise, it is usually easier to use the Quick

ither
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Setup command to add or remove multiple

devices. See "Using Quick Setup to Add FTeeMIDI

Devices" on page 211 in this chapter for more

information on using the Quick Setup command.

See "Working with FTeeMIDI Configurations" on

page22A in this chapter for information on

working with multiple FTeeMIDI configurations.

Adding FreeMlDl Devices
To add a single FTeeMIDI device to your configu-

ration:

1 Choose Create Device... from the Configuration

menu or type command-K on your Mac keyboard.

The FTeeMIDI Device Specification dialog box

appears. Ifyou do not wish to add a device at this

time, click Cancel and the FTeeMIDI Configuration

window reappears.

Figure 35-9: FreeMlDl Device Specificotion Dialog Box

2 Select a manufacturer and model from the pop-

uP menus.

Steps 2-7 below are optional. FTeeMIDI ships with
default settings for each device in it's model list.

These default settings appear when you select a

specific model from the model pop-up menu. If
you would like to change any of the settings such as

the device name, ID, properties, MIDI channels or

icon, proceed to steps 2-7 below. Otherwise,

OK and the new device will appear at the top of
FTeeMIDI Confi guration window.

3 Enter a name for the device by typing the

into the name text box.

4 Set a device ID number by entering a new

number in the Device ID text box.

5 Select up to eight different Device Properties

the device by selecting properties from the eight

pop-uP menus.

For more information, see "Device Properties"

page224.

6 Set transmit and receive channels for the

by clicking the appropriate box(es) below

channel numbers that are displayed.

It is very important to set the MIDI channel

information correctly, since this controls the

amount of channels that appear for the device in

other FTeeMIDI applications such as Performer.

7 Select an icon to represent the device in the

FTeeMIDI Configuration window.

Clicklcons...and scroll until the icon that you

to use is displayed in the middle,bordered field

click OK. For information on entering your own

icons into FreeMIDI, see "Editing FTeeMIDI

Device Files" on page 233.

Removing FreeMlDl Devices
To remove FTeeMIDI devices from your
ration:

I Select the device you wish to remove by

its icon. Shift-click device icons to select more

one device.
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Type backspace or delete on your Mac keyboard

choose Cut or Clear from the Edit menu or type

2 If you select more than one device in the

FTeeMIDI Configuration window, the Edir
Deyice... menu item becomes grayed-out
(disabled) since you can only edit the properties of
one FTeeMIDI device at a time.

'X or command-B on your Mac

of these commands removes the selected

3 Mal<e the changes you desire and click OK or
click Cancel to cancel the edit operation.

If you remove the wrong devices, choos e Undo

the Edit menu and try again. See 'Adding FTeeMIDI Devices" on page 214 in
this chapter for information on the various
properties you can edit in this dialog box.ng FreeMlDl Devices

FTeeMIDI devices are dehned and appear in

FTeeMIDI configuration, you can change any Naming FreeMlDl Devices
When devices are added to your FTeeMIDI

configuration using Quick Setup andAuto Config,
they are given default names that correspond to
their model names.You can easily rename these

devices if you wish. See "Editing FTeeMIDI

Devices" on page 215 in this chapter for
information on one method of changing the name

of anyexisting FTeeMIDI device with the FTeeMIDI

Device Specification dialog box.

their properties with the FTeeMIDI Device

dialog box.

edit a FTeeMIDI device

Double-c1ick the device you wish to edit.

select the device and choose Edit

from the Configuration menu or type

on your Mac keyboard.

fhe FTeeMIDI Device Specification dialog box An even easier way to change a FTeeMIDI device

name follows:
If you do notwish to edit the device at this

time, click Cancel andtheFreeMlDl Conliguration

window reappears. I Select the device by clicking its icon.

You can skip step 2 below by clicking the device's

name directly. The mouse cursor will change to the

text insertion I-beam to indicate that it is in text
entry mode.

2 Typ" the Return or Enterkey on your Mac
keyboard.

3 Enter a new name for the device.

4 Typ. the Return or Enterkey on your Mac
keyboard to confirm your choice. Alternately, you
can click any where in a blank part of the FTeeMIDI

Configuration window to confirm the new name.

'tgure i5- 1 0: FreeMlDl Device Specification Diolog Box.
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5 If you enter the wrong nan-Ie, choose Llizdo

Renante from the Edit menu and try again.

{f For users familiar with the System 7,

FTeeMIDI's naming convention is identical to the

Finder's.

Duplicating FreeMlDl Devices
You can make copies of FTeeMIDI devices in two

ways. Using the Copy or Cilr command along with

the Paste command, yotl can make copies of
devices to paste into other FTeeMIDI confiSura-

tions. Using the Duplicate command, you can

make copies of devices in the current FTeeMIDI

configuration with one command.

To copy or cut and then paste devices:

I Select the device you wish to copy or cut by

clicking its icon. Shift-click device icons to select

more than one deYice.

2 Choose Copy or Cut from the Edit menu.

Alternately, you can type command-C for Copy

and command-X for Cut on your Mac keyboard.

CopT makes a copy ol the selected items and places

it on the clipboard for pasting. Cil, makes a copy of

the selected items and places it on the clipboard for

pasting and removes the original selection.

3 (Optional) If you wish to paste the devices into a

different FTeeMIDI configuration, close the current

configuration and oPen a new or existing

configuration.

For info on opening new and existing configura-

tions see "Opening Existing FTeeMIDI Configura-

tions" on page 221and "Creating a New FTeeMIDI

Configuration ' on page 220 in this chapter.

4 Choose Paste from the Edit menu. Alternately,

you can type command-V on your Mac keyboard.

The pastecl devices will appear in some blank

portion of the FTeeMIDI Conliguration

To duplicate devices:

1 Select the device you wish to duplicate by

clicking its icon. Shift-c1ick device icons to

more than one deYice.

2 Choose Duplicate from the Edit menu.

Alternately, you can tyPe command-D on your

Ivlac keyboard.

The duplicated devices will appear in some

portion of the FTeeNIIDI Configuratiorr

Connecting Devices to lnterfaces
Once you have added a FTeeMIDI device to

FTeeMIDI conliguration, you will need to

its inputs and outputs to an interface in your

conliguration. FTeeMIDI will not be able to

receive MIDI to or from the device unless it is

connected to an interface. FTeeMIDI does not

require that the input and output cable of a

be the same number, but, in most cases, setting

your studio this way may be more organized

simpler to understand.

rf Outputs are represented by small triangles

that are located on the right side of devices and

interface ports. Inputs are represented by small

triangles that are located on the left side of

and interface ports.

To connect a device output to an interface:

1 Drag a "patch cord" from the output of a

to an input on an interface.

When you release the mouse, the connection

appear. Ifyou have a multi-cable interface such

the MTP II or MIDI Express, be sure to

device output to the input to which the device

physically connected. Ifyou are using both the

modem and printer serial ports, be sure to

U5ING FREEMIDI 5ETU
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the device output to the input on the interface on

the serial port to which the device is physically

connected.

2 Alternately, you can drag the "patch cord" from
the input of an interface to an output on the device.

3 If you connect the wrong ports for a device,

chooseUndo Dragfrom the Edit menu and try
again.

To connect a device input to an interface:

I Drag a "patch cord" from the input of a device to

an output on an interface.

\Vhen you release the mouse the connection will
appear. Ifyou have a multi-cable interface such as

the MTP II or MIDI Express, be sure to connect the

device output to the input to which the device is

physically connected. Ifyou are using both the

modem and printer serial ports, be sure to connect

the device output to the input on the interface on

the serial port to which the device is physically

connected.

2 Alternately, you can drag the "patch cord" from
the output of an interface to an input on the device.

3 Ifyou connect the wrong ports for a device,

choose Undo Dragfromthe Edit menu and try
again.

Making MlDl Thru Connections
\\hen more than one MIDI device shares a single

Llutput port from a MIDI interface, you need to

;onnect the MIDI Thru port of the device to the

input of the other device. This mirrors the physical

:onnection that you should have betrveen the

devices.

- t TimP

EEE
sl 000

: gure 35 I I : MllDl Thtu Connection

Making Multiple MlDl lnput Connections
FTeeMIDI Setup allows you to connect more than

one MIDI output from a device to a single MIDI
input on an interface. When you make such a

connection, you are telling FTeeMIDI that both
devices'MIDI outputs are connected to a single

MIDI input on an interface. Without some type of
MIDI merger, this type of connection is not
possible.

Connecting Devices to other Devices
FTeeMIDI Setup allows one connection per port
(input output, or thru) on each device. You cannot

connect devices to each other except from MIDI
Thru to MIDI In of a separate device. If you would
like to make such connections, use the Cable

Routing (on MIDI Time Piece and MIDI Express

interfaces) or similar features in your MIDI
interface or MIDI patch bay/merger gear.

Removing Device Connections
Once you have made connections between devices

and interfaces, you can remove the connections to
make different connections if you physically

change the connections in your MIDI studio.

To remove FTeeMIDI device connections:

I Click at the intersection of the Device port and

the patch cord and drag the connection away from
the device and then release the mouse.

The connection is broken.

,::.R:------..:@E- Y
Figure 35-l 2: Brcaking a Connection

An alternate way to remove FTeeMIDI device

connections follows:

I Select a connection by clicking it. Shift-click

connections to make multiple selections

simuitaneously.
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Figure 35-1 3: Selecting o Connection

2 Type backspace or delete on your Mac keyboard

or choose Cut or Copy from the Edit menu or tyPe

command-X or command-B on your Mac

keyboard.

Any of these commands will remove the selected

connections.

3 lf you remove the wrong connections, choose

Llndo fromthe Edit menu and try again.

Arranging the FreeMlDl Configuration window
You can arrange the FreeMIDi Configuration

r,vindow any way you like. We suggest that you drag

device icons so that they appear as they do in your

studio. For instance, you can arrange all the

modules,rvhich are in a rack to the left of your Mac,

to the ieft side of the window and all the modules,

which are in a rack to the right of your Mac, to the

right side of the windor,rr. You can drag the patch

cords, which connect the devices to the interfaces,

up or dorvn so that you can view the connections

clearly.You can drag MIDI ports in a multi-cable

interface, such as the NITP, MTP II or MIDI
Express, up or dor,r,n to create more or less space

between them. You can delete input or output

cables, rvhich are not part of your studio setup, by

clicking the patch cord to select it and typing the

backspace or delete key on your N{ac keyboard.

You can also r-nake and break connections by jr"rst

dragging the er.rds of the patch cords.You can use

the different options in the Views menu to change

the size of the icons and to view input and outPuts

separately or together.
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Dragfrom t-iltr!Timp
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Figure 35 1 4: Connecting o device to an interfoce output.
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Fiqure 35-1 5: Arranging FreeMlDl devices and connections.

FreeMlDl lnterfaces
Interfaces are an important part of the FTeeMIDI

Configuration. They appear automatically when

FTeeMIDI scans the serial ports for MIDI
interfaces. This happens the first time you set the
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\\rhen a connection is selected, it appears as a

thicker, heavier line than an unselected

connection. To deselect a connection, click

somewhere in a blank area of the FTeeMIDI

Conliguration window.
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FTeeMIDI System Preferences to access one orboth
serial ports for MIDI. You can use the Re-Scan

Serial Ports for Interfaces??? command to have

FreeMIDi check for MIDI interfaces that you may

have installed or powered on after originally
setting the Preferences file.

Only the names of interfaces can be changed. Al1

other parameters cannot be edited.

Selecting FreeMlDl lnterfaces
To select a FTeeMIDI interface in the FTeeMIDI

Configuration window, click its icon. To select

more than one FTeeMIDI interface, shift-click each

icon. To deselect a previously selected FTeeMIDI

interface, shift-click its icon. To deselect all selected

FTeeMIDI interfaces, click in a blank area of the

FTeeMIDI Confi guration window.

Moving FreeMlDl lnterfaces
To move a FTeeMIDI interface, drag its icon to the

desired position. Choose Undo Drag command

from the Edit menu to return the device icon to its

original position.

You can drag the input/output ports of a MIDI
interface up and down to make more room

betlveen each port by dragging the port number

icon that you wish to move. Choose Undo Drag

command from the Edit menu to return the port
number icon to its original position.

fi gure 3 5- I 6: Moving i nterface ports vertico I ly

Editing FreeMlDl lnterface Names
,\fter a FTeeMIDI interface appears in the

FTeeMIDI Configuration window, you can change

its name. To do so:

I Select the FTeeMIDI interface you wish to edit
by clicking its icon.

It's info appears in the info bar. Ifyou clicked the

interface icon's name, the mouse cursor changes to
a text insertion I-beam and you can enter a new
name by just typing. If you did not click the icon

name, you can still edit the name by typing the

Returnkey onyour Mac keyboard and the name

will pop-up for editing and the mouse cursor

changes to a text insertion I-beam when it is over

the icon name. If you are familiar with System 7,

this naming convention works identically to the

Finder in System 7.

Working with Off-Line lnterfaces
You can create and work with MIDI interfaces

which are not currently connected or powered-on
(off-line), usingthe Choose Interfacefeatrre. To use

this feature:

1 Tirrn off or disconnect all your MIDI interfaces.

2 Choose FTeeMIDI Prefences... from the File

menu.

The FTeeMIDI Preferences dialog box appears. The

FTeeMIDI Preferences dialog box is where you tell
FTeeMIDI which serial ports will be used for MIDI
(among other things). See "FreeMIDI Preferences"

on page 209 in this chapter for more information
on the options in the FTeeMIDI Preferences dialog

box.

3 Select the serial ports to which the off-line
interfaces will be connected when they come on-
line and click OK to confirm your choice or click

Cancel to leave the FTeeMIDI Preferences

unchanged.

FTeeMIDI searches the selected serial ports for
MIDI interfaces, but since the interfaces are stili
off-line, no interfaces are found on the selected

ports and this dialog box appears.
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No iaterfare rould be found on the Modem
Port. lf it is off-line, make sure the interfore
is turned trtr End tontrettedr sel anu
MlDl/Thru suit[hes lo Ml0l, End tlick "Trg
Egain. "

It Uour interface is not prssEnt, Uou mau
rlirk "f,hoq$e..." to choose an interfate from
tha EUailablB options.

I ho os e,.

g

f,hoosB an intsrfate for the ModEm Port:

F4lDl Enpress

[Use the Ml0l lnterface dialog to configure
the port uhBn the interface is on-litre,)

OK

Figure 35-1 8: Choose interface diolog box

5 Choose the interface you wish to add to your

FTeeMIDI configuration from the pop-up menu of
interface choices and click OK to conf,rm your

choice or click Cancel to cancel the operation.

Choose an intarfate for the Modem Port:

(Use t
the pB

Figure 35-19: Choose interface pop-up menu.

The interface you choose appears in the FTeeMIDI

Configuration window. if FTeeMIDI devices were

already in the window, theywiil appear

unconnected to this new interface.You can proceed

to add devices to the configuration and connect

devices to the interface in the usual manner. For

more information, see "Quick Setup" on page 21 1 .

WORKING WITH FREEMIDI
CONFIGURATIONS
We call the documents created by the FTeeMIDI

Setup application "FreeMIDI configurations".

When FTeeMIDI Setup is open, the FTeeMIDI

Setup document that is currently open and whose

FreeN{IDI conliguration is visible in the FreeN4ID-

Configuration windorv is the current conflguratior

that all FTeeMIDI applications use. Whenever you

launch FTeeMIDI Setup to vierv or edit your

FreeN{IDI confi guration, the confi guration

document with which you were iast working is

opened automatically. If you do not launch

FTeeMIDI Setup, other FTeeMIDI applications ust

the FTeeMIDI configuration that was last opened ir-

FTeeMIDI Setup.

If you open a new or existing conliguration, it will

immediateiy become the current conhguration

that all FreeM IDI applications use.

Creating a New FreeMlDl Configuration
Although only one FTeeMIDI conliguration can be

current or active at a time, you can create as man\-

FTeeMIDI configurations as you iike. Once you

have created a FreeMIDi configuration for your

own MIDI studio, you might want to create a

FTeeMIDI conliguration for another studio that

you might be working at in the future or you migh:

want to create several variations of your home

studio for different situations.

To create a new FTeeMIDI configuration:

1 If you have not done so already, oPen FreeMID

Setup by double-clicking its icon in the Finder.

Alternately, you can open FTeeMIDI setup by

choosing the Edit FTeeMIDI Configuration...

command in any other FTeeMIDI application.

The FTeeMIDI Configuration window opens and

displays the current FTeeMIDI configuration.

220
USING TREEMiDI SETUF

| [anret I JJ rru nqain ll

Figure 35-l 7: No interfaces Found dialog box

4 Click Choose... and the Choose Interface dialog

box appears.
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I

2 Choose New from the File menu or type

command-N on your Mac keyboard.

trf you have made changes to the current

configuration and have not yet saved them,

FTeeMIDI Setup will ask if you would like to save

these changes before the new configuration opens.

Otherwise, an empty, new FTeeMIDI

Configuration window opens containing no

devices or interfaces.

frgurc 35-20: New FrceMlDl Configurotion

! Choose Fre eMIDI Preferences... fronrthe File

menu.

The FTeeMIDI Preferences dialog appears. This

step is necessary in order to tell FTeeMIDI which
serial ports your new configuration uses for MIDI.

{ Set FTeeMIDI Preferences the way that you like

and click OK or click Cancel to leave the FTeeMIDI

Preferences settings unchanged.

FTeeMIDI searches the serial ports you selected for
MIDI interfaces. Interfaces that are found appear in
the new FTeeMIDI Configuration window. See

'FreeMIDI Preferences" on page 209 in this

chapter for information on the various options in
this dialog box.

tf If you are creating a FTeeMIDI configuration

in which you would like to place MIDI interfaces

that are not currently connected (on-line), you will

need to disconnect or power offany MIDI
interfaces that are on-line and then use the Choose

Interfaces feature to insert an off-line interface. For

more information, see "Working with Off-Line
Interfaces" on page 219.

5 Use Quick Setup or Auto Config to add and

connect devices to the interface in this new

FTeeMIDI configuration. Alternately, you can add

devices to the configuration indiviudallyby
choosing Create Device... from the Configuration

menu.

For more information on adding and connecting
devices in this new FTeeMIDI configuration, see

"Quick Setup" on page211, 'Auto Config" on

page 211, and "Editing FTeeMIDI Configurations"

on page 213 in this chapter.

You now have a FTeeMIDI configuration that can

be used in the studio for which it was designed. See

"Saving FTeeMIDI Configurations"on page 222 for
information on how to save this configuration to
disk so that you can open it when you start work in
the studio for which it was designed.

Opening Existing FreeMlDl Configurations
Once you have saved more than one FreeMIDi

configuration to disk, you can open any existing

configuration for use in a situation such as starting
a project in another MIDI studio.

To open an existing configuration:

1 If you have not done so already, open FTeeMIDI

Setup by double-clicking its icon in the Finder.

Alternately, you can open FTeeMIDI setup by
choosing the Edit FTeeMIDI Confguration...
command in any other FTeeMIDI application.

The FTeeMIDI Configuration window opens and

displays the current FTeeMIDI configuration.

2 Choose Openfrom the File menu. Alternately,

you can type command-O on your Mac keyboard.

MlDl Con
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Ifyou have made changes to the current

conliguration and have not yet saved them,

FTeeMIDI asks if you would like to save these

changes before another conliguration opens.

Otherwise, a standard Macintosh File Open dialog

box opens.

E FreeMlDl Confiqurations t E HErd tlisk

tlesktop
D mg ronfigurstitrn
D FreeMl0l rati6n

Figure 35 2 I : Mo(intosh lile Open dialog box

3 Select the FTeeMIDI configuration that you

rvould like to open and click Op en or click CanceLto

ieave the current FTeeMIDI configuration open.

The selected configuration opens and you can

proceed to use this configuration in your other

FreelvilDI applications. Use the directory pop-up

menu to navigate to a disk and folder in r,vhich the

configuration you wish to open is located. See your

Macintosh orvner's manual for more information

on saving files and navigating to disk and folders.

Saving FreeMlDl Confi gurations
You can save each FTeeMIDI configuration that you

create to disk so that you can recail them at a later

date.

To save a FTeeMIDI configuration:

1 Choose Save from the File menu. Alternately,

you can type command-S on your Mac keyboard.

If the configuration has been saved before, it
replaces the current version ofthe conf,guration. If
there are no changes since the last time the

configuration was saved, the Save menu item is

disabled (grayed-out) in the File menu. If the

configuration has never been saved before, a

standard Macintosh File Save dialog box opens.

Figure 35-22: Macintosh File Save dialog box

2 Use the suggested name "FreeMIDI

Configuration' or enter another name for your

configuration ifyou like, and click Save or click

Cancel to cancel the operation.

Use the the directory pop-up menu to navigate to a

disk and folder in which you wish to save this

configuration. Ifyou like,you can use the New

Folder button to create a new folder in which to

save this configuration and others that you might

create in the future. See your Macintosh owner's

manual for more information on saving files and

navigating to disk and folders.

The configuration is now salely saved and you can

recall it at a later date.

POPUP PATCHLISTS
Librarian applications, sr,rch as Unisyn or PatchLis:

Manager, which support FreeMIDIt patch lists,

can be used to define patch lists for your FreeMID,

devices. You can view the patch lists assigned to

FTeeMIDI devices and send patch changes to ther

default channels directly in the FTeeMIDI Setup

application. For more information on how to

define patch iists for a FTeeMIDI device, consult

your Librarian software's users manual' If you use

the PatchList Manager, this information is in

chapter 7,"Using Patchlist Manager" (page 83) in

the Mosaic Getting Started gide.
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To view and send patch changes in the FTeeMIDI

Setup application:

I Check to be sure that the Popup Patchiists menu

item in the Configuration menu is enabled.

The Popup Patchlists command should have a

check next to its name. If it does not, choose it to

select it.

2 Press the mouse on a device in the FTeeMIDI

Configuration window and its current patchlist

appears in pop-up menu.

Figure 35-29 below shows a portion of an E-Mu

Proteus/3 pop up patch list.

To do so:

I Choose MIDI Preferences... from the MIDI
menu.

The MIDI Preferences dialog box appears.

Figure 35-24: MlDl Preferences Dialog Box

2 Select one of the two options available.

The Use default channel only option is the default

setting. With this setting PatchThru sends all

incoming MIDI data to the selected device on the

first available MIDI receive channel for that device.

The Use all channels optionwill cause PatchThru to

send all incoming MIDI data to the selected device

on all of the selected device's MIDI receive

channels at once. This option is not quite as useful

as the first option.

3 Click OKto confirm your choice or Cancelto

leave the MIDI Preferences unchanged.

Using PatchThru
PatchThru is a checkable menu item. This means

that its state (on or off) is toggled each time you

choose it from the menu. When there is a check

next to the PatchThru menu item in the MIDI
menu, PatchThru is enabled.

To use PatchThru:

1 Check to be sure that the PatchThru menu item

in the MIDI menu is enabled.

2 Desert DaNn
5 Blue Grast

32 Temple Gonq

33 Mod Sitirs
34 Mbira
f,s Shakuhichi
36 Cimbilum
37 HUbrid Vinds
3a Biga Suvuk
39 PPter's Pid

4i PirisHusette
42 ftu Age
43 Shimisen
44 Sgn Kllimh
45 o.!rin! Solo

4? Dulcet Bow
48 Udu Ton*s
49 Jids Sprinq
50 Hgbrid Pluck
51 Fsa,-)Bigpipe

? EBst lndi.n

9 \y'3terphone
l0 lrish H.rp
1 1 shof:r'
12 Pslllerg
13 Fragr.nt T.r
14 Didjeridu 1

l5 Pin Flute
l6 Dulcimer
17 Eagpipe

l9 Hrnoi oronr

Figure 35-23: Popup Patchlist

3 (Optional) If you want to send a patch change

command to the device whose patch list you are

viewing, choose the patch you want to send and

release the mouse.

The patch change will be sent to the device on its

default channel.

PATCHTHRU
The PatchThru command lets you send MIDI data

from one FTeeMIDI device to any selected

FTeeMIDI device while FTeeMIDI Setup is the

current application.

MlDl Preferences
Before using PatchThru, be sure to set the MIDI
Preferences the way you need them.
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The PatchT}rru command should have a check next
to its name. If it does not, choose it to select it. You

can also use the Mac keyboard shortcut to toggle

tl're state of PatchThru by typing command-T.

2 Select a device and play notes on your MIDI
controller keyboard.

You should hear the notes being plal,ed coming
from the device that is selected.

DEVICE PROPERTIES
Every FTeeNIIDI device can be assigned up to eight
different device properties. FTeeMIDI applications

can use these device properties in anywavthat they
require. Here are two examples of the use oldevice
properties:

r A FTeeMIDI application which knows about the

General MIDI specifitation could check FreeMiDI
devices tbr the General MIDI device property. If
the application found this property assigned to a
certain device, it could then adjust itself to display

and send the General MIDI patch changes only to
this device, r,vithout having to know anything else

about the device (such as the device model name or
patch list).

r A FTeeMIDI application that needs to
synchronize its timing to a certain device could
check for the Iransrnits Sync device property. If the
property existed, the application would knor,v that
it could successfully sync to the device.

You can assign device properties to a device when
the device is first added to your FreelvIIDI
configuration or at a later time. The FTeeMIDI

Device Specilication dialog box is where this

assignment is made. See "Editing FTeeMIDI

Devices" on page215 and'Adding FTeeMIDI

Devices" on page 214,for information on

assigning device properties to devices.

Adding Device Properties
You can add clevice properties to the default

properties found in FreeNtIIDI.

To add device properties

1 Choose Device Properfles... from the

Conliguration menu.

The Device Properties window appears.

inE Eeuire Properties :

f, on trolle r
EEceiues 5UnI
GensrEI MlDl
MlDl Mf,rhine
Transmits $Unr

ftdd

@1
Figure 35-25: Device Properties Window

2 Enter the name of the property thal you wish to

add in the text entry box at the bottom ofthe dialog

box and chckAdd.

The new device property will appear in the device

property list. You may add as many device

properties as you like at this time.

Once device properties are added, they will
immediately be available in the FTeeMIDI Device

Specification dialog box pop-up menus.

Removing and Renaming Device Properties
You can remove or rename device properties.
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f Use caution when removing or renaming
device properties that are in use by FTeeMIDI

devices in the current or any other configuration.
The properties will be removed or renamed in all
FTeeMIDI devices to which they are assigned.

Ib remove or rename any existing device

ProPerties:

I Choose Detice Properties... from the

Configuration menu.

The Device Properties window appears.

2 Select the device property you wish to remove

or rename.

3 If you are renaming the device property, enter a

new name in the text entrybox at the bottom of the

nindow and click Re n am e.

The new name for the device property appears in
the list.

,l If you are removing a device property, click
Remove.

The device property you select will be removed

rrom the list.

MIDILOCATE
,\lidilocate is a unique feature designed to make

adding devices to your FTeeMIDI configuration
easier. In this mode, FTeeMIDI automatically
determines the proper input cable to which a

device is physically attached and then displays this
connection in the FTeeMIDI Configuration
rrindow.

\Iidilocate is a checkable menu item. This means
-rhat its state (on or off) is toggled each time you

choose it from the menu. When there is a check

next to the Midilocate menu item in the MIDI
menu, Midilocate is enabled.

To use Midilocate:

1 Select a FTeeMIDI device in the FreeMiDI
Configuration window.

2 Check to be sure that Midilocate menu item in
the M IDI menu is enabled.

The Midilocate command should have a check

next to its name. If it does not, choose it to select it.
You can also use the Mac keyboard shortcut to
toggle the state of Midilocate by typing command-
L.

3 Play some MIDI data from the MIDI device.

FTeeMIDI will determine from where the MIDI
data is coming and redraw the FTeeMIDI

Configuration window to indicate the appropriate

connection.

Here is an example of Midilocate in action. Lett
say you have a Kurzweil K2000 that is connected to
some MIDI input on your MTP II, but you are not
sure which input:

1 Add a K2000 FTeeMIDI device your
configuration using Qulcl< Setup or Create Deyice,

2 Enable Midilocate.

3 Select the K2000 device.

4 Play some notes on its keyboard or send some

other MIDI data from it and the K2000 device

automatically is connected to the correct MIDI
input port on your MTP II in the FTeeMIDI

Configuration window.

THETRANSPORT CONTROLS
The Transport Controls window contains buttons

which can control the transport functions (Play,

Stop, Rewind, Locate) of other FTeeMIDI

applications from within FTeeMIDI Setup. For

instance, you might want to start a sequence
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playing in Performer rvhile you are working on

some aspect of your FTeeMIDI setup. You do so by

opening the Transport Controls window, enabling

FTeeMIDI Sync, and clicking Play.With this feature

there is no need to switch to Performer.

Once FTeeNIIDI Sync is enabled yolt can also stop

Performer, rervind the seqrlence, or locate to up to
8 predefined positions within the sequence directly
from FTeeMIDI Setup.

FTeeMIDI Sync can be enabled from any FTeeMIDI

application that is currently open and that supports
this feature of FTeeMIDL In Performer, this
command is in the Basics menu. When you enable

FTeeMIDI Sync in any open FTeeMIDI application,
it is enabled for all FTeeMIDI applications on that

Macintosh.

tf The state of FTeeMIDI Sync (ON or OFF)

cannot be changed while a FTeeMIDI application

such as Performer is playing.

To use the Transport Controls:

I Choose Transport Controls... from the MIDI
Menu or type command-- on your Mac keyboard.

The Transport Controls window appears

buttons

F i g u re 3 5 -26: : Tra n sport Control swi n d ow

2 Click FTeeMIDI Sync to enable FTeeMIDI Sync

You can skip this step if FreeN{IDI Sync has already

been enablecl by some other FTeeMIDI application.
If it is already enabled, the FTeeMIDI sync

checkbox appears checked.

3 Click the Transport Controi function that you

want to Lrse.

Click Rewind, Play, Stop, or Pause to send those

commands to the FTeeMIDI application that you

are controlling. The FTeeMIDI application should

respond to these commands as if you were using ia
own controls.

4 If the FTeeMIDI application that you are

controlling supports their use. you can use any oi
the 8 auto-locate buttons to auto-locate to some

pre-defined location in the sequence or song that L<

currently playing.

In Performer, you can define these auto-locate

points in the Markers window. Assign a number

from 1-8 for a marker in the Seek column and tha:

marker's location in the sequence will be defined a.

one of the B FTeeMIDI auto-locate points. Click the

corresponding button in the Tiansport Controls

window and Performer will locate to that point.

You can auto-locate at any time, even during
playback.

THE PANIC COMMAND
The Panic command found in the MIDI menu

sends an A// Notes Of MIDI message and then a

note offMIDI message for every MIDI note on

every possible NTIIDI channel on every MIDI
output cable on both serial ports. It also resets

MIDI software bulfers in FTeeMIDI software.

This command can take quite a while. If you wish

to stop the operation, type command-period on

your Mac keyboard.

CHECK CONNECTIONS MODE
The Check Connections command is a utility thar

FreelvllDl Setup provides for troubleshooting anc

testing the connections of yor-rr MIDI studio.

=l
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Check Connections is a checkable menu item. This

means that its state (on or off) is toggled each time
i'ou choose it from the menu.When there is a check

next to the Check Connections menu item in the

\IIDI menu, Check Connections mode is enabled.

Checking MlDlOutput
To use Check Connections mode to check MIDI
output connections:

I Check to be sure that the Check Connections

menu item in the MIDI menu is enabled.

The Check Connections command should have a

check next its name. If it does not, choose it to

select it. When the menu item is checked, Check

Connections mode is enabled and the mouse

cursor will change to the Check Connections

cursor when it is within the FTeeMIDI

Configuration window as shown in Figure 35-29

below.

Checking MlDl lnput
To use Check Connections mode to check MIDI
input connections:

I Check to be sure that Check Connections menu
item in the MIDI menu is enabled.

The Check Connections command should have a

check next its name. If it does not, choose it to
select it. \Arhen the menu item is checked, Check

Connections mode is enabled and the mouse

cursor will change to the Check Connections
cursor when it is within the FTeeMIDI

Configuration window as shown in Figure 35-29

above.

2 Send MIDI data from one of vour MIDI devices.

If the device has a keyboard, play notes on it. If it is

a rack-mount unit, you will need to find a way to
send some type of MIDI data from it. Try changing

patches or initiating a system exclusive dump from
its front panel.

3 The MIDI port to which the device is connected

should flash the eighth note icon as shown below

inFigure 35-29.

m
Fgure i5-27: CheckConnections mouse cursor

2 Press a device icon and hold the mouse button
down.

\Vhiie you hold the mouse button down, FTeeMIDI

sends a C major chord on all MIDI channels to the

IIIDI output port to which the selected device is

connected. If you have an MTR MTP II, MIDI
Express or other interface which can show MIDI
output activity, the LED should light up on the

selected output port. Additionally, the device to
*.hich you are playing MIDI should piay the C

major chord. If you do not see MIDI activity or do

not hear the C major chord, check the connections,

cables and power switches of all your MIDI gear.

3 Press other device icons to test the rest of your
studio.

I Uncheck the Check Connections menu item in
the MIDI menu by selecting it.

Figure 35-28: lncoming MlDl Doto indicator

If no ports flash, this means that FTeeMIDI is not
receiving the MIDI data. Check the connections,

cables and power switches of all your MIDI gear. If
a port flashes, but it is not the port you expected,

you will need to re-connect the MIDI device to the

correct port or better yet, change the connection in
your FTeeMIDI conflguration to match the physical

connection. See "Midilocate" on page 225. for a

quick and easy way to re-connect a device in your
FTeeMIDI configuration.
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THEVIEW MENU
The View menu allows you to change the way the

FTeeMIDI Confi guration window displays.

These choices are useful for making the FreeMIIl
configuration window display easier to read. I

There are three size options, which control the

display of FTeeMIDI device icons and three input/
output options, which control the display ofthe
"patch cords" that connect devices and interfaces,

as illustrated in Figure 35-29 below.

There are two sections in this menu that each have

three mutually exclusive options. Choosing one of
the icon size options disables the other two icon
size options. Similarly, choosing one of the input/
output view options disables the other two input/
output view options.

Figure i5-29: The View Menu

To use the View menu to change the display of your
FTeeMIDI configuration:

I Choose an icon size option from theView menu
and the FTeeMIDI Configuration window will
redraw (if necessary) to display your choice.

The choices are Small Icon, Icon, and Large Icon.

These three choices represent the three icon sizes

possible for each FTeeMIDI device. See "Editing
FTeeMIDI Devices" on page 2l5,for information
on changing the icons of your FTeeMIDI devices.

These options are useful for displaying more or less

of your FTeeMIDI Configuration, depending on

what you are doing at the time.

2 Choose an input/output view option from the

View menu and the FTeeMIDI Configuration
window will redraw (if necessary) to display your
choice.

bU Small lcon
bU lcon

r'bU Large lron

"/shou lnputs E 0utputs

Shou ltrDUls onlg
Shou 0utputs 0nlg
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CHAPTER 36 Quick Reference for FreeMIDl Setup

This chapter contains brief descriptions of all the

commands, dialog boxes and windows contained

in the FTeeMIDI Setup application. Use this
ihapter as a reference gulde for finding out how a

certain feature is used. Read the chapters that are

cross-referenced for more detailed information on
these features.

THE APPLE MENU
The Apple menu contains Desk Accessories under

sr.stem 6 and what ever is in the Apple Menu Items

tblder under system 7. The first command in the

-Lpple Menu is About FTeeMIDI Setup.

About FreeMlDl
Choose About FTeeMIDI Setup... to display the

FTeeMIDI Setup startup screen and version

number. Click the mouse anywhere to make this
display go away and return to the FTeeMIDI

Configuration window.

THE FILE MENU
The File menu contains all the commands that

allowyou to open, close, and save FTeeMIDI

configuration files. Since FTeeMIDI Setup

automatically saves any changes that you make to
the currently opened configuration, the Save and

Revert commands are always grayed-out
idisabled) in the File menu.

New
Use the New command to close the current

configuration and open a new empty configu-

ration. You will be asked if you are sure that you
rr?nt to close the current configuration, since this
will affect all FTeeMIDI applications that are

!-urrently being used. The new configuration will
contain the same MIDI interfaces as the previous

configuration. Use the Re-Scan Serial Ports

command to make FTeeMIDI scan for a different
set of MIDI interfaces.

Open
Use the Open to close the current configuration
and open a previously defined configuration.You
will be asked if you are sure that you want to close

the current configuration, since this will affect all
FTeeMIDI applications that are currently being
used. The opened configuration will contain the

same MIDI interfaces as the previous configu-
ration. Use the Re-Scan Serial Ports command to
make FTeeMIDI scan for a different set of MIDI
interfaces.

Close
Use the Close command to close the current
configuration and open a new empty configu-
ration. You will be asked if you are sure that you
want to close the current configuration, since this
will affect all FTeeMIDI applications that are

currentlybeing used. The new configuration will
contain the same MIDI interfaces as the previous
configuration. Use the Re-Scan Serial Ports

command to make FTeeMIDI scan for a different
set of MIDI interfaces. Since FTeeMIDI must
always have a current configuration in order to
operate, this command works identically to the

New command explained above.

Save As...
Use the Save As...command to save the current

configuration file with a new name.

To save the current configuration file with new

narne:

1 Choose Saye As...from the File menu.
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The Save As dialog box will appear. command that it will Undo, such as Undo Drag

Undo MidiLocate. As a shortcut, type
2 Typ. in the new name for the conliguration file. on your Mac keyboard to invoke this command,
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You cant use a colon (:) in the name; hower,,er all

other characters are permitted, including spaces.

Navigate to the disk and folder to which you wish
to save the contiguration file using the directory
menu at the top of the r'vindotv. If you enter a name

that is already in use, a dialog box r'vilI ask you to
conf,rm your choice.

3 Click Save.

Your configuration lile is saved on the disk in its

current state under the new name.

FreeMlDl Preferences
Use the F'reeMIDI Preferences command to open

the FTeeMIDI Preferences dialog box. This dialog is

rvhere you control some of the globa1 settings of
FTeeMIDI such as rvhich serial ports FTeeMIDI rvili
L1se, whether Inter-application MIDI is enabled,

whether non-FreeMIDI applications will have

access to the serial ports and r,vhether patch change

monitoring is enabled.

Quit
Use the Quit command to exit the FTeeMIDI Setup

application. Since FTeeMIDI automatically saves all
changes to the current configuration, you will
never be asked to save changes when you exit
FreeMlDI Setup.

THE EDIT MENU
The Edit menu contains commands for copying
and pasting FTeeMIDI devices in the FTeeMIDI

Configuration window. These commands can also

lvork in t1-re standard Mac way anpvhere in
FTeeMIDI Setup rvhere you can edit text.

Undo
Use the Undo command to undo the last edit or
change that you made to your FTeeMIDI Configu-
ration. Generally, this command displays the

Cut
Use the Cut command to place a copy of the

current selection on the Clipboard and then

remove the current selection. As a shortcut, type
command-X on vour Mac kevboard to invoke

command.

copy
Use the Copy command to place a copy of the

current selection on the Clipboard. As a

type command-C on your Mac keyboard to

this command.

Paste

Use the Paste comrland to insert whatever data

currently on the Clipboard. As a shortcut, type

command-V on your Mac keyboard to trvoke

command.

Clear
Use the Clear command to remove the current

selection. No copies are placed on the Clipboard.

As a shortcut, type command-B on your Mac

keyboard to invoke this command.

Duplicate
Use the Duplicate command to make copies of
currently selected FTeeMIDI devices. This

command only works on selected FTeeMIDI

devices, so it is grayed-out(disabled) unless at

one FTeeMIDI der.ice is selected. As a shortcut,
type command-D on your Mac keyboard to

this command.

QUI(K REIEREN(E FOR IREEMIDI SETUP



Select All
Lte the Select All command to quickly select all of
the current type of data. For instance, if there is no

selection in the FTeeMIDI Configuration window,

Select All selects all the FTeeMIDI devices,

interfaces, and connections in the window If a text

entry box is active, such as the name field for a

FTeeMIDI device, Select All will select all the text in

the name field. As a shortcut, type command-A on
r-our Mac keyboard to invoke this command.

THE MIDIMENU
The MIDI Menu contains commands which

provide control over FTeeMIDI Setupt various

\IIDI settings.

MlDl lnterface
Lrse the MIDI Interface command to open the

\IIDI Interface dialog box. This dialog box allows

r-ou to enable and disable the two serial ports for
llIDI. Il for instance, you have printer attached to

the Thru port of your MTP II and the MTP is

connected to the Printer serial port, you will need

to disable MIDI on the printer port in order to do

arry printing.

Return
Use the Return command to return to the

FTeeMIDI application that was last active before

svitching to FTeeMIDI Setup. This command will
onlyhave an effect if you switch to FTeeMIDI Setup

n'ith the Edit FTeeMIDI Configuration command

from any other FTeeMIDI application. As a

shortcut, type command-R on your Mac keyboard

to invoke this command.

Transport Controls
L'se the Transport Controls... command to open

rhe Transport Controls window The Tiansport

Controls window contains buttons which can

control the transport functions (Play, Stop,

Rewind, Locate) of other FTeeMIDI applications

from within FTeeMIDI Setup. For more

information, see "The Tiansport Controls" on
page225.

Check Connections
Use the Check Connections command to toggle

the state of Check Connections mode.When the

menu item is checked, Check Connections mode is

enabled.When it is unchecked, Check

Connections mode is disabled. For more

information, see "Check Connections Mode" on
page226.

MidiLocate rM

Use the Midilocate command to toggle the state of
Midilocate. When the menu item is checked,

Midilocate is enabled.When it is unchecked,

Midilocate is disabled. For more information, see

"Midilocate" on page 225.

PatchThru
Use the PatchThru command to toggle the state of
PatchThru. When the menu item is checked,

PatchThru is enabled. When it is unchecked,

PatchThru is disabled. For more information, see

"PatchThru" on page 223.

MlDl Preferences
Use the MIDI Preferences... command to open the

PatchThru Preflerences dialog box. This dialog box
allows you to choose from tlvo options as to how
PatchThru and Check Connections will function.
For more information, see "MIDI Preferences" on
page223.

Panic
Use the Panic command to send an'AIl Notes Off "
MIDI message and then a "note off" MIDI message

for every MIDI note on every possible MIDI
channel on every MIDI output cable on both serial

ports. This command will also reset all MIDI
buffers in all FTeeMIDI software. This command

can take quite a while. If you wish to stop the
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operation, type command-., on your Mac

keyboard. For more information, see"The Panic

Command"on page226.

THE CONFIGURATION MENU
The Conliguration menu provides access to

various commands for setting up and changing

your FrceM I DI configuration.

Quick Setup
Use Quick Setup...to opel the Quick Setup dialog

box which allows you to quickly add and remove

device from your current FTeeMIDI configuration.

For more information, see "Quick Setup" on

page2ll.

Create Device
Use Create Device... to open the FTeeMIDI Device

Specification and add a new FTeeMIDI device to

your current FTeeMIDI configuration. For more

information, see'Adding FTeeMIDI Devices" on

page2l4.

Edit Device
Use Edit Device... to open the FTeeMIDI Device

Specification and edit an existing FTeeMIDI device

in your current FTeeMIDI configuration.You must

select a device before this command becomes

enabled. With no devices selected, it remains

grayed-out (disabled). For more information, see

"Editing FTeeMIDI Devices" on page 215.

Device Properties
Use Device Properties...to open the Device

Properties window which allows you to add,

remove and rename device properties which canbe

assigned to FTeeMIDI devices. For more

information, see "Device Properties Window" on

page232,

Popup Patchlists
Use Popup Patchlists to toggle the state of Popup

Patchlists mode. When the menu item is checked,

Popup Patchlists mode is enabled. \t\4ren it is

unchecked, Popup Patchlists mode is disabled.

THEVIEW MENU
The View menu controls the way the FTeeMIDI

Configuration window displays. The three optioru

at the top of the menu, by Small lcon, by Icon and

by Large Icon are mutually exclusive, choosing one

option disables the other two.When an option is

chosen from the menu, it gets a check mark nextro

its menu item.

The bottom three options, Show Inputs only, Shos

Outputs only, and Show Inputs and Outputs are

also mutually exclusive. For more information, se
"The View Menu'on page 228.

WINDOWS
Windows in FTeeMIDI Setup are where you do

most of your work and where you view the result o

your work.

FreeMlDl Confi guration Window
This is the main window in FTeeMIDI Setup. This

window displays a graphical representation ofyow
MIDI studio and its connections. It is in this

window that you edit your FTeeMIDI configu-

ration. Whatever you see in this window is the

current FTeeMIDI configuration, in use by all

FTeeMIDI applications. For more information, see

"The Current FTeeMIDI Configuration" on

page209.

Transport Controls Window
The Tiansport Controls window contains buttons

which can control the transport functions (PIay,

Stop, Rewind, Locate) of other FTeeMIDI

applications from within FTeeMIDI Setup. For

more information, see "The Tiansport Controls"

onpage225.

Device Properties Window
The Device Properties window is where you can

add, rename and remove device properties which

can be assigned to FTeeMIDI devices. For more

information, see "Device Properties" on page 224

-APTI

_ < t\l

QUI(K RTTERTN(E TOR TEETMIDI SETUP
82 l

::s chal

.

:

- :: rg
.



.y the FTeeMIDI

;. The three options

i Icon, by Icon and

usive, choosing one

Vhen an option is

check mark next trr

,r, Inputs only, Shorr

and Outputs are

rre information, see

re where you do

ou view the result of

dow
:eMIDI Setup. This
presentation ofyour
ns. It is in this
:MIDI configu-
s window is the

rn, in use by all
rre information, see

guration" on

w contains buttons
l functions (Play,

FTeeMIDI

zIIDI Setup. For

lnsport Controls"

'is where you can

e properties which
evices. For more
rrties"on page224.

IEEMIDI SITUP

CHAPTER 37 Editing FreeMIDl Device Files

This chapter explains how to:

r Edit the icons that FTeeMIDI uses to display

devices in the FTeeMIDI Configuration window.

r Add devices to the FTeeMIDI Devices file so that

MIDI devices that are in your studio but not

already defined in the current version of FTeeMIDI

rvill appear in the manufacturer and model name

pop-up menus in places such as the Quick Setup

dialog box and the FTeeMIDI Device Specification

dialog box.

WORKING WITH FREEMIDI ICONS
You can add, delete, and edit icons that ship with
FreeMiDI so that you can customize the look of
vour FreeM IDI contigurations.

Adding lcons to FreeMlDl
To add icons to FTeeMIDI's icon list:

1 Copy the icon you wish to add from your icon

editor to the Clipboard, so that it will be ready to

paste.

2 If you have not done so already, open FTeeMIDI

Setup by double-clicking its icon in the Finder.

Alternately, you can open FTeeMIDI Setup by

choosing the Edit FTeeMIDI Configuration...

command in any other FTeeMIDI application.

The FTeeMIDI Configuration window will open

displaying the current FTeeMIDI configuration.

3 Choose Create Device... from the Configuration

menu or type command-K on your Mac keyboard.

The FTeeMIDI Device Specification dialog box

aPpears.

Figute 37-l: FreeMlDl Device Specification Dialog Box

4 Click lcons... or type command-l on your Mac
keyboard.

The icons dialog box appears.

Figure j7-2: lcons Dialog Box

5 Click Paste to paste the icon from the Clipboard
into FreeMIDIt icon set.

If there is an icon currently selected, you will be

asked whether you want to replace the current icon
or create a new icon. Choose the create option and

the new icon will be added to FTeeMIDI's icon set

and you can assign it to any FTeeMIDI device.

Choose the replace option and the icon will replace

the currently selected icon. For more information,
see "Editing FTeeMIDI Devices" on page 215.

6 Click OK to close the Icons dialog box.
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The FTeeMIDI Device Speciflcation dialog box
reaPPears.

7 Click Cancel to close the FreeMiDI Device

Specification dialog box.

If you do not cancel the FTeeMIDI Device

Specilication dialog box, you rvill be adding a

FTeeMIDI device to your Freel\4IDI configuration

Deleting FreeMlDl lcons
To delete icons from FTeeMIDI's icon set:

1 If you have not done so already, open FTeeMIDI

Setup by double-clicking its icon in the Finder.

Alternately, you can open FTeeMIDI setup by

choosing the Edit FTeeMIDI Configuration...

command in any other FTeeMIDI application.

The FTeeMIDI Configuration Windoi,v r,vi11 open

displaying the current FTeeMIDI configuration.

2 Choose Create Der.ice... tiorn the Configuration
menu or type command-K on your Mac keyboard.

3 Click Icons... or type command-I on your Mac

keyboard.

The Icons dialog box appears as shown in

Figure 37 -2 on page 233.

4 Use the horizontal scroll bar and arrorvs to scroll

the FTeeMIDI icon list until you see the icon you

wish to delete in the center panel.

Alternateliz, you can click icons to the ieft or right of
the center panel and they will be scrolled to the

center pane1.

5 Click Cut.

Since this operation cannot be undone, you will be

asked to conlirm this deletion.

6 Click OK to ciose the Icons dialog box.

The FTeeMIDI Device Speciflcation dialog box

reaPpears.

7 Click Cancel to close the FTeeMIDI Device

Specifi cation dialog box.

If you do not cancel the FTeeMIDI Device

Specification dialog box, you will be adding a

FreeMlDI Device to your FTeeMIDI Conligura

tion.

Editing FreeMlDl lcons
To edit icons in FTeeMIDI's icon set:

The FTeeMIDI Conliguration window rvill open

displaying the current FTeeMIDI configuratior.r.

2 Choose Create Device... from the Configuratic,-

menu or type command-K on your Mac keyboa::

The -r-reeMiDl Device Specification dialog box

appears as shor,vn in Figure 37-1 on page233.

3 Click Icons... or type command-I on your Mac

keyboard.

The Icons dialog box appears as shown in
Figure 37-2 on page 233.

4 Use the horizontal scroll bar and arrows to scroi-

the FTeeMIDI icon list until you see the icon you

wish to edit in the center panel.

Alternately, you can click icons to the left or right t-r

the center panel and they will be scrolled to the

center panel.

5 Click Copy to copy the icon to the Clipboard
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The FTeeMIDI Device Specification dialog box

appears as shown in Figure 37-1 on page 233.

'l If you have not done so already, open FreeMID-

Setup by double-clicking its icon in the Finder.

Alternately, you can open FTeeMIDI setup by

choosing the ErJit FTezMIDI Configuration...

command in any other FTeeMIDI application.
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13 Click OK to close the Icons dialog box.

6 Click OK to close the Icons dialog box.

7 Click Cancel to close the FreeMiDI Device

5pecifi cation dialog box.

8 Launch your icon editing program and paste the

icon into your editing program.

9 Make the icon look the way that you want and

then copy it back to the Clipboard.

I0 Choose Create Device... from the Configuration
menu or type command-K on your Mac keyboard.

The FTeeMIDI Device Specification dialog box

aPpears.

11 Click lcons... or type command-I on your Mac

keyboard.

The Icons dialog box appears.

12 Click Paste to paste the icon from the Clipboard

into FTeeMIDI's icon set.

\bu will be asked whether you want to replace the

current icon or create a new icon. The new icon will
be added to FTeeMIDI's icon set and you can assign

it to any FTeeMIDI device. For more information,
see "Editing FTeeMIDI Devices" on page 215.

The FTeeMIDI Device Specification dialog box

reappears.

'14 Click Cancel to close the FTeeMIDI Device

Specification dialog box,

it you do not cancel the FTeeMIDI Device

Specification dialog box, you will be adding a

FTeeMIDI device to your FTeeMIDI configuration.

EDITING TEXT FILES

Edit the text within the FTeeMIDI Devices and

Auto Config Devices text files so that FTeeMIDI can

have more information about various MIDI
devices than the information that was shipped with
your version.

To edit the text in the FTeeMIDI Devices or Auto

Config Devices files:

1 Open your text editor application.

You can use any text editor which can save files in a
"text only" format. Even the TeachText application
fromApple will work.

2 Open the FTeeMIDI Devices or Auto Config
Devices file.

These files can be found within the FTeeMIDI

Folder which is located inside your System Folder.

3 Enter the information that you wish to add.

Each file contains a description of the data format
that is required by FreeMIDI. Enter the

information about devices following this format. If
you do not understand this format by reading these

descriptions, we suggest that you have someone

else do this type of editing for you.

4 Save the file in the "text onlv" format.

Teachtxt does this automatically.

5 The next time you open FTeeMIDI Setup your
changes will appear in the various pop-up menus.

235
EDITING IREEMIDI DEVICE III.E5

:ation dialog box
-1 onpage233.

rand-I on your Mac

; dialog box.

cation dialog box

reeMIDI Device

4lDI Device

will be adding a

:MIDI Configura-

:ad5 open FTeeMIDI

:on in the Finder.

:MIDI setup by
'onfiguration...

IDI application.

rvindowwill open

DI configuration.

m the Configuration

your Mac keyboard

'and arrows to scrolt

u see the icon you

to the left or right rr:

re scrolled to the

to the Clipboard.

DEVI(E FII.E5

)n set:

rs shown in



: IAPTER 3

-s chapter p

,aic menu

'', our con1.

L.v comn'

ided cros

.r,ra1 that cL

--re.

:,/Ai8VB
,. Change 8r

I )D MEASL
.-rts a desir

re end of t

CRTICULATI

-:e articulat'
. :ey attach tc

l:. enter an ar

' 
-,1 click direr

:rter the artic
,r-ect the note

- Jette articul

(it'L

Ped

236



DI DEVICE FILES

ER 38 Quick Reference

This chapter provides a brief explanation of each

\losaic menu command,, windou,', and palette.

AUTO BARLINE
When checked, this lrormat menu command

automatically inserts barlines according to the

current meter signature when you enter ne\,\,

measures of notes at the end of the document.

For your convenience, features are listed alphabeti-

;al1y by command name or topic. We have also

provided cross-references to other sections in the

manual that contain further information about the

Iiature.

When unchecked, no barlines are automatically
inserted.

8VA/8VB
See Change 8va/Svb.

AUTO BEAM
When checked, this Format menu item causes

beamable notes to automatically beam when they

are inserted or edited. How the beamed notes are

grouped is determined by their meter signature.

ADD MEASURES
Inserts a desired number of new empty measures

at the end of the score.

ARTICULATIONS PALETTE

The articulations palette items are note-specific.

They attach to the note on which you enter them.

To enter an articulation, select the desired symbol
and click directly on top ofor near the notehead. To

enter the articulation on several notes at once,

select the notes and command-click the desired

palette articulation.

When Auto Beam is unchecked, beaffrs are never

inserted automatically and instead are inserted

manually by selecting each group of notes to be

beamed together and choosing Beam from the

Region menu.

Staccato

A((ent

A((ent

(l\4ultipurpose)

Bowings

Tremolo

Pedal markings

Fermata

Stem slashes

Stem slashes

A(cenI

Ac(ent

Tenuto

BARLINES PALETTE

Use the barlines palette to change existing barlines

into the desired barline. (To create a measure, use

the Add Measure command.) To change an

existing barline, choose the desired barline from
the palette and click directly on the barline you

wish to change or click anp,vhere in the nleasure to
its right. Most of the barlines are self -explanatory,

except as noted below.

Phrase mark

Pause

F
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lnvisible barline
Behaves like any other barline except that it does

not appear on the staff, either on the screen or

when printing out. Use the invisible barline to

create barless music.

Line break tool
Moves measures to the previous or next line (or

staff system). To force a line break, grab the

measure(s) that should be on the next or previous

system, and drag them up or down (or left or right)
towards the previous or next system.

This tool gives you manual control over how many

measures appear on a line (or staff system) and

where the line or page break occurs. You can open

up music that is too crowded by moving one or

more measures to the next or previous system.

Likewise, you can tighten up music that is too

spread out by adding measures to it from the

previous or next system.

The line break tool has no effect in a galley view,

since a galleyview has no line breaks, system

breaks, or page breaks.

BEAM
Beams any flagged notes within the selected region.

If Auto-beam is checked in the Format menu,notes

to be beamed are grouped according to the current

meter signature. If Auto-beam is unchecked, all

adjacent beamable notes are grouped together.

0riginal selected notes

to be beamed:

Resultwith Auto beam

rherked in the Format menu:

Result with Auto Beam

uncherked:

CASTING OFF
The Casting Off command lets you have global

control over where line breaks and page.breaks

occur. For example, it lets you choose four
measures per line, with either even or proportional

spacing. It also lets you set the overall horizontal

spacing.

CHANGE 8VA/8VB
Inserts an octave bracket above or below the

selected region of notes. Zero represents no ottar.a

+1 and +2 represent 8va and 15 ma, respectively. -

I and -2 represent 8vb and 15mb, respectively. The

Preferences command in the File menu provides

severai different options for the ottava markings
(i.e. "8" instead of"8va").

8va (+1)

Inserts an 8va (ottava alta) bracket above the

selected notes and displays the notes an octave

lower than originally written.

15ma (+2)

Inserts an 15ma bracket above the selected notes

and displays the notes tlvo octaves lower than

originally written.

Standard barline

Double bar

open fine

Left (open) repeat

Back-to-back repeat

Single bar repeat

lnvisible barline

Heavy barline

Heavy double bar

Fine

Right klose) repeat

Dashed barline

Double bar repeat

Line break tool
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8vb Cl)
lnserts an 8vb (ottava bassa) bracket below the

notes and displays the notes an octave higher than

originally written.

l5mb (-2)

lnserts an l5mb bracket below the notes and

displays the notes two octaves higher than

originally written.

Normal
Removes any existing ottavas from the selected

region.

Repeat ottava at system breaks
Causes an "8va" (or "Bvb", etc.) to appear at the

beginning ofthe next system when the ottava

crosses a system boundary.

Hide bracket
Hides the dashed-line bracket.

CHANGE CLEF
lnserts a clef at the current location ofthe insertion

cursor.

Select clef
Click the left/right arrows to scroll through several

choices of clefs. Stop clicking when you see the clef

you wish to insert.

Set Vertical Position
Click the up/down arrows to move the clef

vertically on the staff. This allows you to place each

clef symbol at any vertical position on the staff.

Warning Clef at system breaks
When checked, this option causes a warning clef to

be displayed at the end of the previous system

when the clef change falis at the beginning of a

system. When unchecked, no warning clef is

displayed.

CHANGE KEY

Inserts a key signature at the current location ofthe
insertion cursor.

Naturalize none
Inserts the key change with no natural signs before

it to cancel the previous key signature.

Naturalize changed
Inserts natural signs before the new key signature

ofaccidentals that have changed from the previous

key signature.

Naturalize all
Inserts natural signs before the new key signature

of all accidentals in the previous key signature.

Before/after barline
Determines where key change naturals are

displayed, either before the barline of the measure

where the key change takes place or after the

barline.
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Warning signature at system breaks
\\rhen checked, this option causes a warning key

signature to be displaled at the end ofthe previous

system when the key signature lalls at the

beginning of a svstem. When unchecked, no
rvarning signature is displayed.

Maintain pitch
Cause the notes being atfected by the new key

signature to remain at their current pitch and to be

respelled correctly according to the new key

signature.

Transpose up/down
Transposes notes to the new key from their current
key and respells them correctly according to the

new key.

Signature
Seiect the desired key signature by using the

horizontal scroll bar. Key signatures are displayed

in the window and identified by name above.

All staves
Inserts the key signature on all staves in the system

lnsert relative key on transposed staves
This option automaticaily becomes checked when

you enable the All staves option. When it is

checked, Nlosaic assumes that the key you choose

in the dialog box is the concert key, and it inserts

the correct relative key in each transposed staff
You can also use this option when inserting a key

signature in a single transposed staff. You choose

the desired concert key, and Mosaic inserts the

proper relative key for you.

CHANGE METER

Inserts a meter signature at the current location of
the insertion cursor.

Select the type of meter you wish to insert. The fir*
option allows you to type in any standard meter,

such as 314,214,618,318,51\6,and so on.

Custom
A11ows you to type in compiex meters, such as 2+3

B. To enter a custom complex meter, type in the

meter using numbers (decimals are permitted), the

plus character ( + ), and the slash character ( / ).

Click to set the default beaming...
Click the space between notes to connect or

disconnect the beam. The beam groups in this

windo'"v determine horv beamed notes are to be

grouped within the metert region by Mosaict
auto-beaming feature.

Warning signature at system breaks
When checked, this option carrses a warning meter

to be placed at the end ofthe previous system when

the meter change fal1s at the beginning of a system.

When unchecked, no warning signature will be

inserted.

All staves
When checked, this option inserts the meter in all

staves at the current location of the insertion

cursor.
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CHECK RANGE
The Check Range command scans your music for
notes that lie above or below the note range you
prescribe for each voice in the Voices window.

Mosaic automatically scrolls to that offending note

and selects the note to identify it.

Check Range begins at the location of the insertion

point in the current voice and proceeds to the end

of a staff. You can also Check Range on a selected

region ofnotes, even in multiple, selected voices at

one time.

CHECK RHYTHM
The Check Rhythm command in the Region menu

scans your music for measures that do not have the

proper number of beats and rests. When Check

Rhythm finds an error, Mosaic automatically

scrolls to that offending measure. Check Rhythm

begins at the insertion point and proceeds to the

end of a staff. You can also Check Rhythm on a

selected region of notes, even in multiple, selected

voices at one time.

CLOSE
The Close command closes the currently open,

active file. (If you have more than one file open at a

time, the active fi\e is the one whose window is

currently active.)

Like many Macintosh programs, Mosaic allows

vou open more than one file at a time. If you have

several files open and you wish to close one of
them, activate one of the file's windows.You can do

so by clicking the window's title bar or by ihoosing
the window name from the Windows menu. For

,vour convenience, each of the basic windows
(Staves, Views, Voices, Lyrics, etc.) display the fi1e

name in parentheses in the title bar.

f Please notel Clicking the close box in a view's

title bar does not close the file. Doing closes the

view window, but the file stays open. This is

because each Mosaic file can contain multiple

views, which 1.ou can close and open

independently rn ithout closing ancl opening the

file. Always use the Close command in the File

menu to close the file.

CLIPBOARD
Temporarily stores data that has been cut, copied,

or snipped. Data in the Clipboard remains there

until it is replaced by newly cut, copied, or snipped

data.

CONTROLS
The Controls window provides transport buttons
just like a tape deck for controlling playback and

recording. It includes a counter to indicate the

current playback location in measures and beats.

COPY
Makes a copy of the selected items and places the

copy on the Clipboard, fiom which they can be

pasted with the Paste command.

CUT
Removes the selected items and places thim on the

Clipboard, from which they can be pasted with the

Paste command.When removing notes, Cut leaves

behind the rhythmic duration of the removed

notes. If you wish to remove that duration, use

Snip. Anything that can be selected can be cut.

DELETE MEASURES
The Delete Measures command lets you quickly
remove any range of measures in the score. This

command is especially useful when you need to

delete quite a few measures because it saves you

from having to delete each barline one at a time. To

deiete measures, place the insertion cursor in the

first measure of the region and choose this

command.
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DOUBLE DURATIONS
The Double Durations command increases the
duration ofthe currently selected notes and rests to
the next highest duration. For example, an eighth
note will be doubled into a quarter note.

DYNAMICS PALETTE
The dynamics palette items are note-specific
(except fbr the crescendo and decrescendo

hairpins). -fhey attach to the note on which you
enter them.'Io enter a dvnamic, seiect the desired
sr.mbol and cLick directly on top of or near the
notehead.'Ib enter the dy,namic on seteral notes at

once, select the notes ancl command-click the
desired palette articulation.

Hairpin decresrendo Hairpin crescendo

Hairpin crescendo/decrescendo
To insert a hairpin, click the desired symbol in the
palette and then drag aboye or below the note or
notes. To be successfully entered, the hairpin must
begin and end on notes that are in the same voice.

EDIT FREEMIDI CONFIGURATION
The Edit FTeeMIDI Configuration command in the
File menu opens the FTeeMIDI Setup program.
Doing so lets you add, remove, and modif, devices

in your FTeeMIDI setup. Use this command when
you would like to make changes to the device list
pop-up menu in theVoices menu.

ERASE

Removes the selected items, but does not place the

selected data on the Clipboard. When removing
notes, Erase leaves behind the empty measures. Ii
you wish to remove that duration, use Snip.

Anything that can be selected can be erasecl.

Alternately, vou can Lise the delete key to erase the

seiected item(s).

EXTEND SELECTION
The Extend Selection command iets you quicklr'
select large regions in the score by specifying the
range of measures you woulcl like to select. 'Ib use

this comrnand, place the insertion cursor at the

beginning of the region and choose the Extend
Selection command from the Edit menu.

FILE PREFERENCES

The File Preferences command allorvs you to
customize certain aspects of a X,tosaic fl1e, such as

the minimum number of consecr,rtive empty
measure that rvill be combined rvith the

consolidated rests command, as r.vell as the width
of the consolidated rest bar. You can also choose

among several ways to dispiay ottavas. Changes
you rnake in this r,vindow are reflected immediatel-,'

throughout all instances of them ii'r tl.re fi1e.
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FLIP

Inverts a selected stem, slur, articulation, or other

similar symbol to the opposite side of the staff
(above or belor,r,,).

FLIP ENHARMONIC
Switches a selected note to its enharmonic

equivalent spelling.

GROUPINGS PALETTE
To enter a grouping, select the desired grouping
palette icon and drag over the notes to which you

want to apply the grouping. To insert a grouping

over a long region, click the flrst note ofthe region,

shift-click the last note, and command-click the

desired grouping in the palette. The notes at which

the grouping begins and ends must be in the same

voice. Endings, tremolos, staffbraces, and staff

brackets are explained in more detail in the

sections below.

Once entered, eclit the text, including the text

attributes, by double-clicking it. Edit the ending
bracket by clicking it and clragging its har.rdles. To

raise or lower it, click the bracket itselfand drag up

or down. To move the text, drag the text box.

1b change the default characteristics ofendings,

clouble-c1ick the ending palette tool. Default

characteristics include:

r A drop line only at the beginning, or.rly at the

end, or on both ends

r The height of the bracket from the measure

r The distance of each end of the bracket frorn tl.re

barlines

r The default text attributes for the ending text

Triplet/Tuplet
To set up the triplet or tuplet, double-click the

palette icon to open the Tuplet setup dialog.

Type in the desired tuplet ratio and select the type
of tuplet you would like. The Show 2nd number

option displays both numbers of the tuplet. For

example, a triplet is normally shown with a 3. With
the second number shown, it is written 3;2.

Staff connections
Insert these by selected the one you want and

dragging vertically to the left ofthe staves you wish
to connect. Staff connections can only be inserted

in a page view; they cannot be entered in a galley

view.

Slur

Straight gliss

Triplet/tuplet

Ending

Staffbrace

Tie

Wavy glis

Roll

Tremolo

Staff bracket

Endings
To enter an elrding, click the palette item and click

the measure over which ).ou would like to insert it.

Ifyou are inserting an ending over several bars,

drag over them. A text box appears beneath the

ending bracket. Type in the desired text. To

complete the insertion, ciick the palette icon to

deselect it, or click another palette icon.
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Roll
Insert the tremolo by clicking the palette icon and

vertically next to the notes.

Tremolo
To choose the number of bars for the tremolo,
double-click the palette icon. Enter the tremolo by
selecting the tremolo tool and dragging fiom or.re

note to the other.

HALVE DURATIONS
The Halve Durations command decreases the

duration ofthe currently selected notes and rests to
the next lowest duration. For example, a quarter
note willbe halved into an eighth note.

HIDE STEMS (RE-STEM)

The Hide Stems command removes stems from the

currently selected notes. The Re-stem command
brings back the hidden stems.

To use these trvo commands, select the notes (see

"Selecting what you want to edit" on page 131),

and choose either Hide Stems or Re-stem from the

Format menu.

The Hide Stems feature is ideal for TAB (tablature)

and chord slashes as sho',vn in Figure 8-,1 on

page 58.

INSERT MEASURES
Tl-re Insert N{easures cornlnand lets you insert new
blank rneasures into the score at any location. This
corlmand is especially usefr"rl when 1.ou need to
insert quite a few because it saves you from having
to click in r-rew barlines clne at a time. To insert

measures, piace the insertion cursor r'r,here you
rvould like to insert the measures and choose this
command.

INSERT PAGE #
The Insert Page # command in the Text menu
inserts a special page number character that
automatically displays the proper page number for
the current page. To use this command, place the

cursor in the desired location in any text box an{
choose tnsert Page # from the Text menu. The p{

ffij;r 
character is inserted at tt.le location of frl

rNVrsrFY RESTS I
The Invisily Rests command causes the currenill
selected rest( s) to become greyed out on tne scrfl

lX,Xliol'""'the 

rest is invisible when the 

'"t" 
*l

JAZZPALETTE
'lhe jazz symbols palette items are note-specific.

They attach to the note on which you enter then.
To enter a jazz symbol, select the desired symbol

and click directly on top of or near the notehead. l.
enter the symbol on several notes at once, seiect t::
notes and command-c1ick the desired palette

symbol.

Shake

Wideliptrill

5mear/short glis up

Long gliss up

Plop

Short lift

5hortspill

Doit

Lip trill

Flip

Short glis down

Long gliss down

Doit

Long lift

Long spill

Hat

KEY BINDINGS
The Key Bindings window lets you customize the

layout of the keystroke commands on the

Macintosh keyboard. It even provides keystroke

sets that emulate other music notation software.

such as Professional Composer, Finale, and

Encore.

'\
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LYRICS WINDOW
Displays all of the lyrics in the file. The name of the

file to which the Lyrics window belongs is

displayed in the title bar in parentheses.

To create a new lyric, choose Add from the mini-
menu. To rename a lyric, click its name. To assign

the lyric to a voice, choose the voice from the pop-

up menu. To set the starting measure for the lyric,
type in the measure number. To enter the lyrics,

double-click the lyric icon to open the lyric
window. To reposition a lyric in the list, drag the

lyric icon up or down. To delete a lyric, select it and

choose Delete from the mini-menu. To select a

lyric, click its icon. To select several lyrics, hold
down the shift key and drag over their icons. Mini-
menu commands are described below.

Add
Adds a lyric. To add more than one lyric at a time,

hold down the option keywhile selecting this

command.

Delete
Deletes selected lyrics from the list.

MEASURE NUMBERS
Inserts measure numbers in all views. Numbering

begins at the measure that contains the insertion

cursor at the time this command is chosen from the

Format menu.A document can have more than

one numbering scheme, and special numbering

situations can be accommodated by placing the

insertion cursor in the measure where special

numbering is needed.

tf The Measure Numbers menu item is grayed

out if the insertion cursor is not currently

positioned in a measure. Place the insertion cursor

to make the command available.

Default positioning
Drag the sample measure number to determine the

default placement of the measure numbers with
respect to their measure's initial barline. Also note

that as text, the Measure number can be left-
justifi ed, right-justifi ed, or center-justifi ed, which

further affects the number's position--especially
two and three digit measure numbers.

Number every...
Determines how often measure numbers will be

displayed.

To plare measure numbels: (hoose this option:

At the beginning barline of
each measure

Measure

At a replular interval of nrea-

sures

At the beginning ofthe first
measure in each staffsystem
only

System

At the first measure ofeach Page

page only

None option
Removes existing measures numbers.

- 

Measures (t}?e in the
desired value)

d ronue rs atio

Johnnie/le.d
Johnnie/le.d

Eackup vocols

1

34
1

1Dhorus/bickups

llh, I neYer
It ll ne-ver be

A.i--hl 0--h!
Y' goiti'

First verse

rllDrui
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ll preserve.djustmenls
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Starting with
Determines the number at which measure

numbering will begin in the measure that currently
contains the insertion cursor.

Preserve adjustments
If the measures have already been numbered, and

you have made adjustments to the position of some

of the numbers (to avoid collisions with notes, for
example), this option (when checked) preserves

those adjustments when re-numbering the

measures. Uncheck this option if you would like to
restore all measures numbers to their default
position.

MEMORY MONITOR
Displays the amount of free memory (RAM)

available to Mosaic. To increase this amount in
MultiFinder or System 7, quit Mosaic, select the

Mosaic program icon, and choose Get Info from
the File menu. Increase the application memory

size in the Get Info window.

MERGE
Places the contents ofthe Clipboard at the current

location and voice ofthe insertion cursor,

combining it with music that is already there. If one

or more items are selected at the time you choose

Merge, the Clipboard contents are combined with
the selected items.

MIDIINTERFACE
The MIDI Interface menu in the File menu lets you

tell Mosaic at what speed your MIDI interface is

operating. This setting is made automatically by

FreeMIDI, so normallyyou won't need to change

it. If you need to set it manually for some reason,

most interfaces run at lMHzl32X, including Mark
of the Unicorn's N{IDI Express. The MIDI Time

Piece II runs at FAST/lX.

NEW
The New command opens a new Mosaic file. You

can create a new file at any time, even if another file

is already open. The new file is given the temporary

name "Untitled". When you save the new file the

first time, you are given an opportunity to name

the file.

When a new file opens, what you see on the screen

depends on the new file default setup that has been

saved in the copy of Mosaic that you are running. It
you have not yet used the Save As Default Setup

command, you will see a window containing a staff
on which you can begin entering music.

NEW SETUP
The New Setup command in the File menu
automatically builds an entire score for you with
the instruments that you choose. It creates all of the

necessary voices, staves, transposed staves, score

views (both page and galley), and instrument part

views, using transposed staves where appropriate.

It is an ideal way to get started quickly when

creating a new score.

NOTEHEADS PALETTE

The noteheads in this palette can be applied to a

single note a region of notes, or all notes in a voice.

To change a single notehead, select the desired

notehead from the palette and click the note. To

change several noteheads, select them and

command-click the desired notehead in the

palette. To change all noteheads in a voice, double-

click a note in the voice to select all notes and

command-click the desired notehead in the

palette.

NOTES PALETTE

The notes palette items shown below are explained

in the following sections.
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Note durations Note durations

Grace note

A((identals (ourtesy a((identals

Dotted

Arrow cur5or

Note durations
Click a note duration to select it for the next note to

be inserted. Or, select the note duration by pressing

the appropriate key on the Macintosh keyboard.

When the duration is highlighted, either ciick the

mouse on the staff at the desired location, or place

the insertion cursor where you want and press the

return key or the enter key to insert the note.

Grace note
Turns the currently selected note duration into a

grace note of the same duration.

Accidentals
Enters the selected accidental.

Courtesy accidentals
Enter the selected courtesy accidental. A courtesy

accidental serves as a reminder for a note that

already has the accidental due to the key signature

or a previous accidental in the measure.

Dotted durations
Turns the currently selected note duration into a

single, double, or triple dot duration.

Arrow cursor
Returns the cursor to the standard arrow cursor for
selected, placing the insertion cursor, etc.

OPEN
The Open command opens Mosaic files and

standard MIDI files.

To open a file, click its name to highlight it and click

O?en. Alternately, you can double-click the file

The directory pop-up menu above the list indicates

the name of the folder or disk currently being

displayed in the window To locate a file in a

different folder, either press the directory pop-up

menu or double-click the folder name. To locate a

file on a different disk drive, click Drive (or press

the tab key). To eject a floppy disk in order to be

able to insert anothea click Eject. Cancel (or

command-period) withdraws the Open

command.

ORNAMENTS PALETTE

The ornaments palette items are note-specific.

They attach to the note on which you enter them.

To enter an ornament, select the desired symbol
and click directly on top ofor near the notehead. To

enter the symbol on several notes at once, select the

notes and command-click the desired palette

synrbol.
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Fingering numbers

Gra(e note slash

OTTAVAS
See "Change 8va/8vU'on p age 238.

PASTE

P1aces the contents ofthe Clipboard at the current
location of the insertion cursor. If one or more
items are selected at the time you choose Paste, the

selected items are removed and replaced by the

Clipboard contents. When you paste several notes,

or several measures, they replace notes or measLlres

onto which they are pasted. If 1,ou rvish to insert the

pasted material and slide over music at the

insertion point so that it does not get replaced, use

Splice.

When pasting copied staves onto a page, the pasted

staves appear at the bottom of the page and can be

dragged in Shorv La1,6s1 mode to any other
location on the page.

If you are in Show Layout mode, and you have

copied an entire page layout by choosing Select AII
and Copy from the Edit menu, the Paste command
applies the copied page layout to the currently
displayed page in the view

The Consolidate empty measures option allows

you to determine how many consecutive measures

must be empty in order for Mosaic to display a

consolidated (multi-measure) rest. For example, if

you set tl.ris option to 5, Mosaic lvill display a

consolidated rest in a system that contains five or
more empty measures.

A measure is only eligible tbr corrsolidaticx if it is
emPtlr in all staves irr the system.

PAGE SETUP

Page Setup defines the paper size, orientation, and

special printer effects for the document. The

settings in the Page Setup command affect the

currentiy open page view. If the Views window is

topmost, this command affects anyhighlighted
page vi('\,r'5 in the lisl.

(.f The options you see in this dialog box may be

different than what is displayed below because you

may be using a different printer, or vou may have a

different version of the LaserWriter softrvare.

The paper sizes and special printer options that are

presented in this dialog depend on the type of
printer you are using. The tvpe of printer you are

using is determined by what you have selected in
the Chooser. If you have selected the LaserWriter,

Page Setup ollers the follorving options:

Paper
Most printers support the following paper sizes

r US Letter (8.5" by 11")

r US I-egal (8.s" by 1a")

Trills
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,A.4 Letter (European) (2l0by 297 mm)

85 Letter (176 by 250 mm)

Tabioid (11" by 17")

Custom (any size)

paper size that you choose here should match

size of the paper in your printer.

custom paper size should be used on some

of printers, such as phototypesetters, that
provide for large page sizes. You can make the

"virtual" pages in your Mosaic page views match

paper size if you wish by setting the page size in
the Page Layout Setup mini-menu command.

Layout
This determines the number of pages to be printed
on each piece ofpaper.

Reduce or Enlarge
Laser printers offer enlargement or reduction at

any percentage. Non-Postscript printers, such as

the StyleWriter, LaserWriter IISC, and other third-
party laser printers offer a few sizes. We strongly

suggest that you use Mosaic Smart Scaling instead

because it will usually product best resuits. See

"Mosaic Smart Scaling" onpage249.

Orientation
Use the Ieft-hand orientation (vertical) for pages

that are taller than they are wide, such as a standard

8.5" by I l" page. Use the right-hand orientation
(landscape) for pages that are wider than they are

tall, such as a lengthwise score page at 1 1 " by 14".

Mosaic Smart Scaling
The Mosaic Smart Scaling option allows you to

scale the document you are printing to any size.

This option provides better results in most

situations than the standard scaling option
provided in the Page Setup dialog box. Leave the

standard options set to their default value ( 100%)

and use the smart scale option by typing in the

desired percentage.

c- It is strongly recommended that you obtain
Adobe Type Manager (ATM) for best results on a

non-Postscript printer, especially when enlarging
or reducing the printout or when printing in best

quality mode.

Options
When you click the options button, you get the

follow options:

Font substitutiol, causes the laser printer to replace

outline (high-quality) fonts that it cannot find in
the system with an outline font that is available.

The result is that all output will be high-quality. If
this option is unchecked, the missing font will
appear bitmapped (jagged) in the printout.

Text smoothing causes bitmap text to be smoothed.

Graphics smoothing carses bitmap graphics to be

smoothed. This option has no effect on printing in
Mosaic, since a Mosaic file cannot contain bitmap

graphics.

Faster Bitmap printing speeds up the printing of
bitmaps, but can sometimes cause printing errors.

For details about printer effects for other printers,
refer to the printer manual.

Print Quality
Dot-matrix and ink-jet printers usually offer at

least two print qualities: Faster and Besf. Faster

mode produces a less crisp image and prints pages

more quickly than Best mode, which produces the

highest degree ofresolution possible on the printer.

(.F Please note! Do not use Draft mode. Doing so

causes your music document to be printed with
alpha-numeric characters instead of music

symbolsl
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PICT CAPTURE
'fhe PICT Capture command lets you export
notation to other programs. Choose the command
and clrag a selection box over the notation 1.ou
rvor-rld like to export. (This only rvorks in page

vien s.) When you release the mouse, the notation
is exported to tl.re N{acintosh Clipboard. You can

then srvitch to anv other graphics program--e\€n
the Scrapbook--and use the standard Paste

cornrnand t1r pa:tc in the nrtrsic.

PRINT

Initiates the printing of the currently active vier'v,

or, if the Vier'r.s lvindow is toprnost, the currently
highlighted viervs in the Vien s rvindour This
command greys out for galle1, vietvs, lvhich cannot

be printed. To print rnusic in a gallev view, place the

staves in a page view. This command presents a

dialog lvith severai options:

Printer: irtaserJet 4"

Pdgesi Offll Dtrom: To:

fromi

0eslindtio

lil Prinl€r

i-l fale

0p tions

t- H"rp_l

LG Note! The options you see in this dialog
depend orr the printer you are using and on the

version of tl.re System Sofiu,are that you have

installed in your computer.

Copies

lvpe the number of copies yor-r r,r,ish to print.

Pages

Choose either all pages or type in a page range. Be

sure that the page range you type matches the page

numbers in the vierv.

Paper Source
Choose between the paper cassette in the printer or
hancl-t-ed sheets manually inserted into the prirrter,

Destination
Click Printer to print out the music on the printer.

Click File to sar.e the music output as a Postscripti

file on disks. Click help fbr more information.

QUIT
Closes all open files, exits the Mosaic program, ano

returns to the Finder. If an open file has unsaved

changes, Mosaic ashs if you rvish to save them
before closing the file.

REALIGN
When several staves are se1ecte.1 in Show Layout

mode, this Format menu command spaces them
evenly \\,ithin the vertical space prescribed by the

highest and lor.vest selected staves. All staves

between them are spaced evenly within the given

sPace.

When using this command, 1rcu can control the

spacing proportions between staves, systems, and

staff groups b,v modifying the ledger line values in

the Staff Layout Pref-erences comrnand in the

Format menu.

REBAR

Rearranges existing notes and rests in a voice to

place the proper number of beats in each measure

in a region in accordance u,ith the current meter

signature.

To rebar a region of notes, select the region. To

rebar all voices on a staff, place the insertion cursor

at the location where you wish to begin rebarring

the staff. To rebar voices on more than one staff.

select the voices.

REDO

Restores the last action that was reversed with
Undo. Redo arrd Urrdo are unlimite(l.You can

reverse and retrace as many steps as you want,

going all the way back to tl.re beginning of the

session ('lvherr you hrst opened the file).
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128th rest

32nd rest

eighth rest

halfrest

double-whole rest

double-dotted rest

single measure repeat

64th rest

16th rest

quarter rest

whole rest

dotted rest

triple-dotted rest

double measure repeat

REFORMAT
When staves are selected in Show Layout mode,

this Format menu command restores their spacing

to the default values specilied by the Staff Layout

Preferences command in the Format menu.

REHEARSAL MARKS
See "Text"on page255.

RE-STEM

See "Hide Stems (Re-stem)" on page 244.

RESTORE DEFAULT SPACING
The Restore Def'ault Spacing command returns the

currently selected notes to their original, default

horizontal spacing.

RESTS PALETTE

The rests palette items shown below are explained

in the following sections.

RETAIN TOOL SELECTION
The Retain Tool Selection command causes palette

items to remain selected while you use them. It is

helpful when you need to accomplish several tasks

with the tool.

REVERTTO SAVED
The Revert to Saved command closes the fiie

without saving changes and reopens the last saved

version of the file from disk. This command does

the same thing as choosing Close, answering"No"

to save changes, choosing Open, and opening the

same file.

Reyert to Saved is useful for discarding all changes

you have made to a lile since you last saved the file.

SAVE
The Save command writes to disk a copy of the

currently open, active file, replacing the last saved

version of the file on the disk. (If you have more

than one file open at a time, the active frle is the one

whose window is currently active.)

If you are saving for the {irst time, Mosaic presents

a dialog box which asks you to name the lile and

choose a disk on which to save it. Type the name

(no colons are allowed). Use the directory pop-up

menu and the Drive and Eject buttons if necessary

to choose a disk. Click Save (or press return) to

complete the operation. Click cancel (or press

command-period) to withdraw the save operation.

If a file with the same name already exists, you will
be asked if you wish to replace it. If so, answer yes.

If not, click no and type in a different name.

Here are a few recommendations regarding saving:

r Save frequently--even as frequently as every time

you make a change that you like. Thus you wont
lose work should Mosaic or the computer be

interrupted.

Rests
Click a rest duration to select it for the next note to

be inserted. When the duration is highlighted,

either click the mouse on the staff at the desired

location, or place the insertion cursor where you

want and press the space key to insert the rest.

Dotted durations
Turns the currently selected rest duration into a

single, double, or triple dot duration.
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r Save to a disk that has plenty of free space.

Saving to a disk that is almost full can cause

serious, irreparable damage to the file, the disk, or
other files on the disk.

SAVE AS

The Save As conrmand is a lvay for vou to create a

new file based on an existing one. It allows you to

save a copy of the currently open lile under a
different name.

Save As is usetti rvhen you would like to make

changes to a fi1e and save them, but you stil1 rvant to
preserve the original file. In this case, the Save

cornmand would not be the right command to use

because it would replace the original file r,vith the
nelr,,1y moclilied fi1e, thus erasing the original file.

Save As lets you save the modihed file under a
diff-erent name.

SAVE AS DEFAULT SETUP
The Save As Default Setup command a11ows you to
customize the file that you get when you choose

Ne'rv from the File menu. You can determine
windor,v positions, zoom settings, text, margins,

stave/system structure, file settings such as Show
Layout and Combine Rests, and more. lb
customize your new file setup rvith the Save As

command, open a Mosaic 1ile, set it up the wayyou
lvish, and then choose Saye As Default Setup.

\\ie also recommend that you save the file to disk as

a regular N,{osaic file so that yolr can restore it if it
gets lost. The new file setup is stored in the Nlosaic

PreJerences fle in the Preferertces Folder in the

System Folder.If this flle somehorv gets removed or
darnaged, you'll lose the nerv lile setup along with
your other preferences. if this happens, just open

your new template setup file and use the Sarve As

Dethult Setup command again to restore it.

SCALE
The Scale command lets you reduce or enlarge th.
size of notes independently from the staff. It is idea
for shrinking notes for the purposes of cue note

passages and cadenzas. A11 symbols attached to th.
notes scale with them.

SCALE SPACING
The Scale Spacing command lets 1,ou tighten or
expand the spacing of any selected note or region

of notes. Select the desired notes, choose this
command, and type the desired percentage.

SELECT ALL
Highlights all items in the currently active windor'.
Once highlighted, the items are selected and can be

edited.

SET SCORE LENGTH
When you create a musical score in Mosaic, it
contains a certain number of measures. When 1rc:
open a new file, it contains one measure, and nerr

measures are added as you enter music.

Adding blank measures to a Score
You might, however, like to set up the score before

you begin entering music. For example, you might
create a score template that contains 100 measures.

in which you would like to place meter changes, ker

changes, repeat barline sections, ar-rd so forth,
before you begin entering notes.

To do so, choose Set Score Length from the File

menu, type in the desired number of measures, and

click OK. The measures are added as empty
measures (with a rvhole rest).
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ng empty measures at the end of a

you have entered your score, you may find

you have a number of extra emPtv measures at

end of the score that you would like to remoYe'

do so, count the number of emPty measures'

Choose Set Score Length and subtract the nunlber

of empty measures from the number shown' Type

in the result and clicl< t )K.

SHIFT

The Shift command allou's you to slide notes and

rests earlier or later in a piece of music. For

example, you cor.rld seiect a section and move it

iour bars earlier.

To use the Shift comn.rand:

1 Select the music that you wish to shift.

For information about selecting, see "Selecting

r,vhat you want to edit" on Page 13 1 .

2 Choose Shift from the Edit menu.

The Shift dialog box aPPears.

3 'Io shift by a number of whole measures, tyPe

the number of measures, select either earlier or

later, and click OK.

4 To shift by a number of measures plus an

additional duration, type the number of measures,

click the "shift b)' an additional x note" option, type

in the appropriate duration, and click OK'

QUICK RETEREN(E

5 To shift by less than a measure, type in 0

measlues, clich the "shift by an aclditional x note"

option, type in the appropriate duration, and click

oK.

SHOW LAYOUT MODE
A mode in which a view can be placed by selecting

the Show Layout item in the view's mini-menu' The

command then changes to Hide Layout.To exist

Layout Mode, choose Hide Layout from the mini-

menu.

In Show Lal,out rnode, any aspect of the page's

layout can be controlled, such as staff spacinS, Page

margins, staff margins, staff size, etc. Notes and

other items that are not relateci to layout still appear

in the rvindow on the staves but they cannot be

edited.

SNIP
Removes the selected items ar-rd places them on the

Clipboard, from rvhich they can be pasted r'r'ith the

Paste command. When removing notes, Snip

closes the rhythmic gap (duration) left behind by

the removed notes by shifting up all notes and rests

after them. Snip is used prin-iarily for removing

notes and rests.

SPLICE

Places the contents ofthe Clipboard at the current

location of the insertion cursor (or currently

selected note or rest) and slides over music after the

insertion point so that it does not get replaced by

the spliced material.'vVtren you paste several notes,

or several measures, they replace notes or measures

onto which they are pasted' If you wish to replace

existing material with the Clipboard material, use

Paste. If youwish to combine the Clipboard

material with existing material, use Merge.
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SPLIT NOTES

Separates notes that share the same stem so that

you can flip the stems in opposite directions or

displace notes left ancl right. Split notes cau be used

on notes that are in the same voice, as weil as notes

in clifferent voices that share the same stem.

STAFF LAYOUT PREFERENCES

Sets the default spacing for staves and the default

size of staves when they are first placed in a view.

These spacing options affect how staves are spaced

when you:

r First add staves to a vierv

r Return staves to their default spacing usir.rg the

Reformat commancl

r Sprace staves evenlyu,ithin anyvertical region

using the Realign command. Since the exact

number of ledger lines rvon't necessarilv rnatch in

this case, ratios of these dethult values are used.

Ledgers between staves
l)etermines the defar"rlt space betrveen staves in a

staff system in the number of ledger lines betlveen

them.

Ledgers between staff grouPs

Determines the defar-rlt space between staff groups

witl.rin an staff svstem. 'I'he "staff groups" option

refers to any set of staves connectecl n'ith either a

brace or a bracket. This option allc'x'r's 1'ou to create

a larger space betr'r,een staff groups than the space

betleen staves within each group to better

differentiate betr'r,een groups of staves in a svstem.

Ledgers between systems
Determ i rtes the defaul t space bettveen staff systsn .'

when trvo or more systems aPPear on a Page.

Ledgers between staves and lYrics

Determines the default spacing of a lyric iine fror-,

its staff.

Default Staff Size

Detern-rines the default size of staves when they a:.

first added to a view. Size is expressed in point sizt

The star.rdard staff size is 20 points. Any point size

is a11owed.

(- Please notel For better screen display, use a

staffpoint size that is a multiple of 4, such as 12, 10.

20,24,28,etc.

STAVES WINDOW
Displai,s all of the staves in the file. I'he name of th.

file to rvhich the Staves wittdorv belongs is

dispiayecl in the title bar in parentheses.
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'fo create a nerv staff, choose Add staff tiorn the

mini-menu. To rename a staff, click its narne. To

change the staff transposition, pop-edit in the

Tiansposition column. To enter a commer-rt, click

the Comments column. To reposition a staff in the

list, clrag the staff icon up or down.'Ib clelete a statt.

select it and choose Delete from the mini-rnet.ru. Tc

select a staff, click its icon. To select severai staves,

hold down the shift key and drag over their icons.

To conligure the statf, double-c1ick its icon''fo

place a stafT in a view, drag the staff icon frorn the

Star.es windorv into the opened View window

Mini-menu commands are described below.
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Add staff
Adds a staff. Seiect the desired clef from the clef

sub-menu. To add more than one staff at a time,

hold down the option keywhile selecting this

command.

Add staff with voice
Identical to the above command, except that the

staff is added with a new voice already assigned to

it.

Show voices
When this menu item is checked, the voices

assigned to the staves appear indented below the

staff. When unchecked, no voices appear in the list.

Delete
Deletes selected voices from the list.

Configure...
Opens the staff configuration dialog for the

currently selected staff or staves. Staff

configuration allows you to set the number of staff

iines, turn ledger lines on or off, rearrange the

order of and delete voices, and set the default stem

direction for the voices on the staff.

TAB NOTEHEADS PALETTE

The noteheads in this palette can be applied to a

single note, a region of notes, or all notes in a voice.

To change a single notehead, select the desired

notehead from the palette and click the note. To

change several noteheads, select them and

command-click the desired notehead in the

palette. To change all noteheads in a voice, double-

click a note in the voice to select all notes and

command-click the desired notehead in the

palette.

TEMPLATES WINDOW
Displays all of the template views in the file. The

name of the file to which the Templates window
belongs is displayed in parentheses next to it in the

Windows menu.

To create a new template view, choose Add from the

mini-menu. To rename a tempiate view, click its

name. To enter a comment, click the Comments

column. To reposition a template view in the list,

drag the template view icon up or down. To delete a

template view, select it and choose Delete from the

mini-menu. To select a template view click its icon.

To select several template views, hold down the

shift key and drag over their icons. To open the

template view window, double-click the template

view's icon. Mini-menu commands are described

below.

Add
Adds a template view. To add more than one

template view at a time, hold down the option key

while selecting this command.

Delete
Deletes selected template views from the list.

TEXT

Mosaic provides several types of text. Each type is

explained in one of the following sections.

Text palette
Each tool is explained in a section below

lrTemDlates (SamEles)
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Voi(e text

System text

Rehearcal mark

Da capo

Segno

(hord symbols

Stafftext

Page text

Metronome marking

Dal segno

foda

(hord symboh with guitarfret symbols

The Text menu
To change the text attributes (font, style, point size,

andjustification) ofany text inside a text box, select

*:j:" 
and choose the desired attribute from the

Text editing
Mosaic shares the same conventions for text editing
as most Macintosh graphics software. To enter text,

click the desired text tool and drag out a text box.

Choose font attributes from the Text menu. Type

the text in the standard fashion, using the delete

key and return key if necessary. To finish entering
the text, click the same text palette item to deselect

it, or click another palette tool. To edit a text item,
double-click it. To change the size of the text box,

select it and drag its handle. To delete a text box,
click it once to select it and press the delete key. To

change the font, point size, or style of the entire
select box, click the text once to select the text box
and choose the desired attributes from the Text

menu. To change the attributes of a selection within
the text box, double-click the text box, select the

desired text, and choose the desired attributes from
the Text menu.

Changing the default text attributes (font,
style, size, etc.)
To change the default text attributes ofpalette text
items such as measure numbers, system text, and

rehearsal marks, double-click the palette icon and

*""".j:the 
desired text attributes from the text

Y:i::;Tl"raves much like note-specific sy*{
such as articulations and ornaments: it is anchorl
to a specific note in a voice, and it sticks with th{
notes when the note is cut, copied, pasted, t
repositioned, etc. I
To insert voice text, click the voice text palette icon

click the notehead of the note to which you want tr

attach it, and type the text.

Staff text
Staff text appears above or beiow the staff and is

anchored to the measure at which you insert it; it
does not flow with the music.

Enter staff text by clicking the staff text icon and

clicking the measure. To set the default font, style

and point size, double-click the staff text palette

icon.

System text
System text appears above the top staff of a staff
system. If a staff from that system is placed by itseE

in another view, the system text appears above it as

well. System text is ideal for directions in a score

that need to appear in each individual instrument
part as well, such as general directions, tempo
markings (*ch as Andanfe), and cues.

Enter system text by clicking the system text palette

icon and clicking the measure over which you wish

to place it. Double-click the system text palette icon

to set the default text attributes.

System text can be edited in the standard fashion

Page text
Page text can only be inserted in a page view. It is
anchored to the page, exists as part ofthe entire
page layout, and copies and pastes along with the

entire page layout. Examples of page text are a title
subtitle, header, footer, page number, or copyright
notice.
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Insert page text by clicking the page text palette

icon, dragging out a text box, and typing in the

text.

Rehearsal marks
Insert a rehearsal mark by clicking the rehearsal

mark palette icon and clicking the measure over

which you wish to place it. Double-click the

rehearsal mark palette icon to set the default text

attributes.

Rehearsal marks are a form of system text, so they

appear above the top staff in a system, and above

every staff within the system when the staffappears

by itself in another view.

Metronome marking, D.C., D.S.,Segno, Coda
To enter one of these symbols, click the palette item

and click the measure over which you would like to

insert it. (Ifyou are inserting an ending over several

bars, drag over them.) A text box appears with the

appropriate symbol (, =, D.C., D.S., X', or s 
), to

which you can add additional text. Type in the

desired text. To complete the insertion, click the

palette icon to deselect it, or click another palette

icon. Once entered, edit the text, including the text

attributes, by double-clicking it.

To change the default characteristics ofthese items,

double-click the palette icon to open the default

configuration dialog. Default characteristics

include:

r the default position above the measure

r the default text attributes (font, size, style, justifi-

cation)

r the note value for the metronome marking
(quarter note, eighth note, and so on)

Measure numbers
To insert measure numbers, place the insertior-t

cursor in the measure where you want to begin and

choose Measure Numbers from the Format menu.

Use the dialog options to set the text attributes,

starting number, and frequency of numbering.You

can change the numbering scheme anywhere in the

document by placing the insertion cursor at the

desired measure and choosing the Measure

Numbers command. Measure numbering occurs

in all views.

Staff names
StafT names are entered as page text to the left of
each staff. See Page Texr above.

Page numbers
To insert a page number, create a text box and then

choose Insert Page # from the fbxt menu.

(- Page numbers cannot be placed in a galley

view.

Lyric text
Lyric text is a line of text that flows beneath the

notes in a voice with each consecutive word or

syllable centering itself beneath each consecutive

note.

TRANSPOSE
The Transpose command in the Region menu

allows you to transpose chromatically and

diatonically.

Chromatic
Allows you to choose the chromatic interval by

which you want to transpose.

Diatonic
Allows you to choose the diatonic intervalbywhich
you want to transpose.

You can also transpose notes diatonically by

dragging them vertically. To drag more than one

note at a time, select them and then drag one of the

selected notes.

(- To transpose by key, use the Change Key

command.
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Up/Down
Determines the direction of transposition

UNDO
Reverses the Iast action that was taken. Almost
anything can be undone. When you choose Undo,

the Redo command becomes active, allowing you
to restore the action you reversed. The Undo
command is unlimited; you can reverse as many
previous actions as you want, going all the way

back to the beginning of the session (when you lirst
opened the file). Likewise, Redo is unlimited.

VIEWS WINDOW
Displays all of the galley views and page views in
the Iile. Page views appear with a page icon. Galley

views have a page icon with an infinity symbol ( - )

superimposed on it. The name of the file to which
the Views window belongs is displayed in
parentheses next to it in the Windows menu.
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To create a new view, choose Add page or Add
galley from the mini-menu. To rename a view, click
its name. To change the starting page number for a
page view, click it in the column next to the name.

To enter a comment, click the Comments column.
To reposition a view in the list, drag the view icon
up or down. To delete a view select it and choose

Delete from the mini-menu. To select a view click
its icon. To select several views, hold down the shift
key and drag over their icons. To open the view
window, double-click the view's icon. Mini-menu
commands are described below.

Add Page
Adds a page view. To add more than one page vielr-

at a time, hold down the option key while selecting

this command.

Add galley
Adds a galley view. To add more than one galley

view at a time, hold down the option keywhile
selecting this command.

Delete
Deletes selected viervs from the list.

VOICES WINDOW
Displays all of the voices in the file. The name of the

file to which the Voices window belongs is

displayed in the title bar in parentheses.

To create a new voice, choose Add from the mini-
menu. To rename a voice, click its name. To change

the note range for the voice, click it in the column
next to the name. To enter a comment, click the

Comments column. To reposition a voice in the

list, drag the voice icon up or down. To delete a

voice, select it and choose Delete from the mini-
menu. To select a voice, click its icon. To select

several voices, hold down the shift key and drag

over their icons. To assign a voice to a staff, drag the

voice icon from the Voices window over to the

Staves window on top of the desired staff. Mini-
menu commands are described below.

Add
Adds a voice. To several voices at a time, hold down

the oution keywhile selecting this command.

Delete
Deletes selected voices from the list.
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ENDtx A Troubleshooting and Technical
Support

PREVENTI NG CATASTROPH E

Keep up-to-date backups ofyour f,les as you work,

so that you aiways have copies of the most recent

work you have done. Almost any software problem

is survivable as long as you have kept backups of
your work. Refer to "Preventing Catastrophe" on

page 18 for detailed suggestions about file

management.

Keep plenty offree space (20K or more) on any

disk containing files which you are actually

working on. This will prevent the Macintosh from
attempting to save your lile onto a disk that doesn't

have enough space for the whole file. Running out

of disk space while saving can result in an

unreadable and irretrievable file.

Write-prote(ed (Hole is open) Keep your Mark of the

Unicorn master disks

locked (write-

protected) at all times

by sliding the tab on the

back ofthe disk open so

that light can be seen

through the rectangular

aperture. We recommend that you use the master

disks only as resources from which you can make

installed copies, and as key disks with which to

start the program when you are working with an

uninstalled copy. Should your working copy of
Mosaic become damaged, you will always be able

to go back to the master disk for fresh working
copies.

TROUBLESHOOTING
Tioubleshooting is always simplest and most

effective when the exact problem can be specified

clearly and concisely. Ifyou are surprised by an

error message or by seemingly erratic behavior in

the program, take a moment to jot down the

relevant details: exactlywhat the error message said

(including any error ID numbers), what actions

were done on-screen 1'ust before the problem

occurred, what kind of file you were working with,
how you recovered from the problem, and any

unusual conditions applying during the

occurrence of the problem. This may not enable

you to solve the problem at once, but will greatly

aid in isolating the problem should it reoccur.

If the problem you are encountering seems

inconsistent, try to determine what the necessary

pattern of actions are that will cause it to occur.

Genuine bugs in application software like Mosaic

are almost always consistent in their manifestation:

the same set of actions under the same conditions

invariably brings about the same results.

Determining the exact cause of a bug often requires

experiments which replicate the problem situation

with one factor changed: starting the program

from a different disk drive, restarting the

Macintosh with a system folder containing
different versions ofthe System File and the Finder,

working with a new file instead of an existing one,

etc.

Tiy to isolate the problem. Often, software

problems are the result of corrupted data within
the f,le.You can often work around them by

copying the music to a new file, and, if necessary,

leaving behind the portions ofthe data that seem to

be causing the trouble. For example, you rnight see

an erratic display of music symbols on the screen.

If so, try cutting in and around that portion of the

score. By doing so, you may be able to remove the

corruption completely. You can then re-enter the

lost music and proceed on your way. If this does not

2s9



work, try copying the unharmed portions of the

fl1e into the clipboard and paste them into a ner'v

file.

See if the same problem happens in other files. if
not, yolr rvill rnost likely be able to abandon the

current file bv using these copy/paste tecl.rniques.

If you cannot open a particular file: first try
opening other existing Iiles, or a ner'v file, to be sure

N{osaic is rvorkir.rg at all. If you have trouble

opening more than one file, remove your installed

copy of N{osaic and then re-install a fresh copl', as

the existing cop,v has gotten corrupted. Refer also

to the list of disk and file errors in "Dealing with hle

problems and disk errors" on page i 7. If a fi1e is

opened and seems damaged, rvill not let you sal'e

changes, etc., )'ou sti11 rnay be able to save some or

all of its musical information by using the

Clipboard to copv the voices and Paste them into

another flle on another disk.

If N{osaic wili not start up at a1l, or always brings up

an irregular or damaged Iile r,vhen the N'losaic icon

is opened from the Finder, your u'orking copy may

be darnaged. Remove your installed copy of N4osaic

ar.rd then re-install a fresh copy. lb be thorough, try
instaliing from your backup master clisk (i.e. not

from the key disk from n'hich the original rvorking

copy was made). Restart the Macintosh and try
opening another (new or existing) Iile u'ith,vour

rrew working copy to see if you have the same

problem. Check also to see if other applications

(Performer, MacWrite, IviacPaint, etc.) are rvorking

properly.

If one of your key disks becomes darnaged and fails to

work as a key, our Customer Support Department

will be glad to replace it.

TROUBLESHOOTING FREEMIDI PROBLEMS

The most important tools for tracking down MIDI
problems are the Check Connections and

PatchThru commands in FTeeMIDI Setup. Using

these commands can isolate problems that stop the

flow of MIDI data from your MIDI gear to the

Nlacintosh and back again.

Ifscreen display in a FTeeMIDI sequenc€r such

as Performer is erratic or s€ems to stall and

skip, you may be running into the limits of your

Mac'.s processing porver. FTeeMIDI gives priorit,v tt
sending and receiving MIDI data over most screer,

redisplays. Horveveq with enough of an overload

vou may hear delays or erratic timing in your

music.

Usr.ra11y the overload is caused bv vast reams of
aftertouch (mono or poly key pressure), controller

or pitcl-r bend events in one or more synthesizer

tracks.

To solve the problem,1,ou must reduce the amoun:

of MIDI information being passed through the

modem and/or printer port in the follorving war-s:

r Slow dolvn the tempo of ti.re sequence during th.

problem passages.

r Delete a track or tracks from the sequence.

If FTeeMIDI starts correctly, but you are unable to recor;

(or play) anything, doubie-check your cable

connections and synthesizer settings. Use Check

Connections mode to find out where the break in

the data flow has happened. Often you will find

that FTeeMIDI may think that a certain device is

connected to an incorrect MIDI port.

If you cannot open a particular configuration file, first

try opening other existing configuration files, or a

new configuration file, to be sure FTeeMIDI is

working at all. If a fiie is opened and seems

damaged, will not let 1rcu save changes, etc., you

still may be able to save some or all of its

inlormation by using the Clipboard to coPV the

devices and paste them into another configuratior

file.
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If FTeeMIDI Setup will not start up at all, or always

brings up an irregular or damaged hle w}ren the

FTeeMIDI Setup icon is opened frorn the Finder,
your rvorking co1ry may be damaged. lte-install
FreeNilDI from one of1.our N{aster disks. Restalt

the Macintosh and try opening ar.rother (nerv or

existing) file r'vith your new \^/orking cop1. to see if
you have the same problem. Check also to see if
other applications (Perfbrmer, MacWrite,

NlacPaint, etc.) are working properl,v.

MOSAIC QUESTION & ANSWER
Here are a few commonlyasked questions about

Mosaic.

"What causes the internal error'MatchingNote
Nat Found'?"
The 'Matching Note Not Founcl' internal error can

only occur rvhen a single voice has been placed on

several staves. ifyor.r run into the error, try
removing tl-re voice from all but one of the staves.

Add it to the other staves only after,vou have

Iinished entering the voice's notes.

"Sometimes the flags on my eighth and sixteenth
notes and rests disappear when I change zoom
levels, scroll, or uncover a view. Why?"
Some display glitches are due to the existence of
multiple versions of the Sonata screen fonts in the

system folder.You can either remove the redundant

Sonata screen fonts that were not installed by
Mosaic, or you can remove all Sonata screen fonts

from your system folder and reinstall them from
your Mosaic installation disks.

"When entering notes, sometimes Mosaic will un-
flip beams I have flipped, or place the note I am
entering in the next measure when I don't want it
there. How can I stop that?"
The Auto-beam and Auto-barline algorithms

optimize the placement of notes. There are some

situations where you will want to disable these

features in the menu.

"Sometimes Mosaic is very slow at updatingthe
s cre en, so metime s not. Wiry? "
X,{osaic is slower at clrarving regular text objects

than it is at drarving music notation. This is

especiallv true wl.ren lyrics are on the page. Tr,v

ternporarilv renroving lvrics tiom the vierv while

you are still etlitilrg your mLrsic.

"How do I get Mosaic to print all of the parts at
once?"
Open the Views windor,r,. Select all (or select just

the vier,vs yorl \,\'ant to plint), trnd choose Print

from the lile menu.All selected views rvill print out
in the order they appear in the list.

TECHNICAL SUPPORT
We are happy to provide customer support to our
registered users. Ifyou haverit already done so,

please take a moment to complete the registration

card in the front of the manual and send it in to us.

When we receive your card, you Il be placed on our
mailing list and sent a free backup key disk.

Registered users r,rrho are r-rnab1e, with their dealert
l-relp, to solve problems thev are encountering with
Mosaic may contact our technical sLrpport

depar tment in one of the following ways:

r Technical support phone: (61 7) 576-3066

r Tech support fax: (617) 354-3068

r Tech support ernail: techsupport@motu.com

r AOL (America Online):kepvord MO1'U (for

dorvnloads)

r AOL tech support: MotUTec@aol.com

Tech Support is stafled Nlonday through Irriday 9

ANI to 8 PM, Ilastern Time.

If 1,ou clecide to contact tecl-r support, please have

your X{osaic manual at hand, and be prepared to

provide the following information to help us solve

your problem as quickly as possible:
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t The serial nuntber ttf the progrom. This is printed

on the cardboard page (at the front of the rnanual)

which holds the registration card. Be sure to retain

this page in the manual for your reference. You

must be able to sLrpply this number to receive

technical sLrpport.

t The version of Mosaic yotL are working wirh. This

is displayed briefly in the start-uP screen u,hen

Mosaic is started; it is also available through the

About Mosaic command from the Apple menll

from within Mosaic.

. A brief explanation of the problem, including the

exact sequence of actions whicl-r cause it, and the

contents ofany error rnessages r,vhich appear on the

screen. It is often very heipful to have brief written

notes to refer to.

t The pages in the mnnual which refer to the parts

of the program which you are having trouble rvith.

t The version or creation date of the system softwore

you are usingto run the Macina;sft. See the

h'rstallation Guide for help in finding version

numbers for the system sofirvare.

We're not able to solve everyproblem ir.nmediatel,v,

but a quick call to us may yield a suggestion for a

problem which you might otherwise spend hours

trying to track down.

Our technical support telephone line is dedicated

to helping registered users solve their problems

quickly. In t1-re past, many peopie have also taken

the time to write to us n ith their comments,

criticism and suggestions for improved versions of
our sofiware. We thank them; many of those ideas

have been addressed in Mosaic. If you ha-n'e f'eatures

or ideas you rvould like to see implemented in our

music softrvare, lved like to hear frorn you. Please

r'vrite to the Mosaic Development Team, N{ark of
the Unicorn lnc., 1280 Massachusetts Avenue,

Cambridge, MA 021 38.

Although we do not announce release dates and

features of newversions of our software in advance.

we notify all registered users immediately by marl

as soon as nerv teieases become availabie. lf you

move from the address indicated on your

registration card, please send us a note with your

change of address so that we can keeP you

informed of future upgrades and releases.
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APPENDIX B Mosaic Keyboard Bindings

A key binding is the action that takes place when

you press a key on the Macintosh keyboard. For

example, if you type the number 4 in Mosaic, the

quarter note duration becomes selected in the

notes palette. In this case, the keystroke"4" rs

bound to thefunction"select quarter note tool".

Mosaic ships with an set of default key bindings for
the entire Macintosh keyboard. These bindings are

described in this appendlx. Ifyou 1ike, you can

change these assignments and create your own

customized set of bindings. For details, see

Appendix D,"Customizing Mosaic's Key

Bindings".

Moving the insertion cursor
Here is a summary of ways to move the cursor:

To move the insertion cursor: Do This:

Left or right within a mea-
sure

Press the left/right anow keys

Up or down one line or Press thc up/clown arrol,kcys
sPace

To the next or previous Press control and the left/
measure right arrorv keys

Up or down one octave Press control and the up/
down arrow keys

'I'o anypilch (A through G)
rvithin the currenl octave

Type the desired letter

To any pitch in a different Press control and the up/
down arrow keys to move to
the desired octave and then
press the desired pitch

octave

Entering a note, rest, or chord from the
keyboard
Once you have placed the insertion cursor and set

the duration, you're ready to enter a note, rest, or

chord. Below is a summary.

(- You can use either the main keyboard or the

keypad on an extended keyboard to speed up

entry.

To enter: Do this:

A note with no accidental Press return

A note with natural Tlpe an equals sign on the
extendedkelpad ( = )

A note with a flat Tlpe a minus sign on the
extendeclkeypaci ( - )

A note rvith a sharp Type a plus sign on the
extendedkelpad(+)

A note with a double flat Type a slash on the extended
keypad ( / )

A note nith a double sharp Tlpe an asterisk on the
extendedkeypad ( * )

A dotted note Press the oeriod or decimal
kev and then return

A double-dotted or triple- Select the desired note dua-
tion and click the double dot
or triple dot palette symbol

dotted note

'l'o c different voice (either
on the same staffor a cliffer-
ent one)

To a staffabove or below
the current staff

Press command and the up/
down arrow heys

Press command and the up/
down arrow keys

The first note ofa chord Press enter

A dotted note with aD acci-
dental

The second, third, fourth,
etc. note ofa chord

A note on the same beat

with a different ciuration

A rest

A dotted rest

Press the period or decimal
key, enter, and then the
appropriate accidental note
k.y

Press enter

Position the insertion cuLsor
on the desired beat/pitch and
press enter or return

Press the space bar

Press the period or decimal
key and then the space bar
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(t- Note: the dot will remain highlighted until
you deselect it. To do so, press the dot key again

Adding an accidental to an existing note
Belor.r, is a suml.nary of the ways to add an

accidental to an existing note:

To add: Do this:

equalsign(=)
(keypad only)

minus ( - )
(kelpad only)

plus(+)
(kelpad only)

asterisk ( " )
(kelpad only)

slash ( / )
(keypad only)

A sharp

A flat

A double sharp

A double flat

A natural

command-period

A,B,C,D,E,F,G

space bar

comma

period

option period

command-option-period

Press the pius ( + ) key on the
kelpad

Press the mlnus ( - ) key on
the kelpad

Press the asterisk ( * ) key on
the keypad

Press the slash key ( / ) on the
kelpad

Press the equal key ( = ) on
the keypad

To get back the arrow cursor
after using a palette tool or
after editing text

Jump the cursor to the t)?ed
pitch within the current cur-
sor octave

command up/down arrow Switch voices

Enter a note with a natural
sign

Enter a note with a flat

Enter a note with a sharp

Enter a note with a double-
sharp

Enter a note with a double flat

Select a lower or higher note
duration

5ummary of Mosaic key bindings
Below is a summary of the Mosaic keyboard
bindings. See also Appendix C,"The Mosaic

Keyboard".

return

enteL

page up/dom (page view)

minus ( - )
(while insertion point is on
top ofa note or a note is
selected)

left/rightbracket ( [, ] )

top ofa note or a note is
selected)

delete

plus(+)
(while insertion point is on
top ofa note or a note is
selected)

asterisk ( * )
(while insertion point is on
top ofa note or a note is
selected)

slash ( / )
(while insertion point is on

Select a whole note duration

Select a halfnote duration

Select a quartcr note duration

Select a sixteenth note dura-
tion

Select an eighth note duration

Scroll to previous/next page

Delete the note to the left of
the insertion cursor or any
selected items

Enter a single note with no
accidental

Enter a note in a chord
(doesn't advance the inser-
tion cursor)

Scroll the display up/down by
one screenful

Add a flat to the note (adds a

courtesy accidental if already
flat by key signature or previ-
ous note in measure)

Add a sharp to the note (adds
a courtesy accidental if
already flat by key signature
or previous note in measure)

Add a double-sharp to the
note (adds a courtesy acci-
dental ifalready sharp by a

previous note)

Add a double-flat to the nofe
(adds a courtesy accidental if
already flat a previous note)

T
L
(\
cs\a
0v
.!
(\
v
c
c
€t
F

4

6

Enter a rest ofthe currently
selected duration in the notes
palette

Togglegrace note statuson or
off

Toggle dotted duration on or
off

Turn on double-dot duration

t
I
(

I
I(

arrow key
(with nothing selected)

Move the cursor horizontally
by one note or vertically by
one space or line

Jump the insertion cursor up/
down one octave

Move thecursortothe next or
previous measure

control up/down arrow

shift left/right arrow
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APPENDIX D Customizing Mosaic's Key Bindings

A key binding is the action that takes place when

you press a key on the Macintosh keyboard. For

example, if you type the number 4 in Mosaic, the

quarter note duration becomes selected in the

notes palette. In this case, the keystroke"4" is

bound to the function"select quarter note tool".

Mosaic ships with an set of default key bindings for
the entire Macintosh keyboard. They are listed in
Appendix B,"Mosaic Keyboard Bindings", and a

diagram is provided in Appendix C,"The Mosaic

Keyboard".

Mosaic lets you customize these key bindings in the

Key Bindings window (Windows menu). Using

this window, you can assign any function to any

keystroke.

.ViiiiEl lllliEl_liiiiiiii;i,iliiii.i:ia Keg Bindings

Enler sh.rped notP
Enter fl!tted note
Enter netural notE
Enter double-5hirped noie
Enter double-flittPd not*
Enler note / stiu
Enter rest ind :dvincP

Deleta s.l.ction / prPYidus evenl
cursor up one line / space
Curror dovn ofte lins / sp.ce
f,ursor next mPasurP
Cursor previou! he3sura
Cursor forvard
Curror back
5Plect preYious.ote./rPsl

E]+
E-

!
i

H

tl
t:'l

I
tl

I

Ii

tr
b

The following keystroke symbol refers to the

Macintosh extended keypad:

For example, this symbol followed by the number
"3" means the "3" key on the keypad.

Here is a summary of what you can do in the Key

Bindings window and how to do it:

To do this: Do this:

E]

Click in the keystroke column next
to the function to pop.edit the key-
stroke. Type the desired key. Alter-
nately, click the function to select it,
press the tab keyto pop-edit the key-
stroke, and type the desired key-
stroke.

Click the function to select it and
choose Unbind from the mini-menu
or press the delete key.

Click the functions to select them
and choose duplicate from the mini-
menu. This makes a copy ofthe
functions in the list. Give each dupli-
cate its own unique keystroke
assignment.

Choose the desired keyset name
from the mini-menu.

Choose Save key set from the mini-
menu. Give your customized set a
unique name and click OK. Its name
appears alphabetically in the mini-
menu. To restore it at any time, iust
select its name from the mini-menu.

Choose Delete Key Set from the
mini-menu and select thekeyset you
want to delete from the hierarchical
menu.

Click the function name. Ifit is a pal
ette symbol, the corresponding pal.
ette item highlights.

m
@tl,l
lM;\,
l4*l

EM

Assign a keystroke to
a function or change
an existing keystroke

Remove a keystroke
assignment

Assign a function k:
more than one key

Switch keysets

Name and save a key
setthat you have cus-
tomized

Delete a key set

Displav a symbol in
the function list

7 I I

4 5 6

1 I 2

I 0
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Find a palette sym-
bol in the Key Bind
ings rvindorr list

Restore the original
Mosaic key set (or
the oriplinirl Com-
poser, Encore, or
Finale key set)

Click the item in the palette

Choose its boldface name from the
mini-menu. Boldface keysets cannot
be modified or deleted so you always

have an unaltered copy. Use the Save

Keyset command to save changes

under a different name.

+/-. As Mosaic does not need to change modes

when entering notes, the zero (on the numeric

keypad) key enters a note and advances the cursor.

MIDI Step entry is very similar and should be easi'

to use if you are familiar with Fina1e". One could

also program Score, Staff and Note expression

"Meta Tools" by assigning them to the number kets

(above the letter keys) and choosing different

modifier keys to choose which group you were

seiecting. For example, you could assign all the

dynamic palette items to the Control key, all the

articulations to the Option key, and ornaments to

the Shift key.

Making a diagram of your customized key set
Using the techniques described earlier, you can

assign any function to any key. Below is a keyboard

diagram that you can fiIl in with your own key

bindings for easy reference.

You maywant to make a copy of this page and mark

up the copy so that you always have a blank original

to make copies from.

if The names of functions are "hard wired" ; they

cannot be changed.

Using keysets from Professional Composer,
EncorerM,and FinalerM
The Key Bindings window rnini-menu provides

alternative keysets for Professional Composer,

Encore (2.51),andFinale (2.6.3).If you are familiar

with these programs and prefer one of these

alternative keysets, you can switch to it by choosing

its name from the mini-menu. If you would like to

preserve the current key set, save it first.

The Encore and Finale keysets do not exactly

match the original programs. Similarities and

differences are summarized below.

Encore 2.5. I key bindings
Duration, play/stop, record, arrow accidentals,

tuplet and dotted note keys are the same. Mosaic

treats ties differently from Encore", and the

command-T keystroke for ties is already taken by

Mosaic's Transpose function. All other command

keys are not implemented, except for standard

Macintosh commands such as Copy, Paste, New,

Open, etc.

Finale 2.6.3 key bindings
These bindings emulate the speedy note entry tool

key strokes. Keys that enable you to move around

the score have been preserved as closely as possible

as are duration keys, grace note select, add note to

chord key" dot key tie key and delete key. One

major difference is the accidental keys (+i -): in

Mosaic they insert a note with a sharp or a flat and

the (*) inserts a note with a natural. To get a double

flat or sharp press the control key before selecting
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APPENDTX r References

The following books are recommended as sources

o[ inlormation about engraving music:

McGrain, Mark. Music Notatlon (Boston: Berklee

College of Music, 1986).

Piston, Walter. Orchestration (New York: W. W.

Norton & Company Inc., 1955).

Read, Gardiner. Music Notation: A Manual of
Modern Practice, 2nd Edition (New York, New
York Thplinger Publishing Company, 1969).

Roemer, Clinton,The Art of Music Copying
(Sherman Oaks: Roerick Music Co., 1985).

Ross, Ted. The Art of Music Engraving and

Processing (Miami: Charles H. Hansen Music and
Books, Inc., 1970).
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APPENDIX F Palette Quick Reference Guide

Articulations
The articulations palette items are note-specific.

They attach to the note on which you enter them.

To enter an articulation, select the desired symbol

and click directly on top ofor near the notehead. To

enter the articulation on several notes at once,

select the notes and command-click the desired

palette articulation.

Standard barline

Double bar

0pen fine

Left (open) repeat

Ba(k-to-ba(k repeat

5plit consolidated rest barline

lnvisible barline

Heavy barline

Heavy double bar

Fine

right klose) repeat

Dashed barline

Double bar repeat

line breaktool

Sta(cato

A((ent

A(cent

(Multipurpose)

Bowings

Tremolo

Pedal markings

fermata

stem slarhes

Stem slashes

A(ent

A((ent

Tenuto

Dynamics
The dynamics palette items are note-specific
(except for the crescendo and decrescendo

hairpins, which are groupings). They attach to the

note on which you enter them. To enter a dynamic,

select the desired symbol and click direcdy on top
of or near the notehead. To enter the dynamic on
several notes at once, select the notes and

command-click the desired palette articulation.

Phrase mark

Pause

Barlines
Select the desired barline from the palette and click
the barline in the view that you wish to change. Use

the line break tool to drag measures to the next or
previous staff system.

Hairpin decescendo Hairpin crescendo

Groupings
Enter groupings by clicking the desired item in the

palette and dragging over the desired region of
notes. To enter a staff brace or bracket, drag
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Dotted durations

Ornaments
fhe ornamett

They attach tt
-lo 

enter an ot

and click dire,

enter the synt

notes and cor

svmbol.

Rests
F.nter items 1

manner as n

Note durations

Fingering n

Accidentals

vertically to the left of the staves in a page view.

Double-click the triplet, ending, and tremolo

palette items to configure them.

click a note in the voice to select all notes and

command-click the desired notehead in the

palette.

Slur

Straight gliss

Triplet/tuplet

Ending

Staffbra(e

Tie

Wavy gliss

Roll

Tremolo

Staffbra(ket

Jazz
The jazz symbols palette items are note-specific.

They attach to the note on which you enter them.

To enter a jazz symbol, select the desired symbol

and click directly on top ofor near the notehead. To

enter the symbol on several notes at once, select the

notes and command-click the desired palette

symbol.

lnvisible notehead

5ha ke

Wide lip trill

Smear/short qliss up

Long qliss up

Plop

Short lift

Short spill

Doit

Lip trill

tlip

Short gliss down

Long glis down

Doit

long lift

Long spill

Hat

Notes
Click a note duration to select it tbr the next note to

be inserted. Or, select the note duration by pressing

the appropriate key on the Macintosh keyboard.

When the duration is highlighted, either click the

mouse on the staff at the desired location, or place

the insertion cursor where you want and press the

return key or the enter key to insert the note. The

grace note turns the currently selected note

duration into a grace note of the same duration.

Enter accidentals and courtesy accidentals by

clicking the accidental palette item and then

clicking the note. Dotted durations turn the

currently selected note duration into a single,

double, or triple dot duration. The arrow cursor

returns the cursor to the standard arrow cursor for

selected, placing the insertion cursor, etc.

Noteheads
The noteheads in this palette can be applied to a

single note a region of notes, or all notes in a voice.

To change a single notehead, select the desired

notehead from the palette and click the note. To

change several noteheads, select them and

command-click the desirecl notehead in the

palette. To change all noteheads in a voice, double-

#
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the next note to
ion by pressing

sh keyboard.

ither click the
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ne duration.

lentals by
rnd then
:urn the

r a single,

Irow cursor
row cursor for
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Note durations Note durations

128th rest

32nd rest

eighth rest

halfrest

double-whole rest

double-dotted rest

single measure repeat

64th rest

l6th rest

quarter rest

whole rest

dotted rest

triple-dotted rest

double measure repeat

Grare note

A(cidentals [ourtesy ac(identals

Dotted durations

\

Text
To enter text, select the appropriate tool from the

text palette and click or drag to insert a text box.

Double-click each text palette item to open its

default conf,guration dialog box, in which you can

choose the default font, style, position, etc.

Arrow (ursor

Ornaments
The ornaments palette items are note-specific.

They attach to the note on which you enter them.

To enter an ornament, select the desired symbol

and click directly on top ofor near the notehead. To

enter the symbol on several notes at once, select the

notes and command-click the desired palette

symbol.

Voi(e text

Sy(em text

Rehearsal mark

Da capo

Segno

(hord symbols

Stafftext

Page text

Metronome marking

Dal segno

(oda

(hord symbols with guitarfret syr

Trilk

accidentals

Fingerinq numbers

Gra(e note slash

Rests
Enter items from the rests palette in the same

manner as notes.
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I

APPENDTx G Mosaic's FretBoard Font

FretBoard is a font developed by Mark of the

Unicorn to provide Mosaic with the ability to

automatically display guitar fingering diagrams

along with chord symbols.

n- If you enter FretBoard symbols are text, they
do not transpose when you transpose notes or
change key. If you would like them to be

transposable, enter them with the chord symbol
tool in the Text palette.

We provide the following point sizes in the screen

font:20,24,32and40 point.At the l00o/o zoom
level in a page view or galley view, these point sizes

Iook best on the computer screen--and also when
printed on an ImageWriter or other dot matrix
printer.We also provide an Adobe Type I version of
FretBoard (affectionately dubbed "FreBoa'), so

that when you print FretBoard symbols on a laser

printer, yot/11 get the same high-quality resolution
as the rest of Mosaic's output.

F ^aL, m'

FretBoard ships with Mosaic. It is a standard font,

and it is installed just like any other font such as

Helvetica. FretBoard contains hundreds of
fingering diagrams for every chord quality (majoa

minor, minor 7, minor 7 flat 5, etc.) and every root
(A-c).

At some point, you may want to work with fret

symbols without having to produce them using

Mosaic's chord symbol tool in the Text palette. You

can do so by entering them as standard text

instead. Each fingering diagram has been assigned

to a key on the Macintosh keyboard. The chart on

the next page shows what key to press to get any

chord fingering diagram in any key. Find the root
across the top of the chart and the chord quality
down the left-hand side. The appropriate key to

type is where the column and row meet.

Since FretBoard is a font, you can insert FretBoard

fingering diagrams using any one of Mosaic's text

entry methods, including lyric text entry. Just

select FretBoard from the Text menu, select a point
size, refer to the chart on the next page, and then

type the appropriate key.
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15ma/15mb 238

8va/8vb 237

A
Accents

see Articulations
Accidental

adjusting Position 52

deleting 57

entering with keYboard 56

entering with mouse 52

flipping to enharmonic equivalent
243

moving 57

Accidentals
collisions with notes 178

when transposed chromatically i40
when transposed diatonicallY 139

Addcommand
Voices window 26

Add galley 258

Add galley view command 36

Add measures 237

Add Page 258

Add page view command 36

Add pages commmd 4l
Add staffcommand 28

Add staffwith voice conmand 28

Adding
pages 40

All staves option 97

Allegro non troppo 105

Altered bass 126

AIto Sax l7l
Always click option 208

Apply changes command 116

Arrow keys 53

Articulations 75-76

deleting 76

entering with multiPle voices 176

flipping 76

inserting 75

inserting manY at once 76

Paleue 75

Articulations palette 23 7

Attributes
text 103

Auto Barline 237

Auto Beam 237

Auto Beam Commmd
customizing gIouPing 64

Auto Beam command 63

Auto-Flow commmd 119

Auto-scroll command 204

B
Backto-back repeat barline 82

Band
charts 153

Brlines 81-83

I[0tx

across views 43

changing 82

connecting between staves 85

connecting in galleY views 149

connecting staves 157

deleting 81

determining number Per line 78

dragging 81

inserting 81

invisible barline 83

moving with the Line Break tool 83

palette 81

Rebarring 143-144

spacing 83-85

Barlines palette 237

Basics menu
CIick

volume 208

Edit FreeM I Dl Configuration com-
mand242

Beam command 238

Beaming
across staves 65

manually 63

re-beaming 65, 181

Beams
across staves 65

adjusting angle 58, 64

adjusting distance from notes 58

adjusting height 63

Auto beaming 63

customizing grouPing 64

deleting 63

re-beaming 65

Before/after barline oPtion 239

Body pages 160, 16l
pasting into a temPlate view 162

Bowings
see Articulations

Brace
adding 40

galleyviews 149

when re-ordering staves 155

Brace (staf0 i56-157
Bracket

adding 40

galleyviews I49
when re-ordering staves 155

Bracket (staft) 156- 157

Bracket thickness option 72

Brackets
ending

see Endings
endings

adjusting 74

c
Cadenza 60

Cancelling 22

Casting Off78-81
Casting Offcommand 238

Automatic line breaks 79

compared to Scale Spacing 78

dialog box 79

Short notes occupy
widths

n notehead
80

space measures n Per line 79

This view only/All views/New views
only 8l

Change 8va/8vb 238

Change Clef239
Change Clefcommand 93

Change Key 239

Change Key command 96, 140

Change Meter 240

Change Meter command 94

Channels
MIDI click 208

Check boxes 22

Check Range 145'146, 241

Check Rhythm 1 45 - 1 46, 241

Children's music 153

Chooser 150, 166

Chord
entering with keybomd 55, 263

entering with mouse 52

Entrydialog 124

slash 58, i69, I89
splitting notes ftom177 -178

Symbol Preferences dialog 123

symbols 123-130
varying durations 52-53

Chord slT nbols
. summarized with other text 101

Chords
gettinga"""sYmbol 126

getting a "A" sYmbol 126

Chromatic
transposition, see TransPose

Chromatic option 140

Clarinet in A 171

Clefs 91-98
changing an existing clef93
inserting 93
moving 94

multiple views 43

removing 94

Click
accented 208

settings 207-208
volume 208

Click Options 207

Accented click 208

channel 208

gate 208
pitch 208

velocity 208
Clik button 205

Clipboard 134, 137,241

Close 16,241
Close trox

closing a file l5
Close command l5

with multiPle oPen files 15

Coda 102, 105,257,275
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inserting 105

making a coda section 158

Collisions
avoiding 178

Combined rests
see consolidated rests

Combining rests
See Consolidated rests

Cornmand-click 22

Comments
for a voice 26

Complex meters
examples 94

inserting 95

Complex rhlthms
rebarring 144

Composer files
Converting to Mosaic 17

Conductor score 30

Configure option (Staves window) 255
Consolidate rests command 147

Consolidated rests 43, 147

splitting 83, 147

Controller (MIDI)
playing in notes from 185

Controls window 201

Hand-splitting option 205

Copy241
multiple voices 137

Copying 135

page Iayout 160

staves 156

text 107,108
Copyright notice 107

Counter 203

Counter display 201

Countoff20T
Countoff button 201, 206

Courtesy accidental 56

Crescendo 73

Cross-staff notation 183

Cue
notes 60-61
staff41, 153

Cursor 53 55

moving 55,263
octave range 54

Customer support 261-262
Customizing

Newfile 1.5-16

Cut 134,241
multiple voices 137

Cutting
staves 156

text 107, 108

D
D.C.257
D.5.257
Dacapo 102,105,275
Dal Segno

inserting 105

Dal segno 102,105,275
Dash

centering between Iyrics 1 17

non-breaking 117, 118

separating syllables rvith 1 17

sustaining a lyric syllable with I l8
Decrescendo 73

Detault StaffSize option 254
Delete command

Staves window mini-menu 29
Delete Measures command 241
Delete pages command 4l
Deleting 134-135

accldental 5 /
articulations 76

beams 63

clefs 94
dot 57

dynamics 76

groupings 74

lyrics 121

measure numbers 89

meters 95

notes 57

ornaments 76

pages 41

rests 57

Staves in Staves window 29
voices 26

Dialog boxes 22-23
Diatonic

transposition, see Transpose
Diatonic option 140

Diminuendo 75

see also Groupings
Disks

errors I 7-18
not enough free space I 7

protecting 259
replacing 260
saving a file on 14

saving files to 12-1 5

Divisi part 25

Doit

Dot
see Articulations

deleting 57

entering with mouse 52
Dot-matrix printer 153

Dotted duration
setting 55

Dotted note (or rest)
entering with mouse 51

Double
llat

entering with mouse 52
sharp

entering with mouse 52
Double Durations command 57,242
Double flat

entering with keyboard 56
Double repeat barline 83
Double-sharp

entering with keyboard 56

Dragging
notes 57

notes to transpose 139

rests 57

single staffinto a galley view 37

single staffinto a page view 38

voice onto a staff29
Drum staff 179- 181

Duration
changing 57
dotted 55

when inserting 55

Dynamics 67,75-76
deleting 76

entering with multiple voices 176

flipping 76

palette 75

see also Groupings
symbols

see Articulations
Dyramics palette 242
Dynamics symbols

inserting 75

E
Edit FreeMlDI Configuration 242
Edit menu

Copy 135,241
Crt 134,241
Erase 134,242
Extend Selection 134

Merge 135-136,246
New 246
Paste 135-136, 248

PICT Capture i95
Redo 250
Select AII 252

Snip 134,253
Splice 135-136,253
Undo 258

Editing 131-138
consolidated rest measures 147

copying 135

large regions 35

multiple voices 137-138

selecting 13i-132
voice selection l3 I

Empty staves
removing 155

Encore
emulating Encore's keyboard layout

268
Endings 67,243

adjusting drop lines 71

adjusting endpoints 71

adjusting height 71

default characteristics 7 I
editing text 70

entering 70-72
extending 71

moving ending text 71

280
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ytoard 56

se 139

L galley view 37
L page view 38
t29

iltiple voices 176

gs

rtions

ralion242

neasures 147

:-138

; keyboard layout

E,
Fall

see Articulations
File menu

Close 15, 16,241
File Preferences

consolidated rests 147

New 12

New Setup 45-48
Open12,247
Page Setup 150,248
Pref-erences 242

Ottavas 99
Print 250
Print command 166

Quit 16,250
Revert To Saved 251

Save 12-15,251
Save As 13, 252
Save As "New" Template252
Save As Default Setup l5-16

Files ll-18
chmging new file setup 15

closing l5
defined I 1

errors 17-18
opening

multiple files 19

previous versions l2
opening Composer files 17

opening MIDI files 12

opening new file 12

preventing the loss of 13

Save As Default Setup 15-16
Save As MIDI File 14-15
saving 12-15
what gets saved 14

Finale

G
Galleyviews

defined 35
displaying a
displalng a
icon 36

mini-menu

single staff37
staffsystem 38-39

see also Groupings
setting default font 103

shortening 71

EPS

exporting notation to 196

Erase 134,242
Error messages 17- l8
Errors

disk 17-18
file l7-18
fonts 103

preventing 13

Undoing49
Exiting (quitting) Mosaic l6
Exporting

music notation to other programs
195-196

Exporting a MIDI file 186

Extend Selection c ommand, 13 4, 242

entering with mouse 52

flipping to enharmonic equivalent
243

Flip 243

Flip command 31,76
groupings 73

stems 177

Flip enharmonic 243

Fonts
endings 103

installing in text menu 103

measure numbers 103

text 103

Footers 107, 108-109
Format 0 MIDI file 186

Format I MIDI file 186
Format Chord Text option 124
Format menu

Auto Barline 237
Auto Beam 237
Flip 243
Hide Stems 58

Invisi$, Rests 58, 59, 138

Measure Numbers 245
Measure Numbers command 87
Realign 158,250
Reformat 157,251
Re-stem 58

Restore Default Spacing 82

Scale command 60
Split Notes 254
Staff Layout Prefe r ences I 57, 25 4
System Layout Preferences 152, 153

Formatting
see Page Layout

FTeeMIDI
Edit FreeMlDl Configuration com-

mand242
Fret symbols

changing for a chord 128

changing size of 124
improving appear nce I24
including with a new chord 128

FretBoard, font277

staves
copying & pasting 156

Gate
Click Options 208

Glissmdos 67
see also Groupings

Grace notes 59-60
Graphics

exporting music notation to other
programs 195-196

Groupings 67-74
adjusting position I shapeT4
definition 67
deleting 74
entering6T-72
entering over large region 68
entering with multiple voices 176
flipping 73

palette 67

Groupings palette 243

Guitar
chord slash noteheads 169

fret symbols 128

see fret symbols
tablature 191-194

H
Hairpins 67,73

see also Groupings
Half-diminished chord I26
Halve Durations 57

Halve Durations command 244
Hand Splitting option 205
Handles

using to adjust groupings 74

Headers 107, 108-109
Hide Layout command 253

Hide Stems command 58

Horizontal printing 167

Hybrid chord 126

I
ImageWriter 153

ImageWriter II 150

ImageWriter LQ i53
Importing MIDI file 186

Indent
staff or system 154

Indenting
staYes 158

Insert Measures command 244
Insert relative keyon transposed staves op-

tion97,240
Inserting

meters 94

Insertion cursor 53-55
moving 55,263
placing 54

Instrument
cue 41

note range 26-27
transposing 30

134
t6

s71
s7l

emulating Finale's keyboard layout
268

entering with keyboard 56

zoom settings 43
naming 36
opening 36

opening several at once 44
page layout 149, 161

printing 35

quick reference 35

shortcut for switching between 44
Show Layout mode 154

spacing ofnotes 80

ics 7l

71.
Flat

INDEX INDEX
281



Instrument parts 171 -1 74

assigning voice to several staves 30
example 4i
generating automatically,l5
transposing 30 31, 17 | -172

Instruments
generating voices & staves fbr 45

Inversion I 26

lnvisible barline 83, 238

Inr.isible noteheads I 69
Invisified rests

using rvith chord symbols 130
Invisi{y Rests command 58,59, 138

I
Jazz

palette 75

Jazz palette 244

Jazz svmbols
deleting 76

flipping 76

see Articulations
lustification

measure numbers 88

lusti$,103

K
Key bindings

customizing 267 269
def-aults 263-264
diagram 265,266

Key Bindings window 267
Key disk

protecting 259
Key disks

replacing 260

Key signatures 91-98
changing existing 97

etl'ect on transposing I 39, 140
inserting 96

noving 98

multiple views 43

removing 97

transposing by ke), 140-141

See Transpose
Keyboard

playing in notes from 185
Keyboard commatds 22 23

see also Keybindings

L
Landscape printing 167

Laser printer 153, 166

LaserWriter 8.0 196

Layout
see Page Layout

Layout, see Page layout
Lead sheet

chord slash noteheads 169
rhlthm slash notation 189

I-edger lines

during note entry 51

hiding/showing 31

Ledgers betrveen staffgroups option 254
I cdgrrs benvcen:lares and lyric' eprien

254
Ledgers betu,een staves option 254
Ledgers betu.een systems option 25,1

Left repeat barline 82
Line break tool 83, 238

l.ine breaks 83

across views 43

casting off78
getting 4, etc. measures per line 78
removing 8,1

Linotronic I 5l
i.1.ric text 101, 257

Llric rvindow
editing text in I 20,121
mini-menu

Apply changes I 16

Auto-Flow 1 19

Lyrics 113-122
above staff 122

across views 43

auto-flor.ing 1 l9
creatingal)Tic114
deleting i21
displaying measure boundaries 121

distance trom staff 121

editing 119-121

editing in lyric rvindow 120-121

editing on the staff I 19

entering 115 118

overview 1 14

example 118

explanation I l3
flowing automatically I l6
flowing manually I l6
font 120,121
printing separately 122

reflorving I 20

summaryof entry 118

sustaining a syllable I 17-1 18

syllables 117

u,in dorv
Add command 114

opening 1 14

Lyrics window 245

displaying measure boundaries 121

M
lvlacDralv 102

MacWrite 113

Maintain pitch option 240

Manuscript paper
analogy to staves 28

building a page 159 160

displaying a single staff.)S
displaying a staffsystem 39-40
hiding empty measure rests 59, 138

lv{argins 150-151

staff margins 154

Master page
see Page Layout'femplates

\,1easure lines
connecting in galley view 1,19

lvleasure numbers 41, 87-90, 245, 257
adjusting position 88-89
inserting 87

removing 89

restarting 89
setting default lbnt 103

I{easure Numbers command 87
N{easure widths command

eflect across vierrs 43

.N{easures 77-85
adding 78

adding blank measures 77, 252

controlling length ofscore 77,

252-253
determinins number per line 78

empty measure whole rests 59, 138
how notes f1otv tlrrough 77
mor.ing with the linc brcak tool 83
Rebarring 1,13-14,1

removing 78

removing blank measures 253

restoring dcfault width 82

spacing 43

width 61, 78

Memory monitor 2,16

N,lcnu bar 11

l\,ierge 135-136,2,{6
multiple voices 137

A,leters 91 -98

changing existing 95

inserting 94

rloving 96
multiple viets 43

removing 95

Metronome click 201

Metronome markrng 102, 105, 257, 27 5

for MIDI playback 203

inserting 106

Middle C
IvIIDI specification 27

M]DI
channels

click 208
controller

playing in notes 185

controls rvindow 201

entering chord symbols 126

Note range 27

plal.back 199 203, 203-205
recording 205-206
step-recording 201 202

IvllDI fiies 185-186
applying page templates to 187- 188

defined 185

Format 0 186

Format 1 186

opening 12

Mini-menus l9
Mosaic

282
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Multiple rests 14;

,1,
n measures optio
Naming

Files 13-14
Natural

enteringwi
entering wi

Naturalization op
Naturalize allopt
Naturalize chmgr
Naturalize none c
Naturalize option
New246
Newcommd l,

Changing d
New file setup

updating 16

New Setup 2116

New Setup comm
No accent option
Note range 26, 26

sPeci$,ing P
Noteheads 169

invisible 161

percussion .

rhytirm slroi
special trote

Noteheads palette
Notes

addingma
beaming6l
beamingm
changicg dt
collisions 17

deleting 57
dragging to
entering a d
entering wit
entering wit

entering wit
flipping enh
flowingthrc
mous€ ent}
moving 57
rebming ltl
re-beaming r

setting dural
spacing 61, i
spacing algo
spacing of7{
spelling whe
splittingfror
transposing
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opening ll
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Lnd 87

rplates

view i49
0,245,257
l-89

res77,252
: score 77,

r per line 78

le rests 59, 138

tgh77
: break tool 83

rsures 253

trh 82

105,257,275
r03

z7

es 185

I
rols 126

)3-205

202

lates to 187-188

increasing responsiveness 44
opening 1 1

quitting l6
user interface 19-23

Moving
Staves 154

Multiple rests 147

ru
n measures option 88

Naming
Files l3-14

Natural
entering with keyboard 56

entering with mouse 52

Naturalization options 97
Naturalize all option 239
Naturalize changed option 239
Naturalize none option 239
Naturalize options 97
New 246
New command 12

Changing default file setup 15

New file setup
updating 16

New Setup 246
New Setup command 12,45-48
No accent option 208

Note range26,26-27
sPeci$ring Pitch 27

Noteheads 169

invisible 169

percussion 18 1

rhythm slash notation 189

special noteheads 59

Noteheads palette 246
Notes

adding an accidental 56

beaming 63-65
beming across staves 65
chmging duration 57

collisions 178

deleting 57

dragging to transpose 139

entering a chord 52

entering with keyb oar d 55, 263

entering with keyboard (overuiew)
53

entering with mouse 5l
flipping enharmonic spelling 243

flowing through measures 77

mouse entry summary 53

moving 57
rebarring 143-144
re-beaming 65

setting duration 55

spacing 61, 78

spacing algorithm 80

spacing of78
spelling when transposed 140

splitting from a stem 177 -178
transposing by key 140-141

varying durations on same beat
52-53

Notes Palette 246
Note-specific qmbols 75

Numbering measures 41, 87-90

staYes

copying & pasting 156

templates 161-163
adding pages 162

creating 161

instrument parts 172-173
pasting a body page 162

title page 160

updating body pages from a tem-
plate 162

Page layout setup 150

Page nmbers 107, 109, 257
starting 36

Page Setup 166,248
Page setup 150

Page templates, see Page Layout Templates
Page text 101, 107- 1 I l, 256

across views 43

centering I I 1

coplng & pasting 108

deleting 108

footers 108

galleyviews 149

headers 108

inserting 107

page numbers 109

removirg (cutting) 108

staffnames 109

Page view
defued 33

Page Views
mini-menu

Add pages 4l
Delete pages 4l
zoom settings 43

Page views
adding pages 40
deleting pages 41

displaying a single staff3S
displaying a staffsystem 39-40
icon 36
instrument parts 173

line breaks 80
margins 151

mini-menu
Consolidate rests 147

Page layout setup 150

Use paper size check box 150

nming36
opening 36

opening several at once 44
page breaks 80

page text 107

quick reference 33

shortcut for switching between 44
Show Layout mode 154

spacing ofnotes 80
staves

coplng & pasting 156

template view 161

Pages

adding 40-41
adding based on a template 162

o
Octave

brackets, see Ottavas
cursor octave range 54
MIDI octaYe range 27

Octave bracket, see Ottavas
Only during countoffoption 208
Only when recording option 208

Open247
Open command 12

MIDI files 12, 186

Option key
adding several voices with 26

Option-click 22
Orientation option 249
Ornaments 75-76

deleting 76

entering with multiple voices 176

flipping 76

inserting 75
palette 75

Ornaments palette 247
Ottavas 98-99

preferences 99

P
Page breaks 83

across views 43
casting off78
removing 84

Page formatting
see Page Layout

Page layout 149-163
across views 43
adding staves l5l-152
applying to all pages 161

building a page 159-160
copying a page layout 160

galleyviews 149

long scores 149

margins 150-i5l
galleyviews 149

modif,ing existing Page I59
moving staves 154

numbering staves 158

overuiew 149

page size 150-151

galleyviews 149

pasting a page layout 160-161

removing staves 155

re-ordering staves 155

selecting staves 154

Show Layout mode 154

staffnmbering 158

staffsize 153

staff spacing 152, 157 -158

INDE)( INDE)(
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deleting 41

updating from a tenplate 162
Pagination 33
Palettes 20-22

closing 20
command-clicking 22
double-clicking 21

entering symbols tiom 21

Groupings 67

horizontal/vertical 21

opening 20

quick ref-erence 20
Paper

printing on large paper 150
Parts 171-174

examples
tempiates

41

172-]173
transposing 171-172
transposing instrument 30-3 I

Paste 135-116,248
multiple voices 137

Pasting
page iayout 160

sta\€s I 56

text 1 08

Patch (sound)
choosing for playback 200

Patch thru 200
Percussion

X noteheads 169
Percussion staff 179- 181

Performer 185

cilmparing, a r oiee rvith 2o
Prano statt J/

importing from a N{IDI file 186
Piano/vocal staff3T
PICT Capture command 195

ovewielv 250
Pin icon 8,1

Pitch
Click Options 208
determining with cursor 54

Playback 1 99-203, 203 -205
scrolling during 204
setting tempo 203

soloing/muting 203

start location 203
playback

choosing sounds for 200
Poly chord 126

Poly-rhr.thms 52
Postscript

printing to a postscript file 196
Preferences 242

chord symbols 123

measure numbering 88
minimum # of consolidated rests 147
number ofmeasures per line 81

or.erall note spacing 8 1

Print AII Viervs 250
Print comrland 1 66, 250
Print Quality option 249
Printcr Elfects 249

Printing I65-167
atareduction 166

galley viervs 35
lyrics separately I 22

on dillbrent printers 41

preparing page size 150 151

reduce/enlarged staves 153

to disk 196

Professional Composer
converting to trlosaic I 7

emulating Composer's keyboard
la,vout 268

a
Quantizing

rvhen reading a MIDI file 186

Quit 250

Quit command 16

R
Radio buttons 22
RAM 12

Realign 250

Realign command 158
Rebar 250

command 143 I 44
explanation 143

Recording
real time 205 206
Step-recording 20 I -202

Redo 250

Reclo command 49-50
Reduction 165, 166
Reformat 251

Reformat command 157
Region menu

Add l4easures 237
Beam 238

Change 8va/8vb 238
Change Clef239
Change Clef command 93
Change Key I 40, 239
Change Kev conirnand 96
Change Meter 240
Change Meter command 94
Check Range 145 146,241
Check Rhlthm 145-146, 241
Double Durations 57
FIip I 77

Halr.e Durations 57
Rebar 141-144,250
Split Notes 177, 183

Transpose 139,140,257
see also Transpose

Regions
editing large 35

Rehearsal mark 102, I05, 275
Rehearsal marks 251, 257
Repeat barlines 82,83

splitting at system breaks 82
Repeat endings

see Endings

Repeat Endings dialog 71

Repeat ottava at system breaks option 239
Repeat signs 105

inserting 105

Re-stems command 58

Restore Default Spacing command 82, 251
Rests

combrnrng l4l!
delefrns 5./

enterini with keyboard 55, 263
entering with keyboard (overview)

53

entering with mouse 5l
hiding 58

invisitying 58

mouse entry summary 53

moving 57

scaling spacing 6l
splitting combined rests 83, 147
whole rest in empty measures 59, 138

Rests Palette 251

Retain Tool Selection command 21.251
Revert To Saved 251

Rhlthrr
poly rhlthms
siash notation

52

Rhl.thm guitar
see Rhlthm slash notation

Rhr,thm slash notation 189
Rhythrns

rebarring 144
Rip

see Articulations
Roll 2,14

s
Save 251

Save As 252

Save As "New" Template 252
Saye As command 13

Save As Default Setup command 15-16
Save As MIDI File 14-15

Save command 12- l 5

Saving
files i2-15

Scale Command 60
Scale cornmand 2-52

Scale Spacing command 61,252
compared to Casting Off78

Score
checking rhlthm & range 146
examples of views 41

generating automatically 45
page layout in large score 149
rebarring 144

Scroll to coutrter option 204

Segno 102,105,257,275
Select A11 252

in Shorv l-avout node 160
Selecting 13 1- 132, 1 32-1-31

large regions 1-32

region for rebarring 143

58
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INDEX

Staves 154

Staves in !
voices 26

Sequencer
sharturg fil

Serial number 2
Set Score Lengtl
Sharp

entering s
enterings
flipping tc

Shift comman:
Shift-click ll
Shortcut corr.-.

inserting I
Single repeat ba
Size (text) 103

Size commmd I
Slash

grace note
noteheads
rh).tim n(

Slurs 67

adjusting i
entering e
see also G

Smart Scalhg o1

Snip 134,253
exmple 1.

multiplev
Snip command

exmple 7
Sound module

playing ba
Space

non-breal
sepaating

Spacing
algorithm
controllinl
Scaling ve:

Speakervolme
Special noteher
Spelling

see Accide
Splice 135-136, 2

Split notes ct:.:
Staccato

see Arii.::
Staff

Contigu::
lines -11

Staffbrace 1i6 -

adding 1

when re-,:

INDEX

Layout mi
ledger lin:
Word Bre

Split
Split

multiple rr
Notes 254
Notes coml

Shorr
Show
Show
Sign
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reaks option 239

ommmd 82,251

)ard 55, 263

)ard (ovetriew)

e51

ary 53

rests 83, 147

measures 59, 138

rmand 21,251

rtation

252

mand 15-16

r )q)

Soff 78

range 146

I

cally 45
score 149

t4

le 160

t43

Staves 154

Staves in Staves window 29

voices 26

Sequencer
sharing Iiles with 185

Serial number 262

Set Score Length command, 77, 252-253

Sharp
entering with keyboard 56

entering with mouse 52

flipping to enharmonic equivalent
243

Shift command 136-137,253
Shift-click 22

Shortcut commands 23

Show Layout mode 154,156,253
Show ledger lines option 180

Show Word Breaks 121

Sign
inserting 105

Single repeat barline 83

Size (text) 103

Size command 153

Slash
grace notes 60
noteheads 169

rhlthm notation 58

Slurs 67
adjusting 74

entering example 68

see also Groupings
Smart Scaling option 166

Snip 134,253
example 135

multiple voices 137

Snip command
exmpleTT

Sound module
playing back on 200

Space
non-breaking 117,118
separating syllables with I 17

Spacing
algorithm 80
controlling overall spacing 78

Scaling versus casting off78
Speaker volume 208
Special noteheads 59

Spelling
see Accidentals

Splice 135-136, 253

multiple voices 137

Split Notes 254

Split Notes command 183

Split notes commandlTT, l8l
Staccato

see Articulations
Staff

Configuration window 31

lines 31

Staffbrace 156-157
adding 40
when re-ordering staves 155

Staffbracket 156 157

adding 40
when re-ordering staves 155

Staffconnections 243

galley views 149

StalT Layout Preferences 155, 254

Staff Layout Preferences command 157

Staff names 107, 109 - lll, 257
abbreviating I 10

Staffpaper
building a page 159-160
displaying a staffsystem 39-40

Staffpaper (adding a staffto a page view)
38

Staffsystem
adding 151

connecting barlines 157

defined 37
displaying on a page 39-40
margins 154

removing 155

re-ordering staves 155

spacing 157-158

Staffsystems
spacingbetween i52

Stafftext 101, 256
coplng & pasting 107

Standard MIDI Files 185-186
Starting page number 36

Staves

adding 151

adding to a view 36

assigning a voice to 29

assigning several voices to 29
beaming across 65

brackets when re-ordering 155

checking Rhltllm & Rmge 145

configuring 31

connecting barlines 85, 157

copying & pasting 156

creating 28, 36

default spacing 152

deleting in Staves window 29
displaying a single staffir galleyview

37
displalng a single staff in page view

38

displaying in multiple views 41

displaying staffsystem in galley view
38-39

displafng staffsystem in page view
39-40

editing multiple 137-138
generating automatically 45
lpic editing 1l9
lJrics above 122

ly,rics below 121

margins 154

moving 154

multiple voices 175-178

numbering 158

rebarring 143-144
removing 155

removing empty staves 155

re-ordering 155

reordering in list 28

resizing 43

selecting 154

selecting in Staves windoH,29
size I 53

spacing 157-158
staff transposition 30-3 I
stem direction 31

transposing 30, I 7l - 172

transposing instruments 30-31
Staves window 19, 254

adding staves to a view 36

assigning a voice to 29

mini-menu
Add staff28
Add staffwith voice 28
Delete 29

Stems
adjusting length 58

collisions 178

default direction 29, 31

direction 176-178
flipping 177

splitting notes frora 177-178

stemless chord slash 169

Step record
button 201

Step-recording 201-202
Straight gliss 243

Styl.
text 103

Subtitle 107

centering I 1 I
Suffixes (on chords) 124,125
SuperPaint 102

Sustain
lyric syllable I 17-1 l8

Syllables
separating in lfics 117

Symbols
entering as text 104

Slmthesizer
playing back on 200

System
breaks

see line breaks
compatibility with Performer 208

System Layout Preferences 152, 153

System text l0l, 105-107,256
across several views 43
coplng & pasting I07
deleting 107

inserting 105

moving 107

T
TAB Noteheads palette 255

Tablature
entering 191-i94
Hiding stems 58

INDEX INDEX
28s



noteheads 169

Technical support 261-262
Template file

default file template 15

defined 15

Templates 161-163
Templates window 16l, 255
Tempo

setting for playback 203

Text 101-111,255
box

defined 102

deleting 102

editing 102

resizing 102

chord symbols 123-130
deleting 107, 108

entering as symbols 104

generated with New Setup com-
mand47

lyrics ll3-122
measure numbers 87-90
menu 103-104
see also Lyrics
summarized 101

typing and editing 102

Text menu 256

fustift 103

Size 103, 153

Style 103

Text Palette 102

Ties 67
adjusting 74

entering at the same time as notes 70

entering by clicking 68
see also Groupings

Title 107

disk errors 17- 18

error messages 17-18
file errors 17-1 8

fonts 103

MIDI playback 204
Trumpet l7l
Tuplets 67

adjusting bracket 74

entering 69
entering at the same time as notes 70

see also Groupings

U
Underline

extending [pic syllable with I l8
Undo 258

Undo command 49-50
Use paper size check box 150

Use printer page size option 151, 167

v
Velocities

Click Options 208
Verse

multiple verses 122

see also Lyrics
Views

adding staves 36-41
closing to increase responsiveness 44
creating 36

examples 4l
galley view defined 35

galley view quick reference 35

generating autom atically 45

icons 36
instrument parts 173

l1,rics

editing 1 l9
naming 36
opening 36
opening a template view 161

opening several at once 44
page view defined 33

scaling staffsizes 153

shortcut for switching between 44
staves

copying & pasting 156

working with multiple 4l
Views window 258

mini-menu
Add Galley view 36

Add page view 36

Vocals
see Lyrics

Voice
defined 25

Voice indicator b ox 54,175
Voice text 101, 256

copying & pasting 107

entering with multiple voices 176

inserting 104

Voices

adding several at once 26

assigning several to a staff29
assigning to a staff29
assigning to several staves 30

changing noteheads of 169

checking rhlthm & range 145

creating26
current voice 54
defined 25
deleting 26

editing multiple 137-138
entering groupings 67
generating automatically 45

icon26
merging 137

MIDI playback 203-205
multiple voices on a staff 29
naming 26

pasting 137

poly-rhyhmic 52
rearanging on a staff31
re-ordering in list 26

Selecting for editing 131

selecting for note entry 54, 17 5

selecting for note insertion 54
selecting in the Voices window 26

setting a note range 26

splicing 137

stem direction 31, 177

Voices window 258
MIDi playback 203-205
mini-menu

Ad.d26
Delete 25

Volume
Click 208

title
page 160

centering I I I
Track names

when reading a MIDI file 186

Transport controls 201

Trmspose 139-141,257
by interval (chromatically) 140

by key 140-141

chord syrnbols 130

chromatically 140

command i39, 1,10

diatonically 139-140
option 141

Transpose up/down option 240
Transposing

instrumenLs 171

Tremolo 244

Tremolos 72-73
Trills

see Articulations
Triplets 67

adjusting bracket 74

entering 69
see also Groupings

Troubleshooting

W
Wait button 201, 206
Warning Clef at system breaks option 93,

239
Warning signature at system breaks option

95,97,240
Wary gliss 243

Whole rests
in empty measures 59, 138

Windows menu 19

Key Bindings 267
Lyrics I 14

Words
see Llrics

WYSIWYG 33, 165

x
X notehead 169

z
Zooming43,44,132

andpagelayout 149

views 43
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